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Warranty
The material contained in this document is 
provided "as is," and is subject to being 
changed, without notice, in future editions. 
Further, to the maximum extent permitted 
by applicable law, Keysight disclaims all 
warranties, either express or implied, with 
regard to this manual and any information 
contained herein, including but not limited 
to the implied warranties of merchantability 

and fitness for a particular purpose. 
Keysight shall not be liable for errors or for 
incidental or consequential damages in 
connection with the furnishing, use, or 
performance of this document or of any 
information contained herein. Should 
Keysight and the user have a separate 
written agreement with warranty terms 
covering the material in this document that 
conflict with these terms, the warranty 
terms in the separate agreement shall 
control.

Technology License
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights
The Software is "commercial computer 
software," as defined by Federal Acquisition 
Regulation ("FAR") 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement ("DFARS") 
227.7202, the U.S. government acquires 
commercial computer software under the 
same terms by which the software is 
customarily provided to the public. 
Accordingly, Keysight provides the Software 
to U.S. government customers under its 
standard commercial license, which is 
embodied in its End User License Agreement 
(EULA), a copy of which can be found at 
www.keysight.com/find/sweula. The 
license set forth in the EULA represents the 
exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require or 
permit, among other things, that Keysight: (1) 
Furnish technical information related to 
commercial computer software or 
commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish to, or 
otherwise provide, the government rights in 
excess of these rights customarily provided 

to the public to use, modify, reproduce, 
release, perform, display, or disclose 
commercial computer software or 
commercial computer software 
documentation. No additional government 
requirements beyond those set forth in the 
EULA shall apply, except to the extent that 
those terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight shall 
be under no obligation to update, revise or 
otherwise modify the Software. With respect 
to any technical data as defined by FAR 
2.101, pursuant to FAR 12.211 and 27.404.2 
and DFARS 227.7102, the U.S. government 
acquires no greater than Limited Rights as 
defined in FAR 27.401 or DFAR 227.7103-5 
(c), as applicable in any technical data.

Safety Notices
This product has been designed and tested in 
accordance with accepted industry 
standards, and has been supplied in a safe 
condition. The documentation contains 
information and warnings that must be 
followed by the user to ensure safe operation 
and to maintain the product in a safe 
condition.

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula
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WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated 
conditions are fully understood and 
met.
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InfiniiVision 6000 X-Series Oscilloscopes—At a Glance

The Keysight InfiniiVision 6000 X-Series oscilloscopes deliver these features:

• 1 GHz, 2.5 GHz, 4 GHz, and 6 GHz bandwidth options.

Table 1 6000 X-Series Model Numbers, Bandwidths, Sample Rates 

Model Analog 
Channels

Digital 
Channels

Bandwidth Options Sample Rate (interleaved, 
non-interleaved)

DSO-X 6002A 2  • (none) = 1 GHz

• BW250 = 2.5 GHz

• BW400 = 4 GHz

• BW600 = 6 GHz

20 GSa/s, 10 GSa/s

DSO-X 6004A 4  

MSO-X 6002A 2 16

MSO-X 6004A 4 16
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• 2- and 4-channel digital storage oscilloscope (DSO) models.

• 2+16-channel and 4+16-channel mixed-signal oscilloscope (MSO) models.

An MSO lets you debug your mixed-signal designs using analog signals and 
tightly correlated digital signals simultaneously. The 16 digital channels have a 
1 GSa/s sample rate, with a 250 MHz toggle rate.

• 12.1 inch SVGA capacitive touchscreen display. The touchscreen makes the 
oscilloscope easier to use:

• You can use the pinch and flick multi-touch gestures on waveforms to 
change a channel's V/div setting, the time/div setting, or the delay time.

• You can "touch" inside alpha-numeric keypad dialogs to enter file, label, 

network, and printer names, etc., instead of using softkeys and the  
Entry knob.

• You can drag a finger across the screen to draw rectangular boxes for 
zooming in on waveforms or setting up Zone triggers.

• You can touch the blue menu icon in the sidebar to display information or 
control dialogs. You can drag (undock) these dialogs out of the sidebar, for 
example, to view cursor values and measurements at the same time.

• You can touch other areas of the screen as substitutes for using front panel 
keys, softkeys, and knobs.

• Voice control commands for hands-free operation.

• Interleaved 4 Mpts or non-interleaved 2 Mpts MegaZoom IV memory for the 
fastest waveform update rates.

• All knobs are pushable for making quick selections.

• Trigger types: edge, edge then edge, pulse width, pattern, OR, rise/fall time, 
Nth edge burst, runt, setup & hold, video, and zone.

• Reference waveform locations (4) for comparing with other channel or math 
waveforms.

• Many built-in measurements and a measurement statistics display.

• Serial decode/trigger options for: CAN/CAN FD/LIN, CXPI, FlexRay, I2C/SPI, 
I2S, Manchester/NRZ, MIL-STD-1553/ARINC 429, SENT, 
UART/RS232/422/485, USB, and USB PD. There is a Lister for displaying serial 
decode packets.

• Math waveforms: add, subtract, multiply, divide, d/dt, integrate, FFT 
(Magnitude), FFT (Phase), Ax+B, square, square root, absolute value, common 
logarithm, natural logarithm, exponential, base 10 exponential, low pass filter, 
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high pass filter, averaged value, smoothing, envelope, magnify, maximum, 
minimum, peak-peak, max hold, min hold, measurement trend, chart logic bus 
timing, chart logic bus state, and clock recovery.

• Jitter measurement analysis and real-time eye analysis option.

• Analysis features/options including: Color grade waveform analysis, digital 
voltmeter (DVM) and counter option, histogram display/statistics, mask testing 
option, power measurements and analysis option, and precision measurements 
and math functions.

• Built-in, license-enabled 2-channel waveform generator with: arbitrary, sine, 
square, ramp, pulse, DC, noise, sine cardinal, exponential rise, exponential fall, 
cardiac, and Gaussian pulse. Modulated waveforms on WaveGen1 except for 
arbitrary, pulse, DC, and noise waveforms.

• USB and LAN ports make printing, saving, and sharing data easy.

• VGA port for displaying the screen on a different monitor.

• A Quick Help system is built into the oscilloscope. Press and hold any key to 
display Quick Help. Complete instructions for using the quick help system are 
given in "Access the Built-In Quick Help" on page 67.

For more information about InfiniiVision oscilloscopes, see: 
www.keysight.com/find/scope

http://www.keysight.com/find/scope
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In This Guide
This guide shows how to use the InfiniiVision 6000 X-Series oscilloscopes.

When unpacking and using the 
oscilloscope for the first time, see:

• Chapter 1, “Getting Started,” starting on page 31

When displaying waveforms and 
acquired data, see:

• Chapter 2, “Horizontal Controls,” starting on page 69

• Chapter 3, “Vertical Controls,” starting on page 85

• Chapter 4, “Math Waveforms,” starting on page 95

• Chapter 5, “Reference Waveforms,” starting on page 
137

• Chapter 6, “Digital Channels,” starting on page 141

• Chapter 7, “Serial Decode,” starting on page 159

• Chapter 8, “Display Settings,” starting on page 165

• Chapter 9, “Labels,” starting on page 175

When setting up triggers or changing 
how data is acquired, see:

• Chapter 10, “Triggers,” starting on page 181

• Chapter 11, “Trigger Mode/Coupling,” starting on 
page 219

• Chapter 12, “Acquisition Control,” starting on page 
227

Making measurements and analyzing 
data:

• Chapter 13, “Cursors,” starting on page 245

• Chapter 14, “Measurements,” starting on page 255

• Chapter 15, “Histogram,” starting on page 291

• Chapter 16, “Color Grade Waveform,” starting on page 
301

• Chapter 17, “Jitter and Real-Time Eye Analysis,” 
starting on page 305

• Chapter 18, “Mask Testing,” starting on page 317

• Chapter 19, “Digital Voltmeter and Counter,” starting 
on page 331

• Chapter 20, “Frequency Response Analysis,” starting 
on page 337

When using the built-in license 
enabled waveform generator, see:

• Chapter 21, “Waveform Generator,” starting on page 
343
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When saving, recalling, or printing, 
see:

• Chapter 22, “Save/Email/Recall (Setups, Screens, 
Data),” starting on page 365

• Chapter 23, “Print (Screens),” starting on page 379

When using the oscilloscope's utility 
functions or web interface, see:

• Chapter 24, “Utility Settings,” starting on page 385

• Chapter 25, “Web Interface,” starting on page 409

For reference information, see: • Chapter 26, “Reference,” starting on page 423

When using licensed serial bus 
triggering and decode features, see:

• Chapter 27, “CAN/LIN Triggering and Serial Decode,” 
starting on page 443

• Chapter 28, “CXPI Triggering and Serial Decode,” 
starting on page 465

• Chapter 29, “FlexRay Triggering and Serial Decode,” 
starting on page 475

• Chapter 30, “I2C/SPI Triggering and Serial Decode,” 
starting on page 485

• Chapter 31, “I2S Triggering and Serial Decode,” 
starting on page 505

• Chapter 32, “Manchester/NRZ Triggering and Serial 
Decode,” starting on page 515

• Chapter 33, “MIL-STD-1553/ARINC 429 Triggering 
and Serial Decode,” starting on page 531

• Chapter 34, “SENT Triggering and Serial Decode,” 
starting on page 547

• Chapter 35, “UART/RS232/422/485 Triggering and 
Serial Decode,” starting on page 561

• Chapter 36, “USB 2.0 Triggering and Serial Decode,” 
starting on page 571

• Chapter 37, “USB PD Triggering and Serial Decode,” 
starting on page 581
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NOTE Abbreviated instructions for pressing a series of keys and softkeys

Instructions for pressing a series of keys are written in an abbreviated manner. Instructions for 
pressing [Key1], then pressing Softkey2, then pressing Softkey3 are abbreviated as follows:

Press [Key1] > Softkey2 > Softkey3.

The keys may be a front panel [Key] or a Softkey. Softkeys are the six keys located directly 
below the oscilloscope display.
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This chapter describes the steps you take when using the oscilloscope for the first 
time.

Inspect the Package Contents

• Inspect the shipping container for damage.

If your shipping container appears to be damaged, keep the shipping container 
or cushioning material until you have inspected the contents of the shipment 
for completeness and have checked the oscilloscope mechanically and 
electrically.
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• Verify that you received the following items and any optional accessories you 
may have ordered:

• InfiniiVision 6000 X-Series oscilloscope.

• Power cord (country of origin determines specific type).

• Oscilloscope probes:

• Two probes for 2-channel models.

• Four probes for 4-channel models.

• Digital probe kit (MSO models only).
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See Also • "Probes and Accessories" on page 426

InfiniiVision 60 00 X-Series oscilloscope

Power cord
(Based on country
of origin)

N2894A probes
(Qty 2 or 4)

N2756-60001
Digital Probe Kit
(MSO models only)
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Tilt the Oscilloscope for Easy Viewing

There are tabs under the oscilloscope's front feet that can be flipped out to tilt the 
oscilloscope.

Power-On the Oscilloscope

Power
Requirements

Line voltage, frequency, and power:

• 100-120 Vac, 50/60/400 Hz

• 100-240 Vac, 50/60 Hz

• 200 W max

Mains supply voltage fluctuations are not to exceed ±10% of the nominal supply 
voltage.

Ventilation
Requirements

The air intake and exhaust areas must be free from obstructions. Unrestricted air 
flow is required for proper cooling. Always ensure that the air intake and exhaust 
areas are free from obstructions.
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As viewed from the front of the oscilloscope, the fan draws air in from the back 
right side, and air is exhausted out the back left side and the bottom.

When using the oscilloscope in a bench-top setting, provide at least 2" clearance 
at the sides and 4" (100 mm) clearance above and behind the oscilloscope for 
proper cooling.

To power-on the
oscilloscope

1 Connect the power cord to the rear of the oscilloscope, then to a suitable AC 
voltage source. Route the power cord so the oscilloscope's feet and legs do not 
pinch the cord.

Install the instrument so that the detachable power cord is readily identifiable 
and is easily reached by the operator. The detachable power cord is the 
instrument disconnecting device. It disconnects the mains circuits from the 
mains supply before other parts of the instrument. The front panel switch is only 
a standby switch and is not a LINE switch. Alternatively, an externally installed 
switch or circuit breaker (which is readily identifiable and is easily reached by 
the operator) may be used as a disconnecting device.

2 The oscilloscope automatically adjusts for input line voltages in the range 100 
to 240 VAC. The line cord provided is matched to the country of origin.

3 Press the power switch.

The power switch is located on the lower left corner of the front panel. The 
oscilloscope will perform a self-test and will be operational in a few seconds.

Connect Probes to the Oscilloscope

1 Connect the oscilloscope probe to an oscilloscope channel BNC connector.

CAUTION  Use only the power cord that came with the oscilloscope

The power cord provided is matched to the country of origin of the order.

WARNING Always use a grounded power cord. Do not defeat the power cord ground.
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2 Connect the probe's retractable hook tip to the point of interest on the circuit or 
device under test. Be sure to connect the probe ground lead to a ground point 
on the circuit.

CAUTION  Maximum input voltage at analog inputs

Do not exceed the maximum input voltage rating.

The maximum input voltage for the 50 Ω input impedance setting is ±5 V.

Input protection is enabled in 50 Ω mode and the 50 Ω load will disconnect if greater 
than 5 Vrms is detected. However the inputs could still be damaged, depending on the 
time constant of the signal. The 50 Ω input protection functions only when the 
oscilloscope is powered on.

The maximum input voltage for the 1 MΩ input impedance setting is 30 Vrms or 
±40 Vmax (DC+Vpeak)

Probing technology allows for testing of higher voltages; the included N2894A 10:1 
probe supports 300 Vrms or ±400 Vmax (DC+Vpeak). No transient overvoltage allowed.

CAUTION When measuring voltages over 30 V, use a 10:1 probe.

CAUTION  Do not float the oscilloscope chassis

Defeating the ground connection and "floating" the oscilloscope chassis will probably 
result in inaccurate measurements and may also cause equipment damage. The probe 
ground lead is connected to the oscilloscope chassis and the ground wire in the power 
cord. If you need to measure between two live points, use a differential probe with 
sufficient dynamic range.

WARNING Do not negate the protective action of the ground connection to the oscilloscope. The 
oscilloscope must remain grounded through its power cord. Defeating the ground 
creates an electric shock hazard.
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Input a Waveform

The first signal to input to the oscilloscope is the Demo 2, Probe Comp signal. This 
signal is used for compensating probes.

1 Connect an oscilloscope probe from channel 1 to the Demo 2 (Probe Comp) 
terminal on the front panel.

2 Connect the probe's ground lead to the ground terminal (next to the Demo 2 
terminal).

Recall the Default Oscilloscope Setup

To recall the default oscilloscope setup:

1 Press [Default Setup].

The default setup restores the oscilloscope's default settings. This places the 
oscilloscope in a known operating condition. The major default settings are:

In the Save/Recall Menu, there are also options for restoring the complete factory 
settings (see "Recalling Default Setups" on page 377) or performing a secure 
erase (see "Performing a Secure Erase" on page 378).

Table 2 Default Configuration Settings

Horizontal Normal mode, 100 µs/div scale, 0 s delay, center time reference.

Vertical (Analog) Channel 1 on, 5 V/div scale, DC coupling, 0 V position, 1 MΩ impedance.

Trigger Edge trigger, Auto trigger mode, 0 V level, channel 1 source, DC coupling, rising 
edge slope, 40 ns holdoff time.

Display Persistence off, 20% grid intensity, 50% waveform intensity.

Other Acquire mode normal, [Run/Stop] to Run, cursors and measurements off.

Labels All custom labels that you have created in the Label Library are preserved (not 
erased), but all channel labels will be set to their original names.
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Use Autoscale

Use [Auto Scale] to automatically configure the oscilloscope to best display the 
input signals.

1 Press [Auto Scale].

You should see a waveform on the oscilloscope's display similar to this:

2 If you want to return to the oscilloscope settings that existed before, press Undo 
Autoscale.

3 If you want to enable "fast debug" autoscaling, change the channels 
autoscaled, or preserve the acquisition mode during autoscale, press Fast 
Debug, Channels, or Acq Mode.

These are the same softkeys that appear in the Autoscale Preferences Menu. 
See "To set Autoscale preferences" on page 394.

If you see the waveform, but the square wave is not shaped correctly as shown 
above, perform the procedure "Compensate Passive Probes" on page 39.
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If you do not see the waveform, make sure the probe is connected securely to the 
front panel channel input BNC and to the left side, Demo 2, Probe Comp terminal.

How Autoscale
Works

Auto Scale analyzes any waveforms present at each channel and at the external 
trigger input. This includes the digital channels, if connected.

Auto Scale finds, turns on, and scales any channel with a repetitive waveform that 
has a frequency of at least 25 Hz, a duty cycle greater than 0.5%, and an 
amplitude of at least 10 mV peak-to-peak. Any channels where no signal is found 
are turned off.

The trigger source is selected by looking for the first valid waveform starting with 
external trigger, then continuing with the lowest number analog channel up to the 
highest number analog channel, and finally (if digital probes are connected) the 
highest number digital channel.

During Autoscale, the delay is set to 0.0 seconds, the horizontal time/div (sweep 
speed) setting is a function of the input signal (about 2 periods of the triggered 
signal on the screen), and the triggering mode is set to Edge.

Compensate Passive Probes

Each oscilloscope passive probe must be compensated to match the input 
characteristics of the oscilloscope channel to which it is connected. A poorly 
compensated probe can introduce significant measurement errors.

1 Input the Probe Comp signal (see "Input a Waveform" on page 37).

2 Press [Default Setup] to recall the default oscilloscope setup (see "Recall the 
Default Oscilloscope Setup" on page 37).

3 Press [Auto Scale] to automatically configure the oscilloscope for the Probe 
Comp signal (see "Use Autoscale" on page 38).

4 Press the channel key to which the probe is connected ([1], [2], etc.).

5 In the Channel Menu, press Probe.

6 In the Channel Probe Menu, press Probe Check; then, follow the instructions 
on-screen.

If necessary, use a nonmetallic tool (supplied with the probe) to adjust the 
trimmer capacitor on the probe for the flattest pulse possible.

On N2894A probes, the trimmer capacitor is located on the probe BNC 
connector.
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7 Connect probes to all other oscilloscope channels (channel 2 of a 2-channel 
oscilloscope, or channels 2, 3, and 4 of a 4-channel oscilloscope).

8 Repeat the procedure for each channel.

Learn the Front Panel Controls and Connectors

On the front panel, key refers to any key (button) you can press.

Softkey specifically refers to the six keys that are directly below the display. The 
legend for these keys is directly above them, on the display. Their functions 
change as you navigate through the oscilloscope's menus.

For the following figure, refer to the numbered descriptions in the table that 
follows.

Perfectly compensated 

Over compensated 

Under compensated
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14. Tools keys

1. Power switch

2. Softkeys

3. [Intensity] key

4. Entry knob

6. Trigger controls5. Waveform keys

18. Demo 2, Ground,
and Demo 1

terminals

17. Analog
channel
inputs

19. USB
Host
ports

15. [Help] key

13. File keys

8. Run Control keys

12. Measure controls

11. Additional
waveform controls

7. Horizontal controls

10. [Auto Scale] key

9. [Default Setup] key

16. Vertical controls

21. Waveform
generator
outputs

20. EXT TRIG IN
connector

1. Power switch Press once to switch power on; press again to switch power off. See 
"Power-On the Oscilloscope" on page 34.

2. Softkeys The functions of these keys change based upon the menus shown on the 
display directly above the keys.

The Back/Up key moves up in the softkey menu hierarchy. At the top 

of the hierarchy, the Back/Up key turns the menus off, and 
oscilloscope information is shown instead.

3. [Intensity] key Press the key to illuminate it. When illuminated, turn the Entry knob to 
adjust waveform intensity.

You can vary the intensity control to bring out signal detail, much like an 
analog oscilloscope.

Digital channel waveform intensity is not adjustable.

More details about using the Intensity control to view signal detail are on 
"To adjust waveform intensity" on page 165.

Back

Back
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4. Entry knob The Entry knob is used to select items from menus and to change values. 
The function of the Entry knob changes based upon the current menu and 
softkey selections.

Note that the curved arrow symbol above the entry knob illuminates 
whenever the entry knob can be used to select a value. Also, note that 

when the Entry knob symbol appears on a softkey, you can use the 
Entry knob, to select values.

Often, rotating the Entry knob is enough to make a selection. Sometimes, 
you can push the Entry knob to enable or disable a selection. Pushing the 
Entry knob also makes popup menus disappear.



Getting Started 1

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 43

 

5. Waveform keys [Analyze] key — Press this key to access analysis features like:

• Trigger level setting.

• Measurement threshold setting.

• The USB 2.0 signal quality analysis application.

• Video trigger automatic set up and display.

• Color grade waveform display (see Chapter 16, “Color Grade 
Waveform,” starting on page 301).

• Counter (see "Counter" on page 334).

• Digital voltmeter (see "Digital Voltmeter" on page 332).

• Histogram of waveforms or measurements (see Chapter 15, 
“Histogram,” starting on page 291).

• Mask testing (see Chapter 18, “Mask Testing,” starting on page 317).

• The power measurement and analysis application.

• Precision measurements and math functions (see "Precision 
Measurements and Math" on page 289).

• Real-time eye analysis (included with the jitter analysis application, see 
"Real-Time Eye Analysis" on page 313).

The [Acquire] key lets you select Normal, Peak Detect, Averaging, or High 
Resolution acquisition modes (see "Selecting the Acquisition 
Mode" on page 233) and use segmented memory (see "Acquiring to 
Segmented Memory" on page 242).

The [Jitter] key lets you set up jitter analysis (see Chapter 17, “Jitter and 
Real-Time Eye Analysis,” starting on page 305).

[Clear Display] key — Press this key to clear acquisition data from the 
oscilloscope display.

The [Display] key lets you access the menu where you can enable 
persistence (see "To set or clear persistence" on page 167), clear the 
display, and adjust the display grid (graticule) intensity (see "To adjust 
the grid intensity" on page 169).

6. Trigger controls These controls determine how the oscilloscope triggers to capture data. 
See Chapter 10, “Triggers,” starting on page 181 and Chapter 11, 
“Trigger Mode/Coupling,” starting on page 219.
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7. Horizontal 
controls

The Horizontal controls consist of:

• Horizontal scale knob — Turn the knob in the Horizontal section that is 

marked  to adjust the time/div (sweep speed) setting. The 
symbols under the knob indicate that this control has the effect of 
spreading out or zooming in on the waveform using the horizontal scale.

• Horizontal position knob — Turn the knob marked  to pan through 
the waveform data horizontally. You can see the captured waveform 
before the trigger (turn the knob clockwise) or after the trigger (turn the 
knob counterclockwise). If you pan through the waveform when the 
oscilloscope is stopped (not in Run mode) then you are looking at the 
waveform data from the last acquisition taken.

• [Horiz] key — Press this key to open the Horizontal Menu where you can 
select XY and Roll modes, enable or disable Zoom, enable or disable 
horizontal time/division fine adjustment, and select the trigger time 
reference point.

• Zoom  key — Press the  zoom key to split the oscilloscope 
display into Normal and Zoom sections without opening the Horizontal 
Menu.

• [Search] key — Lets you search for events in the acquired data.

• [Navigate] keys — Press these keys to navigate through captured data 
via time, search events, or segmented memory acquisition. See 
"Navigating the Time Base" on page 81.

For more information see Chapter 2, “Horizontal Controls,” starting on 
page 69.

8. Run Control 
keys

When the [Run/Stop] key is green, the oscilloscope is running, that is, 
acquiring data when trigger conditions are met. To stop acquiring data, 
press [Run/Stop].

When the [Run/Stop] key is red, data acquisition is stopped. To start 
acquiring data, press [Run/Stop].

To capture and display a single acquisition (whether the oscilloscope is 
running or stopped), press [Single]. The [Single] key is yellow until the 
oscilloscope triggers.

For more information, see "Running, Stopping, and Making Single 
Acquisitions (Run Control)" on page 227.

9. [Default Setup] 
key

Press this key to restore the oscilloscope's default settings (details on 
"Recall the Default Oscilloscope Setup" on page 37).
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10. [Auto Scale] 
key

When you press the [Auto Scale] key, the oscilloscope will quickly 
determine which channels have activity, and it will turn these channels on 
and scale them to display the input signals. See "Use Autoscale" on 
page 38.

11. Additional 
waveform 
controls

The additional waveform controls consist of:

• [Math] key — provides access to math (add, subtract, etc.) waveform 
functions. See Chapter 4, “Math Waveforms,” starting on page 95.

• [Ref] key — provides access to reference waveform functions. Reference 
waveforms are saved waveforms that can be displayed and compared 
against other analog channel or math waveforms. Also, measurements 
can be made on reference waveforms. See Chapter 5, “Reference 
Waveforms,” starting on page 137.

• [Digital] key — Press this key to turn the digital channels on or off (the 
arrow to the left will illuminate).

When the arrow to the left of the [Digital] key is illuminated, the upper 
multiplexed knob selects (and highlights in red) individual digital 
channels, and the lower multiplexed knob positions the selected digital 
channel.

If a trace is repositioned over an existing trace the indicator at the left 
edge of the trace will change from Dnn designation (where nn is a one 
or two digit channel number from 0 to 15) to D*. The "*" indicates that 
two or more channels are overlaid.

You can rotate the upper knob to select an overlaid channel, then rotate 
the lower knob to position it just as you would any other channel.

For more information on digital channels see Chapter 6, “Digital 
Channels,” starting on page 141.

• [Serial] key — This key is used to enable serial decode. The multiplexed 
scale and position knobs are not used with serial decode. For more 
information on serial decode, see Chapter 7, “Serial Decode,” starting 
on page 159.

• Multiplexed scale knob — This scale knob is used with Math, Ref, or 
Digital waveforms, whichever has the illuminated arrow to the left. For 
math and reference waveforms, the scale knob acts like an analog 
channel vertical scale knob.

• Multiplexed position knob — This position knob is used with Math, Ref, 
or Digital waveforms, whichever has the illuminated arrow to the left. 
For math and reference waveforms, the position knob acts like an 
analog channel vertical position knob.
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12. Measure 
controls

The measure controls consist of:

• Cursors knob — Push this knob to select cursors from a popup menu. 
Then, after the popup menu closes (either by timeout or by pushing the 
knob again), rotate the knob to adjust the selected cursor position.

• [Cursors] key — Press this key to open a menu that lets you select the 
cursors mode and source.

• [Meas] key — Press this key to access a set of predefined 
measurements. See Chapter 14, “Measurements,” starting on page 
255.

13. File keys Press the [Save/Recall] key to save or recall a waveform or setup. See 
Chapter 22, “Save/Email/Recall (Setups, Screens, Data),” starting on 
page 365.

The [Print] key opens the Print Configuration Menu so you can print the 
displayed waveforms. See Chapter 23, “Print (Screens),” starting on page 
379.

14. Tools keys The Tools keys consist of:

• [Utility] key — Press this key to access the Utility Menu, which lets you 
configure the oscilloscope's I/O settings, use the file explorer, set 
preferences, access the service menu, and choose other options. See 
Chapter 24, “Utility Settings,” starting on page 385.

• [Quick Action] key — Press this key to perform the selected quick 
action: measure all snapshot, print, save, recall, freeze display, and 
more. See "Configuring the [Quick Action] Key" on page 407.

• [Wave Gen1], [Wave Gen2] keys — Press these keys to access 
waveform generator functions. See Chapter 21, “Waveform 
Generator,” starting on page 343.

15. [Help] key Opens the Help Menu where you can display overview help topics and 
select the Language. See also "Access the Built-In Quick Help" on 
page 67.
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16. Vertical 
controls

The Vertical controls consist of:

• Analog channel on/off keys — Use these keys to switch a channel on or 
off, or to access a channel's menu in the softkeys. There is one channel 
on/off key for each analog channel.

• Vertical scale knob — There are knobs marked  for each 
channel. Use these knobs to change the vertical sensitivity (gain) of 
each analog channel.

• Vertical position knobs — Use these knobs to change a channel's 
vertical position on the display. There is one Vertical Position control for 
each analog channel.

• [Label] key — Press this key to access the Label Menu, which lets you 
enter labels to identify each trace on the oscilloscope display. See 
Chapter 9, “Labels,” starting on page 175.

• [Touch] key — Press this key to disable/enable the touchscreen.

For more information, see Chapter 3, “Vertical Controls,” starting on page 
85.

17. Analog channel 
inputs

Attach oscilloscope probes or BNC cables to these BNC connectors.

With the InfiniiVision 6000 X-Series oscilloscopes, you can set the input 
impedance of the analog channels to either 50 Ω or 1 MΩ. See "To 
specify channel input impedance" on page 89.

The InfiniiVision 6000 X-Series oscilloscopes also provide the AutoProbe 
interface. The AutoProbe interface uses a series of contacts directly below 
the channel's BNC connector to transfer information between the 
oscilloscope and the probe. When you connect a compatible probe to the 
oscilloscope, the AutoProbe interface determines the type of probe and 
sets the oscilloscope's parameters (units, offset, attenuation, coupling, and 
impedance) accordingly.

18. Demo 2, 
Ground, and 
Demo 1 
terminals

• Demo 2 terminal — After a [Default Setup], this terminal outputs the 
Probe Comp signal which helps you match a probe's input capacitance 
to the oscilloscope channel to which it is connected. See 
"Compensate Passive Probes" on page 39. With certain licensed 
features, the oscilloscope can also output demo or training signals on 
this terminal.

• Ground terminal — Use the ground terminal for oscilloscope probes 
connected to the Demo 1 or Demo 2 terminals.

• Demo 1 terminal — The oscilloscope can output training signals on this 
and the Demo 2 terminal. See: [Help] > Training Signals > Training 
Signals.
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Front Panel Overlays for Different Languages

Front panel overlays, which have translations for the English front panel keys and 
label text, are available in 10 languages. The appropriate overlay is included when 
the localization option is chosen at time of purchase.

To install a front panel overlay:

1 Gently pull on the front panel knobs to remove them.

19. USB Host ports These ports are for connecting a USB mass storage device, printer, mouse, 
or keyboard to the oscilloscope.

Connect a USB compliant mass storage device (flash drive, disk drive, etc.) 
to save or recall oscilloscope setup files and reference waveforms or to 
save data and screen images. See Chapter 22, “Save/Email/Recall 
(Setups, Screens, Data),” starting on page 365.

To print, connect a USB compliant printer. For more information about 
printing see Chapter 23, “Print (Screens),” starting on page 379.

You can also use the USB port to update the oscilloscope's system 
software when updates are available.

You do not need to take special precautions before removing the USB mass 
storage device from the oscilloscope (you do not need to "eject" it). Simply 
unplug the USB mass storage device from the oscilloscope when the file 
operation is complete.

CAUTION:  Do not connect a host computer to the oscilloscope's 
USB host port. Use the device port. A host computer sees the oscilloscope 
as a device, so connect the host computer to the oscilloscope's device port 
(on the rear panel). See "I/O Interface Settings" on page 385.

There is a third USB host port on the back panel.

20. EXT TRIG IN 
connector

External trigger input BNC connector. See "External Trigger Input" on 
page 225 for an explanation of this feature.

21. Waveform 
generator 
outputs

Built-in, license-enabled 2-channel waveform generator can output 
arbitrary, sine, square, ramp, pulse, DC, noise, sine cardinal, exponential 
rise, exponential fall, cardiac, or Gaussian pulse waveforms on the 
Gen Out 1 or Gen Out 2 BNC connectors. Modulated waveforms are 
available on WaveGen1 except for arbitrary, pulse, DC, and noise 
waveforms. Press the [Wave Gen1] or [Wave Gen2] keys to set up the 
waveform generator. See Chapter 21, “Waveform Generator,” starting on 
page 343.



Getting Started 1

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 49

 

2 Insert the overlay's side tabs into the slots on the front panel.

3 Reinstall the front panel knobs.

Front panel overlays may be ordered from www.keysight.com/find/parts using the 
following part numbers:

http://www.keysight.com/find/parts
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Learn the Touchscreen Controls

When the [Touch] key is lit, you can control the oscilloscope by touching different 
areas of the screen. You can:

• "Draw Rectangles for Waveform Zoom or Zone Trigger Set Up" on page 51

• "Pinch, Flick, or Drag to Scale, Position, and Change Offset" on page 52

• "Select Sidebar Information or Controls" on page 54

• "Undock Sidebar Dialogs by Dragging" on page 55

• "Select Dialog Menus and Close Dialogs" on page 56

• "Drag Cursors" on page 56

• "Touch Softkeys and Menus On the Screen" on page 56

• "Enter Names Using Alpha-Numeric Keypad Dialogs" on page 57

• "Change Waveform Offsets By Dragging Ground Reference Icons" on page 58

• "Access Controls and Menus Using the Spark Icon" on page 59

• "Turn Channels On/Off and Open Scale/Offset Dialogs" on page 61

• "Access the Horizontal Menu and Open the Scale/Delay Dialog" on page 61

Language 2 Channel Overlay 4 Channel Overlay

French 54608-94314 54609-94314

German 54608-94313 54609-94313

Italian 54608-94315 54609-94315

Japanese 54608-94317 54609-94317

Korean 54608-94312 54609-94312

Portuguese 54608-94318 54609-94318

Russian 54608-94319 54609-94319

Simplified Chinese 54608-94310 54609-94310

Spanish 54608-94316 54609-94316

Traditional Chinese 54608-94311 54609-94311
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• "Access the Trigger Menu, Change the Trigger Mode, and Open the Trigger 
Level Dialog" on page 62

• "Use a USB Mouse and/or Keyboard for Touchscreen Controls" on page 63

Draw Rectangles for Waveform Zoom or Zone Trigger Set Up

1 Touch the upper-right corner to select the rectangle draw mode.

2 Drag your finger across the screen to draw a rectangle.

3 Take your finger off the screen.

4 Touch the desired option from the popup menu.
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Pinch, Flick, or Drag to Scale, Position, and Change Offset

1 Touch the upper-right corner to select the waveform drag mode.

2 When the waveform drag mode is selected, you can use these touch gestures:
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• Pinch — used to zoom in on a waveform of interest. A horizontal pinch 
adjusts the oscilloscope's time/div and delay settings at once — for "off 
center zooming", this is more efficient than using knobs. A vertical pinch 
adjusts a waveform's V/div and offset settings at once.

To select waveforms, tap them. The waveform closest horizontally to the tap 
location is selected. The selected waveform is indicated by the ground 
marker with the filled background (channel 1 in the following example).
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• Flick — allows very fast browsing of waveforms. It is similar to browsing on 
tablets and smartphones. It is much easier to flick than to continually turn a 
knob.

• Drag — drag your finger across the screen to change the horizontal delay.

Select Sidebar Information or Controls

1 Touch the blue menu icon in the sidebar.

2 In the popup menu, touch the type of information or controls you want to see in 
the sidebar.
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Undock Sidebar Dialogs by Dragging

Sidebar dialogs can be undocked and placed anywhere on the screen.

1 Drag the sidebar dialog title wherever you like.

This lets you view multiple types of information or controls at the same time.
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Select Dialog Menus and Close Dialogs

• Touch the blue menu icon in the dialog for options.

• Touch the red "X" icon to close a dialog.

Drag Cursors

When cursors are displayed, you can drag the name handles to position them.

Touch Softkeys and Menus On the Screen

• Touch onscreen softkey labels to select them.

This is the same as pressing the softkey keys.
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• When softkeys provide menus, double-touch to select a menu item.

This may be an easier than selecting a menu item via the  Entry knob.

Enter Names Using Alpha-Numeric Keypad Dialogs

Some softkeys open alpha-numeric dialogs that let you touch to enter names.
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Change Waveform Offsets By Dragging Ground Reference Icons

When the waveform drag mode is selected, you can drag waveforms up or down 
to change the vertical offset.

You can always change waveform vertical offsets by dragging ground markers and 
labels, even when in the rectangle draw mode.
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Access Controls and Menus Using the Spark Icon

1 Touch the upper-left spark icon to open the main menu.

2 Touch left side controls to perform oscilloscope operations.
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3 Touch menu items and submenu items to access menus and additional 
controls.
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Turn Channels On/Off and Open Scale/Offset Dialogs

• Touch channel numbers to turn them on or off.

• When channels are on, touch the scale and offset values to access a dialog for 
changing them.

Access the Horizontal Menu and Open the Scale/Delay Dialog

• Touch "H" to access the Horizontal Menu.

• Touch the horizontal scale and delay values to access a dialog for changing 
them.
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Access the Trigger Menu, Change the Trigger Mode, and Open the 
Trigger Level Dialog

• Touch "T" to access the Trigger Menu.

• Touch the trigger level value(s) to access a dialog for changing the level(s).

• Touch "Auto" or "Trig'd" to quickly toggle the trigger mode.
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Use a USB Mouse and/or Keyboard for Touchscreen Controls

Connecting a USB mouse gives you a mouse pointer on the display. Mouse clicks 
and drags behave the same as screen touches and finger drags.

If you connect a USB keyboard, you can use it to enter values in alpha-numeric 
keypad dialogs.

Learn the Voice Controls

Voice control is a valuable feature when browsing signals in your device under test 
and using your hands to hold down probes. The set of voice commands is limited 
so they are easy to remember.

On the upper right corner of the display is an icon that describes the state of voice 
recognition:

•  means voice recognition is not running at all.

•  means voice recognition is running but it is only listening for the wakeup 
command.

•  means voice recognition is listening for commands.

To enable voice recognition, tap the icon and (in the Audio Menu) press the Voice 
Recognition softkey.

The initial screen shows the list of commands and includes a few brief 
explanations. There is also a smaller help screen that simply lists the commands.

The best way to recall the list of voice commands is to say the command "Help".

Notes on Voice
Recognition

Most equipment noise will not bother recognition but other people speaking will. 
Use a USB headset if other people are speaking nearby.

It is best to speak at a normal speed. Speaking slowly or with long pauses will 
make recognition worse just like speaking too quickly.

The voice recognition uses Speaker Adaption. This is reset each time a different 
person speaks, so it is best if only one person speaks to the oscilloscope.
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The recognition is best when using the accent of the selected language. See "To 
select the language" on page 68.

Learn the Rear Panel Connectors

For the following figure, refer to the numbered descriptions in the table that 
follows.

9. USB Device port

8. USB Host port

1. Power cord connector2. Kensington lock hole

3. TRIG OUT connector
5. Calibration protect switch4. 10 MHz REF connector6. Digital channel inputs

7. VGA Video Out

10. LAN port

1. Power cord 
connector

Attach the power cord here.

2. Kensington lock 
hole

This is where you can attach a Kensington lock for securing the instrument.

3. TRIG OUT 
connector

Trigger output BNC connector. See "Setting the Rear Panel TRIG OUT 
Source" on page 396.
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Learn the Oscilloscope Display

The oscilloscope display contains acquired waveforms, setup information, 
measurement results, and the softkey definitions.

4. 10 MHz REF 
connector

For synchronizing the timebase of multiple instruments. See "Setting the 
Reference Signal Mode" on page 397.

5. Calibration 
protect switch

See "To perform user calibration" on page 404.

6. Digital channel 
inputs

Connect the digital probe cable to this connector (MSO models only). See 
Chapter 6, “Digital Channels,” starting on page 141.

7. VGA video 
output

Lets you connect an external monitor or projector to provide a larger 
display or to provide a display at a viewing position away from the 
oscilloscope.

The oscilloscope's built-in display remains on even when an external 
display is connected. The video output connector is always active.

For optimal video quality and performance, we recommend you use a 
shielded video cable with ferrite cores.

8. USB Host port This port functions identically to the USB host port on the front panel. USB 
Host Port is used for saving data from the oscilloscope and loading 
software updates. See also USB Host port (see page 48).

9. USB Device 
port

This port is for connecting the oscilloscope to a host PC. You can issue 
remote commands from a host PC to the oscilloscope via the USB device 
port. See "Remote Programming with Keysight IO Libraries" on 
page 414.

10. LAN port Lets you print to network printers (see Chapter 23, “Print (Screens),” 
starting on page 379) and access the oscilloscope's built-in web server. 
See Chapter 25, “Web Interface,” starting on page 409 and "Accessing 
the Web Interface" on page 410.
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Figure 1 Interpreting the oscilloscope display

Status line The top line of the display contains vertical, horizontal, and trigger setup 
information, as well as the voice recognition icon and the rectangle draw mode 
or waveform drag mode selector.

Display area The display area contains the waveform acquisitions, channel identifiers, and 
analog trigger, and ground level indicators. Each analog channel's information 
appears in a different color.

Signal detail is displayed using 256 levels of intensity. For more information 
about viewing signal detail see "To adjust waveform intensity" on 
page 165.

For more information about display modes see Chapter 8, “Display Settings,” 
starting on page 165.
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Access the Built-In Quick Help

To view Quick Help 1 Press and hold the key or softkey for which you would like to view help.

Sidebar 
information and 
controls area

The sidebar information area can contain summary, cursors, measurements, or 
digital voltmeter information dialogs or it can contain navigation and other 
control dialogs.

For more information, see:

• "Select Sidebar Information or Controls" on page 54

• "Undock Sidebar Dialogs by Dragging" on page 55

Menu line This line normally contains menu name or other information associated with the 
selected menu.

Softkey labels These labels describe softkey functions. Typically, softkeys let you set up 
additional parameters for the selected mode or menu.

Pressing the Back/Up key at the top of the menu hierarchy turns off softkey 
labels and displays additional status information describing channel offset and 
other configuration parameters.

Back
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Quick Help remains on the screen until another key is pressed or a knob is turned.

To select the
language

To select the language of the user interface, Quick Help, and voice control:

1 Press [Help], then press the Language (Voice) softkey.

2 Repeatedly press and release the Language (Voice) softkey or rotate the Entry 
knob until the desired language is selected.

The "Voice" in parentheses specifies the accent of the selected language for voice 
recognition. See "Learn the Voice Controls" on page 63.

Quick Help
message

Press and hold front panel key or softkey
(or right-click softkey when using web browser remote front panel).
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2 Horizontal Controls
To adjust the horizontal (time/div) scale / 70
To adjust the horizontal delay (position) / 71
Panning and Zooming Single or Stopped Acquisitions / 72
To change the horizontal time mode (Normal, XY, or Roll) / 73
To display the zoomed time base / 77
To change the horizontal scale knob's coarse/fine adjustment setting / 78
To position the time reference (left, center, right, custom) / 79
Searching for Events / 79
Navigating the Time Base / 81

The horizontal controls include:

• Touchscreen controls for setting the horizontal scale and position (delay), 
accessing the Horizontal Menu, and navigating (see "Pinch, Flick, or Drag to 
Scale, Position, and Change Offset" on page 52 and "Access the Horizontal 
Menu and Open the Scale/Delay Dialog" on page 61).

• The horizontal scale and position knobs.

• The [Horiz] key for accessing the Horizontal Menu.

• The  zoom key for quickly enabling/disabling the split-screen zoom display.

• The [Search] key for finding events on analog channels or in serial decode.

• The [Navigate] keys for navigating time, search events, or segmented memory 
acquisitions.

The following figure shows the Horizontal Menu which appears after pressing the 
[Horiz] key.
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The Horizontal Menu lets you select the time mode (Normal, XY, or Roll), enable 
Zoom, set the time base fine control (vernier), and specify the time reference.

The current sample rate is displayed in the right-side information area.

To adjust the horizontal (time/div) scale

You can:

Figure 2 Horizontal Menu
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• Use the touchscreen pinch gesture (see "Pinch, Flick, or Drag to Scale, 
Position, and Change Offset" on page 52).

• Use the touchscreen controls to open a horizontal scale/delay dialog (see 
"Access the Horizontal Menu and Open the Scale/Delay Dialog" on page 61).

• Turn the large horizontal scale (sweep speed) knob marked  to 
change the horizontal time/div setting.

Notice how the time/div information in the status line changes.

The ∇ symbol at the top of the display indicates the time reference point.

The horizontal scale knob works (in the Normal time mode) while acquisitions are 
running or when they are stopped. When running, adjusting the horizontal scale 
knob changes the sample rate. When stopped, adjusting the horizontal scale knob 
lets you zoom into acquired data. See "Panning and Zooming Single or Stopped 
Acquisitions" on page 72.

Note that the horizontal scale knob has a different purpose in the Zoom display. 
See "To display the zoomed time base" on page 77.

To adjust the horizontal delay (position)

You can:

• Use the touchscreen flick and drag gestures (see "Pinch, Flick, or Drag to 
Scale, Position, and Change Offset" on page 52).

• Use the touchscreen controls to open a horizontal scale/delay dialog (see 
"Access the Horizontal Menu and Open the Scale/Delay Dialog" on page 61).

• Turn the horizontal delay (position) knob ( ).

The trigger point moves horizontally, pausing at 0.00 s (mimicking a 
mechanical detent), and the delay value is displayed in the status line.

Changing the delay time moves the trigger point (solid inverted triangle) 
horizontally and indicates how far it is from the time reference point (hollow 
inverted triangle ∇). These reference points are indicated along the top of the 
display grid.
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Figure 2 shows the trigger point with the delay time set to 200 µs. The delay time 
number tells you how far the time reference point is located from the trigger point. 
When delay time is set to zero, the delay time indicator overlays the time reference 
indicator.

All events displayed left of the trigger point happened before the trigger occurred. 
These events are called pre-trigger information, and they show events that led up 
to the trigger point.

Everything to the right of the trigger point is called post-trigger information. The 
amount of delay range (pre-trigger and post-trigger information) available 
depends on the time/div selected and memory depth.

The horizontal position knob works (in the Normal time mode) while acquisitions 
are running or when they are stopped. When running, adjusting the horizontal 
scale knob changes the sample rate. When stopped, adjusting the horizontal scale 
knob lets you zoom into acquired data. See "Panning and Zooming Single or 
Stopped Acquisitions" on page 72.

Note that the horizontal position knob has a different purpose in the Zoom display. 
See "To display the zoomed time base" on page 77.

Panning and Zooming Single or Stopped Acquisitions

When the oscilloscope is stopped, use the touchscreen pinch, flick, and drag 
gestures or use the horizontal scale and position knobs to pan and zoom your 
waveform. The stopped display may contain several acquisitions worth of 
information, but only the last acquisition is available for pan and zoom.

The ability to pan (move horizontally) and scale (expand or compress horizontally) 
an acquired waveform is important because of the additional insight it can reveal 
about the captured waveform. This additional insight is often gained from seeing 
the waveform at different levels of abstraction. You may want to view both the big 
picture and the specific little picture details.

The ability to examine waveform detail after the waveform has been acquired is a 
benefit generally associated with digital oscilloscopes. Often this is simply the 
ability to freeze the display for the purpose of measuring with cursors or printing 
the screen. Some digital oscilloscopes go one step further by including the ability 
to further examine the signal details after acquiring them by panning through the 
waveform and changing the horizontal scale.
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There is no limit imposed on the scaling ratio between the time/div used to 
acquire the data and the time/div used to view the data. There is, however, a 
useful limit. This useful limit is somewhat a function of the signal you are 
analyzing.

To change the horizontal time mode (Normal, XY, or Roll)

1 Press [Horiz].

2 In the Horizontal Menu, press Time Mode; then, select:

• Normal — the normal viewing mode for the oscilloscope.

In the Normal time mode, signal events occurring before the trigger are 
plotted to the left of the trigger point (▼) and signal events after the trigger 
plotted to the right of the trigger point.

• XY — XY mode changes the display from a volts-versus-time display to a 
volts-versus-volts display. The time base is turned off. Channel 1 amplitude 
is plotted on the X-axis and Channel 2 amplitude is plotted on the Y-axis.

You can use XY mode to compare frequency and phase relationships 
between two signals. XY mode can also be used with transducers to display 
strain versus displacement, flow versus pressure, volts versus current, or 
voltage versus frequency.

Use the cursors to make measurements on XY mode waveforms.

For more information about using XY mode for measurements, refer to "XY 
Time Mode" on page 74.

• Roll — causes the waveform to move slowly across the screen from right to 
left. It only operates on time base settings of 50 ms/div and slower. If the 
current time base setting is faster than the 50 ms/div limit, it will be set to 
50 ms/div when Roll mode is entered.

NOTE Zooming into stopped acquisitions

The screen will still contain a relatively good display if you zoom-in horizontally by a factor of 
1000 and zoom-in vertically by a factor of 10 to display the information from where it was 
acquired. Remember that you can only make automatic measurements on displayed data.
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In Roll mode there is no trigger. The fixed reference point on the screen is the 
right edge of the screen and refers to the current moment in time. Events 
that have occurred are scrolled to the left of the reference point. Since there 
is no trigger, no pre-trigger information is available.

If you would like to pause the display in Roll mode press the [Single] key. To 
clear the display and restart an acquisition in Roll mode, press the [Single] 
key again.

Use Roll mode on low-frequency waveforms to yield a display much like a 
strip chart recorder. It allows the waveform to roll across the display.

XY Time Mode

The XY time mode converts the oscilloscope from a volts-versus-time display to a 
volts-versus-volts display using two input channels. Channel 1 is the X-axis input, 
channel 2 is the Y-axis input. You can use various transducers so the display could 
show strain versus displacement, flow versus pressure, volts versus current, or 
voltage versus frequency.

Example This exercise shows a common use of the XY display mode by measuring the 
phase difference between two signals of the same frequency with the Lissajous 
method.

1 Connect a sine wave signal to channel 1, and a sine wave signal of the same 
frequency but out of phase to channel 2.

2 Press the [Auto Scale] key, press the [Horiz] key; then, press Time Mode and select 
"XY".

3 Center the signal on the display with the channel 1 and 2 position ( ) knobs. 
Use the channel 1 and 2 volts/div knobs and the channel 1 and 2 Fine softkeys 
to expand the signal for convenient viewing.

The phase difference angle (θ) can be calculated using the following formula 
(assuming the amplitude is the same on both channels):

sinθ = ABor
C
D
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4 Press the [Cursors] key.

5 Set the Y2 cursor to the top of the signal, and set Y1 to the bottom of the 
signal.

Note the ΔY value at the bottom of the display. In this example, we are using 
the Y cursors, but you could have used the X cursors instead.

6 Move the Y1 and Y2 cursors to the intersection of the signal and the Y axis. 
Again, note the ΔY value.

Figure 3 XY time mode signals, centered on display
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7 Calculate the phase difference using the formula below.

For example, if the first ΔY value is 2.297 and the second ΔY value is 1.319:

Figure 4 Phase difference measurements, automatic and using cursors

sinθ = second ΔY
first ΔY

= 1.319
2.297; θ = 35.05 degrees of phase shift

NOTE Z-Axis Input in XY Display Mode (Blanking)

When you select the XY display mode, the time base is turned off. Channel 1 is the X-axis 
input, channel 2 is the Y-axis input, and the EXT TRIG IN is the Z-axis input. If you only want to 
see portions of the Y versus X display, use the Z-axis input. Z-axis turns the trace on and off 
(analog oscilloscopes called this Z-axis blanking because it turned the beam on and off). 
When Z is low (<1.4 V), Y versus X is displayed; when Z is high (>1.4 V), the trace is turned off.
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To display the zoomed time base

Zoom, formerly called Delayed sweep mode, is a horizontally expanded version of 
the normal display. When Zoom is selected, the display divides in half. The top 
half of the display shows the normal time/div window and the bottom half 
displays a faster Zoom time/div window.

The Zoom window is a magnified portion of the normal time/div window. You can 
use Zoom to locate and horizontally expand part of the normal window for a more 
detailed (higher-resolution) analysis of signals.

To turn on (or off) Zoom:

1 Press the  zoom key (or press the [Horiz] key and then the Zoom softkey).
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The area of the normal display that is expanded is outlined with a box and the rest 
of the normal display is ghosted. The box shows the portion of the normal sweep 
that is expanded in the lower half.

To change the time/div for the Zoom window, turn the horizontal scale (sweep 
speed) knob. As you turn the knob, the zoomed window time/div is highlighted in 
the status line above the waveform display area. The Horizontal scale (sweep 
speed) knob controls the size of the box.

The Horizontal position (delay time) knob sets the left-to-right position of the 
zoom window. The delay value, which is the time displayed relative to the trigger 
point) is momentarily displayed in the upper-right portion of the display when the 
delay time ( ) knob is turned.

Negative delay values indicate you're looking at a portion of the waveform before 
the trigger event, and positive values indicate you're looking at the waveform after 
the trigger event.

To change the time/div of the normal window, turn off Zoom; then, turn the 
horizontal scale (sweep speed) knob.

For information about using zoom mode for measurements, refer to "To isolate a 
pulse for Top measurement" on page 264 and "To isolate an event for frequency 
measurement" on page 271.

To change the horizontal scale knob's coarse/fine adjustment 
setting

1 Push the horizontal scale knob (or press [Horiz] > Fine) to toggle between fine 
and coarse adjustment of the horizontal scale.

When Fine is enabled, turning the horizontal scale knob changes the time/div 
(displayed in the status line at the top of the display) in smaller increments. The 
time/div remains fully calibrated when Fine is on.

When Fine is turned off, the Horizontal scale knob changes the time/div setting in 
a 1-2-5 step sequence.
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To position the time reference (left, center, right, custom)

Time reference is the reference point on the display for delay time (horizontal 
position).

1 Press [Horiz].

2 In the Horizontal Menu, press Time Ref; then, select:

• Left — the time reference is set to one major division from the left edge of the 
display.

• Center — the time reference is set to the center of the display.

• Right — the time reference is set to one major division from the right edge of 
the display.

• Custom Location — lets you place the time reference location at a percent of 
the graticule width (where 0% is the left edge and 100% is the right edge).

A small hollow triangle (∇) at the top of the display grid marks the position of the 
time reference. When delay time is set to zero, the trigger point indicator (▼) 
overlays the time reference indicator.

The time reference position sets the initial position of the trigger event within 
acquisition memory and on the display, with delay set to 0.

Turning the Horizontal scale (sweep speed) knob expands or contracts the 
waveform about the time reference point (∇). See "To adjust the horizontal 
(time/div) scale" on page 70.

Turning the Horizontal position ( ) knob in Normal mode (not Zoom) moves the 
trigger point indicator (▼) to the left or right of the time reference point (∇). See 
"To adjust the horizontal delay (position)" on page 71.

Searching for Events

You can use the [Search] key and menu to search for Edge, Pulse Width, Rise/Fall 
Time, Runt, Frequency Peaks, and Serial events on the analog channels.

Setting up searches (see "To set up searches" on page 80) is similar to setting up 
triggers. In fact, except for Frequency Peaks and Serial events, you can copy 
search setups to trigger setups and vice-versa (see "To copy search setups" on 
page 80).
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Searches are different than triggers in that they use the measurement threshold 
settings instead of trigger levels.

Found search events are marked with white triangles at the top of the graticule, 
and the number of events found is displayed in the menu line just above the 
softkey labels.

To set up searches

1 Press [Search].

2 In the Search Menu, press Search; then, turn the Entry knob to select the search 
type.

3 Use the remaining softkeys to set up the selected search type.

In most cases, setting up searches is similar to setting up triggers:

• For setting up Edge searches, see "Edge Trigger" on page 184.

• For setting up Pulse Width searches, see "Pulse Width Trigger" on 
page 188.

• For setting up Rise/Fall Time searches, see "Rise/Fall Time Trigger" on 
page 195.

• For setting up Runt searches, see "Runt Trigger" on page 198.

• For setting up Frequency Peak searches, see "Searching for FFT Peaks" on 
page 110.

• For setting up Serial searches, see "Serial Trigger" on page 215 and 
"Searching Lister Data" on page 163.

Remember that searches use the measurement threshold settings instead of 
trigger levels. Use the Thresholds softkey in the Search Menu to access the 
Measurement Threshold Menu. See "Measurement Thresholds" on page 283.

To copy search setups

Except for Frequency Peak and Serial event search setups, you can copy search 
setups to trigger setups and vice-versa.

1 Press [Search].

2 In the Search Menu, press Search; then, turn the Entry knob to select the search 
type.

3 Press Copy.
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4 In the Search Copy Menu:

• Press Copy to Trigger to copy the setup for the selected search type to the 
same trigger type. For example, if the current search type is Pulse Width, 
pressing Copy to Trigger copies the search settings to the Pulse Width trigger 
settings and selects the Pulse Width trigger.

• Press Copy from Trigger to copy the trigger setup for the selected search type 
to the search setup.

• To undo a copy, press Undo Copy.

The softkeys in the Search Copy Menu may not be available when one of the 
settings cannot be copied or there is no trigger type that corresponds to the 
search type.

Navigating the Time Base

You can use the [Navigate] key and controls to navigate through:

• Captured data (see "To navigate time" on page 81).

• Search events (see "To navigate search events" on page 82).

• Segments, when segmented memory acquisitions are turned on (see "To 
navigate segments" on page 82).

You can also access navigation controls on the touchscreen. See "Select Sidebar 
Information or Controls" on page 54.

To navigate time

When acquisitions are stopped, you can use the navigation controls to play 
through the captured data.

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Time.

3 Press the    navigation keys to play backward, stop, or play forward in 

time. You can press the  or  keys multiple times to speed up the 
playback. There are three speed levels.

You can also access navigation controls on the touchscreen. See "Select Sidebar 
Information or Controls" on page 54.
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To navigate search events

When acquisitions are stopped, you can use the navigation controls to go to found 
search events (set using the [Search] key and menu, see "Searching for Events" on 
page 79).

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Search.

3 Press the   back and forward keys to go to the previous or next search 
event.

When searching Serial decode:

• The Auto zoom softkey specifies whether the waveform display is automatically 
zoomed to fit the marked row as you navigate.

• Pressing the Scroll Lister softkey lets you use the Entry knob to scroll through 
data rows in the Lister display.

You can also access navigation controls on the touchscreen. See "Select Sidebar 
Information or Controls" on page 54.

To navigate segments

When the segmented memory acquisition is enabled and acquisitions are stopped, 
you can use the navigation controls to play through the acquired segments.

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Segments.

3 Press Play Mode; then, select:

• Manual — to play through segments manually.

In the Manual play mode:

• Press the   back and forward keys to go to the previous or next 
segment.

• Press the  softkey to go to the first segment.

• Press the  softkey to go to the last segment.

• Auto — to play through segments in an automated fashion.

In the Auto play mode:
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• Press the    navigation keys to play backward, stop, or play 

forward in time. You can press the  or  keys multiple times to speed 
up the playback. There are three speed levels.

You can also access navigation controls on the touchscreen. See "Select Sidebar 
Information or Controls" on page 54.
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3 Vertical Controls
To turn waveforms on or off (channel or math) / 86
To adjust the vertical scale / 87
To adjust the vertical position / 87
To specify channel coupling / 88
To specify channel input impedance / 89
To specify bandwidth limiting / 89
To change the vertical scale knob's coarse/fine adjustment setting / 90
To invert a waveform / 91
Setting Analog Channel Probe Options / 91

The vertical controls include:

• Touchscreen controls for setting the vertical scale and position (offset) and 
accessing the Channel menus (see "Pinch, Flick, or Drag to Scale, Position, 
and Change Offset" on page 52 and "Turn Channels On/Off and Open 
Scale/Offset Dialogs" on page 61).

• The vertical scale and position knobs for each analog channel.

• The channel keys for turning a channel on or off and accessing the channel's 
softkey menu.

The following figure shows the Channel 1 Menu that appears after pressing the [1] 
channel key.



86 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

3 Vertical Controls
 

The ground level of the signal for each displayed analog channel is identified by 

the position of the  icon at the far-left side of the display.

To turn waveforms on or off (channel or math)

You can:

• Use the touchscreen controls to turn channels on or off (see "Turn Channels 
On/Off and Open Scale/Offset Dialogs" on page 61).

• Press an analog channel key turn the channel on or off (and to display the 
channel's menu).

When a channel is on, its key is illuminated.

Channel,
Volts/div

Channel 1
ground
level

Trigger
source

Trigger level
or threshold 

Channel 2
ground
level



Vertical Controls 3

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 87

 

To adjust the vertical scale

You can:

• Use the touchscreen pinch gesture (see "Pinch, Flick, or Drag to Scale, 
Position, and Change Offset" on page 52).

• Use the touchscreen controls to open a vertical scale/offset dialog (see "Turn 
Channels On/Off and Open Scale/Offset Dialogs" on page 61).

• Turn the large knob above the channel key marked  to set the vertical 
scale (volts/division) for the channel.

The vertical scale knob changes the analog channel scale in a 1-2-5 step 
sequence (with a 1:1 probe attached) unless fine adjustment is enabled (see "To 
change the vertical scale knob's coarse/fine adjustment setting" on page 90).

The analog channel Volts/Div value is displayed in the status line.

The default mode for expanding the signal when you turn the volts/division knob 
is vertical expansion about the ground level of the channel; however, you can 
change this to expand about the center of the display. See "To choose "expand 
about" center or ground" on page 391.

To adjust the vertical position

You can:

• Use the touchscreen pinch and drag gestures (see "Pinch, Flick, or Drag to 
Scale, Position, and Change Offset" on page 52).

• Use the touchscreen controls to open a vertical scale/offset dialog (see "Turn 
Channels On/Off and Open Scale/Offset Dialogs" on page 61).

NOTE Turning channels off

You must be viewing the menu for a channel before you can turn it off. For example, if channel 
1 and channel 2 are turned on and the menu for channel 2 is being displayed, to turn channel 
1 off, press [1] to display the channel 1 menu; then, press [1] again to turn channel 1 off.
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• Turn the small vertical position knob ( ) to move the channel's waveform up or 
down on the display.

The offset voltage value represents the voltage difference between the vertical 

center of the display and the ground level ( ) icon. It also represents the voltage 
at the vertical center of the display if vertical expansion is set to expand about 
ground (see "To choose "expand about" center or ground" on page 391).

To specify channel coupling

Coupling changes the channel's input coupling to either AC (alternating current) 
or DC (direct current).

1 Press the desired channel key.

2 In the Channel Menu, press the Coupling softkey to select the input channel 
coupling:

• DC — DC coupling is useful for viewing waveforms as low as 0 Hz that do not 
have large DC offsets.

• AC — AC coupling is useful for viewing waveforms with large DC offsets.

When AC coupling is chosen, you cannot select 50Ω mode. This is done to 
prevent damage to the oscilloscope.

AC coupling places a 10 Hz high-pass filter in series with the input waveform 
that removes any DC offset voltage from the waveform.

Note that Channel Coupling is independent of Trigger Coupling. To change trigger 
coupling see "To select the trigger coupling" on page 221.

TIP If the channel is DC coupled, you can quickly measure the DC component of the signal by 
simply noting its distance from the ground symbol.

If the channel is AC coupled, the DC component of the signal is removed, allowing you to use 
greater sensitivity to display the AC component of the signal.
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To specify channel input impedance

1 Press the desired channel key.

2 In the Channel Menu, press Imped (impedance); then, select either:

• 50 Ohm — matches 50 ohm cables commonly used in making high frequency 
measurements, and 50 ohm active probes.

When 50 Ohm input impedance is selected, it is displayed with the channel 
information on-screen.

When AC coupling is selected (see "To specify channel coupling" on 
page 88) or excessive voltage is applied to the input, the oscilloscope 
automatically switches to 1M Ohm mode to prevent possible damage.

• 1M Ohm — is for use with many passive probes and for general-purpose 
measurements. The higher impedance minimizes the loading effect of the 
oscilloscope on the device under test.

This impedance matching gives you the most accurate measurements because 
reflections are minimized along the signal path.

See Also • For more information on probing, visit: www.keysight.com/find/scope_probes

• Information about selecting a probe can be found in document number 
Keysight Oscilloscope Probes and Accessories Selection Guide (part number 
5989-6162EN), available at www.keysight.com.

To specify bandwidth limiting

1 Press the desired channel key.

2 In the Channel Menu, press the BW Limit softkey to specify the channel's 
bandwidth limit or to turn off the bandwidth limit.

For waveforms with frequencies below the bandwidth limit, turning the bandwidth 
limit on removes unwanted high frequency noise from the waveform.

NOTE When you connect an AutoProbe, self-sensing probe, or a compatible InfiniiMax probe, the 
oscilloscope automatically configures the analog input channels to the correct impedance.

http://www.keysight.com/find/scope_probes
http://literature.cdn.keysight.com/litweb/pdf/5989-6162EN.pdf
http://www.keysight.com
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The bandwidth limit also limits the trigger signal path of any channel that has BW 
Limit turned on.

The limits that can be selected depend on the bandwidth of oscilloscope, the 
channel's input impedance setting, and the channel's V/div setting:

To change the vertical scale knob's coarse/fine adjustment setting

1 Push the channel's vertical scale knob (or press the channel key and then the 
Fine softkey in the Channel Menu) to toggle between fine and coarse 
adjustment of the vertical scale.

You can also do this using the touchscreen. See "Turn Channels On/Off and 
Open Scale/Offset Dialogs" on page 61.

When Fine adjustment is selected, you can change the channel's vertical 
sensitivity in smaller increments. The channel sensitivity remains fully calibrated 
when Fine is on.

The vertical scale value is displayed in the status line at the top of the display.

When Fine is turned off, turning the volts/division knob changes the channel 
sensitivity in a 1-2-5 step sequence.

Input Impedance V/div Oscilloscope 
Bandwidth

Limits Available

1M Ohm >2 mV/
div

(all) 20 MHz

<=2 mV
/div

(all) 20 MHz or 200 MHz

50 Ohm (all) 1 GHz 20 MHz or 200 MHz

2.5 GHz 20 MHz, 200 MHz, or 1.5 GHz

4 GHz 20 MHz, 200 MHz, 1.5 GHz, or 3 GHz

6 GHz 20 MHz, 200 MHz, 1.5 GHz, or 3 GHz
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To invert a waveform

1 Press the desired channel key.

2 In the Channel Menu, press the Invert softkey to invert the selected channel.

When Invert is selected, the voltage values of the displayed waveform are inverted.

Invert affects how a channel is displayed. However, when using basic triggers, the 
oscilloscope attempts to maintain the same trigger point by changing trigger 
settings.

Inverting a channel also changes the result of any math function selected in the 
Waveform Math Menu or any measurement.

Setting Analog Channel Probe Options

1 Press the probe's associated channel key.

2 In the Channel Menu, press the Probe softkey to display the Channel Probe 
Menu.

This menu lets you select additional probe parameters such as attenuation 
factor and units of measurement for the connected probe.

The Channel Probe Menu changes depending on the type of probe connected.

For passive probes, the Probe Check softkey appears; it guides you through the 
process of compensating probes.

For some active probes (such as InfiniiMax probes), the oscilloscope can 
accurately calibrate its analog channels for the probe. When you connect a 
probe that can be calibrated, the Calibrate Probe softkey appears (and the probe 
attenuation softkey may change). See "To calibrate a probe" on page 93.

See Also • "To specify the channel units" on page 92

• "To specify the probe attenuation" on page 92

• "To specify the channel external scaling" on page 93
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• "To specify the probe skew" on page 93

To specify the channel units

1 Press the probe's associated channel key.

2 In the Channel Menu, press Probe.

3 In the Channel Probe Menu, press Units; then, select:

• Volts — for a voltage probe.

• Amps — for a current probe.

Channel sensitivity, trigger level, measurement results, and math functions will 
reflect the measurement units you have selected.

To specify the probe attenuation

This is set automatically if the oscilloscope can identify the connected probe. See 
Analog channel inputs (see page 47).

The probe attenuation factor must be set properly for accurate measurement 
results.

If you connect a probe that is not automatically identified by the oscilloscope, you 
can manually set the attenuation factor as follows:

1 Press the channel key.

2 Press the Probe softkey until you have selected how you want to specify the 
attenuation factor, choosing either Ratio or Decibels.

3 Turn the Entry knob  to set the attenuation factor for the connected probe.

When measuring voltage values, the attenuation factor can be set from 0.1:1 to 
10000:1 in a 1-2-5 sequence.

When measuring current values with a current probe, the attenuation factor can 
be set from 10 V/A to 0.0001 V/A.

When specifying the attenuation factor in decibels, you can select values from 
-20 dB to 80 dB.

If Amps is chosen as the units and a manual attenuation factor is chosen, then the 
units as well as the attenuation factor are displayed above the Probe softkey.
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To specify the channel external scaling

External scaling lets you apply additional gain to the input channel to account for 
additional attenuators, adapters, etc., in the probing system.

1 Press the channel key.

2 In the Channel Menu, press Probe.

3 In the Channel Probe Menu, press External Scaling.

4 In the Channel External Scaling Menu:

• Press Units and select Volts or Amps (same as in the previous Channel Probe 
Menu).

• Press External Scaling to enable or disable external scaling.

• Press External Gain and choose either Ratio or Decibels to select how you want 
to specify the attenuation factor. Then, turn the Entry knob (or press the 
softkey again for a keypad entry dialog) to specify the external gain value.

To specify the probe skew

When measuring time intervals in the nanoseconds (ns) range, small differences in 
cable length can affect the measurement. Use Skew to remove cable-delay errors 
between any two channels.

1 Probe the same point with both probes.

2 Press one of the probes associated channel key.

3 In the Channel Menu, press Probe.

4 In the Channel Probe Menu, press Skew; then, select the desired skew value.

Each analog channel can be adjusted ±100 ns in 10 ps increments for a total of 
200 ns difference.

The skew setting is not affected by pressing [Default Setup] or [Auto Scale].

To calibrate a probe

The Calibrate Probe softkey guides you through the process of calibrating probes.
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For certain active probes, such as InfiniiMax probes, the oscilloscope can 
accurately calibrate its analog channels for the probe. When you connect a probe 
that can be calibrated, the Calibrate Probe softkey in the Channel Probe Menu 
becomes active.

To calibrate one of these probes:

1 First, plug your probe into one of the oscilloscope channels.

This could be, for example, an InfiniiMax probe amplifier/probe head with 
attenuators attached.

2 Connect the probe to the left side, Demo 2, Probe Comp terminal, and the 
probe ground to the ground terminal.

3 Press the Channel on/off key to turn the channel on (if the channel is off).

4 In the Channel Menu, press the Probe softkey.

5 In the Channel Probe Menu, the second softkey from the left is for specifying 
your probe head (and attenuation). Repeatedly press this softkey until the 
probe head selection matches the attenuator you are using.

The choices are:

• 10:1 single-ended browser (no attenuator).

• 10:1 differential browser (no attenuator).

• 10:1 (+6 dB Atten) single-ended browser.

• 10:1 (+6 dB Atten) differential browser.

• 10:1 (+12 dB Atten) single-ended browser.

• 10:1 (+12 dB Atten) differential browser.

• 10:1 (+20 dB Atten) single-ended browser.

• 10:1 (+20 dB Atten) differential browser.

6 Press the Calibrate Probe softkey and follow the instructions on the display.

For more information on InfiniiMax probes and accessories, see the probe's User's 
Guide.

NOTE When calibrating a differential probe, connect the positive lead to the Probe Comp terminal 
and the negative lead to the ground terminal. You may need to connect an alligator clip to the 
ground lug to allow a differential probe to span between the Probe Comp test point and 
ground. A good ground connection ensures the most accurate probe calibration.
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4 Math Waveforms
To display math waveforms / 95
To adjust the math waveform scale and offset / 97
Units for Math Waveforms / 97
Math Operators / 98
Math Transforms / 100
Math Filters / 119
Math Visualizations / 123
The Measurement Record and Waveform Math / 134

You can define and display up to four math functions. Math function waveforms 
display in shades of light purple.

Math functions can be performed on analog channels or they can be performed on 
lower math functions when using operators other than add, subtract, multiply, or 
divide.

To display math waveforms

1 Press the [Math] key on the front panel to display the Waveform Math Menu.

2 Press the Display Math softkey and turn the Entry knob to select the math 
function you want to display. Then, either push the Entry knob or press the 
Display Math softkey again to display the selected math function.
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3 Use the Operator softkey to select an operator, transform, filter, or visualization.

For more information on the operators, see:

• "Math Operators" on page 98

• "Math Transforms" on page 100

• "Math Filters" on page 119

• "Math Visualizations" on page 123

4 Use the Source 1 softkey to select the analog channel, lower math function, or 
reference waveform on which to perform math. You can rotate the Entry knob or 
repetitively press the Source 1 softkey to make your selection.

Higher math functions can operate on lower math functions. For example, if 
Math 1 is set up as a subtract operation between channels 1 and 2, the Math 2 
function could be set up as a FFT operation on the Math 1 function. These are 
called cascaded math functions.

To cascade math functions, select the lower math function using the Source 1 
softkey.

5 If you selected an arithmetic operator for the math function, use the Source 2 
softkey to select the second source for the arithmetic operation.

6 To re-size and re-position the math waveform, see "To adjust the math 
waveform scale and offset" on page 97.

TIP When cascading math functions, to get the most accurate results, be sure to vertically scale 
lower math functions so that their waveforms take up the full screen without being clipped.

TIP Math Operating Hints

If the analog channel or math function is clipped (not fully displayed on screen) the resulting 
displayed math function will also be clipped.

Once the function is displayed, the analog channel(s) may be turned off for better viewing of 
the math waveform.

The vertical scaling and offset of each math function can be adjusted for ease of viewing and 
measurement considerations.

The math function waveform can be measured using [Cursors] and/or [Meas].
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To adjust the math waveform scale and offset

1 Make sure the multiplexed scale and position knobs above and below the [Math] 
key are selected for the math waveform.

If the arrow to the left of the [Math] key is not illuminated, press the key.

2 Use the multiplexed scale and position knobs above and below the [Math] key to 
re-size and re-position the math waveform.

See Also • "Units for Math Waveforms" on page 97

Units for Math Waveforms

Units for each input channel can be set to Volts or Amps using the Units softkey in 
the channel's Probe Menu. Units for math function waveforms are:

NOTE Math Scale and Offset are Set Automatically

Any time the currently displayed math function definition is changed, the function is 
automatically scaled for optimum vertical scale and offset. If you manually set scale and offset 
for a function, select a new function, then select the original function, the original function will 
be automatically rescaled.
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A scale unit of U (undefined) will be displayed for math functions when two source 
channels are used and they are set to dissimilar units and the combination of units 
cannot be resolved.

Math Operators

Math operators perform arithmetic operations (like add, subtract, or multiply) on 
analog input channels.

• "Add or Subtract" on page 98

• "Multiply or Divide" on page 99

Add or Subtract

When you select add or subtract, the Source 1 and Source 2 values are added or 
subtracted point by point, and the result is displayed.

You can use subtract to make a differential measurement or to compare two 
waveforms.

If your waveforms' DC offsets are larger than the dynamic range of the 
oscilloscope's input channels you will need to use a differential probe instead.

Math function Units

add or subtract V or A

multiply V2, A2, or W (Volt-Amp)

d/dt V/s or A/s (V/second or A/second)

 dt Vs or As (V-seconds or A-seconds)

FFT dB* (decibels). See also "FFT Units" on 
page 112.

√(square root) V1/2, A1/2, or W1/2 (Volt-Amp)

* When the FFT source is channel 1, 2, 3 or 4, FFT units will be displayed in dBV when channel units 
is set to Volts and channel impedance is set to 1 MΩ. FFT units will be displayed in dBm when 
channel units is set to Volts and channel impedance is set to 50Ω. FFT units will be displayed as dB 
for all other FFT sources or when a source channel's units has been set to Amps.
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See Also • "Units for Math Waveforms" on page 97

Multiply or Divide

When you select the multiply or divide math function, the Source 1 and Source 2 
values are multiplied or divided point by point, and the result is displayed.

The divide by zero case places holes (that is, zero values) in the output waveform.

Multiply is useful for seeing power relationships when one of the channels is 
proportional to the current.

Figure 5 Example of Subtract Channel 2 from Channel 1
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See Also • "Units for Math Waveforms" on page 97

Math Transforms

Math transforms perform a transform function (like differentiate, integrate, FFT, or 
square root) on an analog input channel or on the result of an arithmetic 
operation.

• "Differentiate" on page 101

• "Integrate" on page 102

• "FFT Magnitude, FFT Phase" on page 105

• "Square Root" on page 115

• "Ax + B" on page 115

Figure 6 Example of Multiply Channel 1 by Channel 2
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• "Square" on page 116

• "Absolute Value" on page 117

• "Common Logarithm" on page 117

• "Natural Logarithm" on page 118

• "Exponential" on page 118

• "Base 10 Exponential" on page 119

Differentiate

d/dt (differentiate) calculates the discrete time derivative of the selected source.

You can use differentiate to measure the instantaneous slope of a waveform. For 
example, the slew rate of an operational amplifier may be measured using the 
differentiate function.

Because differentiation is very sensitive to noise, it is helpful to set acquisition 
mode to Averaging (see "Selecting the Acquisition Mode" on page 233).

d/dt plots the derivative of the selected source using the "average slope estimate 
at 4 points" formula. The equation is:

Where:

• d = differential waveform.

• y = channel 1, 2, 3, 4, or Math 1, Math 2, Math 3 (lower math function) data 
points.

• i = data point index.

• Δt = point-to-point time difference.

di =
yi+4 + 2yi+2 − 2yi−2 − yi−4

8 Δ t
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See Also • "Units for Math Waveforms" on page 97

Integrate

 dt (integrate) calculates the integral of the selected source. It shows the 
accumulated amount of change.

You can use integrate to calculate the energy of a pulse in volt-seconds or 
measure the area under a waveform by measuring the difference in the integrate 
function value across the pulse or waveform.

 dt plots the integral of the source using the "Trapezoidal Rule". The equation is:

Figure 7 Example of Differentiate Function
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Where:

• I = integrated waveform.

• Δt = point-to-point time difference.

• y = channel 1, 2, 3, 4, or Math 1, Math 2, Math 3 (lower math function) data 
points.

• co = arbitrary constant.

• i = data point index.

The integrate operator provides an Offset softkey that lets you enter a DC offset 
correction factor for the input signal. Small DC offset in the integrate function 
input (or even small oscilloscope calibration errors) can cause the integrate 
function output to "ramp" up or down. This DC offset correction lets you level the 
integrate waveform.

In = co + Δ t∑
i=0

n
yi
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Figure 8 Integrate Without Signal Offset

0 V level

Integrate
without
DC offset
correction
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When Initial Condition is enabled, the integrate math waveform is vertically 
centered in the screen. In other words, the top and bottom of the math waveform 
are equal distances from the top and bottom of the screen. When Initial Condition is 
disabled, the integrate math waveform starts at the zero-level reference on the left 
side of the screen.

See Also • "Units for Math Waveforms" on page 97

FFT Magnitude, FFT Phase

Using the Fast Fourier Transform (FFT), the FFT (Magnitude) math function 
displays the magnitudes of the frequency content that makes up the source 
waveform, and the FFT (Phase) math function shows the phase relationships of the 
frequency content. The FFT takes the digitized time record of the specified source 
and transforms it to the frequency domain.

Figure 9 Integrate With Signal Offset

Integrate
with DC offset
correction
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The source of the FFT math functions can be analog input channels or a lower 
math function.

The horizontal axis of FFT math functions is frequency (Hertz). For the FFT 
(Magnitude) math function, the vertical axis is in decibels when Logarithmic 
vertical units are selected or V RMS when Linear vertical units are selected. For 
the FFT (Phase) math function, the vertical axis is in degrees or radians.

Use the FFT (Magnitude) function to find crosstalk problems, to find distortion 
problems in analog waveforms caused by amplifier non-linearity, or for adjusting 
analog filters.

To display a FFT waveform:

1 Press the Display Math softkey and turn the Entry knob to select the math 
function you want to display. Then, either push the Entry knob or press the 
Display Math softkey again to display the selected math function.

2 Press the [Math] key. Then, press the Display Math softkey and select the math 
function you want to use. Then, press the Operator softkey and select FFT 
(Magnitude) or FFT (Phase).

• Source 1 — selects the source for the FFT.

• Span/Center or Start Freq/Stop Freq — this pair of softkeys let you define the 
displayed frequency range. Press the softkeys to toggle between:

• Span/Center — Span specifies the frequency range represented by the 
width of the display. Divide span by 10 to calculate the frequency scale 
per division. Center specifies the frequency at the center vertical grid line 
of the display.

• Start Freq/Stop Freq — Start Freq specifies the frequency at the left side of 
the display. Stop Freq specifies the frequency at the right side of the 
display.

To set desired values, tap the softkey label on screen for a keypad entry 
dialog or turn the Entry knob.

• Scale — opens a dialog box for adjusting the math waveform's vertical scale.

• Offset — opens a dialog box for adjusting the math waveform's vertical offset.
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• Bin Size, RBW (Resolution Bandwidth), Sample Rate — displays the FFT 
resolution in one of three different ways.

• More FFT — displays the More FFT Settings Menu.

3 Press the More FFT softkey to display additional FFT settings.

• Window — selects a window to apply to your FFT input signal:

• Hanning — window for making accurate frequency measurements or for 
resolving two frequencies that are close together.

• Flat Top — window for making accurate amplitude measurements of 
frequency peaks.

• Rectangular — good frequency resolution and amplitude accuracy, but use 
only where there will be no leakage effects. Use on self-windowing 
waveforms such as pseudo-random noise, impulses, sine bursts, and 
decaying sinusoids.

• Blackman Harris — window reduces time resolution compared to a 
rectangular window, but improves the capacity to detect smaller impulses 
due to lower secondary lobes.

• Bartlett — (triangular, with end points at zero) window is similar to the 
Hanning window in that it is good for making accurate frequency 
measurements, but its higher and wider secondary lobes make it not quite 
as good for resolving frequencies that are close together.

• Vertical Units — For FFT (Magnitude), you can select Logarithmic (decibels) or 
Linear (V RMS). For FFT (Phase), you can select Degrees or Radians.

Use the multiplexed knobs for the [Math] key to adjust the FFT waveform 
vertical scale and offset.

• FFT Gating — When the zoomed time base is displayed, press this softkey to 
select:

• No Gating — the FFT is performed on the source waveform in the upper 
Main time base window.

• Gate By Zoom — the FFT is performed on the source waveform in the lower 
Zoom window.
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• Detection Type — When the FFT (Magnitude) operator is selected, this softkey 
lets you set the FFT detector decimation type.

Detectors give you a way of manipulating the acquired data to emphasize 
different features of the data. Detectors reduce (decimate) the number of 
FFT points to at most the number of specified detector points. In this 
reduction, sampled FFT points are bucketized, that is, split into a number of 
groups that equals the specified number of detector points. Then, the points 
in each bucket are reduced to a single point according to the selected 
detection type. The detector types are:

• None — No detector is used.

• Sample — Takes the point nearest to the center of every bucket.

• + Peak — Takes the most positive point in every bucket.

• - Peak — Takes the most negative point in every bucket.

• Average — Takes the average of all points in every bucket.

• Normal — Implements a rosenfell algorithm. This method to picks either 
the minimum or maximum sample in every bucket depending on whether 
the data is monotonically increasing, decreasing, or varying. For details, 
see the Spectrum Analysis Basics application note at www.keysight.com.

When detectors are used, the FFT's output is decimated, and any analysis is 
performed on the reduced or detected data set.

• Points per Span — When the FFT (Magnitude) operator is selected and a 
detector is used, this softkey specifies the maximum number of points that 
detectors should decimate to. This is also the number of buckets that 
sampled FFT points are grouped into before the selected detection type 
reduction (decimation) is applied.

The minimum number of points is 640.

When precision analysis is off, the maximum number of points is the 
measurement record limit of 64K.

When precision analysis is on (see "Precision Measurements and Math" on 
page 289), the maximum number of points is 1/2 the power-of-two value 
needed to hold the precision analysis record length.

http://literature.cdn.keysight.com/litweb/pdf/5952-0292.pdf
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• Auto Setup — sets the frequency Span and Center to values that will cause 
the entire available spectrum to be displayed. The maximum available 
frequency is half the FFT sample rate, which is a function of the time per 
division setting. The FFT resolution is the quotient of the sampling rate and 
the number of FFT points (fS/N). The current FFT Resolution is displayed 
above the softkeys.

• Zero Phase Ref — When the FFT (Phase) operator is selected, this softkey sets 
the reference point for calculating the FFT Phase function:

• Trigger — the FFT phase is measured from the trigger (time=0) point of the 
waveform.

• Entire Display — the FFT phase is measured from the beginning of the 
displayed waveform.

4 To make cursor measurements, press the [Cursors] key and set the Source 
softkey to Math N.

Use the X1 and X2 cursors to measure frequency values and difference between 
two frequency values (ΔX). Use the Y1 and Y2 cursors to measure amplitude in 
dB and difference in amplitude (ΔY).

5 To make other measurements, press the [Meas] key and set the Source softkey to 
Math N.

You can make peak-to-peak, maximum, minimum, and average dB 
measurements on the FFT waveform. You can also find the frequency value at 
the first occurrence of the waveform maximum by using the X at Max Y 
measurement.

NOTE Scale and offset considerations

If you do not manually change the FFT scale or offset settings, when you turn the horizontal 
scale knob, the span and center frequency settings will automatically change to allow 
optimum viewing of the full spectrum.

If you do manually set scale or offset, turning the horizontal scale knob will not change the 
span or center frequency settings, allowing you see better detail around a specific frequency.

Pressing the FFT Auto Setup softkey will automatically rescale the waveform and span and 
center will again automatically track the horizontal scale setting.
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The following FFT (Magnitude) spectrum was obtained by connecting a 2.5 V, 
100 kHz square wave to channel 1. Set the horizontal scale to 50 µs/div, vertical 
sensitivity to 1 V/div, Units/div to 20 dBV, Offset to -40.0 dBV, Center frequency to 
500 kHz, frequency Span to 1 MHz, and window to Hanning.

See Also • "Searching for FFT Peaks" on page 110

• "FFT Measurement Hints" on page 111

• "FFT Units" on page 112

• "FFT DC Value" on page 112

• "FFT Aliasing" on page 113

• "FFT Spectral Leakage" on page 114

• "Units for Math Waveforms" on page 97

Searching for FFT Peaks

To search for FFT math function frequency peaks:
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1 Press [Search].

2 In the Search Menu, press Search; then, turn the Entry knob to select Frequency 
Peaks.

3 Press Source and select the FFT math function waveform to search.

4 Press Max # Peaks and specify the maximum number of FFT peaks to find.

5 Press Threshold and turn the Entry knob to specify the threshold level necessary 
to be considered a peak.

6 Press Excursion to specify the amplitude above the FFT waveform's noise floor 
necessary to be recognized as a peak.

Note that the FFT waveform's noise floor level differs when additional math 
functions are applied to the FFT:

• When Averaged Value, Max Hold, or Min Hold are applied, the FFT waveform's 
noise floor is more stable, and excursion level settings are more accurate.

• When no additional math functions are applied (normal), the FFT waveform's 
noise floor is less stable and excursion level settings are less accurate.

White arrowheads at the top of the graticule show where FFT peaks are found.

When acquisitions are stopped, you can use the [Navigate] keys and cursors to look 
at the search events found.

FFT Measurement Hints

The number of points acquired for the FFT record can be up to 65,536, and when 
frequency span is at maximum, all points are displayed. Once the FFT spectrum is 
displayed, the frequency span and center frequency controls are used much like 
the controls of a spectrum analyzer to examine the frequency of interest in greater 
detail. Place the desired part of the waveform at the center of the screen and 
decrease frequency span to increase the display resolution. As frequency span is 
decreased, the number of points shown is reduced, and the display is magnified.

While the FFT spectrum is displayed, use the [Math] and [Cursors] keys to switch 
between measurement functions and frequency domain controls in FFT Menu.

NOTE FFT Resolution

The FFT resolution is the quotient of the sampling rate and the number of FFT points (fS/N). 
With a fixed number of FFT points (up to 65,536), the lower the sampling rate, the better the 
resolution.
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Decreasing the effective sampling rate by selecting a greater time/div setting will 
increase the low frequency resolution of the FFT display and also increase the 
chance that an alias will be displayed. The resolution of the FFT is the effective 
sample rate divided by the number of points in the FFT. The actual resolution of 
the display will not be this fine as the shape of the window will be the actual 
limiting factor in the FFTs ability to resolve two closely space frequencies. A good 
way to test the ability of the FFT to resolve two closely spaced frequencies is to 
examine the sidebands of an amplitude modulated sine wave.

For the best vertical accuracy on peak measurements:

• Make sure the probe attenuation is set correctly. The probe attenuation is set 
from the Channel Menu if the operand is a channel.

• Set the source sensitivity so that the input signal is near full screen, but not 
clipped.

• Use the Flat Top window.

• Set the FFT sensitivity to a sensitive range, such as 2 dB/division.

For best frequency accuracy on peaks:

• Use the Hanning window.

• Use Cursors to place an X cursor on the frequency of interest.

• Adjust frequency span for better cursor placement.

• Return to the Cursors Menu to fine tune the X cursor.

For more information on the use of FFTs please refer to Keysight Application Note 
243, The Fundamentals of Signal Analysis at 
http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf. Additional 
information can be obtained from Chapter 4 of the book Spectrum and Network 
Measurements by Robert A. Witte.

FFT Units

FFT (Magnitude)
Units

FFT units are displayed as dB.

FFT (Phase) Units In this case, the vertical units are degrees or radians.

FFT DC Value

The FFT computation produces a DC value that is incorrect. It does not take the 
offset at center screen into account. The DC value is not corrected in order to 
accurately represent frequency components near DC.

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
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FFT Aliasing

When using FFTs, it is important to be aware of frequency aliasing. This requires 
that the operator have some knowledge as to what the frequency domain should 
contain, and also consider the sampling rate, frequency span, and oscilloscope 
vertical bandwidth when making FFT measurements. The FFT resolution (the 
quotient of the sampling rate and the number of FFT points) is displayed directly 
above the softkeys when the FFT Menu is displayed.

Aliasing happens when there are frequency components in the signal higher than 
half the sample rate. Because the FFT spectrum is limited by this frequency, any 
higher components are displayed at a lower (aliased) frequency.

The following figure illustrates aliasing. This is the spectrum of a 990 Hz square 
wave, which has many harmonics. The horizontal time/div setting for the square 
wave sets the sample rate and results in a FFT resolution of 1.91 Hz. The displayed 
FFT spectrum waveform shows the components of the input signal above the 
Nyquist frequency to be mirrored (aliased) on the display and reflected off the right 
edge.

NOTE Nyquist Frequency and Aliasing in the Frequency Domain

The Nyquist frequency is the highest frequency that any real-time digitizing oscilloscope can 
acquire without aliasing. This frequency is half of the sample rate. Frequencies above the 
Nyquist frequency will be under sampled, which causes aliasing. The Nyquist frequency is also 
called the folding frequency because aliased frequency components fold back from that 
frequency when viewing the frequency domain.
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Because the frequency span goes from ≈ 0 to the Nyquist frequency, the best way 
to prevent aliasing is to make sure that the frequency span is greater than the 
frequencies of significant energy present in the input signal.

FFT Spectral Leakage

The FFT operation assumes that the time record repeats. Unless there is an 
integral number of cycles of the sampled waveform in the record, a discontinuity is 
created at the end of the record. This is referred to as leakage. In order to minimize 
spectral leakage, windows that approach zero smoothly at the beginning and end 
of the signal are employed as filters to the FFT. The FFT Menu provides these 
windows: Hanning, Flat Top, Rectangular, Blackman-Harris, and Bartlett. For 
more information on leakage, see Keysight Application Note 243, The 
Fundamentals of Signal Analysis at 
http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf.

Figure 10 Aliasing

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
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Square Root

Square root (√) calculates the square root of the selected source.

Where the transform is undefined for a particular input, holes (zero values) appear 
in the function output.

See Also • "Units for Math Waveforms" on page 97

Ax + B

The Ax + B function lets you apply a gain and offset to an existing input source.

Figure 11 Example of √ (Square Root)
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Use the Gain (A) softkey to specify the gain.

Use the Offset (B) softkey to specify the offset.

The Ax + B function differs from the Magnify math visualization function in that the 
output is likely different than the input.

See Also • "Magnify" on page 123

Square

The square function calculates the square of the selected source, point by point, 
and displays the result.

Press the Source softkey to select the signal source.

See Also • "Square Root" on page 115

Figure 12 Example of Ax + B
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Absolute Value

The absolute value function changes negative values in the input to positive values 
and displays the resulting waveform.

See Also • "Square" on page 116

Common Logarithm

The Common Logarithm (log) function performs a transform of the input source. 
Where the transform is undefined for a particular input, holes (zero values) appear 
in the function output.

See Also • "Natural Logarithm" on page 118

Figure 13 Example of Absolute Value
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Natural Logarithm

The Natural Logarithm (ln) function performs a transform of the input source. 
Where the transform is undefined for a particular input, holes (zero values) appear 
in the function output.

See Also • "Common Logarithm" on page 117

Exponential

The Exponential (e^x) function performs a transform of the input source.

See Also • "Base 10 Exponential" on page 119

Figure 14 Example of Natural Logarithm
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Base 10 Exponential

The Base 10 Exponential (10^x) function performs a transform of the input source.

See Also • "Exponential" on page 118

Math Filters

You can use math filters to create a waveform that is the result of a the filter on an 
analog input channel or on the result of an arithmetic operation.

• "High Pass and Low Pass Filter" on page 120

• "Band Pass Filter" on page 121

• "Averaged Value" on page 122

Figure 15 Example of Base 10 Exponential
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• "Smoothing" on page 122

• "Envelope" on page 123

High Pass and Low Pass Filter

The high-pass or low-pass filter functions apply the filter to the selected source 
waveform and display the result in the math waveform.

The high-pass filter is a single-pole high-pass filter.

The low-pass filter is a 4th order Bessel-Thompson filter.

Use the Bandwidth softkey to select the filter's -3 dB cutoff frequency.

NOTE The ratio of the input signal's Nyquist frequency and the selected -3 dB cutoff frequency 
affects how many points are available in the output, and under some circumstances, there are 
no points in the output waveform.
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Band Pass Filter

The band-pass filter function applies the filter to the selected source waveform 
and displays the result in the math waveform.

Use the Center softkey to enter the center frequency of the band-pass filter.

Use the Width softkey to enter the frequency width of the band-pass filter. This 
specifies the filter's -3 dB cutoff frequencies (center frequency minus half the 
width and center frequency plus half the width).

Figure 16 Example of Low Pass Filter

NOTE The ratio of the input signal's Nyquist frequency and the selected -3 dB cutoff frequencies 
affects how many points are available in the output, and under some circumstances, there are 
no points in the output waveform.
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Averaged Value

When the Averaged Value operator is selected, the math waveform becomes the 
selected source waveform, averaged the selected number of times.

The source waveform can be one of the analog input channels or one of the 
previous math function waveforms.

Unlike acquisition averaging, the math averaging operator can be used to average 
the data on a single analog input channel or math function.

If acquisition averaging is also used, the analog input channel data is averaged 
and the math function averages it again. You can use both types of averaging to 
get a certain number of averages on all waveforms and an increased number of 
averages on a particular waveform.

As with acquisition averaging, averages are calculated using a "decaying average" 
approximation, where:

next_average = current_average + (new_data - current_average)/N

Where N starts at 1 for the first acquisition and increments for each following 
acquisition until it reaches the selected number of averages, where it holds.

Press the Reset Count softkey to clear the number of waveforms evaluated.

See Also • "Averaging Acquisition Mode" on page 237

Smoothing

The resulting math waveform is the selected source with a normalized rectangular 
(boxcar) FIR filter applied.

The boxcar filter is a moving average of adjacent waveform points, where the 
number of adjacent points is specified by the Smoothing Points softkey. You can 
choose an odd number of points, from 3 up to half of the measurement record or 
precision analysis record.

The smoothing operator limits the bandwidth of the source waveform. The 
smoothing operator can be used, for example, to smooth measurement trend 
waveforms.
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Envelope

The resulting math waveform shows the amplitude envelope for an amplitude 
modulated (AM) input signal.

This function uses a Hilbert transform to get the real (in-phase, I) and imaginary 
(quadrature, Q) parts of the input signal and then performs a square root of the 
sum of the real and imaginary parts to get the demodulated amplitude envelope 
waveform.

Math Visualizations

You can apply visualization math functions that give you different ways of viewing 
captured data and measurement values.

• "Magnify" on page 123

• "Maximum/Minimum" on page 124

• "Peak-Peak" on page 125

• "Max/Min Hold" on page 125

• "Measurement Trend" on page 125

• "Chart Logic Bus Timing" on page 127

• "Chart Logic Bus State" on page 128

• "Chart Serial Signal" on page 129

• "Clock Recovery" on page 132

Magnify

The magnify math function lets you display an existing input source at different 
vertical settings to provide more vertical detail.



124 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

4 Math Waveforms
 

See Also • "Ax + B" on page 115

Maximum/Minimum

The Maximum operator is like the Max Hold operator without the hold. The 
maximum vertical values found at each horizontal bucket are used to build a 
waveform.

The Minimum operator is like the Min Hold operator without the hold. The 
minimum vertical values found at each horizontal bucket are used to build a 
waveform.

Figure 17 Example of Magnify
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Peak-Peak

The Peak-Peak operator is like the Maximum operator minus the Minimum 
operator. At each horizontal bucket, the minimum vertical values found are 
subtracted from the maximum vertical values found to build a waveform.

Max/Min Hold

The Max Hold operator records the maximum vertical values found at each 
horizontal bucket across multiple analysis cycles and uses those values to build a 
waveform.

The Min Hold operator is the same, except it records the minimum vertical values.

When not used in a frequency analysis domain, these functions are often referred 
to as Max Envelope and Min Envelope.

Press the Reset Count softkey to clear the number of waveforms evaluated.

Measurement Trend

The measurement trend math function shows measurement values for a waveform 
(based on measurement threshold settings) as the waveform progresses across 
the screen. For every cycle, a measurement is made, and the value is displayed on 
the screen for the cycle.
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Press the Measurement softkey to select the previously added measurement whose 
trend you want to look at. You can display trend values for these measurements:

• Average

• RMS - AC

• Ratio

• Period

• Frequency

• +Width

• -Width

• +Duty Cycle

• -Duty Cycle

• Rise Time

Figure 18 Example of Measurement Trend
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• Fall Time

Use the Thresholds softkey to access the Measurement Threshold Menu. See 
"Measurement Thresholds" on page 283.

If a measurement cannot be made for part of a waveform, the trend function 
output is a hole (that is, no value) until a measurement can be made.

Chart Logic Bus Timing

The Chart Logic Bus Timing function displays bus data values as an analog 
waveform (like a D/A conversion). When the bus value is transitioning, the 
function output is the bus's last stable state.

Use the Units/Code softkey to specify the analog value equivalent of each 
increment in the bus data value.

Figure 19 Example of Chart Logic Bus Timing
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Use the 0 Offset softkey to specify the analog value equivalent of a bus data value 
of zero.

Use the Units softkey to specify the type of values the bus data represents (volts, 
amps, etc.).

See Also • "Chart Logic Bus State" on page 128

Chart Logic Bus State

The Chart Logic Bus State function displays bus data values, sampled on a clock 
signal's edge, as an analog waveform (like a D/A conversion).

Use the Clock softkey to select the clock signal.

Use the Slope softkey to select the edge of the clock signal to be used.

Figure 20 Example of Chart Logic Bus State
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Use the More Chart softkey to open a submenu for specifying the analog value 
equivalent of each bus value increment, the analog equivalent of a zero bus value, 
and the type of values the charted bus data represents (volts, amps, etc.).

Use the Units/Code softkey to specify the analog value equivalent of each 
increment in the bus data value.

Use the 0 Offset softkey to specify the analog value equivalent of a bus data value 
of zero.

Use the Units softkey to specify the type of values the bus data represents (volts, 
amps, etc.).

See Also • "Chart Logic Bus Timing" on page 127

Chart Serial Signal

The Chart Serial Signal math function plots serial bus "signals". Signals are the 
values of defined bits within the data/payload field of CAN, LIN, or SENT 
protocols.
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• Charting a CAN or LIN signal requires a symbolic data file be loaded into the 
oscilloscope.

• With CAN, symbolic data definitions are recalled from a *.dbc file.

• With LIN, symbolic data definitions are recalled from a *.ldf file.

The symbolic data file defines the information (or "signals") present in the 
data/payload field. From these definitions, you can select the "signal" to be 
charted.

• Charting a SENT signal requires that you define the bits and transfer function of 
the SENT signal in the serial decode's SENT > Settings > Fast Signals menu.

Use the Bus Source softkey to select the serial decode from which the symbolic 
data values come (either S1 or S2).

Softkeys in the fourth and fifth positions select the signal to plot:

Figure 21 Example of Chart Serial Signal
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• With the CAN serial decode (when its display setting is Symbolic), use the 
Message and Signal softkeys to select the message and signal you want to plot.

• With the LIN serial decode (when its display setting is Symbolic), use the Frame 
and Signal softkeys to select the frame and signal you want to plot.

• With the SENT serial decode (when its display setting is Transfer Function), use 
the SENT Signal softkey to select the SENT signal source you want to plot (Signal 
1-6).

The Time Mode softkey opens the Time menu.

In the Time menu:

• You can select the time mode:

• Normal — The signal data values are plotted per acquisition, in the same 
horizontal time scale as the other waveforms, and all waveform data is 
time-correlated.

In this mode, the oscilloscope's timebase (time/div) is typically set for a long 
acquisition time to capture multiple occurrences of the 
message/frame/packet that contains the signal to be charted.

If the timebase is set to longer than 200 ms/div for high-speed CAN or 
SENT, undersampling may occur due to limited acquisition memory and 
reduced sample rate. Timebase settings for LIN can usually be much longer.

• Roll — The signal data values are plotted at the right side of the display and 
roll across the display for a specified amout of time. This resulting math 
function waveform is not time-correlated with other waveforms on the 
display.

Roll mode establishes a second and typically much slower timebase and is 
useful for charting very slow changing signals (up to 1 hour), such as 
temperature or pressure.

Signal values are typically under-sampled (not every occurrence of a signal 
will be plotted). Signal values roll across the display as new signal values are 
received and plotted.

If charting a CAN or LIN signal in this mode, you should set up the 
oscilloscope to trigger on the message/frame that contains the signal.
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If charting SENT, the oscilloscope should be set up to trigger on "Start of Fast 
Channel Message".

In Roll mode, the oscilloscope's main timebase setting is typically set to 
capture just a few messages.

• When the Roll time mode is selected, you can specify the Time Range and the 
Offset:

• Time Range — Defines the width across the display for the charted serial 
signal waveform.

• Offset — Shows the time value of the center of the display. When 
oscilloscope acquisitions are running, the offset is automatically set to the 
middle of the time range.

When oscilloscope acquisitions are stopped, you can adjust the Offset and Time 
Range to scroll and zoom the plotted signal values.

See Also • The CAN, LIN, and SENT decode options in "Serial Decode Options" on 
page 159

Clock Recovery

Clock recovery is a feature that provides an ideal clock for comparison to actual 
signal edges. Clock recovery is used, for example, in Clock TIE and Data TIE (Time 
Interval Error) jitter measurements. You can also set up clock recovery and display 
the recovered ideal clock as a math function waveform.

Use the Setup softkey to open a dialog where you can set up clock recovery 
options. See "Setting Up Clock Recovery" on page 132.

Setting Up Clock Recovery

The Clock Recovery dialog is used to select the clock recovery method and specify 
its options.
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You can choose:

• Constant Frequency — The clock is assumed to be a constant frequency, and the 
data rate recovery options are:

• Fully Automatic — The clock is recovered using the signal edge database only. 
The narrowest pulse is presumed to be an isolated one or zero.

• Semi Automatic — The clock is recovered using the expected Nominal Data Rate 
as a "seed" and the signal edge database.

• Manual — The expected Nominal Data Rate you enter is used. It should be the 
reciprocal of the signal's unit interval.

• First Order PLL — The clock is recovered using the DSP-modeled response of an 
ideal first-order hardware PLL. Enter these parameters:

• Nominal Data Rate — The signal's expected bits/second data rate.

• Loop Bandwidth — The -3 dB bandwidth specification of the PLL.

• Second Order PLL — The clock is recovered using the DSP-modeled response of 
an ideal Type II, second-order hardware PLL. Enter these parameters:

• Nominal Data Rate — The signal's expected bits/second data rate.
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• Loop Bandwidth — The -3 dB bandwidth specification of the PLL.

• Damping Factor — The damping factor of the PLL's observed jitter transfer 
function (OJTF).

Typical damping factor values are 1.0, which is critically damped, and 0.707, 
which is considered ideal or optimal because of its fast settling time 
(optimally flat) and Butterworth type response. Values less than 1 are 
underdamped, and values greater than 1 are overdamped.

• Explicit — The clock is recovered from a second signal in your device under test, 
with a multiplier from 1 to 1000 applied.

The Measurement Record and Waveform Math

Keysight InfiniiVision oscilloscopes are designed to provide high waveform update 
rates which give you an increased probability of capturing infrequent events. With 
high waveform update rates, there is less "dead time" between acquisitions.

To provide high waveform update rates, there are some things the oscilloscope 
does with memory:

• When running, acquisition memory is split into two memories so that the 
processing of one acquisition can take place while another acquisition is being 
captured. For single acquisitions, the full memory is used. Waveform data in 
acquisition memory is called the raw acquisition record.

• There is a separate 65536 (64K) points maximum of eavesdrop memory that is 
used for making measurements and for calculating math functions. Data in this 
memory is a reduced-sample decimation of the data in the raw acquisition 
record. When a math function is turned on, eavesdrop memory is limited to 
62500 points maximum. Waveform data in eavesdrop memory is called the 
measurement record.

(If you want to calculate math functions on a longer record, you can save the 
raw acquisition record and use programs like Excel or MATLAB to perform the 
analysis.)

• On 6000 X-Series oscilloscopes, there is a third memory used to enable 
precision measurements and math functions at the expense of waveform 
update rate. The depth of this memory is user-selectable from 100k points to 
1M points. Using this "precision analysis" memory gives you better resolution 
on measurements and math waveforms (including FFT). Waveform data in this 
memory is called the precision analysis record.
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Waveform data for the acquisition time (that is, the time per division setting 
multiplied by 10 divisions across the display) is saved to the memories. When the 
oscilloscope analog-to-digital converter's (ADC, or digitizer) sample period yields 
more data points than can be stored in the memory, some samples are thrown 
away (decimated), and the effective (or actual) sample rate is reduced. This is why, 
at greater time/div settings, the displayed sample rate decreases.

For example, suppose an oscilloscope's digitizer has a sample period of 1 ns 
(maximum sample rate of 1 GSa/s) and a 1 M memory depth. At that rate, memory 
is filled in 1 ms. If the acquisition time is 100 ms (10 ms/div), only 1 of every 100 
samples is needed to fill memory. The effective sample rate becomes 10 MSa/s.

The decimator is configured to provide a best-estimate of all the samples that 
each point in the record represents. There is no filtering in the decimation.

FFT (Spectral)
Analysis of

Measurement
Record Data

When the FFT operator is turned on, the decimation from the raw acquisition 
record to the measurement record works on integer rate down-sampling. For 
example, a raw acquisition record of 2000000 points and a measurement record of 
62500 points are already set up with an integer rate decimation of 32 (2000000/32 
= 62500).

For FFT analysis, the decimated record is then zero-padded to 2(X+1) where 2X >= 
record length. For the above example, the power of 2 greater than the record 
length is 65536, so the record is zero-padded to 131072 points.

You can look at the FFT math function results on the oscilloscope to work 
backward and find the un-zero-padded decimated record length as well as the 
FFT length used after the zero-padding:

• First, we know:

• The FFT algorithm translates a time record of N equally spaced samples into 
N/2 equally spaced lines in the frequency domain.

• The width of the FFT on the display is the maximum frequency in the FFT. 
The maximum FFT frequency is also fS/2, where fS is the effective sample 
rate of the decimated data. (Use the center/span or start/stop frequency 
controls to display the maximum FFT frequency.)

• The FFT Resolution is displayed in the FFT menu. FFT resolution is also 
known as the FFT bin width or a line in the frequency domain.

• Therefore, the un-zero-padded decimated record length is: fS x the acquisition 
time (or 2 x max FFT freq x acquisition time).

• Also, the FFT length used after the zero-padding is: 2 x (maximum FFT 
frequency)/(FFT Resolution).
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All this works the same with the precision analysis record, except that, instead of a 
62500 point record length, the record length is user-selectable between 100k 
points and 1M points.

For more information on FFT transformation, see Keysight Application Note 243, 
The Fundamentals of Signal Analysis at 
http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf.

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
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5 Reference Waveforms
To save a waveform to a reference waveform location / 137
To display a reference waveform / 138
To scale and position reference waveforms / 139
To adjust reference waveform skew / 140
To display reference waveform information / 140
To save/recall reference waveform files to/from a USB storage device / 140

Analog channel or math waveforms can be saved to one of four reference 
waveform locations in the oscilloscope. Then, reference waveforms can be 
displayed and compared against other waveforms.

When the multiplexed knobs are assigned to reference waveforms (this happens 
when you press the [Ref] key and the LED to the left of it is lit), you can use the 
knobs to scale and position reference waveforms. There is also a skew adjustment 
for reference waveforms. Reference waveform scale, offset, and skew information 
can optionally be included on the oscilloscope display.

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. You can recall a reference waveform file 
from a USB storage device into one of the reference waveform locations.

To save a waveform to a reference waveform location

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Display Ref softkey and turn the 
Entry knob to select the desired reference waveform location you want to 
display. Then, either push the Entry knob or press the Display Ref softkey again 
to display the selected reference waveform location.
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3 Press the Source softkey and turn the Entry knob to select the source waveform.

4 Press the Save to R1/R2/R3/R4 softkey to save the waveform to the reference 
waveform location.

Reference waveforms are limited to 64K points. If necessary, decimation of the 
source waveform will occur during the save.

To clear a
reference

waveform location

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Ref softkey and turn the Entry knob 
to select the desired reference waveform location.

3 Press the Clear R1/R2/R3/R4 softkey to clear the reference waveform location.

Reference waveforms are also cleared by a Factory Default or Secure Erase (see 
Chapter 22, “Save/Email/Recall (Setups, Screens, Data),” starting on page 365).

To display a reference waveform

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Ref softkey and turn the Entry knob 
to select the desired reference waveform location.

3 Then, press the Ref softkey again to enable/disable the reference waveform 
display.

NOTE Reference waveforms are non-volatile — they remain after power cycling or performing a 
default setup.
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Reference waveforms are always drawn as vectors (that is, lines between 
waveform data points) and may look different than waveforms drawn as dots (if 
that option is available in your oscilloscope).

See Also • "To display reference waveform information" on page 140

To scale and position reference waveforms

1 Make sure the multiplexed scale and position knobs above and below the [Ref] 
key are selected for the reference waveform.

If the arrow to the left of the [Ref] key is not illuminated, press the key.

2 Turn the upper multiplexed knob to adjust the reference waveform scale.

3 Turn the lower multiplexed knob to adjust the reference waveform position.
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To adjust reference waveform skew

Once reference waveforms are displayed, you can adjust their skew.

1 Display the desired reference waveform (see "To display a reference 
waveform" on page 138).

2 Press the Skew softkey and turn the Entry knob to adjust the reference 
waveform skew.

To display reference waveform information

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Options softkey.

3 In the Reference Waveform Options Menu, press the Display Info softkey to 
enable or disable reference waveform information on the oscilloscope display.

To save/recall reference waveform files to/from a USB storage 
device

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. See "To save reference waveform files to a 
USB storage device" on page 372.

You can recall a reference waveform file from a USB storage device into one of the 
reference waveform locations. See "To recall reference waveform files from a USB 
storage device" on page 376.
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6 Digital Channels
To connect the digital probes to the device under test / 141
Acquiring waveforms using the digital channels / 145
To display digital channels using Autoscale / 145
Interpreting the digital waveform display / 146
To switch all digital channels on or off / 148
To switch groups of channels on or off / 148
To switch a single channel on or off / 148
To change the displayed size of the digital channels / 147
To reposition a digital channel / 149
To change the logic threshold for digital channels / 149
To display digital channels as a bus / 150
Digital channel signal fidelity: Probe impedance and grounding / 153

This chapter describes how to use the digital channels of a Mixed-Signal 
Oscilloscope (MSO).

The digital channels are enabled on MSOX6000 X-Series models and 
DSOX6000 X-Series models that have the MSO upgrade license installed.

To connect the digital probes to the device under test

1 If necessary, turn off the power supply to the device under test.

Turning off power to the device under test would only prevent damage that 
might occur if you accidentally short two lines together while connecting 
probes. You can leave the oscilloscope powered on because no voltage appears 
at the probes.
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2 Connect the digital probe cable to the DIGITAL Dn - D0 connector on the 
mixed-signal oscilloscope. The digital probe cable is keyed so you can connect 
it only one way. You do not need to power-off the oscilloscope.

The MSO cable operating temperature range is 0 °C to 55 °C, and its 
non-operating (storage) temperature range is -40 °C to 70 °C.

3 Connect the ground lead on each set of channels (each pod), using a probe 
grabber. The ground lead improves signal fidelity to the oscilloscope, ensuring 
accurate measurements.

Off

CAUTION  Probe cable for digital channels

Use only the Keysight logic probe and accessory kit supplied with the mixed-signal 
oscilloscope.
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4 Connect a grabber to one of the probe leads. (Other probe leads are omitted 
from the figure for clarity.)

5 Connect the grabber to a node in the circuit you want to test.
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6 For high-speed signals, connect a ground lead to the probe lead, connect a 
grabber to the ground lead, and attach the grabber to ground in the device 
under test.

7 Repeat these steps until you have connected all points of interest.
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Acquiring waveforms using the digital channels

When you press [Run/Stop] or [Single] to run the oscilloscope, the oscilloscope 
examines the input voltage at each input probe. When the trigger conditions are 
met the oscilloscope triggers and displays the acquisition.

For digital channels, each time the oscilloscope takes a sample it compares the 
input voltage to the logic threshold. If the voltage is above the threshold, the 
oscilloscope stores a 1 in sample memory; otherwise, it stores a 0.

To display digital channels using Autoscale

When signals are connected to the digital channels — be sure to connect the 
ground leads — Autoscale quickly configures and displays the digital channels.

• To configure the instrument quickly, press the [Auto Scale] key.
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Any digital channel with an active signal will be displayed. Any digital channels 
without active signals will be turned off.

• To undo the effects of Autoscale, press the Undo Autoscale softkey before 
pressing any other key.

This is useful if you have unintentionally pressed the [Auto Scale] key or do not like 
the settings Autoscale has selected. This will return the oscilloscope to its previous 
settings. See also: "How Autoscale Works" on page 39.

To set the instrument to the factory-default configuration, press the [Default Setup] 
key.

Interpreting the digital waveform display

The following figure shows a typical display with digital channels.

Figure 22 Example: Autoscale of digital channels (MSO models only)
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Activity indicator When any digital channels are turned on, an activity indicator is displayed in the 

status line at the bottom of the display. A digital channel can be always high ( ), 

always low ( ), or actively toggling logic states ( ).

To change the displayed size of the digital channels

1 Press the [Digital] key.

Activity
indicators

Delay
time

Time/
div

Trigger
type and
source

Digital
channel
identifiers

Waveform
size

Turn
individual
channels
on/off

Turn
groups of
channels
on/off

Threshold
menu key

Trigger
mode or
run status
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2 Press the size ( ) softkey to select how the digital channels are 
displayed.

The sizing control lets you spread out or compress the digital traces vertically on 
the display for more convenient viewing.

To switch a single channel on or off

1 With the Digital Channel Menu displayed, rotate the Entry knob to select the 
desired channel from the popup menu.

2 Push the Entry knob or press the softkey that is directly below the popup menu 
to switch the selected channel on or off.

To switch all digital channels on or off

1 Press the [Digital] key to toggle the display of digital channels. The Digital 
Channel Menu is displayed above the softkeys.

If you want to switch the digital channels off, and the Digital Channel Menu is not 
already displayed, you must push the [Digital] key twice to switch the digital 
channels off. The first push displays the Digital Channel Menu, and the second 
push switches the channels off.

To switch groups of channels on or off

1 Press the [Digital] key on the front panel if the Digital Channel Menu is not 
already displayed.

2 Press the Turn off (or Turn on) softkey for the D15 - D8 group or the D7 - D0 group.

Each time you press the softkey, the softkey's mode toggles between Turn on and 
Turn off.
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To change the logic threshold for digital channels

1 Press the [Digital] key so that the Digital Channel Menu is displayed.

2 Press the Thresholds softkey

3 Press the D15 - D8 or D7 - D0 softkey, then select a logic family preset or select 
User to define your own threshold.

The threshold you set applies to all channels within the selected D15 - D8 or 
D7 - D0 group. Each of the two channel groups can be set to a different threshold 
if desired.

Values greater than the set threshold are high (1) and values less than the set 
threshold are low (0).

If the Thresholds softkey is set to User, press the User softkey for the channel group, 
then turn the Entry knob to set the logic threshold. There is one User softkey for 
each group of channels.

To reposition a digital channel

1 Make sure the multiplexed scale and position knobs above and below the key 
are selected for digital channels.

If the arrow to the left of the [Digital] key is not illuminated, press the key.

2 Use the multiplexed Select knob to select the channel.

The selected waveform is highlighted in red.

3 Use the multiplexed Position knob to move the selected channel waveform.

Logic family Threshold Voltage

TTL +1.4 V

CMOS +2.5 V

ECL –1.3 V

User Variable from –8 V to +8 V
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If a channel waveform is repositioned over another channel waveform, the 
indicator at the left edge of the trace will change from Dnn designation (where 
nn is a one or two digit channel number) to D*. The "*" indicates that multiple 
channels are overlaid.

To display digital channels as a bus

Digital channels may be grouped and displayed as a bus, with each bus value 
displayed at the bottom of the display in hex or binary. You can create up to two 
buses. To configure and display each bus, press the [Digital] key on the front panel. 
Then press the Bus softkey.

Next, select a bus. Rotate the Entry knob, then press the Entry knob or the 
Bus1/Bus2 softkey to switch it on.

Use the Channel softkey and the Entry knob to select individual channels to be 
included in the bus. You can rotate the Entry knob and push it or push the softkey 
to select channels. You can also press the Select/Deselect D15-D8 and 
Select/Deselect D7-D0 softkeys to include or exclude groups of eight channels in 
each bus.

If the bus display is blank, completely white, or if the display includes "...", you 
need to expand the horizontal scale to allow space for the data to be shown, or 
use the cursors to display the values (see "Using cursors to read bus values" on 
page 151).

The Base softkey lets you choose to display the bus values in hex or binary.

The buses are shown at the bottom of the display.
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Bus values can be shown in hex or binary.

Using cursors to
read bus values

To read the digital bus value at any point using the cursors:

1 Turn on Cursors (by pressing the [Cursors] key on the front panel)

2 Press the cursor Mode softkey and change the mode to Hex or Binary.

3 Press the Source softkey and select Bus1 or Bus2.

4 Use the Entry knob and the X1 and X2 softkeys to position the cursors where 
you want to read the bus values.
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Bus values are
displayed when

using Pattern
trigger

The bus values are also displayed when using the Pattern trigger function. Press 
the [Pattern] key on the front panel to display the Pattern Trigger Menu and the bus 
values will be displayed on the right, above the softkeys.

The dollar sign ($) will be displayed in the bus value when the bus value cannot be 
displayed as a hex value. This occurs when one or more "don't cares" (X) are 
combined with low (0) and high (1) logic levels in the pattern specification, or 

when a transition indicator — rising edge ( ) or falling edge ( ) — are included in 
the pattern specification. A byte that consists of all don't cares (X) will be 
displayed in the bus as a don't care (X).

Bus values
at cursors
shown here

Bus values

Set cursors
mode to
Binary or Hex

Select Bus1
or Bus2 source

X2 cursor

X1 cursor
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See "Pattern Trigger" on page 191 for more information on Pattern triggering.

Digital channel signal fidelity: Probe impedance and grounding

When using the mixed-signal oscilloscope you may encounter problems that are 
related to probing. These problems fall into two categories: probe loading and 
probe grounding. Probe loading problems generally affect the device under test, 
while probe grounding problems affect the accuracy of the data to the 
measurement instrument. The design of the probes minimizes the first problem, 
while the second is easily addressed by good probing practices.

Digital
channel
values
at cursor

Trigger
pattern
definition

Bus values
displayed

Analog
channel
values
at cursor
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Input Impedance

The logic probes are passive probes, which offer high input impedance and high 
bandwidths. They usually provide some attenuation of the signal to the 
oscilloscope, typically 20 dB.

Passive probe input impedance is generally specified in terms of a parallel 
capacitance and resistance. The resistance is the sum of the tip resistor value and 
the input resistance of the test instrument (see the following figure). The 
capacitance is the series combination of the tip compensating capacitor and the 
cable, plus instrument capacitance in parallel with the stray tip capacitance to 
ground. While this results in an input impedance specification that is an accurate 
model for DC and low frequencies, the high-frequency model of the probe input is 
more useful (see the following figure). This high-frequency model takes into 
account pure tip capacitance to ground as well as series tip resistance, and the 
cable's characteristic impedance (Zo).

Figure 23 DC and Low-Frequency Probe Equivalent Circuit
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The impedance plots for the two models are shown in these figures. By comparing 
the two plots, you can see that both the series tip resistor and the cable's 
characteristic impedance extend the input impedance significantly. The stray tip 
capacitance, which is generally small (1 pF), sets the final break point on the 
impedance chart.

Figure 24 High-Frequency Probe Equivalent Circuit
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The logic probes are represented by the high-frequency circuit model shown 
above. They are designed to provide as much series tip resistance as possible. 
Stray tip capacitance to ground is minimized by the proper mechanical design of 
the probe tip assembly. This provides the maximum input impedance at high 
frequencies.

Probe Grounding

A probe ground is the low-impedance path for current to return to the source from 
the probe. Increased length in this path will, at high frequencies, create large 
common mode voltages at the probe input. The voltage generated behaves as if 
this path were an inductor according to the equation:

Figure 25 Impedance versus Frequency for Both Probe Circuit Models
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Increasing the ground inductance (L), increasing the current (di) or decreasing the 
transition time (dt), will all result in increasing the voltage (V). When this voltage 
exceeds the threshold voltage defined in the oscilloscope, a false data 
measurement will occur.

Sharing one probe ground with many probes forces all the current that flows into 
each probe to return through the same common ground inductance of the probe 
whose ground return is used. The result is increased current (di) in the above 
equation, and, depending on the transition time (dt), the common mode voltage 
may increase to a level that causes false data generation.

In addition to the common mode voltage, longer ground returns also degrade the 
pulse fidelity of the probe system. Rise time is increased, and ringing, due to the 
undamped LC circuit at the input of the probe, is also increased. Because the 
digital channels display reconstructed waveforms, they do not show ringing and 
perturbations. You will not find ground problems through examination of the 

Figure 26 Common Mode Input Voltage Model
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waveform display. In fact, it is likely you will discover the problem through random 
glitches or inconsistent data measurements. Use the analog channels to view 
ringing and perturbations.

Best Probing Practices

Because of the variables L, di, and dt, you may be unsure how much margin is 
available in your measurement setup. The following are guidelines for good 
probing practices:

• The ground lead from each digital channel group (D15–D8 and D7–D0) should 
be attached to the ground of the device under test if any channel within the 
group is being used for data capture.

• When capturing data in a noisy environment, every third digital channel probe's 
ground should be used in addition to the channel group's ground.

• High-speed timing measurements (rise time < 3 ns) should make use of each 
digital channel probe's own ground.

When designing a high-speed digital system, you should consider designing 
dedicated test ports that interface directly to the instrument's probe system. This 
will ease measurement setup and ensure a repeatable method for obtaining test 
data. The 01650-61607 16-channel logic probe cable and the 01650-63203 
termination adapter are designed to make it easy to connect to industry-standard, 
20-pin board connectors. The cable is a 2 m logic analyzer probe cable, and the 
termination adapter provides the proper RC networks in a very convenient 
package. These parts, as well as the 1251-8106 20-pin, low-profile, straight board 
connector, can be ordered from Keysight Technologies.
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7 Serial Decode
Serial Decode Options / 159
Lister / 161
Searching Lister Data / 163

Triggering on
Serial Data

In some cases, such as when triggering on a slow serial signal (for example, I2C, 
SPI, CAN, LIN, etc.) it may be necessary to switch from the Auto trigger mode to 
the Normal trigger mode to prevent the oscilloscope from Auto-triggering and 
stabilize the display. You can select the trigger mode by:

• Touching "Auto" or "Trig'd" onscreen to quickly toggle the trigger mode. See 
"Access the Trigger Menu, Change the Trigger Mode, and Open the Trigger 
Level Dialog" on page 62.

• Pressing the [Mode/Coupling] key, then the Mode softkey.

Also, the threshold voltage level must be set appropriately for each source 
channel. The threshold level for each serial signal can be set in the Signals Menu. 
Press the [Serial] key, then the Signals softkey.

Serial Decode Options

Keysight's hardware-accelerated serial decode options can be installed when the 
oscilloscope is manufactured, or added later. The following serial decodes are 
available:
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To determine whether these licenses are installed on your oscilloscope, see "To 
display oscilloscope information" on page 405.

To order serial decode licenses, go to www.keysight.com and search for the 
product number (see "Licensed Options Available" on page 427) or contact your 
local Keysight Technologies representative (see 
www.keysight.com/find/contactus).

Licensed Serial Decode See:

CAN (Controller Area Network) and LIN (Local 
Interconnect Network) serial buses.

• "CAN/CAN FD Serial Decode" on 
page 450.

• "LIN Serial Decode" on page 460.

CXPI (Clock Extension Peripheral Interface) serial 
buses.

• "CXPI Serial Decode" on page 469.

FlexRay serial buses. • "FlexRay Serial Decode" on page 479.

I2C (Inter-IC) and SPI (Serial Peripheral 
Interface) serial buses.

• "I2C Serial Decode" on page 490.

• "SPI Serial Decode" on page 500.

I2S (Inter-IC Sound or Integrated Interchip 
Sound) serial buses.

• "I2S Serial Decode" on page 511.

UART (Universal Asynchronous 
Receiver/Transmitter) protocols including 
RS232 (Recommended Standard 232).

• "UART/RS232/422/485 Serial 
Decode" on page 565.

Manchester and NRZ serial buses. • "Manchester Serial Decode" on 
page 520.

• "NRZ Serial Decode" on page 527.

MIL-STD-1553 and ARINC 429 serial buses. • "MIL-STD-1553 Serial Decode" on 
page 534.

• "ARINC 429 Serial Decode" on page 541.

SENT (Single Edge Nibble Transmission) serial 
buses.

• "SENT Serial Decode" on page 554.

USB Full/Low Speed or USB High Speed serial 
buses.

• "USB 2.0 Serial Decode" on page 575.

USB PD (Power Delivery) serial buses. • "USB PD Serial Decode" on page 584.

http://www.keysight.com/
http://www.keysight.com/find/contactus
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Lister

Lister is a powerful tool for investigating protocol failures. You can use Lister to 
view large amounts of packet level serial data in a tabular format, including time 
tags and specific decoded values. After pressing the [Single] key, you can press the 
Scroll Lister softkey and then rotate the Entry knob to select an event and press the 
Zoom to Selection softkey to jump to the event.

To use the Lister:

1 Set up trigger and decode on the serial data signals to be analyzed.

2 Press [Serial] > Lister.

3 Press Window; then, turn the Entry knob to select the size of the Lister window 
(Half-Screen or Full-Screen).

When the touchscreen is enabled, you can touch the Lister down or up 
chevrons at the top right of the graticule to select the size of the Lister window.

4 Press Display; then, turn the Entry knob to select the serial slot (Serial 1 or 
Serial 2) on which the serial bus signals are being decoded. (If you select All, the 
decode information for different buses is interleaved in time.)
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Before you can select a row or navigate through the Lister data, oscilloscope 
acquisitions must be stopped.

5 Press the [Single] key (in the Run Control group on the front panel) to stop the 
acquisition.

Pressing [Single] instead of [Stop] fills the maximum memory depth.

When zoomed out and viewing a large number of packets, the Lister may not 
be able to display information for all packets. However, when you press the 
[Single] key the Lister will contain all on-screen serial decode information.

6 Press the Scroll Lister softkey and use the Entry knob to scroll through the data.

Time tags in the Time column indicate the event time relative to the trigger 
point by default, and can optionally be configured to be relative to the previous 
row, as described in step 9 that follows. The time tags of events that are shown 
in the waveform display area are displayed with a dark background.

7 Press the Zoom to Selection softkey (or push the Entry knob) to center the 
waveform display at the time associated with the selected Lister row and 
automatically set the horizontal scale setting.
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8 Press the Undo Zoom softkey to return to the horizontal scale and delay settings 
before the last Zoom to Selection.

9 Press the Options softkey to open the Lister Options Menu. In this menu, you 
can:

• Enable or disable the Track Time option. When enabled, as you select 
different Lister rows (using the Entry knob while acquisitions are stopped), 
the horizontal delay changes to the Time of the selected row. Also, changing 
the horizontal delay will scroll the Lister.

• Press the Scroll Lister softkey and use the Entry knob to scroll though data 
rows in the Lister display.

• Press the Time Ref softkey and use the Entry knob to select whether the Time 
column in the Lister display shows times relative to the trigger or relative to 
the previous packet row.

Searching Lister Data

When serial decode is enabled, you can use the [Search] key to find and place 
marks on rows in the Lister.

The Search softkey lets you specify events to find. It is similar to specifying protocol 
triggers.

Events found are marked in orange in the far left Lister column. The total number 
of events found is displayed above the softkeys.
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Each serial decode option lets you find protocol-specific headers, data, errors, etc. 
See:

• "Searching for ARINC 429 Data in the Lister" on page 546

• "Searching for CAN Data in the Lister" on page 455

• "Searching for FlexRay Data in the Lister" on page 483

• "Searching for I2C Data in the Lister" on page 493

• "Searching for I2S Data in the Lister" on page 514

• "Searching for LIN Data in the Lister" on page 464

• "Searching for MIL-STD-1553 Data in the Lister" on page 537

• "Searching for SENT Data in the Lister" on page 559

• "Searching for SPI Data in the Lister" on page 503

• "Searching for UART/RS232/422/485 Data in the Lister" on page 568

• "Searching for USB 2.0 Data in the Lister" on page 579
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8 Display Settings
To adjust waveform intensity / 165
To set or clear persistence / 167
To clear the display / 169
To select the grid type / 169
To adjust the grid intensity / 169
To add an annotation / 170
To display waveforms as vectors or dots / 172
To disable/enable antialiasing / 173
To freeze the display / 174

To adjust waveform intensity

You can adjust the intensity of displayed waveforms to account for various signal 
characteristics, such as fast time/div settings and low trigger rates.

Increasing the intensity lets you see the maximum amount of noise and 
infrequently occurring events.

Reducing the intensity can expose more detail in complex signals as shown in the 
following figures.

1 Press the [Intensity] key to illuminate it.

This key is located just below the Entry knob.

2 Turn the Entry knob to adjust the waveform intensity.

Waveform intensity adjustment affects analog channel waveforms only (not math 
waveforms, reference waveforms, digital waveforms, etc.).
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Figure 27 Amplitude Modulation Shown at 100% Intensity
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To set or clear persistence

With persistence, the oscilloscope updates the display with new acquisitions, but 
does not immediately erase the results of previous acquisitions. All previous 
acquisitions are displayed with reduced intensity. New acquisitions are shown in 
their normal color with normal intensity.

Waveform persistence is kept only for the current display area; you cannot pan 
and zoom the persistence display.

To use persistence:

1 Press the [Display] key; then, press the Persistence softkey.

Figure 28 Amplitude Modulation Shown at 40% Intensity
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2 In the Waveform Persistence Menu, press Persistence; then, turn the Entry knob 
to select between:

• Off — turns off persistence.

When persistence is off, you can press the Capture Waveforms softkey to 
perform a single-shot infinite persistence. A single acquisition's data is 
displayed with reduced intensity, and it remains on the display until you 
clear persistence or clear the display.

Included in the persistence data are active analog channels and digital 
channels.

• ∞ Persistence — (infinite persistence) Results of previous acquisitions are 
never erased.

Use infinite persistence to measure noise and jitter, to see the worst-case 
extremes of varying waveforms, to look for timing violations, or to capture 
events that occur infrequently.

• Variable Persistence — Results of previous acquisitions are erased after a 
certain amount of time.

Variable persistence gives you a view of acquired data that is similar to 
analog oscilloscopes.

When variable persistence is selected, press the Time softkey and use the 
Entry knob to specify the amount of time that previous acquisitions are to be 
displayed.

The display will begin accumulating multiple acquisitions.

3 To erase the results of previous acquisitions from the display, press the Clear 
Persistence softkey.

The oscilloscope will start to accumulate acquisitions again.

4 To return the oscilloscope to the normal display mode, turn off persistence; 
then, press the Clear Persistence softkey.

Turning off persistence does not clear the display. The display is cleared if you 
press the Clear Display softkey or if you press the [Auto Scale] key (which also 
turns off persistence).
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For another method of seeing worst-case extremes of varying waveforms, see 
"Glitch or Narrow Pulse Capture" on page 235.

To clear the display

1 Press [Clear Display] (or press [Display] > Clear Display).

You can also configure the [Quick Action] key to clear the display. See "Configuring 
the [Quick Action] Key" on page 407.

To select the grid type

When the Video trigger type is selected (see "Video Trigger" on page 202), and the 
vertical scaling of at least one displayed channel is 140 mV/div, the Grid softkey 
lets you select from these grid types:

• Full — the normal oscilloscope grid.

• mV — shows vertical grids, labeled on the left, from -0.3 V to 0.8 V.

• IRE — (Institute of Radio Engineers) shows vertical grids in IRE units, labeled on 
the left, from -40 to 100 IRE. The 0.35 V and 0.7 V levels from the mV grid are 
also shown and labeled at the right. When the IRE grid is selected, cursor values 
are also shown in IRE units. (Cursor values via the remote interface are not in 
IRE units.)

The mV and IRE grid values are accurate (and match Y cursor values) when the 
vertical scaling is 140 mV/division and the vertical offset is 245 mV.

To select the grid type:

1 Press the [Display] key; then, press the Grid softkey.

2 In the Grid Menu, press the Grid softkey; then, turn the Entry knob  to select 
the grid type.

To adjust the grid intensity

To adjust the display grid (graticule) intensity:
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1 Press the [Display] key; then, press the Grid softkey.

2 In the Grid Menu, press the Grid Intensity softkey; then, turn the Entry knob  
to change the intensity of the displayed grid.

The intensity level is shown in the Grid Intensity softkey and is adjustable from 0 to 
100%.

Each major vertical division in the grid corresponds to the vertical sensitivity 
shown in the status line at the top of the display.

Each major horizontal division in the grid corresponds to the time/div shown in the 
status line at the top of the display.

To add an annotation

You can add annotations to the oscilloscope's display. Annotations are useful for 
documentation purposes, to add notes before capturing screens.

To add an annotation:

1 On the oscilloscope's front panel, press [Display].

2 In the Display Menu, press Annotations.

3 In the Annotations Menu, press the Display softkey and turn the Entry knob to 
select the desired annotation.

4 Then, press the Display softkey again to enable/disable the annotation display.

When enabled, you can drag the annotation anywhere in the graticule using the 
touchscreen, a USB mouse, or the X1 and Y1 softkeys.

5 Press Edit.

6 In the Edit keypad dialog, you can enter text using:
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• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; then, push 

the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that can be 
touched.

7 When you are done entering text, select the dialog's Enter or OK key or press 
the Edit softkey again.

The annotation text appears in the softkey.

8 Press the Text Color softkey and turn the Entry knob to select the annotation 
color.

You can choose white, red, or colors that match analog channels, digital 
channels, math waveforms, reference waveforms, or markers.
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9 Press the Background softkey and turn the Entry knob to select the annotation 
background:

• Opaque — the annotation has a solid background.

• Inverted — the annotation's foreground and background colors are switched.

• Transparent — the annotation has a transparent background.

See Also • "To save BMP or PNG image files" on page 368

• "To print the oscilloscope's display" on page 379

To display waveforms as vectors or dots

Keysight InfiniiVision 6000 X-Series oscilloscopes are designed to operate 
optimally with vectors (connect the dots) on. This mode produces the most 
insightful waveforms for most situations.
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On the 6 GHz bandwidth model, you can disable vectors to view just waveform 
data points.

To disable or re-enable vectors:

1 Press the [Display] key; then, press the Waveforms softkey.

2 Press Vectors.

When enabled, Vectors draws a line between consecutive waveform data points.

• Vectors give an analog look to a digitized waveform. Complex analog signals 
like video and modulated signals show analog-like intensity information with 
vectors on.

• Vectors allow you to see steep edges on waveforms, such as square waves.

• Vectors allow subtle detail of complex waveforms to be viewed, much like an 
analog oscilloscope trace, even when the detail is just a small number of pixels 
in size.

You may want to turn vectors off when highly complex or multivalued waveforms 
are displayed. Turning vectors off may aid the display of multivalued waveforms 
such as eye diagrams.

Having vectors on does not slow down the display rate.

Digital channels on a mixed-signal oscilloscope are not affected by the Vectors 
setting. They are always displayed with vectors on. They also only contain one 
acquisition worth of information.

To disable/enable antialiasing

At slower sweep speeds, the sample rate is reduced and a proprietary display 
algorithm is used to minimize the likelihood of aliasing.

By default, Antialiasing is enabled. You should leave Antialiasing enabled unless 
there is a specific reason to switch it off.

Anti-aliasing is turned off automatically, even though the Antialiasing softkey 
appears to be enabled, when FFTs are on, when the Envelope or Differentiate math 
functions are on, or when Jitter analysis is turned on.

If you need to switch Antialiasing off, press [Display] > Waveforms and press the 
Antialiasing softkey to switch the feature off. The displayed waveforms will be more 
susceptible to aliasing.



174 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

8 Display Settings
 

To freeze the display

To freeze the display without stopping running acquisitions, you must configure 
the [Quick Action] key. See "Configuring the [Quick Action] Key" on page 407.

1 Once the [Quick Action] key has been configured, press it to freeze the display.

2 To un-freeze the display, press [Quick Action] again.

Manual cursors can be used on the frozen display.

Many activities, such as adjusting the trigger level, adjusting vertical or horizontal 
settings, or saving data will un-freeze the display.
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To turn the label display on or off / 175
To assign a predefined label to a channel / 176
To define a new label / 177
To load a list of labels from a text file you create / 178
To reset the label library to the factory default / 179

You can define labels and assign them to each analog input channel, or you can 
turn labels off to increase the waveform display area. Labels can also be applied to 
digital channels on MSO models.

To turn the label display on or off

1 Press the [Label] key on the front panel.

This turns on labels for the displayed analog and digital channels. Labels are 
displayed at the left edge of the displayed traces.

The Offset softkey lets you adjust the vertical Y position of the label with respect 
to the reference level.

The figure below shows an example of displayed labels.
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2 To turn the labels off, press the [Label] key again.

To assign a predefined label to a channel

1 Press the [Label] key.

2 Press the Channel softkey, then turn the Entry knob or successively press the 
Channel softkey to select a channel for label assignment.
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The figure above shows the list of channels and their default labels. The 
channel does not have to be turned on to have a label assigned to it.

3 Press the Library softkey, then turn the Entry knob or successively press the 
Library softkey to select a predefined label from the library.

4 Press the Apply New Label softkey to assign the label to your selected channel.

5 Repeat the above procedure for each predefined label you want to assign to a 
channel.

To define a new label

1 Press the [Label] key.

2 Press the Channel softkey; then, turn the Entry knob or successively press the 
softkey to select a channel for label assignment.

The channel does not have to be turned on to have a label assigned to it. If the 
channel is turned on, its current label will be highlighted.
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3 Press the New Label softkey.

4 In the New Label keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; then, push 

the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that can be 
touched.

5 When you are done entering text, select the dialog's Enter or OK key or press 
the New Label softkey again.

The new label appears in the softkey.

6 Press the Apply New Label softkey to assign the new label to the selected 
channel and to save the new label to the Library.

When you define a new label, it is added to the nonvolatile label list.

Label Assignment
Auto-Increment

When you assign a label ending in a digit, such as ADDR0 or DATA0, the 
oscilloscope automatically increments the digit and displays the modified label in 
the "New label" field after you press the Apply New Label softkey. Therefore, you 
only need to select a new channel and press the Apply New Label softkey again to 
assign the label to the channel. Only the original label is saved in the label list. This 
feature makes it easier to assign successive labels to numbered control lines and 
data bus lines.

To load a list of labels from a text file you create

It may be convenient to create a list of labels using a text editor, then load the 
label list into the oscilloscope. The list can have up to 75 labels. When loaded, 
labels are added to the beginning of the oscilloscope's list. If more than 75 labels 
are loaded, only the first 75 are stored.

To load labels from a text file into the oscilloscope:

1 Use a text editor to create each label. Each label can be up to 32 characters in 
length. Separate each label with a line feed.

2 Name the file labellist.txt and save it on a USB mass storage device such as a 
thumb drive.
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3 Load the list into the oscilloscope using the File Explorer (press [Utility] > File 
Explorer).

To reset the label library to the factory default

1 Press [Utility] > Options > Preferences.

2 Press the Reset Library softkey.

This will delete all user-defined labels from the library and set the labels in the 
library back to the factory default. However, this does not default the labels 
currently assigned to the channels (those labels that appear in the waveform 
area).

NOTE Label List Management

When you press the Library softkey, you will see a list of the last 75 labels used. The list does 
not save duplicate labels. Labels can end in any number of trailing digits. As long as the base 
string is the same as an existing label in the library, the new label will not be put in the library. 
For example, if label A0 is in the library and you make a new label called A12345, the new 
label is not added to the library.

When you save a new user-defined label, the new label will replace the oldest label in the list. 
Oldest is defined as the longest time since the label was last assigned to a channel. Any time 
you assign any label to a channel, that label will move to the newest in the list. Thus, after you 
use the label list for a while, your labels will predominate, making it easier to customize the 
instrument display for your needs.

When you reset the label library list (see next topic), all of your custom labels will be deleted, 
and the label list will be returned to its factory configuration.

NOTE Pressing the Reset Library softkey will remove all user-defined labels from the library and set 
the labels back to the factory default. Once deleted, these user-defined labels cannot be 
recovered.

NOTE Defaulting labels without erasing the default library

Pressing [Default Setup] sets all channel labels back to the default labels but does not erase 
the list of user-defined labels in the library.



180 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

9 Labels
 



181

Keysight InfiniiVision 6000 X-Series Oscilloscopes 
User's Guide

 

10 Triggers
Adjusting the Trigger Level / 182
Forcing a Trigger / 183
Edge Trigger / 184
Edge then Edge Trigger / 186
Pulse Width Trigger / 188
Pattern Trigger / 191
OR Trigger / 194
Rise/Fall Time Trigger / 195
Nth Edge Burst Trigger / 197
Runt Trigger / 198
Setup and Hold Trigger / 201
Video Trigger / 202
Serial Trigger / 215
Zone Qualified Trigger / 216

A trigger setup tells the oscilloscope when to acquire and display data. For 
example, you can set up to trigger on the rising edge of the analog channel 1 input 
signal.

You can adjust the vertical level used for analog channel edge detection by 
turning the Trigger Level knob.

In addition to the edge trigger type, you can also set up triggers on rise/fall times, 
Nth edge bursts, patterns, pulse widths, runt pulses, setup and hold violations, TV 
signals, and serial signals (if option licenses are installed).

You can use any input channel or the "External Trigger Input" on page 225 BNC as 
the source for most trigger types.
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Changes to the trigger setup are applied immediately. If the oscilloscope is 
stopped when you change a trigger setup, the oscilloscope uses the new 
specification when you press [Run/Stop] or [Single]. If the oscilloscope is running 
when you change a trigger setup, it uses the new trigger definition when it starts 
the next acquisition.

You can use the [Force Trigger] key to acquire and display data when triggers are 
not occurring.

You can use the [Mode/Coupling] key to set options that affect all trigger types (see 
Chapter 11, “Trigger Mode/Coupling,” starting on page 219).

You can save trigger setups along with the oscilloscope setup (see Chapter 22, 
“Save/Email/Recall (Setups, Screens, Data),” starting on page 365).

Triggers - General
Information

A triggered waveform is one in which the oscilloscope begins tracing (displaying) 
the waveform, from the left side of the display to the right, each time a particular 
trigger condition is met. This provides stable display of periodic signals such as 
sine waves and square waves, as well as nonperiodic signals such as serial data 
streams.

The figure below shows the conceptual representation of acquisition memory. You 
can think of the trigger event as dividing acquisition memory into a pre-trigger 
and post-trigger buffer. The position of the trigger event in acquisition memory is 
defined by the time reference point and the delay (horizontal position) setting (see 
"To adjust the horizontal delay (position)" on page 71).

Adjusting the Trigger Level

You can adjust the trigger level for a selected analog channel by turning the 
Trigger Level knob.

Pre-Trigger Buffer Post-Trigger Buffer

Acquisition Memory

Trigger Event
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You can also adjust the trigger level using the touchscreen. See "Access the 
Trigger Menu, Change the Trigger Mode, and Open the Trigger Level Dialog" on 
page 62.

You can push the Trigger Level knob to set the level of all displayed analog 
channels to the waveform's 50% value. If AC coupling is used, pushing the Trigger 
Level knob sets the trigger level to about 0 V.

When High and Low (dual) trigger levels are used (as with the Rise/Fall Time and 
Runt triggers, for example), pushing the Level knob toggles between high and low 
level adjustment.

The position of the trigger level for the analog channel is indicated by the trigger 
level icon  (if the analog channel is on) at the far left side of the display. The 
value of the analog channel trigger level is displayed in the upper-right corner of 
the display.

The trigger level for a selected digital channel is set using the threshold menu in 
the Digital Channel Menu. Press the [Digital] key on the front panel, then press the 
Thresholds softkey to set the threshold level (TTL, CMOS, ECL, or user defined) for 
the selected digital channel group. The threshold value is displayed in the 
upper-right corner of the display.

The line trigger level is not adjustable. This trigger is synchronized with the power 
line supplied to the oscilloscope.

Forcing a Trigger

The [Force Trigger] key causes a trigger (on anything) and displays the acquisition.

This key is useful in the Normal trigger mode where acquisitions are made only 
when the trigger condition is met. In this mode, if no triggers are occurring (that is, 
the "Trig'd?" indicator is displayed), you can press [Force Trigger] to force a trigger 
and see what the input signals look like.

In the Auto trigger mode, when the trigger condition is not met, triggers are forced 
and the "Auto?" indicator is displayed.

T

NOTE You can also change the trigger level of all channels by pressing [Analyze] > Features and 
then selecting Trigger Levels.
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Edge Trigger

The Edge trigger type identifies a trigger by looking for a specified edge (slope) 
and voltage level on a waveform. You can define the trigger source and slope in 
this menu. The trigger type, source, and level are displayed in the upper-right 
corner of the display.

1 On the front panel, in the Trigger section, press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob to select 
Edge.

3 Select the trigger source:

• Analog channel, 1 to the number of channels

• Digital channel (on mixed-signal oscilloscopes), D0 to the number of digital 
channels minus one.

• External — triggers on the EXT TRIG IN signal.

• Line — triggers at the 50% level of the rising or falling edge of the AC power 
source signal.

• WaveGen 1/2 — triggers at the 50% level of the rising edge of the waveform 
generator output signal. (Not available when the DC, Noise, or Cardiac 
waveforms are selected.)

• WaveGen Mod (FSK/FM) — when waveform generator FSK or FM modulation is 
used, triggers at the 50% level of the rising edge of the modulating signal.

You can choose a channel that is turned off (not displayed) as the source for the 
edge trigger.

The selected trigger source is indicated in the upper-right corner of the display 
next to the slope symbol:

• 1 through 4 = analog channels.

• D0 through Dn = digital channels.

• E = External trigger input.

• L = Line trigger.

• W = Waveform generator.

4 Press the Slope softkey and select rising edge, falling edge, alternating edges, 
or either edge (depending on the selected source). The selected slope is 
displayed in the upper-right corner of the display.
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Using Autoscale to

Set Up Edge
Triggers

The easiest way to set up an Edge trigger on a waveform is to use Autoscale. 
Simply press the [Auto Scale] key and the oscilloscope will attempt to trigger on the 
waveform using a simple Edge trigger type. See "Use Autoscale" on page 38.

NOTE Alternating edge mode is useful when you want to trigger on both edges of a clock (for 
example, DDR signals).

Either edge mode is useful when you want to trigger on any activity of a selected source.

All modes operate up to the bandwidth of the oscilloscope except Either edge mode, which 
has a limitation. Either edge mode will trigger on Constant Wave signals up to 100 MHz, but 
can trigger on isolated pulses down to 1/(2*oscilloscope's bandwidth).
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Edge then Edge Trigger

The Edge then Edge trigger mode triggers when the Nth edge occurs after an 
arming edge and a delay period.

The arm and trigger edges can be specified as  (Rising) or  (Falling) edges on 
analog or digital channels.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Edge then Edge.

NOTE MegaZoom Technology Simplifies Triggering

With the built-in MegaZoom technology, you can simply Autoscale the waveforms, then stop 
the oscilloscope to capture a waveform. You can then pan and zoom through the data using 
the Horizontal and Vertical knobs to find a stable trigger point. Autoscale often produces a 
triggered display.



Triggers 10

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 187

 

3 Press the Sources softkey.

4 In the Edge then edge Sources Menu:

a Press the Arm A softkey, and turn the Entry knob to select the channel on 
which the arming edge will occur.

b Press the Slope A softkey to specify which edge of the Arm A signal will arm 
the oscilloscope.

c Press the Trigger B softkey, and turn the Entry knob to select the channel on 
which the trigger edge will occur.

d Press the Slope B softkey to specify which edge of the Trigger B signal will 
trigger the oscilloscope.
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Adjust the trigger level for the selected analog channel by turning the Trigger 
Level knob. Press the [Digital] key and select Thresholds to set the threshold level 
for digital channels. The value of the trigger level or digital threshold is 
displayed in the upper-right corner of the display.

5 Press the Back/Up key to return to the Trigger Menu.

6 Press the Delay softkey; then, turn the Entry knob to enter the delay time 
between the Arm A edge and the Trigger B edge.

7 Press the Nth Edge B softkey; then, turn the Entry knob to select the Nth edge of 
the Trigger B signal to trigger on.

Pulse Width Trigger

Pulse Width (glitch) triggering sets the oscilloscope to trigger on a positive or 
negative pulse of a specified width. If you want to trigger on a specific timeout 
value, use Pattern trigger in the Trigger Menu (see "Pattern Trigger" on page 191).

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Pulse Width.

Back
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3 Press the Source softkey; then, rotate the Entry knob to select a channel source 
for the trigger.

The channel you select is shown in the upper-right corner of the display next to 
the polarity symbol.

The source can be any analog or digital channel available on your oscilloscope.

4 Adjust the trigger level:

• For analog channels, turn the Trigger Level knob.

• For digital channels, press the [Digital] key and select Thresholds to set the 
threshold level.

The value of the trigger level or digital threshold is displayed in the upper-right 
corner of the display.

5 Press the pulse polarity softkey to select positive ( ) or negative ( ) polarity 
for the pulse width you want to capture.
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The selected pulse polarity is displayed in the upper-right corner of the display. 
A positive pulse is higher than the current trigger level or threshold and a 
negative pulse is lower than the current trigger level or threshold.

When triggering on a positive pulse, the trigger will occur on the high to low 
transition of the pulse if the qualifying condition is true. When triggering on a 
negative pulse, the trigger will occur on the low to high transition of the pulse if 
the qualifying condition is true.

6 Press the qualifier softkey (< > ><) to select the time qualifier.

The Qualifier softkey can set the oscilloscope to trigger on a pulse width that is:

• Less than a time value (<).

For example, for a positive pulse, if you set t<10 ns:

• Greater than a time value (>).

For example, for a positive pulse, if you set t>10 ns:

• Within a range of time values (><).

For example, for a positive pulse, if you set t>10 ns and t<15 ns:

7 Select the qualifier time set softkey (< or >), then rotate the Entry knob to set 
the pulse width qualifier time.

The qualifiers can be set as follows:

• 2 ns to 10 s for > or < qualifier.

• 10 ns to 10 s for >< qualifier, with minimum difference of 5 ns between upper 
and lower settings.

10 ns 10 ns Trigger

10 ns 10 ns Trigger

10 ns 15 ns Trigger12 ns
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Pulse width
trigger < qualifier

time set softkey

• When the less than (<) qualifier is selected, the Entry knob sets the oscilloscope 
to trigger on a pulse width less than the time value displayed on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the upper 
time range value.

Pulse width
trigger > qualifier

time set softkey

• When the greater than (>) qualifier is selected, the Entry knob sets the 
oscilloscope to trigger on a pulse width greater than the time value displayed 
on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the lower 
time range value.

Pattern Trigger

The Pattern trigger identifies a trigger condition by looking for a specified pattern. 
This pattern is a logical AND combination of the channels. Each channel can have 
a value of 0 (low), 1 (high), or don't care (X). A rising or falling edge can be 
specified for one channel included in the pattern.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Pattern.

3 Press the Qualifier softkey; then, turn the Entry knob to select from the pattern 
duration qualifier options:

• Entered – when the pattern is entered.

• < (Less Than) – when the pattern is present for less than a time value.

• > (Greater Than) – when the pattern is present for greater than a time value. 
The trigger occurs when the pattern exits (not when the > softkey time value 
is exceeded).

• Timeout – when the pattern is present for greater than a time value. In this 
case, the trigger occurs when the > softkey time value is exceeded (not when 
the pattern exits).

• >< (In Range) – when the pattern is present for a time within a range of values.

• <> (Out of Range) – when the pattern is present for a time outside of range of 
values.
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Pattern durations are evaluated using a timer. The timer starts on the last edge 
that makes the pattern (logical AND) true. Except when the Timeout qualifier is 
selected, the trigger occurs on the first edge that makes the pattern false, 
provided the time qualifier criteria has been met.

The time values for the selected qualifier are set using the qualifier time set 
softkeys (< and >) and the Entry knob.

4 To set the analog or digital channel patterns, press the Analog softkey or the 
Digital softkey and use the binary keypad dialog to enter:

• 0 sets the pattern to zero (low) on the selected channel. A low is a voltage 
level that is less than the channel's trigger level or threshold level.

• 1 sets the pattern to 1 (high) on the selected channel. A high is a voltage 
level that is greater than the channel's trigger level or threshold level.

• X sets the pattern to don't care on the selected channel. Any channel set to 
don't care is ignored and is not used as part of the pattern. However, if all 
channels in the pattern are set to don't care, the oscilloscope will not trigger.
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• The rising edge ( ) or falling edge ( ) softkey sets the pattern to an edge 
on the selected channel. Only one rising or falling edge can be specified in 
the pattern. When an edge is specified, the oscilloscope will trigger at the 
edge specified if the pattern set for the other channels is true.

If no edge is specified, the oscilloscope will trigger on the last edge that 
makes the pattern true.

You can also specify patterns for digital channels using the Bus1 and Bus2 
softkeys and entering hexadecimal values. See "Hex Bus Pattern Trigger" on 
page 193.

The specified pattern is shown in the "Pattern =" line directly above the 
softkeys.

5 Adjust the trigger levels for analog and digital channels by using the softkeys in 
the Analyze Menu after pressing [Analyze] > Features and selecting Trigger Levels.

You can also set the threshold levels for digital channels by pressing [Digital] > 
Thresholds.

Hex Bus Pattern Trigger

You can specify a bus value on which to trigger. To do this, first define the bus. See 
"To display digital channels as a bus" on page 150 for details. You can trigger on 
a bus value whether you are displaying the bus or not.

To trigger on a bus value:

1 Select the pattern trigger type and qualifier as described in "Pattern 
Trigger" on page 191.

2 Press the Bus1 or Bus2 softkey and use the hex keypad dialog to enter nibble 
(hex character) values.

NOTE Specifying an Edge in a Pattern

You are allowed to specify only one rising or falling edge term in the pattern. If you define an 
edge term, then select a different channel in the pattern and define another edge term, the 
previous edge definition is changed to a don't care.
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When a hex bus digit contains one or more don't care (X) bits and one or more bits 
with a value or 0 or 1, the "$" sign will be displayed for the digit.

For information regarding digital bus display when Pattern triggering see "Bus 
values are displayed when using Pattern trigger" on page 152.

OR Trigger

The OR trigger mode triggers when any one (or more) of the specified edges on 
analog or digital channels is found.

1 On the front panel, in the Trigger section, press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob to select 
OR.

3 Press the Slope softkey and select rising edge, falling edge, either edge, or don't 
care. The selected slope is displayed in the upper-right corner of the display.

4 For each analog or digital channel you want to include in the OR trigger, press 
the Channel softkey to select the channel.

As you press the Channel softkey (or rotate the Entry knob), the channel you 
select is highlighted in the OR = line directly above the softkeys and in the 
upper-right corner of the display next to the OR gate symbol.

Adjust the trigger level for the selected analog channel by turning the Trigger 
Level knob. Press the [Digital] key and select Thresholds to set the threshold level 
for digital channels. The value of the trigger level or digital threshold is 
displayed in the upper-right corner of the display.

5 For each channel you select, press the Slope softkey and select  (Rising),  

(Falling),  (Either), or X (Don't Care). The selected slope is displayed above the 
softkeys.

NOTE If a digit is made up of less than four bits, the value of the digit is limited to the greatest 
number that can be represented by the number of bits.
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If all channels in the OR trigger are set to don't care, the oscilloscope will not 
trigger.

6 To set all analog and digital channels to the edge selected by the Slope softkey, 
press the Set all Edges softkey.

Rise/Fall Time Trigger

The Rise/Fall Time trigger looks for a rising or falling transition from one level to 
another level in greater than or less than a certain amount of time.
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1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Rise/Fall Time.

3 Press the Source softkey, and turn the Entry knob to select the input channel 
source.

4 Press the Rising Edge or Falling Edge softkey to toggle between edge types.

High level

Low level

Rising edge time Falling edge time
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5 Press the Level Select softkey to select High; then, turn the Trigger Level knob to 
adjust the high level.

6 Press the Level Select softkey to select Low; then, turn the Trigger Level knob to 
adjust the low level.

You can also push the Trigger Level knob to toggle between High and Low 
selection.

7 Press the Qualifier softkey to toggle between "greater than" or "less than".

8 Press the Time softkey, and turn the Entry knob to select the time.

Nth Edge Burst Trigger

The Nth Edge Burst trigger lets you trigger on the Nth edge of a burst that occurs 
after an idle time.

Nth Edge Burst trigger set up consists of selecting the source, the slope of the 
edge, the idle time, and the number of the edge:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Nth Edge Burst.
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3 Press the Source softkey, and turn the Entry knob to select the input channel 
source.

4 Press the Slope softkey to specify the slope of the edge.

5 Press the Idle softkey; then, turn the Entry knob to specify the idle time.

6 Press the Edge softkey; then, turn the Entry knob to which edge number to 
trigger on.

Runt Trigger

The Runt trigger looks for pulses that cross one threshold but not another.
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• A positive runt pulse crosses through a lower threshold but not an upper 
threshold.

• A negative runt pulse crosses through an upper threshold but not a lower 
threshold.

To trigger on runt pulses:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Runt.

High level

Low level

Positive runt pulse Negative runt pulse
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3 Press the Source softkey, and turn the Entry knob to select the input channel 
source.

4 Press the Positive, Negative, or Either Runt Pulse softkey to toggle between pulse 
types.

5 Press the Level Select softkey to select High; then, turn the Trigger Level knob to 
adjust the high level.

6 Press the Level Select softkey to select Low; then, turn the Trigger Level knob to 
adjust the low level.

You can also push the Trigger Level knob to toggle between High and Low 
selection.

7 Press the Qualifier softkey to toggle between "less than", "greater than", or 
None.

This lets you specify that a runt pulse be less than or greater than a certain 
width.

8 If you selected the "less than" or "greater than" Qualifier, press the Time softkey; 
then, turn the Entry knob to select the time.
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Setup and Hold Trigger

The Setup and Hold trigger looks for setup and hold violations.

One oscilloscope channel probes the clock signal and another channel probes the 
data signal.

To trigger on setup and hold violations:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Setup and Hold.

3 Press the Clock softkey; then, turn the Entry knob to select the input channel 
with the clock signal.

4 Set the appropriate trigger level for the clock signal using the Trigger Level 
knob.

5 Press the Rising Edge or Falling Edge softkey to specify the clock edge being used.

6 Press the Data softkey; then, turn the Entry knob to select the input channel 
with the data signal.

7 Set the appropriate trigger level for the data signal using the Trigger Level 
knob.

8 Press the < Setup softkey, and turn the Entry knob to select the setup time.

Data

Clock
(rising
edge)

Setup time Hold time
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9 Press the < Hold softkey, and turn the Entry knob to select the hold time.

Video Trigger

Video triggering can be used to capture the complicated waveforms of most 
standard analog video signals. The trigger circuitry detects the vertical and 
horizontal interval of the waveform and produces triggers based on the video 
trigger settings you have selected.

The oscilloscope's MegaZoom IV technology gives you bright, easily viewed 
displays of any part of the video waveform. Analysis of video waveforms is 
simplified by the oscilloscope's ability to trigger on any selected line of the video 
signal.

NOTE It is important, when using a 10:1 passive probe, that the probe is correctly compensated. The 
oscilloscope is sensitive to this and will not trigger if the probe is not properly compensated, 
especially for progressive formats.
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1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Source softkey and select any analog channel as the video trigger 
source.

The selected trigger source is displayed in the upper-right corner of the display. 
Turning the Trigger Level knob does not change the trigger level because the 
trigger level is automatically set to the sync pulse. Trigger coupling is 
automatically set to TV in the Trigger Mode and Coupling Menu.

NOTE Provide Correct Matching

Many video signals are produced from 75 Ω sources. To provide correct matching to these 
sources, a 75 Ω terminator (such as a Keysight 11094B) should be connected to the 
oscilloscope input.
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4 Press the sync polarity softkey to set the Video trigger to either positive ( ) or 

negative ( ) sync polarity.

5 Press the Settings softkey.

6 In the Video Trigger Menu, press the Standard softkey to set the video standard.

The oscilloscope supports triggering on the following television (TV) and video 
standards.

With the extended video triggering license, the oscilloscope additionally 
supports these standards:

Standard Type Sync Pulse

NTSC Interlaced Bi-level

PAL Interlaced Bi-level

PAL-M Interlaced Bi-level

SECAM Interlaced Bi-level
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The Generic selection lets you trigger on custom bi-level and tri-level sync video 
standards. See "To set up Generic video triggers" on page 207.

7 Press the Auto Setup softkey to automatically set up the oscilloscope for the 
selected Source and Standard:

• Source channel vertical scaling is set to 140 mV/div.

• Source channel offset is set to 245 mV.

• Source channel is turned on.

• Trigger type is set to Video.

• Video trigger mode is set to All Lines (but left unchanged if Standard is 
Generic).

• Display Grid type is set to IRE (when Standard is NTSC) or mV (see "To select 
the grid type" on page 169).

• Horizontal time/division is set to 10 µs/div for NTSC/PAL/SECAM standards 
or 4 µs/div for EDTV or HDTV standards (unchanged for Generic).

• Horizontal delay is set so that trigger is at first horizontal division from the 
left (unchanged for Generic).

Standard Type Sync Pulse

Generic Interlaced/Progressive Bi-level/Tri-level

EDTV 480p/60 Progressive Bi-level

EDTV 567p/50 Progressive Bi-level

HDTV 720p/50 Progressive Tri-level

HDTV 720p/60 Progressive Tri-level

HDTV 1080p/24 Progressive Tri-level

HDTV 1080p/25 Progressive Tri-level

HDTV 1080p/30 Progressive Tri-level

HDTV 1080p/50 Progressive Tri-level

HDTV 1080p/60 Progressive Tri-level

HDTV 1080i/50 Interlaced Tri-level

HDTV 1080i/60 Interlaced Tri-level
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You can also press [Analyze] > Features and then select Video to quickly access 
the video triggering automatic set up and display options.

8 Press the Mode softkey to select the portion of the video signal that you would 
like to trigger on.

The Video trigger modes available are:

• Field1 and Field2 — Trigger on the rising edge of the first serration pulse of 
field 1 or field 2 (interlaced standards only).

• All Fields — Trigger on the rising edge of the first pulse in the vertical sync 
interval.

• All Lines — Trigger on all horizontal sync pulses.

• Line — Trigger on the selected line number (EDTV and HDTV standards only).

• Line: Field1 and Line:Field2 — Trigger on the selected line # in field 1 or field 2 
(interlaced standards only).

• Line: Alternate — Alternately trigger on the selected line # in field 1 and field 2 
(NTSC, PAL, PAL-M, and SECAM only).

9 If you select a line # mode, press the Line # softkey, then rotate the Entry knob 
to select the line number on which you want to trigger.

The following table lists the line (or count) numbers per field for each video 
standard.

The following table lists the line numbers for each EDTV/HDTV video standard 
(available with the extended video triggering license).

Video standard Field 1 Field 2 Alt Field

NTSC 1 to 263 1 to 262 1 to 262

PAL 1 to 313 314 to 625 1 to 312

PAL-M 1 to 263 264 to 525 1 to 262

SECAM 1 to 313 314 to 625 1 to 312
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Video Triggering
Examples

The following are exercises to familiarize you with video triggering. These exercises 
use the NTSC video standard.

• "To trigger on a specific line of video" on page 208

• "To trigger on all sync pulses" on page 209

• "To trigger on a specific field of the video signal" on page 210

• "To trigger on all fields of the video signal" on page 211

• "To trigger on odd or even fields" on page 212

To set up Generic video triggers

When Generic (available with the extended video triggering license) is selected as 
the Video trigger Standard, you can trigger on custom bi-level and tri-level sync 
video standards. The Video Trigger Menu changes as follows.

1 Press the Time > softkey; then, turn the Entry knob to set the time to 
greater-than the sync-pulse width so that the oscilloscope synchronizes to the 
vertical sync.

2 Press the Edge # softkey; then, turn the Entry knob to select the Nth edge after 
after vertical sync to trigger on.

3 To enable or disable the horizontal sync control, press the first Horiz Sync 
softkey.

EDTV 480p/60 1 to 525

EDTV 567p/50 1 to 625

HDTV 720p/50, 720p/60 1 to 750

HDTV 1080p/24, 1080p/25, 1080p/30, 
1080p/50, 1080p/60

1 to 1125

HDTV 1080i/50, 1080i/60 1 to 1125
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• For interleaved video, enabling the Horiz Sync control and setting the 
Horiz Sync adjustment to the sync time of the probed video signal allows the 
Edge # function to count only lines and not double count during equalization. 
Additionally, the Field Holdoff can be adjusted so that the oscilloscope 
triggers once per frame.

• Similarly, for progressive video with a tri-level sync, enabling the Horiz Sync 
control and setting the Horiz Sync adjustment to the sync time of the probed 
video signal allows the Edge # function to count only lines and not double 
count during vertical sync.

When the horizontal sync control is enabled, press the second Horiz Sync 
softkey; then, turn the Entry knob to set the minimum time the horizontal sync 
pulse must be present to be considered valid.

To trigger on a specific line of video

Video triggering requires greater than 1/2 division of sync amplitude with any 
analog channel as the trigger source. Turning the trigger Level knob in Video 
trigger does not change the trigger level because the trigger level is automatically 
set to the sync pulse tips.

One example of triggering on a specific line of video is looking at the vertical 
interval test signals (VITS), which are typically in line 18. Another example is 
closed captioning, which is typically in line 21.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard (NTSC).

4 Press the Mode softkey and select the TV field of the line you want to trigger on. 
You can choose Line:Field1, Line:Field2, or Line:Alternate.

5 Press the Line # softkey and select the number of the line you want to examine.

NOTE Alternate Triggering

If Line:Alternate is selected, the oscilloscope will alternately trigger on the selected line 
number in Field 1 and Field 2. This is a quick way to compare the Field 1 VITS and Field 2 VITS 
or to check for the correct insertion of the half line at the end of Field 1.
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To trigger on all sync pulses

To quickly find maximum video levels, you could trigger on all sync pulses. When 
All Lines is selected as the Video trigger mode, the oscilloscope will trigger on all 
horizontal sync pulses.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select All Lines.

Figure 29 Example: Triggering on Line 136
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To trigger on a specific field of the video signal

To examine the components of a video signal, trigger on either Field 1 or Field 2 
(available for interleaved standards). When a specific field is selected, the 
oscilloscope triggers on the rising edge of the first serration pulse in the vertical 
sync interval in the specified field (1 or 2).

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select Field1 or Field2.

Figure 30 Triggering on All Lines
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To trigger on all fields of the video signal

To quickly and easily view transitions between fields, or to find the amplitude 
differences between the fields, use the All Fields trigger mode.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select All Fields.

Figure 31 Triggering on Field 1
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To trigger on odd or even fields

To check the envelope of your video signals, or to measure worst case distortion, 
trigger on the odd or even fields. When Field 1 is selected, the oscilloscope 
triggers on color fields 1 or 3. When Field 2 is selected, the oscilloscope triggers 
on color fields 2 or 4.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select Field1 or Field2.

Figure 32 Triggering on All Fields
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The trigger circuits look for the position of the start of Vertical Sync to determine 
the field. But this definition of field does not take into consideration the phase of 
the reference subcarrier. When Field 1 is selected, the trigger system will find any 
field where the vertical sync starts on Line 4. In the case of NTSC video, the 
oscilloscope will trigger on color field 1 alternating with color field 3 (see the 
following figure). This setup can be used to measure the envelope of the reference 
burst.

If a more detailed analysis is required, then only one color field should be selected 
to be the trigger. You can do this by using the Field Holdoff softkey in the Video 
Trigger Menu. Press the Field Holdoff softkey and use the Entry knob to adjust the 
holdoff in half-field increments until the oscilloscope triggers on only one phase of 
the color burst.

A quick way to synchronize to the other phase is to briefly disconnect the signal 
and then reconnect it. Repeat until the correct phase is displayed.

Figure 33 Triggering on Color Field 1 Alternating with Color Field 3



214 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

10 Triggers
 

When holdoff is adjusted using the Field Holdoff softkey and the Entry knob, the 
corresponding holdoff time will be displayed in the Trigger Mode and Coupling 
Menu.

Table 3 Half-field holdoff time

Standard Time

NTSC 8.35 ms

PAL 10 ms

PAL-M 10 ms

SECAM 10 ms

Generic 8.35 ms

EDTV 480p/60 8.35 ms

EDTV 567p/50 10 ms

HDTV 720p/50 10 ms

HDTV 720p/60 8.35 ms

HDTV 1080p/24 20.835 ms

HDTV 1080p/25 20 ms

HDTV 1080p/30 20 ms

HDTV 1080p/50 16.67 ms

HDTV 1080p/60 8.36 ms

HDTV 1080i/50 10 ms

HDTV 1080i/60 8.35 ms



Triggers 10

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 215

 

Serial Trigger

With serial decode option licenses (see "Serial Decode Options" on page 159), 
you can enable serial trigger types. To set up these triggers, see:

• "ARINC 429 Triggering" on page 539

• "CAN/CAN FD Triggering" on page 447

• "CXPI Triggering" on page 466

• "FlexRay Triggering" on page 476

• "I2C Triggering" on page 486

• "I2S Triggering" on page 508

• "LIN Triggering" on page 458

• "Manchester Triggering" on page 518

Figure 34 Using Field Holdoff to Synchronize to Color Field 1 or 3 (Field 1 mode)
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• "MIL-STD-1553 Triggering" on page 533

• "NRZ Triggering" on page 526

• "SENT Triggering" on page 552

• "SPI Triggering" on page 498

• "UART/RS232/422/485 Triggering" on page 563

• "USB 2.0 Triggering" on page 573

• "USB PD Triggering" on page 582

Zone Qualified Trigger

The zone qualified trigger feature gives you one or two rectangular areas, Zone 1 
and Zone 2, that a waveform must either intersect or not intersect in order for an 
acquisition to be displayed and stored in memory.

The zone qualified trigger feature works on top of the oscilloscope's hardware 
trigger, which determines the acquisitions whose waveforms are evaluated for 
zone intersection.

To set up a zone qualified trigger:

1 Touch the upper-right corner to select the rectangle draw mode.

2 Drag your finger (or connected USB mouse pointer) across the screen to draw a 
rectangular zone that the waveform must either intersect or not intersect.

3 Take your finger off the screen (or release the mouse button).

4 In the popup menu, select whether the rectangle is Zone 1 or Zone 2 and 
whether it is a "Must Intersect" or "Must Not Intersect" zone.
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The [Zone] key becomes lit to show the zone qualified trigger feature is enabled.

5 In the Zone Qualified Trigger Menu, press the Source softkey and select the 
analog channel input source that both zones are associated with.

Zone colors match the selected analog input channel. "Must Not Intersect" 
zones are shaded differently than the solid "Must Intersect" zones.

The zone qualified trigger source does not have to be the same as the hardware 
trigger source.

6 You can use the Zone 1 On and Zone 2 On softkeys to disable or enable zones, 
and you can use the Zone 1 and Zone 2 softkeys to toggle between the "Must 
Intersect" and "Must Not Intersect" conditions.
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Disabling both zones disables the zone qualified trigger feature. When the zone 
qualified trigger feature is enabled, at least one zone must be enabled.

You can press the [Zone] key to disable or re-enable the zone qualified trigger.

When two non-overlapping zones are used, their conditions are ANDed to become 
the final qualifying condition.

When two overlapping zones have the must intersect condition, the zones are 
ORed. When two overlapping zones have different conditions, Zone 1 takes 
precedence and Zone 2 is not used. In this case, Zone 2 will have no fill (that is, 
neither solid nor shaded) to indicate that it is not being used.

When two overlapping zones have the must not intersect condition, the zones are 
ANDed.

The zone qualified trigger feature is incompatible with, and will disable, the XY and 
Roll horizontal time modes and the Averaging acquisition mode.

NOTE Keep in mind that the TRIG OUT signal comes from the oscilloscope's hardware trigger. The 
TRIG OUT signal indicates when there is a trigger (acquisition) that is evaluated for zone 
intersection, not when an acquisition meets the zone qualification and is plotted on the 
oscilloscope's display.
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11 Trigger Mode/Coupling
To select the Auto or Normal trigger mode / 220
To select the trigger coupling / 221
To enable or disable trigger noise rejection / 223
To enable or disable trigger HF Reject / 223
To set the trigger holdoff / 224
External Trigger Input / 225

To access the Trigger Mode and Coupling Menu:

• In the Trigger section of the front panel, press the [Mode/Coupling] key.

Noisy Signals If the signal you are probing is noisy, you can set up the oscilloscope to reduce the 
noise in the trigger path and on the displayed waveform. First, stabilize the 
displayed waveform by removing the noise from the trigger path. Second, reduce 
the noise on the displayed waveform.

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Remove the noise from the trigger path by turning on high-frequency rejection 
("To enable or disable trigger HF Reject" on page 223), low-frequency 
rejection ("To select the trigger coupling" on page 221), or "To enable or 
disable trigger noise rejection" on page 223.

3 Use "Averaging Acquisition Mode" on page 237 to reduce noise on the 
displayed waveform.
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To select the Auto or Normal trigger mode

When the oscilloscope is running, the trigger mode tells the oscilloscope what to 
do when triggers are not occurring.

In the Auto trigger mode (the default setting), if the specified trigger conditions are 
not found, triggers are forced and acquisitions are made so that signal activity is 
displayed on the oscilloscope.

In the Normal trigger mode, triggers and acquisitions only occur when the 
specified trigger conditions are found.

To select the trigger mode:

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Mode softkey; then select 
either Auto or Normal.

You can also make this selection using the touchscreen. See "Access the 
Trigger Menu, Change the Trigger Mode, and Open the Trigger Level 
Dialog" on page 62.

See the following "When to Use Auto Trigger Mode" on page 221 and "When 
to Use Normal Trigger Mode" on page 221 descriptions.

You can also configure the [Quick Action] key to toggle between the Auto and 
Normal trigger modes. See "Configuring the [Quick Action] Key" on page 407.

Triggering and the
Pre- and

Post-Trigger
Buffers

After the oscilloscope starts running (after pressing [Run] or [Single] or changing 
the trigger condition), the oscilloscope first fills the pre-trigger buffer. Then, after 
the pre-trigger buffer is filled, the oscilloscope starts searching for a trigger, and 
sampled data continues to flow data through the pre-trigger buffer in a first-in 
first-out (FIFO) manner.

When a trigger is found, the pre-trigger buffer contains the events that occurred 
just before the trigger. Then, the oscilloscope fills the post-trigger buffer and 
displays the acquisition memory. If the acquisition was initiated by [Run/Stop], the 
process repeats. If the acquisition was initiated by pressing [Single], the acquisition 
stops (and you can Pan and Zoom the waveform).

In either Auto or Normal trigger mode, a trigger may be missed if the event occurs 
while the pre-trigger buffer is being filled. This may be more likely, for example, 
when the horizontal scale knob is set to a slow time/div setting, such as 
500 ms/div.
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Trigger Indicator The trigger indicator at the top right of the display shows whether triggers are 
occurring.

In the Auto trigger mode, the trigger indicator can show:

• Auto? — the trigger condition is not found (after the pre-trigger buffer has 
filled), and forced triggers and acquisitions are occurring.

• Auto — the trigger condition is found (or the pre-trigger buffer is being filled).

In the Normal trigger mode, the trigger indicator can show:

• Trig'd? — the trigger condition is not found (after the pre-trigger buffer has 
filled), and no acquisitions are occurring.

• Trig'd — trigger condition is found (or pre-trigger buffer is being filled).

When the oscilloscope is not running, the trigger indicator area shows Stop.

When to Use Auto
Trigger Mode

The Auto trigger mode is appropriate when:

• Checking DC signals or signals with unknown levels or activity.

• When trigger conditions occur often enough that forced triggers are 
unnecessary.

When to Use
Normal Trigger

Mode

The Normal trigger mode is appropriate when:

• You only want to acquire specific events specified by the trigger settings.

• Triggering on an infrequent signal from a serial bus (for example, I2C, SPI, CAN, 
LIN, etc.) or another signal that arrives in bursts. The Normal trigger mode lets 
you stabilize the display by preventing the oscilloscope from auto-triggering.

• Making single-shot acquisitions with the [Single] key.

Often with single-shot acquisitions, you must initiate some action in the device 
under test, and you don't want the oscilloscope to auto-trigger before that 
happens. Before initiating the action in the circuit, wait for the trigger condition 
indicator Trig'd? to display (this tells you the pre-trigger buffer is filled).

See Also • "Forcing a Trigger" on page 183

• "To set the trigger holdoff" on page 224

• "To position the time reference (left, center, right, custom)" on page 79

To select the trigger coupling

1 Press the [Mode/Coupling] key.
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2 In the Trigger Mode and Coupling Menu, press the Coupling softkey; then, turn 
the Entry knob to select:

• DC coupling — allows DC and AC signals into the trigger path.

• AC coupling — places a 10 Hz high-pass filter in the trigger path removing 
any DC offset voltage from the trigger waveform.

The high-pass filter in the External Trigger input path is 50 Hz for all models.

Use AC coupling to get a stable edge trigger when your waveform has a 
large DC offset.

• LF (low frequency) Reject coupling — adds a high-pass filter with the 3-dB 
point at 50 kHz in series with the trigger waveform.

Low frequency reject removes any unwanted low frequency components 
from a trigger waveform, such as power line frequencies, etc., that can 
interfere with proper triggering.

Use LF Reject coupling to get a stable edge trigger when your waveform has 
low frequency noise.

• Video coupling — is normally grayed-out, but is automatically selected when 
Video trigger is enabled in the Trigger Menu.

Note that Trigger Coupling is independent of Channel Coupling (see "To specify 
channel coupling" on page 88).

Pass
Band

50 kHz

0 dB

3 dB down point

DC
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To enable or disable trigger noise rejection

Noise Rej adds additional hysteresis to the trigger circuitry. By increasing the 
trigger hysteresis band, you reduce the possibility of triggering on noise. However, 
this also decreases the trigger sensitivity so that a slightly larger signal is required 
to trigger the oscilloscope.

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Noise Rej softkey to enable or 
disable.

To enable or disable trigger HF Reject

HF Reject adds a 50 kHz low-pass filter in the trigger path to remove high 
frequency components from the trigger waveform.

You can use HF Reject to remove high-frequency noise, such as AM or FM 
broadcast stations or noise from fast system clocks, from the trigger path.

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the HF Reject softkey to enable 
or disable.

Pass
Band

50 kHzDC

0 dB

-3 dB
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To set the trigger holdoff

Trigger holdoff sets the amount of time the oscilloscope waits after a trigger 
before re-arming the trigger circuitry.

Use the holdoff to trigger on repetitive waveforms that have multiple edges (or 
other events) between waveform repetitions. You can also use holdoff to trigger on 
the first edge of a burst when you know the minimum time between bursts.

For example, to get a stable trigger on the repetitive pulse burst shown below, set 
the holdoff time to be >200 ns but <600 ns.

To set the trigger holdoff:

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press Holdoff.

3 In the Trigger Holdoff Menu, press the Random softkey to enable or disable the 
random trigger holdoff mode.

The random trigger holdoff mode ensures that the oscilloscope re-arms after 
each acquisition in a manner that minimizes or eliminates the likelihood of 
triggering at the beginning of a DDR burst. Randomizing the holdoff time 
increases the likelihood that the oscilloscope will trigger on different data 
phases of a multi-phase (8 data transfer) burst. This mode mixes up the traffic 
pattern the oscilloscope triggers on and is very effective when used on 
repeating patterns.

4 If random trigger holdoff is disabled, use the Holdoff softkey to enter the trigger 
holdoff time.

If random trigger holdoff is enabled, use the Min and Max softkeys to enter the 
minimum and maximum trigger holdoff times.

Trigger Holdoff
Operating Hints

The correct holdoff setting is typically slightly less than one repetition of the 
waveform. Set the holdoff to this time to generate a unique trigger point for a 
repetitive waveform.

200 ns

Oscilloscope triggers hereHoldoff

600 ns
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Changing the time base settings does not affect the trigger holdoff time.

With Keysight's MegaZoom technology, you can press [Stop], then pan and zoom 
through the data to find where the waveform repeats. Measure this time using 
cursors; then, set the holdoff.

External Trigger Input

The external trigger input can be used as a source in several of the trigger types. 
The external trigger BNC input is labeled EXT TRIG IN.

The external trigger input impedance is 1M Ohm. This lets you use passive probes 
for general-purpose measurements. The higher impedance minimizes the loading 
effect of the oscilloscope on the device under test.

To set the EXT TRIG IN units and probe attenuation:

1 Press the [Mode/Coupling] key in the Trigger section of the front panel.

2 In the Trigger Mode and Coupling Menu, press the External softkey.

3 In the External Trigger Menu, press the Units softkey to select between:

• Volts — for a voltage probe.

• Amps — for a current probe.

CAUTION  Maximum voltage at oscilloscope external trigger input

30 Vrms

1M ohm input: For steady-state sinusoidal waveforms derate at 20 dB/decade above 
100 kHz to a minimum of 5 Vpk
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Measurement results, channel sensitivity, and the trigger level will reflect the 
measurement units you have selected.

4 Press the Probe softkey; then, turn the Entry knob to specify the probe 
attenuation.

The attenuation factor can be set from 0.001:1 to 10000:1 in a 1-2-5 sequence.

The probe attenuation factor must be set properly for measurements to be 
made correctly.

5 Press the Range softkey; then, turn the Entry knob to set the External Trigger 
input signal range.

The range is either 1.6 V or 8 V when you are using a 1:1 probe.

The range is automatically recalculated when a different External Trigger probe 
attenuation factor is chosen.
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12 Acquisition Control
Running, Stopping, and Making Single Acquisitions (Run Control) / 227
Overview of Sampling / 228
Selecting the Acquisition Mode / 233
Data Acquisition (Sampling) Mode / 240
Acquiring to Segmented Memory / 242

This chapter shows how to use the oscilloscope's acquisition and run controls.

Running, Stopping, and Making Single Acquisitions (Run Control)

There are two front panel keys for starting and stopping the oscilloscope's 
acquisition system: [Run/Stop] and [Single].

• When the [Run/Stop] key is green, the oscilloscope is running, that is, acquiring 
data when trigger conditions are met.

To stop acquiring data, press [Run/Stop]. When stopped, the last acquired 
waveform is displayed.

• When the [Run/Stop] key is red, data acquisition is stopped.

"Stop" is displayed next to the trigger type in the status line at the top of the 
display.

To start acquiring data, press [Run/Stop].

• To capture and display a single acquisition (whether the oscilloscope is running 
or stopped), press [Single].
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The [Single] run control lets you view single-shot events without subsequent 
waveform data overwriting the display. Use [Single] when you want maximum 
memory depth for pan and zoom.

When you press [Single], the trigger mode is temporarily set to Normal (to keep 
the oscilloscope from auto-triggering immediately), the trigger circuitry is 
armed, the [Single] key is illuminated, and the oscilloscope waits until a trigger 
condition occurs before it displays a waveform.

When the oscilloscope triggers, the single acquisition is displayed and the 
oscilloscope is stopped (the [Run/Stop] key is illuminated in red). Press [Single] 
again to acquire another waveform.

If the oscilloscope doesn't trigger, you can press the [Force Trigger] key to trigger 
on anything and make a single acquisition.

To display the results of multiple acquisitions, use persistence. See "To set or 
clear persistence" on page 167.

Single vs. Running
and Record Length

Data record lengths are usually different for single and running acquisitions:

• Single — Single acquisitions use the maximum memory available — usually twice 
as much as acquisitions captured when running. At slower time/div settings, 
because there is more memory available for a single acquisition, the acquisition 
has a higher effective sample rate.

• Running — When running (versus taking a single acquisition), the memory is 
usually divided in half. This lets the acquisition system acquire one record while 
processing the previous acquisition, dramatically improving the number of 
waveforms per second processed by the oscilloscope. When running, a high 
waveform update rate provides the best representation of your input signal.

To acquire data with the longest possible record length, press the [Single] key.

For more information on settings that affect record length, see "Length 
Control" on page 370.

Overview of Sampling

To understand the oscilloscope's sampling and acquisition modes, it is helpful to 
understand sampling theory, aliasing, oscilloscope bandwidth and sample rate, 
oscilloscope rise time, oscilloscope bandwidth required, and how memory depth 
affects sample rate.
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Sampling Theory

The Nyquist sampling theorem states that for a limited bandwidth (band-limited) 
signal with maximum frequency fMAX, the equally spaced sampling frequency fS 
must be greater than twice the maximum frequency fMAX, in order to have the 
signal be uniquely reconstructed without aliasing.

fMAX = fS/2 = Nyquist frequency (fN) = folding frequency

Aliasing

Aliasing occurs when signals are under-sampled (fS < 2fMAX). Aliasing is the signal 
distortion caused by low frequencies falsely reconstructed from an insufficient 
number of sample points.

Oscilloscope Bandwidth and Sample Rate

An oscilloscope's bandwidth is typically described as the lowest frequency at 
which input signal sine waves are attenuated by 3 dB (-30% amplitude error).

Figure 35 Aliasing
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At the oscilloscope bandwidth, sampling theory says the required sample rate is fS 
= 2fBW. However, the theory assumes there are no frequency components above 
fMAX (fBW in this case) and it requires a system with an ideal brick-wall frequency 
response.

However, digital signals have frequency components above the fundamental 
frequency (square waves are made up of sine waves at the fundamental frequency 
and an infinite number of odd harmonics), and the oscilloscope's frequency 
response is not ideal — it can be more like the following Gaussian frequency 
response.

Figure 36 Theoretical Brick-Wall Frequency Response
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 So, in practice, an oscilloscope's sample rate should be four or more times its 
bandwidth: fS = 4fBW. This way, there is less aliasing, and aliased frequency 
components have a greater amount of attenuation.

Note that some oscilloscope models (typically higher bandwidth) have more of a 
brick-wall type frequency response than the Gaussian response of other 
oscilloscope models (typically lower bandwidth). To understand the 
characteristics of each type of oscilloscope frequency response, see 
Understanding Oscilloscope Frequency Response and Its Effect on Rise-Time 
Accuracy, Keysight Application Note 1420 
(http://literature.cdn.keysight.com/litweb/pdf/5988-8008EN.pdf).

See Also Evaluating Oscilloscope Sample Rates vs. Sampling Fidelity: How to Make the 
Most Accurate Digital Measurements, Keysight Application Note 1587 
(http://literature.cdn.keysight.com/litweb/pdf/5989-5732EN.pdf)

Oscilloscope Rise Time

Closely related to an oscilloscope's bandwidth specification is its rise time 
specification. Oscilloscopes with a Gaussian-type frequency response have an 
approximate rise time of 0.35/fBW based on a 10% to 90% criterion.

Figure 37 Sample Rate and Oscilloscope Bandwidth
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An oscilloscope's rise time is not the fastest edge speed that the oscilloscope can 
accurately measure. It is the fastest edge speed the oscilloscope can possibly 
produce.

Oscilloscope Bandwidth Required

The oscilloscope bandwidth required to accurately measure a signal is primarily 
determined by the signal's rise time, not the signal's frequency. You can use these 
steps to calculate the oscilloscope bandwidth required:

1 Determine the fastest edge speeds.

You can usually obtain rise time information from published specifications for 
devices used in your designs.

2 Compute the maximum "practical" frequency component.

From Dr. Howard W. Johnson's book, High-Speed Digital Design – A 
Handbook of Black Magic, all fast edges have an infinite spectrum of frequency 
components. However, there is an inflection (or "knee") in the frequency 
spectrum of fast edges where frequency components higher than fknee are 
insignificant in determining the shape of the signal.

fknee = 0.5 / signal rise time (based on 10% - 90% thresholds)

fknee = 0.4 / signal rise time (based on 20% - 80% thresholds)

3 Use a multiplication factor for the required accuracy to determine the 
oscilloscope bandwidth required.

See Also Choosing an Oscilloscope with the Right Bandwidth for your Application, Keysight 
Application Note 1588 
(http://literature.cdn.keysight.com/litweb/pdf/5989-5733EN.pdf)

Required accuracy Oscilloscope bandwidth required

20% fBW = 1.0 x fknee

10% fBW = 1.3 x fknee

3% fBW = 1.9 x fknee

http://literature.cdn.keysight.com/litweb/pdf/5989-5733EN.pdf
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Memory Depth and Sample Rate

The number of points of oscilloscope memory is fixed, and there is a maximum 
sample rate associated with oscilloscope's analog-to-digital converter; however, 
the actual sample rate is determined by the time of the acquisition (which is set 
according to the oscilloscope's horizontal time/div scale).

sample rate = number of samples / time of acquisition

For example, when storing 50 µs of data in 50,000 points of memory, the actual 
sample rate is 1 GSa/s.

Likewise, when storing 50 ms of data in 50,000 points of memory, the actual 
sample rate is 1 MSa/s.

The actual sample rate is displayed in the Summary box in the right-side 
information area.

The oscilloscope achieves the actual sample rate by throwing away (decimating) 
unneeded samples.

Selecting the Acquisition Mode

When selecting the oscilloscope acquisition mode, keep in mind that samples are 
normally decimated at slower time/div settings.

At slower time/div settings, the effective sample rate drops (and the effective 
sample period increases) because the acquisition time increases and the 
oscilloscope's digitizer is sampling faster than is required to fill memory.

For example, suppose an oscilloscope's digitizer has a sample period of 1 ns 
(maximum sample rate of 1 GSa/s) and a 1 M memory depth. At that rate, memory 
is filled in 1 ms. If the acquisition time is 100 ms (10 ms/div), only 1 of every 100 
samples is needed to fill memory.

To select the acquisition mode:

1 Press the [Acquire] key on the front panel.

2 In the Acquire Menu, press the Acq Mode softkey; then, turn the Entry knob to 
select the acquisition mode.

The InfiniiVision oscilloscopes have the following acquisition modes:
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• Normal — at slower time/div settings, normal decimation occurs, and there is 
no averaging. Use this mode for most waveforms. See "Normal Acquisition 
Mode" on page 234.

• Peak Detect — at slower time/div settings, the maximum and minimum 
samples in the effective sample period are stored. Use this mode for 
displaying narrow pulses that occur infrequently. See "Peak Detect 
Acquisition Mode" on page 234.

• Averaging — at all time/div settings, the specified number of triggers are 
averaged together. Use this mode for reducing noise and increasing 
resolution of periodic signals without bandwidth or rise time degradation. 
See "Averaging Acquisition Mode" on page 237.

• High Resolution — at slower time/div settings, all samples in the effective 
sample period are averaged and the average value is stored. Use this mode 
for reducing random noise. See "High Resolution Acquisition Mode" on 
page 239.

Normal Acquisition Mode

In Normal mode at slower time/div settings, extra samples are decimated (in other 
words, some are thrown away). This mode yields the best display for most 
waveforms.

Peak Detect Acquisition Mode

In Peak Detect mode at slower time/div settings, minimum and maximum samples 
are kept in order to capture infrequent and narrow events (at the expense of 
exaggerating any noise). This mode displays all pulses that are at least as wide as 
the sample period.

For InfiniiVision 6000 X-Series oscilloscopes, which have a maximum sample rate 
of 20 GSa/s, a sample is taken every 50 ps (sample period).

See Also • "Glitch or Narrow Pulse Capture" on page 235

• "Using Peak Detect Mode to Find a Glitch" on page 236
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Glitch or Narrow Pulse Capture

A glitch is a rapid change in the waveform that is usually narrow as compared to 
the waveform. Peak detect mode can be used to more easily view glitches or 
narrow pulses. In peak detect mode, narrow glitches and sharp edges are 
displayed more brightly than when in Normal acquire mode, making them easier 
to see.

To characterize the glitch, use the cursors or the automatic measurement 
capabilities of the oscilloscope.

Figure 38 Sine With Glitch, Normal Mode
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Using Peak Detect Mode to Find a Glitch

1 Connect a signal to the oscilloscope and obtain a stable display.

2 To find the glitch, press the [Acquire] key; then, press the Acq Mode softkey until 
Peak Detect is selected.

3 Press the [Display] key then press the ∞ Persistence (infinite persistence) softkey.

Infinite persistence updates the display with new acquisitions but does not 
erase previous acquisitions. New sample points are shown at normal intensity 
while previous acquisitions are displayed at reduced intensity. Waveform 
persistence is not kept beyond the display area boundary.

Press the Clear Display softkey to erase previously acquired points. The display 
will accumulate points until ∞ Persistence is turned off.

Figure 39 Sine With Glitch, Peak Detect Mode
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4 Characterize the glitch with Zoom mode:

a Press the  zoom key (or press the [Horiz] key and then the Zoom softkey).

b To obtain a better resolution of the glitch, expand the time base.

Use the horizontal position knob ( ) to pan through the waveform to set the 
expanded portion of the normal window around the glitch.

Averaging Acquisition Mode

The Averaging mode lets you average multiple acquisitions together to reduce 
noise and increase vertical resolution (at all time/div settings). Averaging requires 
a stable trigger.

The number of averages can be set from 2 to 65536 in power-of-2 increments.

A higher number of averages reduces noise more and increases vertical resolution.

The higher the number of averages, the slower the displayed waveform responds 
to waveform changes. You must compromise between how quickly the waveform 
responds to changes and how much you want to reduce the displayed noise on 
the signal.

To use the Averaging mode:

1 Press the [Acquire] key, then press the Acq Mode softkey until the Averaging 
mode is selected.

2 Press the #Avgs softkey and turn the Entry knob to set the number of averages 
that best eliminates the noise from the displayed waveform. The number of 
acquisitions being averaged is displayed in the # Avgs softkey.

# Avgs Bits of resolution

2 8

4 9

16 10

64 11

≥ 256 12



238 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

12 Acquisition Control
 

Figure 40 Random noise on the displayed waveform
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When the Averaging acquisition mode is enabled, a Single acquisition will perform 
the selected number of averages and then stop.

See Also • Chapter 11, “Trigger Mode/Coupling,” starting on page 219

• "Averaged Value" on page 122

High Resolution Acquisition Mode

In High Resolution mode, at slower time/div settings extra samples are averaged 
in order to reduce random noise, produce a smoother trace on the screen, and 
effectively increase vertical resolution.

Figure 41 128 Averages used to reduce random noise
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High Resolution mode averages sequential sample points within the same 
acquisition. An extra bit of vertical resolution is produced for every factor of 2 
averages. Random noise is reduced by ½ for every factor of 4 averages. The 
number of extra bits of vertical resolution is dependent on the time per division 
setting (sweep speed) of the oscilloscope.

The slower the time/div setting, the greater the number of samples that are 
averaged together for each display point.

High Resolution mode can be used on both single-shot and repetitive signals and 
it does not slow waveform update because the computation is done in the 
MegaZoom custom ASIC. High Resolution mode limits the oscilloscope's real-time 
bandwidth because it effectively acts like a low-pass filter.

Data Acquisition (Sampling) Mode

The Data Acq Mode softkey lets you select the type of sampling used by the 
oscilloscope:

• Realtime — Specifies that the oscilloscope produce the waveform display from 
samples collected during one trigger event (that is, one acquisition). At fast 
sweep speeds, when not enough samples can be collected for a waveform, a 
sophisticated reconstruction filter is used to fill-in sample points and enhance 
the waveform display.

In Realtime mode, to accurately reproduce a sampled waveform, the sample 
rate should be at least 2.5 times the highest frequency component of the 
waveform. If not, it is possible for the reconstructed waveform to be distorted or 
aliased. Aliasing is most commonly seen as jitter on fast digital edges.

Sweep speed Bits of resolution

≤ 1 µs/div 8

2 µs/div 9

5 µs/div 10

10 µs/div 11

≥ 20 µs/div 12
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Use Realtime sampling to capture infrequent triggers, unstable triggers, or 
complex changing waveforms, such as eye diagrams.

• Realtime (Max Update Rate) — This is the same as Realtime except that in order to 
provide maximum update rate (trigger rates), the sample rate drops from 
20 GSa/s to 2 GSa/s at a faster time/div setting than normal.

This mode is ideal for finding glitches and infrequent events in waveforms that 
do not require the full 20 GSa/s sample rate (and associated bandwidth).

This mode is not allowed in single, roll, segmented, or mask test.

• Equivalent Time — Available in 6 GHz bandwidth models, this option gives you 
another way to fill-in sample points at fast sweep speeds — it is used only when 
sweep speeds are 20 ns/div or faster. In this case, instead of a reconstruction 
filter, a technique known as random repetitive sampling is used to build-up and 
draw one waveform using multiple triggers (acquisitions).

At slower sweep speeds, there are enough sample points in a trigger 
(acquisition, in other words) to render a waveform on the display.

Equivalent time sampling mode requires a repetitive waveform with a stable 
trigger.

See Also • "Realtime Sampling and Oscilloscope Bandwidth" on page 241

Realtime Sampling and Oscilloscope Bandwidth

To accurately reproduce a sampled waveform, the sample rate should be at least 
2.5 times the highest frequency component of the waveform. If not, it is possible 
for the reconstructed waveform to be distorted or aliased. Aliasing is most 
commonly seen as jitter on fast edges.

The maximum sample rate for the 6000 X-Series oscilloscopes is 20 GSa/s for a 
single channel in a channel pair. Channels 1 and 2 constitute a channel pair, and 
channels 3 and 4 constitute another channel pair. For example, the sample rate of 
a 4-channel oscilloscope is 20 GSa/s when channels 1 and 3, 1 and 4, 2 and 3, or 
2 and 4 are on.

Whenever both channels in a channel pair are on, the sample rate for all channels 
is halved. For example, when channels 1, 2, and 3 are on, the sample rate for all 
channels is 10 GSa/s.
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When Realtime sampling is on, the bandwidth of the oscilloscope is limited 
because the bandwidth of the reconstruction filter is set to fs/4. For example, a 
6 GHz MSOX600xA oscilloscope with channels 1 and 2 on has a bandwidth of 
2.5 MHz when Realtime sampling on and 6 GHz when Realtime sampling is off.

The sample rate is displayed in the sidebar Summary dialog.

Acquiring to Segmented Memory

When capturing multiple infrequent trigger events it is advantageous to divide the 
oscilloscope's memory into segments. This lets you capture signal activity without 
capturing long periods of signal inactivity.

Each segment is complete with all analog channel, digital channel (on MSO 
models), and serial decode data.

When using segmented memory, use the Analyze Segments feature (see 
"Measurements, Statistics, and Infinite Persistence with Segmented Memory" on 
page 244) to show infinite persistence across all acquired segments. See also "To 
set or clear persistence" on page 167 for details.

To acquire to
segmented

memory

1 Set up a trigger condition. (See Chapter 10, “Triggers,” starting on page 181 
for details.)

2 Press the [Acquire] key in the Waveform section of the front panel.

3 Press the Segmented softkey.

4 In the Segmented Memory Menu, press the Segmented softkey to enable 
segmented memory acquisitions.

5 Press the # of Segs softkey and turn the Entry knob to select the number of 
segments into which you would like to divide the oscilloscope's memory.

Memory can be divided into as few as two segments and as many as 1000 
segments.

6 Press the [Run] or [Single] key.

The oscilloscope runs and fills a memory segment for each trigger event. When 
the oscilloscope is busy acquiring multiple segments, the progress is displayed on 
screen. The oscilloscope continues to trigger until memory is filled, then the 
oscilloscope stops.
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If the signal you are measuring has more than about 1 s of inactivity, consider 
selecting the Normal trigger mode to prevent AutoTriggering. See "To select the 
Auto or Normal trigger mode" on page 220.

See Also • "Navigating Segments" on page 243

• "Measurements, Statistics, and Infinite Persistence with Segmented 
Memory" on page 244

• "Segmented Memory Re-Arm Time" on page 244

• "Saving Data from Segmented Memory" on page 244

Navigating Segments

1 Press the Current Seg softkey and turn the Entry knob to display the desired 
segment along with a time tag indicating the time from the first trigger event.

You can also navigate segments using the [Navigate] key and controls. See "To 
navigate segments" on page 82.
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Measurements, Statistics, and Infinite Persistence with Segmented 
Memory

To perform measurements and view statistical information, press [Meas] and set up 
your desired measurements (see Chapter 14, “Measurements,” starting on page 
255). Then, press Analyze Segments. Statistical data will be accumulated for the 
measurements you have chosen.

The Analyze Segments softkey appears when the acquisition is stopped and the 
segmented memory feature is on or when the serial Lister or Histogram is enabled.

You can also turn on infinite persistence (in the Display Menu) and press the 
Analyze Segments softkey to create an infinite persistence display.

Segmented Memory Re-Arm Time

After each segment fills, the oscilloscope re-arms and is ready to trigger in about 
1 µs.

Remember though, for example: if the horizontal time per division control is set to 
5 µs/div, and the Time Reference is set to Center, it will take at least 50 µs to fill all 
ten divisions and re-arm. (That is 25 µs to capture pre-trigger data and 25 µs to 
capture post-trigger data.)

Saving Data from Segmented Memory

You can save either the currently displayed segment (Save Segment - Current), or all 
segments (Save Segment - All) in the following data formats: CSV, ASCII XY, and 
BIN.

Be sure to set the Length control to capture enough points to accurately represent 
the captured data. When the oscilloscope is busy saving multiple segments, 
progress is displayed in the upper right area of the display.

For more information, see "To save CSV, ASCII XY, or BIN data files" on page 368.
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13 Cursors
To make cursor measurements / 246
Cursor Examples / 249

Cursors are horizontal and vertical markers that indicate X-axis values and Y-axis 
values on a selected waveform source. You can use cursors to make custom 
voltage, time, phase, or ratio measurements on oscilloscope signals.

Cursor information is displayed in the right-side information area.

Cursors are not always limited to the visible display. If you set a cursor, then pan 
and zoom the waveform until the cursor is off screen, its value will not be changed. 
It will still be there when you return to its original location.

X Cursors X cursors are vertical dashed lines that adjust horizontally and can be used to 
measure time (s), frequency (1/s), phase (°), and ratio (%).

The X1 cursor is the short-dashed vertical line, and the X2 cursor is the 
long-dashed vertical line.

When used with the FFT math function as a source, the X cursors indicate 
frequency.

In XY horizontal mode, the X cursors display channel 1 values (Volts or Amps).

The X1 and X2 cursor values for the selected waveform source are displayed in the 
softkey menu area.

The difference between X1 and X2 (ΔX) and 1/ΔX are displayed in the Cursors box 
in the right-side information area.

Y Cursors Y cursors are horizontal dashed lines that adjust vertically and can be used to 
measure Volts or Amps, dependent on the channel Probe Units setting, or they can 
measure ratios (%). When math functions are used as a source, the measurement 
units correspond to that math function.
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The Y1 cursor is the short-dashed horizontal line and the Y2 cursor is the 
long-dashed horizontal line.

The Y cursors adjust vertically and typically indicate values relative to the 
waveform's ground point, except math FFT where the values are relative to 0 dB.

In XY horizontal mode, the Y cursors display channel 2 values (Volts or Amps).

When active, the Y1 and Y2 cursor values for the selected waveform source are 
displayed in the softkey menu area.

The difference between Y1 and Y2 (ΔY) is displayed in the Cursors box in the 
right-side information area.

To make cursor measurements

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Press the [Cursors] key.

The Cursors box in the right-side information area appears, indicating that 
cursors are "on". (Press the [Cursors] key again when you want to turn cursors 
off.)

3 In the Cursors Menu, press Mode; then, select the desired mode:

• Manual — ΔX, 1/ΔX, and ΔY values are displayed. ΔX is the difference 
between the X1 and X2 cursors and ΔY is the difference between the Y1 and 
Y2 cursors.

• Track Waveform — As you move a marker horizontally, the vertical amplitude 
of the waveform is tracked and measured. The time and voltage positions 
are shown for the markers. The vertical (Y) and horizontal (X) differences 
between the markers are shown as ΔX and ΔY values.

• Measure — When measurements are displayed, this mode shows the cursor 
locations used to make the measurement. When you add a measurement, it 
becomes the one that cursors are displayed for. You can use the Measurement 
softkey or touch in the Meas sidebar dialog to select the measurement 
whose cursor locations are displayed.
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• Binary — Logic levels of displayed waveforms at the current X1 and X2 cursor 
positions are displayed in the Cursor sidebar dialog in binary. The display is 
color coded to match the color of the related channel's waveform.

• Hex — Logic levels of displayed waveforms at the current X1 and X2 cursor 
positions are displayed in the Cursor sidebar dialog in hexadecimal.

Manual and Track Waveform modes can be used on waveforms that are displayed 
on the analog input channels (including math functions).

Binary and Hex modes apply to digital signals (of MSO oscilloscope models).

In Hex and Binary modes, a level can be displayed as 1 (higher than trigger 
level), 0 (lower than trigger level), indeterminate state (-), or X (don't care).

In Binary mode, X is displayed if the channel is turned off.

In Hex mode, the channel is interpreted as 0 if turned off.

4 Press Source (or X1 Source, X2 Source in the Track Waveform mode); then, select 
the input source for cursor values.

5 To select and adjust cursors:

• Using the touchscreen, select cursors by touching their handles, and adjust 
them by dragging their handles. See "Drag Cursors" on page 56.

You can use the Cursors knob after that to make precise adjustments.

• Using the Cursors knob, you can select the cursor(s) to be adjusted by 
pushing the knob, turning the knob to make the selection, and pushing the 
knob again (or waiting about five seconds for the popup menu to disappear) 
to finalize the selection.

The X1 X2 linked and Y1 Y2 linked selections let you adjust both cursors at the 
same time, while the delta value remains the same. This can be useful, for 
example, for checking pulse width variations in a pulse train.



248 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

13 Cursors
 

To adjust the selected cursor(s), turn the Cursors knob.

• Using the Cursors softkey, you select cursors by pressing the softkey and 
then turning the Entry knob.

To adjust the selected cursor(s), turn the Cursors knob.

The currently selected cursor(s) display brighter than the other cursors.

6 To change the cursor units, press the Units softkey.

In the Cursor Units Menu:

You can press the X Units softkey to select:

• Seconds (s).

• Hz (1/s).

• Phase (°) — when selected, use the Use X Cursors softkey to set the current X1 
location as 0 degrees and the current X2 location as 360 degrees.

• Ratio (%) — when selected, use the Use X Cursors softkey to set the current X1 
location as 0% and the current X2 location as 100%.

You can press the Y Units softkey to select:

• Base — the same units used for the source waveform.

• Ratio (%) — when selected, use the Use Y Cursors softkey to set the current Y1 
location as 0% and the current Y2 location as 100%.

For phase or ratio units, once the 0 and 360 degree or 0 and 100% locations are 
set, adjusting cursors will display measurements relative to the set locations.
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Cursor Examples

Figure 42 Cursors used to measure pulse widths other than middle threshold points
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Expand the display with Zoom mode, then characterize the event of interest with 
the cursors.

Figure 43 Cursors measure frequency of pulse ringing
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Put the X1 cursor on one side of a pulse and the X2 cursor on the other side of the 
pulse.

Figure 44 Cursors track Zoom window
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Press the X1 X2 linked softkey and move the cursors together to check for pulse 
width variations in a pulse train.

Figure 45 Measuring pulse width with cursors
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Figure 46 Moving the cursors together to check pulse width variations
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14 Measurements
To make automatic measurements / 256
To edit measurements / 258
Measurements Summary / 258
Voltage Measurements / 263
Time Measurements / 270
Count Measurements / 278
Mixed Measurements / 280
FFT Analysis Measurements / 281
Measurement Thresholds / 283
Measurement Window / 285
Measurement Statistics / 285
Measurement Limit Testing / 287
Precision Measurements and Math / 289

The [Meas] key lets you make automatic measurements on waveforms. Some 
measurements can only be made on analog input channels.

The results of the last 10 selected measurements are displayed in the 
Measurements list dialog (which can be selected from the right-hand sidebar 
menu — see "Select Sidebar Information or Controls" on page 54 and "Undock 
Sidebar Dialogs by Dragging" on page 55).

When you add a measurement, it appears at the bottom of the Measurements list 
dialog, and cursors that show the portion of the waveform being measured are 
automatically displayed. You can change the measurement for which cursors are 
displayed by touching the measurement in the list and choosing Track With Cursors 
in the popup menu or by selecting the measurement in the Cursors Menu.



256 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

14 Measurements
 

To make automatic measurements

1 Press the [Meas] key to display the Measurement Menu.

2 Press the Add Meas softkey to open the Add Measurements Menu.

3 If the Parameter softkey is available, select the Source parameter.

The Parameter softkey is available when there are multiple settings for a 
measurements.

4 Press the Source softkey to select the channel, running math function, or 
reference waveform to be measured.

Only channels, math functions, or reference waveforms that are displayed are 
available for measurements.

5 Press the Type: softkey; then, rotate the Entry knob to select a measurement to 
be made.

NOTE Post Acquisition Processing

In addition to changing display parameters after the acquisition, you can perform all of the 
measurements and math functions after the acquisition. Measurements and math functions 
will be recalculated as you pan and zoom and turn channels on and off. As you zoom in and out 
on a signal using the horizontal scale knob and vertical volts/division knob, you affect the 
resolution of the display. Because measurements and math functions are performed on 
displayed data, you affect the resolution of functions and measurements.

NOTE If a portion of the waveform required for a measurement is not displayed or does not display 
enough resolution to make the measurement (approximately 4% of full scale), the result will 
display "No Edges", "Clipped", "Low Signal" (not enough amplitude), "< value", or "> value", 
or a similar message to indicate that the measurement may not be reliable.
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You can also use the touchscreen to select measurements. You can touch the 
"+" in the Measurements sidebar dialog to open the measurement type menu. 
See also "Touch Softkeys and Menus On the Screen" on page 56.

For more information on the types of measurements, see "Measurements 
Summary" on page 258.

6 The Settings softkey will be available to make additional measurement settings 
on some measurements.

7 Press the Add Measurement softkey or push the Entry knob to display the 
measurement.

Cursors are turned on to show the portion of the waveform being measured for 
the most recently added measurement (bottom-most on the display). To view 
the cursors for a previously added measurement (but not the last one), add the 
measurement again.

By default, measurement statistics are displayed. See "Measurement 
Statistics" on page 285.

8 To turn off measurements, press the [Meas] key again.
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Measurements are erased from the display.

9 To stop making one or more measurements, press the Clear Meas softkey and 
choose the measurement to clear, or press Clear All.

After all measurements have been cleared, when [Meas] is pressed again, the 
default measurements will be Frequency and Peak-Peak.

To edit measurements

When added measurements have parameters that can be edited (like the Delay, 
Phase, Occupied Bandwidth, ACPR, or THD measurements), you can edit the 
parameters of those measurements.

1 Press the [Meas] key to display the Measurement Menu.

2 Press the Edit Meas softkey open the Edit Measurements Menu.

3 Press the Select Measurement softkey to select the measurement you would like 
to edit.

4 Press the Parameter softkey to select the parameter(s) you would like to edit; 
then, use the remaining softkeys to edit that parameter.

Measurements Summary

The automatic measurements provided by the oscilloscope are listed in the 
following table. All measurements are available for analog channel waveforms. All 
measurements except Counter are available for reference waveforms and math 
waveforms other than FFT. A limited set of measurements is available for math FFT 
waveforms and for digital channel waveforms (as described in the following table).
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Measurement Valid 
for 
Math 
FFT*

Valid for 
Digital 
Channels

Notes

"Snapshot All" on page 262

"Amplitude" on page 264

"Area" on page 280

"Average" on page 267 Yes, Full 
Screen

"Base" on page 265

"Bit Rate" on page 274 Yes

"Burst Width" on page 273

"Counter" on page 272 Yes Not valid for math waveforms.

"Delay" on page 275 Yes Measures between two sources. 
Press Settings to specify the second 
source.

"Duty Cycle" on page 273 Yes

"Fall Time" on page 274

"Frequency" on page 271 Yes

"Maximum" on page 264 Yes

"Minimum" on page 264 Yes

"Rising Edge Count" on 
page 279

"Falling Edges Count" on 
page 279

"Positive Pulse Count" on 
page 278

Yes

"Negative Pulse Count" on 
page 279

Yes

"Overshoot" on page 265

"Peak-Peak" on page 263 Yes
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Power App
Measurements

Note that additional Power App measurements are available when the power 
measurement and analysis license is installed and the Power Application is 
enabled. For more information, see the Power Measurement Application User's 
Guide at www.keysight.com/find/6000X-Series-manual.

"Period" on page 271 Yes

"Phase" on page 276 Measures between two sources. 
Press Settings to specify the second 
source.

"Preshoot" on page 267

"Ratio" on page 270 Measures between two sources. 
Press Settings to specify the second 
source.

"Rise Time" on page 274

"Slew Rate" on page 280

"DC RMS" on page 268

"AC RMS" on page 268

"Time at Edge" on page 274 Yes

"Top" on page 264

"+ Width" on page 273 Yes

"– Width" on page 273 Yes

"X at Max Y" on page 278 Yes The resultant units are in Hertz.

"X at Min Y" on page 278 Yes The resultant units are in Hertz.

"Y at X" on page 264 Yes Yes With FFT waveforms, X is a frequency 
value.

* Use the cursors to make other measurements on FFT.

Measurement Valid 
for 
Math 
FFT*

Valid for 
Digital 
Channels

Notes

http://www.keysight.com/find/6000X-Series-manual
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Jitter and
Real-time Eye

Analysis
Measurements

Note that additional Jitter and Real-Time Eye Analysis measurements are 
available when the JITTER license is installed and the features are enabled. See 
"Jitter Measurements" on page 309 and "Real-Time Eye Analysis" on page 313.

Dual-Channel
(N2820A Probe)

Measurements

Note that additional measurements are available with the N2820A high-sensitivity 
current probe when both the Primary and Secondary probe cables are used. 
Zoom In waveform data below the probe's clamp level is joined with Zoom Out 
waveform data above the probe's clamp level to create the waveform on which the 
measurement is made. These measurements are only valid for analog input 
channels.

When using the N2820A probe to make measurements on a battery-powered 
(floating) device, always connect the supplied ground lead between ground on 
your device and the probe's ground connector as shown in the following figure. 
Simply snap the end of the ground lead onto the probe's connector. Without the 
ground connection, the probe's common-mode input amplifier cannot properly 
display waveforms.

Dual-Channel (N2820A Probe) 
Measurement

Notes

Amplitude See "Amplitude" on page 264.

Charge Charge (in Amp-hours) is the measured area under 
the waveform. See "Area" on page 280.

Average See "Average" on page 267.

Base See "Base" on page 265.

Peak-Peak See "Peak-Peak" on page 263.

DC RMS See "DC RMS" on page 268.

AC RMS See "AC RMS" on page 268.
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Snapshot All

The Snapshot All measurement type displays a popup containing a snapshot of all 
the single waveform measurements.

Figure 47 Measurements on Battery Powered Devices Using the N2820A Probe
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You can also configure the [Quick Action] key to display the Snapshot All popup. 
See "Configuring the [Quick Action] Key" on page 407.

Voltage Measurements

The following figure shows the voltage measurement points.

Measurement units for each input channel can be set to Volts or Amps using the 
channel Probe Units softkey. See "To specify the channel units" on page 92.

The units of math waveforms are described in "Units for Math Waveforms" on 
page 97.

• "Peak-Peak" on page 263

• "Maximum" on page 264

• "Minimum" on page 264

• "Amplitude" on page 264

• "Top" on page 264

• "Base" on page 265

• "Overshoot" on page 265

• "Preshoot" on page 267

• "Average" on page 267

• "DC RMS" on page 268

• "AC RMS" on page 268

• "Ratio" on page 270

Peak-Peak

The peak-to-peak value is the difference between Maximum and Minimum values. 
The Y cursors show the values being measured.

Amplitude

Maximum

Minimum
Base

Top

Peak-Peak
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Maximum

Maximum is the highest value in the waveform display. The Y cursor shows the 
value being measured.

Minimum

Minimum is the lowest value in the waveform display. The Y cursor shows the 
value being measured.

Y at X

Y at X measures the vertical value at a specified horizontal location on the specified 
source waveform. The horizontal location must be on the screen.

When the horizontal axis is time, the horizontal location is a time value referenced 
to the trigger event.

When the source is an FFT (Fast Fourier Transform) waveform, the horizontal axis 
is frequency instead of time, and the horizontal location is a frequency value.

Amplitude

The Amplitude of a waveform is the difference between its Top and Base values. 
The Y cursors show the values being measured.

Top

The Top of a waveform is the mode (most common value) of the upper part of the 
waveform, or if the mode is not well defined, the top is the same as Maximum. The 
Y cursor shows the value being measured.

See Also • "To isolate a pulse for Top measurement" on page 264

To isolate a pulse for Top measurement

The following figure shows how to use Zoom mode to isolate a pulse for a Top 
measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement 
Window" on page 285.
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Base

The Base of a waveform is the mode (most common value) of the lower part of the 
waveform, or if the mode is not well defined, the base is the same as Minimum. 
The Y cursor shows the value being measured.

Overshoot

Overshoot is distortion that follows a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being measured (edge 
closest to the trigger reference point).

Figure 48 Isolating area for Top measurement

Rising edge overshοot =
local Maximum − D Top

Amplitude
× 100
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Figure 49 Automatic Overshoot measurement

Falling edge overshοot = Base − D local Minimum
Amplitude

× 100

Overshoot
local Maximum

local Minimum

Base

Top

Overshoot
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Preshoot

Preshoot is distortion that precedes a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being measured (edge 
closest to the trigger reference point).

Average

Average is the sum of the levels of the waveform samples divided by the number 
of samples.

Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an integral 
number of periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show what interval of the waveform is being measured.

Rising edge preshοot =
local Maximum − D Top

Amplitude
× 100

Falling edge preshοot = Base − D local Minimum
Amplitude

× 100

Preshootlocal Maximum

local Minimum

Base

Top

Preshoot

Average =
∑ xi
n
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DC RMS

DC RMS is the root-mean-square value of the waveform over one or more full 
periods.

Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an integral 
number of periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

AC RMS

AC RMS is the root-mean-square value of the waveform, with the DC component 
removed. It is useful, for example, for measuring power supply noise.

The N Cycles measurement interval measures the value on an integral number of 
periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

The Full Screen (Std Deviation) measurement interval variation is an RMS 
measurement across the full screen with the DC component removed. It shows the 
standard deviation of the displayed voltage values.

The standard deviation of a measurement is the amount that a measurement 
varies from the mean value. The Mean value of a measurement is the statistical 
average of the measurement.

RMS (dc) =
∑i=1

n
xi

2

n
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The following figure graphically shows the mean and standard deviation. Standard 
deviation is represented by the Greek letter sigma: σ. For a Gaussian distribution, 
two sigma (± 1σ) from the mean, is where 68.3 percent of the measurement results 
reside. Six sigma (± 3σ) from is where 99.7 percent of the measurement results 
reside.

The mean is calculated as follows:

where:

• x = the mean.

• N = the number of measurements taken.

• xi = the ith measurement result.

The standard deviation is calculated as follows:

where:

• σ = the standard deviation.

-2σ

mean

-1σ 1σ 2σ
68.3%

-3σ

95.4%
99.7%

0 3σ

x̄ =
∑i=1

N xi
N

σ =
∑i=1

N
(xi − x̄)

2

N
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• N = the number of measurements taken.

• xi = the ith measurement result.

• x = the mean.

Ratio

The Ratio measurement displays the ratio of the AC RMS voltages of two sources, 
expressed in dB. Press the Settings softkey to select the source channels for the 
measurement.

Time Measurements

The following figure shows time measurement points.

The default lower, middle, and upper measurement thresholds are 10%, 50%, and 
90% between Top and Base values. See "Measurement Thresholds" on page 283 
for other percentage threshold and absolute value threshold settings.

• "Period" on page 271

• "Frequency" on page 271

• "Counter" on page 272

• "+ Width" on page 273

• "– Width" on page 273

• "Burst Width" on page 273

• "Duty Cycle" on page 273

• "Bit Rate" on page 274

• "Rise Time" on page 274

• "Fall Time" on page 274

Rise Time

+ Width

Fall Time

- Width
Period

Middle
Upper

Thresholds

Lower
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• "Delay" on page 275

• "Phase" on page 276

• "X at Min Y" on page 278

• "X at Max Y" on page 278

Period

Period is the time period of the complete waveform cycle. The time is measured 
between the middle threshold points of two consecutive, like-polarity edges. A 
middle threshold crossing must also travel through the lower and upper threshold 
levels which eliminates runt pulses. The X cursors show what portion of the 
waveform is being measured. The Y cursor shows the middle threshold point.

Frequency

Frequency is defined as 1/Period. Period is defined as the time between the 
middle threshold crossings of two consecutive, like-polarity edges. A middle 
threshold crossing must also travel through the lower and upper threshold levels 
which eliminates runt pulses. The X cursors show what portion of the waveform is 
being measured. The Y cursor shows the middle threshold point.

See Also • "To isolate an event for frequency measurement" on page 271

To isolate an event for frequency measurement

The following figure shows how to use Zoom mode to isolate an event for a 
frequency measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement 
Window" on page 285.

If the waveform is clipped, it may not be possible to make the measurement.
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Counter

The InfiniiVision 6000 X-Series oscilloscopes have an integrated hardware 
frequency counter which counts the number of cycles that occur within a period of 
time (known as the gate time) to measure the frequency of a signal.

The gate time is the horizontal range of the oscilloscope but is limited to >= 0.1 s 
and <= 10 s. Unlike other measurements, the Zoom horizontal timebase window 
does not gate the Counter measurement.

The Counter measurement can measure frequencies up to 1 GHz (1.2 GHz 
typical). The minimum frequency supported is 2.0 / gateTime.

The hardware counter uses the trigger comparator output. Therefore, the counted 
channel's trigger level (or threshold for digital channels) must be set correctly. The 
Y cursor shows the threshold level used in the measurement.

Analog and digital channels can be selected as the source.

Figure 50 Isolating an event for Frequency measurement
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Only one Counter measurement can be displayed at a time.

This counter is different than the one that comes with the DVM (see "Counter" on 
page 334).

+ Width

+ Width is the time from the middle threshold of the rising edge to the middle 
threshold of the next falling edge. The X cursors show the pulse being measured. 
The Y cursor shows the middle threshold point.

– Width

– Width is the time from the middle threshold of the falling edge to the middle 
threshold of the next rising edge. The X cursors show the pulse being measured. 
The Y cursor shows the middle threshold point.

Burst Width

The Burst Width measurement is the time from the first edge to the last edge on 
screen.

Duty Cycle

The duty cycle of a repetitive pulse train is the ratio of the pulse width to the 
period, expressed as a percentage. The X cursors show the time period being 
measured. The Y cursor shows the middle threshold point.

Burst width

+ Duty cycle = + Width
Period

× 100 − Duty cycle = − Width
Period

× 100
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Bit Rate

The bit rate measurement measures all positive and negative pulse widths on the 
waveform, takes the minimum value found of either width type and inverts that 
minimum width to give a value in Hertz.

Rise Time

The rise time of a signal is the time difference between the crossing of the lower 
threshold and the crossing of the upper threshold for a positive-going edge. The X 
cursor shows the edge being measured. For maximum measurement accuracy, set 
the horizontal time/div as fast as possible while leaving the complete rising edge 
of the waveform on the display. The Y cursors show the lower and upper threshold 
points.

Fall Time

The fall time of a signal is the time difference between the crossing of the upper 
threshold and the crossing of the lower threshold for a negative-going edge. The X 
cursor shows the edge being measured. For maximum measurement accuracy, set 
the horizontal time/div as fast as possible while leaving the complete falling edge 
of the waveform on the display. The Y cursors show the lower and upper threshold 
points.

Time at Edge

Time at Edge measures the horizontal time of the edge location specified by the 
Source, Slope, and Edge # parameters.

The threshold voltage used for this measurement is the 50% point with a small 
amount of hysteresis added. (The "middle" measurement threshold setting for the 
source waveform does not affect this measurement.)

When the specified slope and edge number threshold crossing is found, the 
oscilloscope reports the time of that crossing in seconds, with the trigger point 
(time=zero) as the reference.

If the specified crossing cannot be found, that is, if the waveform does not cross 
the 50% vertical value, or if the waveform does not cross the 50% vertical value for 
the specific number of times at the slope specified, the oscilloscope reports "No 
edges".
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When Auto is selected as the Edge #, the edge closest to the timebase reference 
point is used. When you specify an edge number, edges are counted from the left 
side of the display.

FFT (Fast Fourier Transform) waveforms cannot be selected as the source.

Delay

Delay measures the time difference between two waveform edges using the 
specified threshold points of the waveforms.

Negative delay values indicate that the selected edge of source 1 occurred after 
the selected edge of source 2.

1 Press the [Meas] key to display the Measurement Menu.

2 Press the Add Meas softkey.

3 Press the Type: softkey; then, turn the Entry knob to select Delay.

4 Click the Parameter softkey; then, select and specify the following parameters:

• Source 1, Source 2 — waveform source.

• Source 1 Slope, Source 2 Slope — rising edge or falling edge.

• Source 1 Edge #, Source 2 Edge # — edge number for the selected source.

When Auto is selected for the Source 1 Edge #, the edge closest to the 
timebase reference point is used. Auto is also automatically selected for the 
Source 2 Edge #, and cannot be changed. In this case, the source 2 edge 
closest to the source 1 edge is used.

When edge numbers are selected, edges are counted from the left side of 
the display for both sources.

• Source 1 Threshold, Source 2 Threshold — specifies whether the measurement 
should be made using the Upper, Middle, or Lower threshold level on the 
source.

5 Press the Add Measurement softkey to make the measurement.

The example below shows a delay measurement between the rising edge of 
channel 1 and the rising edge of channel 2.

Source 2

Source 1

Delay
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Phase

Phase is the calculated phase shift from source 1 to source 2, expressed in 
degrees. Negative phase shift values indicate that the rising edge of source 1 
occurred after the rising edge of source 2.

1 Press the [Meas] key to display the Measurement Menu.

Phase =
Delay

Source 1 Period
× 360

Source 2

Source 1
Delay

Period
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2 Press the Add Meas softkey.

3 Press the Type: softkey; then, turn the Entry knob to select Phase.

4 Click the Parameter softkey; then, select and specify the following parameters:

• Source 1

• Source 2

The default Phase settings measure from channel 1 to channel 2.

5 Press the Add Measurement softkey to make the measurement.

The example below shows a phase measurement between the channel 1 and the 
math d/dt function on channel 1.
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X at Min Y

X at Min Y is the X axis value (usually time) at the first displayed occurrence of the 
waveform Minimum, starting from the left-side of the display. For periodic signals, 
the position of the minimum may vary throughout the waveform. The X cursor 
shows where the current X at Min Y value is being measured.

X at Max Y

X at Max Y is the X axis value (usually time) at the first displayed occurrence of the 
waveform Maximum, starting from the left-side of the display. For periodic signals, 
the position of the maximum may vary throughout the waveform. The X cursor 
shows where the current X at Max Y value is being measured.

See Also • "To measure the peak of an FFT" on page 278

To measure the peak of an FFT

1 Select FFT as the Operator in the Waveform Math Menu.

2 Choose Math N as the source in the Measurement Menu.

3 Choose Maximum and X at Max Y measurements.

Maximum units are in dB and X at Max Y units are in Hertz for FFT.

See Also • "Searching for FFT Peaks" on page 110

Count Measurements

• "Positive Pulse Count" on page 278

• "Negative Pulse Count" on page 279

• "Rising Edge Count" on page 279

• "Falling Edges Count" on page 279

Positive Pulse Count

The Positive Pulse Count measurement is a pulse count for the selected waveform 
source.



Measurements 14

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 279

 

Negative Pulse Count

The Negative Pulse Count measurement is a pulse count for the selected waveform 
source.

Rising Edge Count

The Rising Edge Count measurement is an edge count for the selected waveform 
source.

This measurement is available for analog channels.

Falling Edges Count

The Falling Edges Count measurement is an edge count for the selected waveform 
source.

This measurement is available for analog channels.

Positive pulse count

Negative pulse count
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Mixed Measurements

• "Area" on page 280

Area

Area measures the area between the waveform and the ground level. Area below 
the ground level is subtracted from area above the ground level.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an integral 
number of periods of the displayed signal. If less than three edges are present, the 
measurement shows "No edges".

The X cursors show what interval of the waveform is being measured.

Slew Rate

Slew Rate measures the change in vertical value (ΔY) divided by the change in 
horizontal value (ΔX) for the edge closest to the timebase reference point specified 
by the Source and Slope parameters.

The lower and upper thresholds for the measurement are specified by the 
measurement threshold setting for the source waveform.

FFT (Fast Fourier Transform) waveforms cannot be selected as the source.

T

Negative area
N cycles

Positive area
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FFT Analysis Measurements

• "Channel Power" on page 281

• "Occupied Bandwidth" on page 281

• "Adjacent Channel Power Ratio (ACPR)" on page 281

• "Total Harmonic Distortion (THD)" on page 282

Channel Power

Channel Power measures the spectral power across a frequency range.

The center frequency used in the measurement is the one defined for the FFT 
function, and the FFT span specifies the frequency range.

When this measurement is tracked with cursors, the cursors are at the far left and 
right edges of the graticule.

Occupied Bandwidth

Occupied Bandwidth measures the bandwidth (frequency range) containing some 
percent (usually 99%) of the total spectral power. While 99% is the industry norm, 
you can specify the percent you want to use in the measurement.

The center frequency used in the measurement is the one defined for the FFT 
function, and the FFT span represents the total spectral power.

When this measurement is tracked with cursors, the cursors show the measured 
bandwidth (frequency range).

Adjacent Channel Power Ratio (ACPR)

Adjacent Channel Power Ratio or just Adjacent Power Ratio (or channel leakage 
ratio) measures the ratio of the power contained in one or more sidebands to the 
power in the main frequency range.

The main range is specified by a channel width and a center frequency. The 
Channel Width is one of the measurement's parameters. The center frequency 
used in the measurement is the one defined for the FFT function.

Sidebands (with the same width as the main range) exist above and below the 
main range separated by the channel spacing width. The Channel Spacing width 
is another measurement parameter.
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The sideband used for the measurement is selected with the Channel Select 
parameter. You can select the first through fifth sidebands above or below the 
main range (1H through 5H above and 1L through 5L below). The full sideband 
must be in the graticule to be measured. Otherwise, the measurement results will 
be "Incomplete".

When this measurement is tracked with cursors, the cursors show the sideband 
being measured.

Total Harmonic Distortion (THD)

Total Harmonic Distortion (THD) is the ratio of power in the fundamental frequency to 
the power contained in the rest of the harmonics and noise. THD is a measure of 
signal purity.

Total Harmonic Distortion (THD) measures the power contained in the bands 
surrounding each harmonic and compares it to the power in the band surrounding 
the fundamental frequency. The width of the bands measured is the same for the 
fundamental frequency and each harmonic. That width is 1/2 of the fundamental 
frequency.

Main 1H 2H 3H 4H 5H5L 4L 3L 2L 1L

WidthSpacing
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You can either enter the fundamental frequency as a measurement parameter and 
have the fundamental frequency and harmonics be tracked manually, or you can 
allow the fundamental frequency and harmonics to be tracked automatically, 
where the highest peak is assumed to be the fundamental frequency.

When this measurement is tracked with cursors, the cursors show the band 
surrounding the fundamental frequency that is being measured (at ±1/4 of the 
fundamental frequency).

Measurement Thresholds

Setting measurement thresholds defines the vertical levels where measurements 
will be taken on an analog channel or math waveform.

1 From the Measurement Menu, press the Thresholds softkey to set analog 
channel measurement thresholds.

You can also open the Measurement Threshold Menu by pressing [Analyze] > 
Features and then selecting Measurement Thresholds.

2 Press the Source softkey to select the analog channel or math waveform source 
for which you want to change measurement thresholds.

Each analog channel and the math waveform can be assigned unique threshold 
values.

3 Press the Type softkey to set the measurement threshold to % (percentage of 
Top and Base value) or to Absolute (absolute value).

• Percentage thresholds can be set from 0% to 100%.

NOTE Changing default thresholds may change measurement results

The default lower, middle, and upper threshold values are 10%, 50%, and 90% of the value 
between Top and Base. Changing these threshold definitions from the default values may 
change the returned measurement results for Average, Delay, Duty Cycle, Fall Time, 
Frequency, Overshoot, Period, Phase, Preshoot, Rise Time, +Width, and -Width.
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• The units for absolute threshold for each channel is set in the channel probe 
menu.

4 Press the Lower softkey; then, turn the Entry knob to set the lower measurement 
threshold value.

Increasing the lower value beyond the set middle value will automatically 
increase the middle value to be more than the lower value. The default lower 
threshold is 10% or 800 mV.

If threshold Type is set to %, the lower threshold value can be set from 0% to 
98%.

5 Press the Middle softkey; then, turn the Entry knob to set the middle 
measurement threshold value.

The middle value is bounded by the values set for lower and upper thresholds. 
The default middle threshold is 50% or 1.20 V.

• If threshold Type is set to %, the middle threshold value can be set from 1% to 
99%.

6 Press the Upper softkey; then, turn the Entry knob to set the upper 
measurement threshold value.

Decreasing the upper value below the set middle value will automatically 
decrease the middle value to be less than the upper value. The default upper 
threshold is 90% or 1.50 V.

• If threshold Type is set to %, the upper threshold value can be set from 2% to 
100%.

TIP Absolute threshold hints

• Absolute thresholds are dependent on channel scaling, probe attenuation, and probe units. Always 
set these values first before setting absolute thresholds.

• The minimum and maximum threshold values are limited to on-screen values.

• If any of the absolute threshold values are above or below the minimum or maximum waveform 
values, the measurement may not be valid.
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Measurement Window

You can choose whether measurements are made in the Main window portion of 
the display, the Zoom window portion of the display (when the zoomed time base 
is displayed), or gated by the X1 and X2 cursors.

1 Press the [Meas] key.

2 In the Measurement Menu, press the Meas Window softkey; then, turn the Entry 
knob to select from:

• Auto Select — When the zoomed time base is displayed, the measurement is 
attempted in the lower, Zoom window; if it cannot be made there, or if the 
zoomed time base is not displayed, the Main window is used.

• Main — The measurement window is the Main window.

• Zoom — The measurement window is the lower, Zoom window.

• Gated by Cursors — The measurement window is between the X1 and X2 
cursors. When the zoomed time base is displayed, the X1 and X2 cursors in 
the Zoom window portion of the display are used.

Measurement Statistics

To display measurement statistics:

1 Press the [Meas] key to enter the Measurement Menu. By default frequency and 
peak-to-peak voltage are measured on channel 1.

2 Select the measurements you desire for the channels you are using (see 
"Measurements Summary" on page 258).

3 From the Measurement Menu, press the Statistics softkey to enter the Statistics 
Menu.

4 Press the Display On softkey to enable the measurement statistics display.
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The source channel of the measurement is shown in parenthesis after the 
measurement name. For example: "Freq(1)" indicates a frequency measurement 
on channel 1.

The following statistics are shown: Name of the measurement, current 
measured value, mean, minimum measured value, maximum measured value, 
standard deviation, and the number of times the measurement has been made 
(count). Statistics are based on the total number of captured waveforms 
(count).

The standard deviation shown in Statistics is calculated using the same formula 
used for calculating the standard deviation measurement. The formula is shown 
in the section titled "AC RMS" on page 268.

You can press the Display On softkey again to disable the measurement statistics 
display. Statistics continue to accumulate even when the statistics display is 
disabled.

5 To reset the statistics measurements, press the Reset Statistics softkey. This 
resets all statistics and begins recording statistical data again.
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Each time a new measurement (for example: frequency, period, or amplitude) is 
added the statistics are reset and accumulation of statistical data begins again.

6 To enable a relative standard deviation, press the Relative σ softkey.

When enabled, the standard deviation shown in measurement statistics 
becomes the standard deviation/mean.

7 To specify the number of values used when calculating measurement statistics, 
press the Max Count softkey and enter the desired value.

Statistics are calculated on the most recent "N" number of values, where N is 
the either the total number of acquisitions measured or a limited Max Count 
number of acquisitions measured.

Other things to know about measurement statistics:

• When the [Single] key is pressed, statistics are reset and a single measurement 
is done (count = 1). Successive [Single] acquisitions accumulate statistical data 
(and the count is incremented).

• The Increment Statistics softkey only appears when the acquisition is stopped 
and the optional segmented memory feature is off. Press the [Single] or 
[Run/Stop] key to stop the acquisition. You can use the horizontal position 
control (in the Horizontal control section of the front panel) to pan through the 
waveform. Active measurements will stay on screen, allowing you to measure 
various aspects of the captured waveforms. Press Increment Statistics to add the 
currently measured waveform to the collected statistical data.

• The Analyze Segments softkey only appears when the acquisition is stopped and 
the optional segmented memory feature is on. After an acquisition has 
completed (and the oscilloscope is stopped), you can press the Analyze 
Segments softkey to accumulate measurement statistics for the acquired 
segments.

You can also turn on infinite persistence (in the Display Menu) and press the 
Analyze Segments softkey to create an infinite persistence display.

Measurement Limit Testing

The Measurement Limit Test feature is enabled with any bundled software license 
that includes mask testing.
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This feature lets you test measurement values to see whether they are inside or 
outside specified limits. You can display limit test results, and you can stop 
running oscilloscope acquisitions when there is a failure. You can specify whether 
measured values inside the limits or outside the limits are considered failures.

To enable measurement limit testing:

1 First, add the measurements whose limits you want to test.

2 Press the [Analyze] key.

3 Press Features; then, select Measurement Limit Test.

4 Press Features again to enable measurement limit testing.

Measurement limit results are reset whenever Measurement Limit Test is 
switched on using the Limit softkey.

To add measurements to the limit test, specify limits, and specify whether failures 
are inside or outside the limits:

1 In the Analyze menu, press Setup.

2 In the Limit Test Setup menu, press Measurement; then, select the measurement 
you want to include. Press Measurement again or select the measurement again 
to enable it.

3 Use the Lower Limit and Upper Limit softkeys to enter the measurement limits.

You can set the limits to the last measured value plus or minus a percent 
margin by using the Copy Margin softkey to specify the percent margin; then, 
press Copy From Results to set the Lower Limit and Upper Limit values.

4 Use the Fail When softkey to select whether failures are Outside Limits or Inside 
Limits.

Repeate the previous steps for each measuremement you want to include in the 
limit test.
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For each enabled measurement, these values are displayed:

• Measurement name (and source channel number)

• The minimum measured value

• The maximum measured value

• The number of failures on the lower limit

• The number of failures on the upper limit

• The number of times the measurement has been made (count)

The source channel of the measurement is shown in parenthesis after the 
measurement name. For example, "Freq(1)" indicates a frequency measurement 
on channel 1.

Counts, failures, and minimum and maximum values continue to be accumulated 
whether the limit test information is displayed or not.

Clicking in the measurement limit test results dialog box opens a popup menu 
where you can clear the measurement limit results and perform other related 
tasks.

To stop running acquisitions when there are measurement limit test failures:

1 In the Analyze menu, press Stop On Failure to enable it.

Precision Measurements and Math

Normally, after pressing [Default Setup], the oscilloscope performs measurements 
and generates math waveforms using a 65535-point (maximum) measurement 
record. This measurement record is purposely small in order to provide high 
waveform update rates and minimal "dead time" between acquisitions to improve 
the probability of capturing infrequent events.

However, at the expense of waveform update rate, you can enable precision 
measurements and math waveforms that use a user-selectable 100k-point to 
1M-point (maximum) record. This mode gives you better resolution on 
measurements and math waveforms (including FFT).

To enable precision measurements and math:

1 Press the [Analyze] key.

2 Press Features; then, select Precision.
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3 Press Features again to enable precision measurements and math waveforms.

4 Press the Rec Length softkey and turn the Entry knob (or press the softkey again 
for a keypad entry dialog) to specify the length of the precision analysis record.

You can specify between 100k and 1M points.

Precision measurements and math are disabled in the same way, or you can 
disable them by pressing the [Default Setup] key.
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15 Histogram
Waveform Histogram Set Up / 292
Measurement Histogram Set Up / 296
Histogram Data Graph / 297
Histogram Data Statistics / 298

The histogram analysis feature provides a statistical view of a waveform or a 
measurement's results.

Waveform histograms show the number of times a waveform crosses into (or hits) 
a row or column of a user-defined window. For vertical histograms, the window is 
divided into rows. For horizontal histograms, the window is divided into columns.

Measurement histograms show the distribution of a measurement's results similar 
to ordinary measurement statistics.

As waveforms are acquired and displayed, or as measurements are made, a 
counter database accumulates the total number of hits (or measurements), and 
the histogram data is displayed as a bar graph on the graticule.

When the oscilloscope is stopped, that counter database remains intact until the 
acquired data display is modified, usually horizontally or vertically. At that time, 
the database is reset and the last displayed acquisition is used to start a new 
database.

Histogram results statistics are displayed in a sidebar Hist dialog.

The following screen shows a horizontal histogram looking at edge times:
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Histogram
Interaction With

Other Oscilloscope
Features

When you enable a histogram, horizontal zoom, XY time mode, or roll time mode 
are automatically disabled.

When using segmented memory acquisitions, histograms perform similarly to 
math waveforms and measurements. The histogram is reset at the start of a 
segmented acquisition and all segments are histogrammed at the end of the 
acquisition.

Because it is not possible to histogram every waveform, be aware that persistence 
can show a peak or glitch that does not show up in the histogram data.

Histograms do not wait for the specified number of averaged acquisitions to be 
acquired before starting analysis, so intermediate results could be erratic.

Waveform Histogram Set Up

To set up a waveform histogram:

1 Press the [Analyze] key.
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2 Press Features; then, select Histogram.

3 Press Features again to enable the histogram.

4 Press the Type softkey and turn the Entry knob to select:

• Horizontal — the limits window is divided into columns, and the number of 
hits in each column is displayed in a histogram bar graph at the bottom of 
the graticule.

• Vertical — the limits window is divided into rows, and the number of hits in 
each row is displayed in a histogram bar graph at the left of the graticule.

5 Press the Source softkey to select the analog channel, running math function, 
reference waveform, or color grade analysis to analyze.

6 Define the limits window in which waveform crossings (hits) are measured. See 
"Defining the Histogram Limits Window" on page 294.

7 Press the Histogram Size softkey and specify the number of divisions the 
histogram bar graph should use:

• For horizontal histograms, you can choose whole and half divisions from 1 to 
4.

• For vertical histograms, you can choose whole and half divisions from 1 to 5.

You can press the Reset Histogram softkey to zero the histogram counters.

The following screen shows a vertical histogram of auto-triggered noise — note 
the Gaussian distribution:
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Defining the Histogram Limits Window

You can define the histogram limits window by drawing a rectangle on the screen:

1 Touch the upper-right corner to select the rectangle draw mode.

2 Drag your finger (or connected USB mouse pointer) across the screen to draw a 
rectangular zone that the waveform must either intersect or not intersect.

3 Take your finger off the screen (or release the mouse button).

4 Choose Histogram from the popup menu.
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You can also define the histogram limits window by selecting the default window 
(which is six divisions tall and eight divisions wide, centered on the graticule):

1 First, set up the horizontal and vertical scaling so that the waveform of interest 
is centered in the graticule.

2 Press [Analyze] > Features; then, select and enable Histogram.

3 Press the Limits softkey.

The Limits softkey is active when the Type is Horizontal or Vertical.

4 In the Histogram Limits Menu, press the Default Window softkey.

When the Histogram Limits Menu is being displayed, you can adjust the limits 
window by dragging its touch handles. The upper left corner touch handle moves 
the window, and the lower right corner touch handle changes the size of the 
window.
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You can also adjust the size and location of the limits window by using the Top 
Limit, Bottom Limit, Left Limit, or Right Limit softkeys and the Entry knob or keypad 
dialogs.

Measurement Histogram Set Up

To set up a measurement histogram:

1 First, add the measurement whose results you want to display as a histogram. 
See "To make automatic measurements" on page 256.

2 Press the [Analyze] key.

3 Press Features; then, select Histogram.

4 Press Features again to enable the histogram.
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5 Press the Type softkey and turn the Entry knob to select:

• Measurements — shows the distribution of a measurement's results similar to 
ordinary measurement statistics.

6 Press the Measurement softkey to select the measurement to analyze.

7 Press the Histogram Size softkey and specify the number of divisions the 
histogram bar graph should use. You can choose whole and half divisions from 
1 to 4.

For measurement histograms, information about the scale of the bar graph 
appears above the softkeys. This scale is automatically determined.

You can press the Reset Histogram softkey to zero the histogram counters.

Histogram Data Graph

The visual component of a histogram is the bar graph on the display.

This graph appears on the left side of the graticule area for a vertical waveform 
histogram or on the graticule bottom for a horizontal waveform histogram or a 
measurement histogram.

For measurement histograms, information about the scale of the bar graph 
appears above the softkeys. This scale is automatically determined.

As waveforms are acquired and displayed, or as measurements are made, the bar 
graph scale changes so that the peak number of hits is displayed at the histogram 
size specified.

The Reset Histogram softkey zeros the histogram counters.

Cursors on
Histogram Data

When the histogram analysis feature is enabled and when cursors are in Manual or 
Track Waveform mode, Histogram is added to the list of sources you can select for 
cursors.

If you are doing a measurement on a histogram, cursors track that measurement 
on the histogram waveform.
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When cursors are in the Track Waveform mode, the X or the Y cursor is moveable 
depending on whether the histogram type is horizontal, vertical, or measurement.

Histogram Data Statistics

Histogram data results are displayed in the Hist sidebar dialog (which can be 
selected from the right-hand sidebar menu — see "Select Sidebar Information or 
Controls" on page 54 and "Undock Sidebar Dialogs by Dragging" on page 55).

There are several standard results that can be derived from the histogram 
database.

The basic units of histograms are hits, and there are some results that are 
expressed as hits:

• Hits — The sum of all bins (buckets) in the histogram.

• Peak — Maximum number of hits in any single bin.
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Some results are expressed in the source's (vertical, horizontal or measurement) 
units:

• Max — The value corresponding to the maximum bin that has any hits.

• Min — The value corresponding to the minimum bin that has any hits.

• Pk-Pk — Delta between the Max and Min.

• Mean — Mean of the histogram.

• Median — Median of the histogram.

• Mode — Mode of the histogram.

• Bin Width — The width of each bin (bucket) in the histogram.

• Std Dev — Standard deviation of the histogram.

Some results are derived from other results:

• u±1σ — Percentage of histogram hits that lie within ±1 Std Dev of the mean.

• u±2σ — Percentage of histogram hits that lie within ±2 Std Dev of the mean.

• u±3σ — Percentage of histogram hits that lie within ±3 Std Dev of the mean.

NOTE You can touch any of the individual entries in the sidebar and reset the histogram results.
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16 Color Grade Waveform
Enabling a Color Grade Waveform / 302
Color Grade Themes / 304

The color grade analysis feature shows how often a waveform crosses into (or hits) 
pixels on the display. As waveforms are acquired and displayed, a counter 
database accumulates the number of hits, and pixels in the color grade analysis 
waveform are displayed using one of seven graduated colors that indicate a 
relative number of hits. You can choose temperature or intensity color grade 
scales (themes).

When the oscilloscope is stopped, the counter database remains intact until the 
acquired data display is modified, usually horizontally or vertically. At that time, 
the database is reset and the last displayed acquisition is used to start a new 
database.

The following screen shows a color grade analysis waveform for channel 2:
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The color grade analysis display is updated every second or so.

Over time, you can see the nominal waveform as well as the waveform's envelope.

When any of the database counters saturate, the message The color grade database 
is saturated is displayed above the softkeys in the in the color grade analysis menu.

Color grade analysis works best on repetitive waveforms.

Color Grade
Interaction With

Other Oscilloscope
Features

When you enable a color grade waveform display, horizontal zoom, XY time mode, 
or roll time mode are automatically disabled.

Enabling a Color Grade Waveform

To set up color grade analysis of a waveform:

1 Press the [Analyze] key.
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2 Press Features; then, select Color Grade.

3 Press Features again to enable the color grade waveform display.

4 Press the Source softkey to select the analog channel, running math function, or 
reference waveform to analyze.

5 Press the Show Color Key softkey to see the color grade theme's seven colors 
and the range of database counts that each color represents.

6 Press the Theme softkey and select Intensity or Temperature. For a description of 
the colors used in these themes, see "Color Grade Themes" on page 304.

You can press the Reset Color Grade softkey to zero the color grade counters.

Changing the horizontal time/div or delay settings, or the channel's vertical V/div 
or offset settings, or the source waveform will also zero the color grade counters.
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Color Grade Themes

When color grade analysis is enabled, a database is created that has the same 
number of memory locations as there are pixel locations in the waveform viewing 
area. Each database memory location is a counter. These counters are 
incremented when sampled waveform data crosses (or "hits") the associated pixel.

The color grade theme specifies seven colors that represent the ranges of counter 
values (hits) in the database. The color used for the greatest number of hits (white 
in both themes) represents pixels with the greatest number to about half that 
number. The next color represents half as many hits, and so on, until the last range 
(green in the "intensity" theme or dark blue in the "temperature" theme) represents 
the remaining range of hits.

The following table shows the approximate counter ranges of each color in the 
Intensity and Temperature color grade themes.

Color Grade Theme Range (MH = most hits)

Intensity Temperature Upper Limit to Lower Limit (0 if Upper 
Limit is 0, Else)

MH to MH/2

MH/2 to MH/4

MH/4 to MH/8

MH/8 to MH/16

MH/16 to MH/32

MH/32 to MH/64

MH/64 to 1
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17 Jitter and Real-Time Eye 
Analysis
Setting Up Jitter Analysis / 306
Jitter Measurements / 309
Real-Time Eye Analysis / 313

Jitter analysis measures the variance of a measurement over time. The principal 
measurement used with jitter analysis is time interval error (TIE), but several other 
measurements can be analyzed as well.

The TIE measurement recovers an ideal clock frequency from the source waveform 
and compares it against measured transitions to generate error statistics. Several 
different clock recovery methods are available.

Jitter measurements can be visualized in these ways:

• Meas Histogram — Shows the distribution of jitter measurement results. 
Gaussian distributions indicate random jitter. Non-Gaussian distributions 
usually indicate that the jitter has deterministic components. Measurement 
statistics are displayed along with the histogram.

• Meas Trend — Shows the trend of jitter measurement results. The trend 
waveform over a greater time can show shapes or patterns that indicate what 
might be affecting jitter.

• Jitter Spectrum — Shows the jitter measurement trend in the frequency 
domain. Spikes in the FFT show frequencies of what might be affecting jitter.
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For more information, see Measuring Jitter in Digital Systems, Application Note 
(http://literature.cdn.keysight.com/litweb/pdf/5988-9109EN.pdf)

Setting Up Jitter Analysis

To set up jitter analysis:

1 Press the [Jitter] key.

2 In the Jitter Configuration dialog, select Enable Jitter Analysis.

When jitter analysis is enabled, the [Jitter] key is lit, and these oscilloscope 
settings are forced on:

• Precision measurements with a 1M precision analysis record length (see 
"Precision Measurements and Math" on page 289), which gives better 
accuracy.

http://literature.cdn.keysight.com/litweb/pdf/5988-9109EN.pdf
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• All edges in each acquisition are measured (instead of a single edge per 
acquisition, as is normally the case). For each acquisition, the measurement 
count increases by the number of edges in the acquisition. This applies to all 
measurements that look at edges, not just jitter analysis measurements.

3 To change the measurement thresholds settings, touch Measurement 
Thresholds... and use the softkeys in the Measurement Threshold Menu to 
change the settings (see "Measurement Thresholds" on page 283).

NOTE It is important to set up absolute thresholds for the integrity of jitter measurements from 
acquisition to acquisition.
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4 To add a jitter measurement:

a Touch Add Measurement...; then, select the jitter measurement you want from 
the popup menu.

b In the Measurement dialog, select the Source to be measured and select any 
other measurement options (see "Jitter Measurements" on page 309 or 
"Duty Cycle" on page 273).

The source can be analog channels, math waveforms, or reference 
waveforms.

c Touch OK.

When jitter analysis is enabled, you can also add or modify jitter measurements 
using the [Meas] key and the Measurement Menu (see "To make automatic 
measurements" on page 256).

5 Back in the Jitter Configuration dialog, touch the Analysis Measurement 
drop-down and choose the jitter measurement you want to analyze.

6 In the Auto Setup & Configuration area, set up the jitter measurement visualization 
options using these controls:

• Meas Histogram — The Auto Setup control enables a histogram on the selected 
jitter analysis measurement. The settings control opens the softkey 
histogram analysis menu (see "Measurement Histogram Set Up" on 
page 296).

• Meas Trend — The Auto Setup control sets up a measurement trend waveform 
on the selected jitter analysis measurement. The settings control opens the 
softkey menu for the measurement trend math waveform (see 
"Measurement Trend" on page 125).

• Jitter Spectrum — The Auto Setup control sets up an FFT of the measurement 
trend waveform on the selected jitter measurement. The settings control 
opens the softkey menu for the FFT math waveform (see "FFT Magnitude, 
FFT Phase" on page 105).

Note that another math function is set up to perform smoothing on the 
measurement trend waveform. You can change the FFT's source to be the 
smoothed trend waveform if you like.

7 When you are done setting up the jitter analysis options, press the [Jitter] key 
again to close the Jitter Configuration dialog.

To disable jitter analysis:
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1 In the Jitter Configuration dialog (press the [Jitter] key if the dialog is not 
currently displayed), deselect Enable Jitter Analysis.

When jitter analysis is disabled:

• The light behind the [Jitter] key is turned off.

• The "precision measurements" and 1M precision analysis record length 
settings are returned to the settings present when jitter analysis was 
enabled.

• The oscilloscope returns to measuring a specific edge in each acquisition 
(generally around the horizontal time reference) and ignoring all other edges 
in the acquisition, as is normally the case. For each acquisition, the 
measurement count increases by one.

Jitter Measurements

• "Data TIE" on page 309

• "Clock TIE" on page 310

• "N-Period" on page 310

• "Period-Period" on page 311

• "+Width to +Width" on page 312

• "-Width to -Width" on page 312

Data TIE

The Data TIE (Time Interval Error) jitter measurement compares edges in a data 
signal with the edges in an ideal data signal determined by the clock recovery 
feature (see "Setting Up Clock Recovery" on page 132).

Once the ideal data rate is determined, all of the data intervals are measured with 
respect to the ideal data rate and the error statistics are computed. The following 
figure shows how the Data TIE is measured on rising edges of the data.
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The measurement is made on all the cycles of the waveform. Even in Zoom mode, 
all the cycles of the waveform in the Main window will be measured.

Clock TIE

The Clock TIE (Time Interval Error) jitter measurement compares edges in a clock 
signal with the edges in an ideal clock signal determined by the clock recovery 
feature (see "Setting Up Clock Recovery" on page 132). You can measure rising, 
falling, or both rising and falling edges.

Once the ideal clock frequency is determined, all of the cycles of your waveform 
are compared to the ideal clock frequency and the error statistics are computed. 
The following figure shows how the Clock TIE is measured on rising edges of the 
clock.

The measurement is made on all the cycles of the waveform. Even in Zoom mode, 
all the cycles of the waveform in the Main window will be measured.

N-Period

The N-Period jitter measurement measures the time span of N consecutive 
periods. Then, it shifts ahead one period and measures the time span of the next N 
consecutive periods, and so on.

Data TIE

Measured Data

Ideal Clock

t1 t2 t3

Clock TIE

Measured Clock

Ideal Clock

t2t1 t3 t4 t5 t6
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Period-Period

The Period-Period jitter measurement takes a group of cycles and measures the 
period from the first edge of the first cycle of the group to the final edge of the last 
cycle of the group. The N-period of the first group is measured and subtracted 
from the N-period of the second group. After shifting ahead one cycle the next 
measurement is made. The following figure shows how an N-cycle jitter 
measurement is made for N=3.

Once all of the groups of cycles of the waveform are measured, the statistics are 
calculated. The statistics are the values accumulated over all of the trigger cycles 
that have occurred.

To perform a cycle-cycle jitter measurement, use Period-Period and set N=1.

The measurement is made on all the cycles of the waveform. Even in Zoom mode, 
all the cycles of the waveform in the Main window will be measured.

N = 3

Period 1

Period 2

N = 3

Period 1

Period 3

Period 2

Period 4

1st Measurement = Period 2 - Period 1

2nd Measurement = Period 4 - Period 3
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+Width to +Width

The +Width to +Width jitter measurement subtracts the first cycle's positive pulse 
width from the second cycle's positive pulse width for the first measurement 
result. Then, the second cycle's positive pulse width is subtracted from the third 
cycle's positive pulse width for the second measurement result, and so on, until all 
of the cycles of the waveform have been measured. The following figure shows the 
first two +Width to +Width measurements.

All of the measurement results are used to compute the statistics. The statistics 
are the values accumulated over all of the trigger cycles that have occurred.

The measurement is made on all the cycles of the waveform. Even in Zoom mode, 
all the cycles of the waveform in the Main window will be measured.

-Width to -Width

The -Width to -Width jitter measurement subtracts the first cycle's negative pulse 
width from the second cycle's negative pulse width for the first measurement 
result. Then, the second cycle's negative pulse width is subtracted from the third 
cycle's negative pulse width for the second measurement result, and so on, until 
all of the cycles of the waveform have been measured. The following figure shows 
the first two -Width to -Width measurements.

+Width1 +Width2
1st Measurement = +Width2 - +Width1

+Width2 +Width3
2nd Measurement = +Width3 - +Width2



Jitter and Real-Time Eye Analysis 17

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 313

 

All of the measurement results are used to compute the statistics. The statistics 
are the values accumulated over all of the trigger cycles that have occurred.

The measurement is made on all the cycles of the waveform. Even in Zoom mode, 
all the cycles of the waveform in the Main window will be measured.

Real-Time Eye Analysis

When the jitter analysis feature is licensed, you can also perform real-time eye 
analysis.

An eye diagram is a view of a signal in which the waveform is triggered using its 
data rate. A real-time eye accomplishes this by acquiring data, performing clock 
recovery, then superimposing (folding) successive unit intervals within a single 
plot. This is a statistical view in the form of a color grade.

When real-time eye analysis is enabled, the color grade analysis feature is no 
longer available.

Mask testing and unfolding the real-time eye (features available with real-time 
eyes on other Keysight oscilloscopes) are not available on this oscilloscope.

To set up real-time eye analysis of a waveform:

1 Press the [Analyze] key.

2 Press Features; then, select Real-Time Eye.

3 Press Features again to enable the real-time eye display.

-Width1 -Width2
1st Measurement = -Width2 - -Width1

-Width2 -Width3
2nd Measurement = -Width3 - -Width2
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4 Press the Source softkey to select the analog channel to analyze.

5 Press the Clock Recovery... softkey to open a dialog where you can set up the 
clock recovery feature (see "Setting Up Clock Recovery" on page 132).

6 Press the Thresholds softkey and use the softkeys in the Measurement Threshold 
Menu to change the settings (see "Measurement Thresholds" on page 283).

7 Press the Color Grade softkey and use the softkeys in the Color Grade Setup 
Menu to change the settings (see Chapter 16, “Color Grade Waveform,” 
starting on page 301).

8 Adjust the oscilloscope's horizontal scale.

9 To begin making acquisitions, press the Auto Setup softkey.

When building the real-time eye, full-length acquisitions are used to get the 
largest acquisition record possible, resulting in the most accurate clock 
recovery and eye measurements possible.
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10 To stop real-time eye analysis acquisitions, press the [Stop] front panel key.

When real-time eye analysis is enabled, you can press the [Meas] key, select Color 
Grade as the measurement source, and add these real-time eye measurements 
(made using the color grade database):

• Eye Height — the vertical opening of an eye diagram. The opening at the center 
time reference is reported.

• Eye Width — the horizontal opening of an eye diagram. The largest opening 
within the crossings is reported.

To clear the real-time eye analysis, press the Reset Color Grade softkey in the Color 
Grade Setup Menu.
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18 Mask Testing
To create a mask from a "golden" waveform (Automask) / 317
Mask Test Setup Options / 319
Mask Statistics / 322
To manually modify a mask file / 323
Building a Mask File / 327

One way to verify a waveform's compliance to a particular set of parameters is to 
use mask testing. A mask defines a region of the oscilloscope's display in which 
the waveform must remain in order to comply with chosen parameters. 
Compliance to the mask is verified point-by-point across the display. Mask test 
operates on displayed analog channels; it does not operate on channels that are 
not displayed.

Mask test is a license-enabled feature.

To create a mask from a "golden" waveform (Automask)

A golden waveform meets all chosen parameters, and it is the waveform to which 
all others will be compared.

1 Configure the oscilloscope to display the golden waveform.

2 Press the [Analyze] key.

3 Press Features; then, select Mask Test.

4 Press Features again to enable mask testing.
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5 Press Automask.

6 In the Automask Menu, press the Source softkey and ensure the desired analog 
channel is selected.

7 Adjust the mask's horizontal tolerance (± Y) and vertical tolerance (± X). These 
are adjustable in graticule divisions or in absolute units (volts or seconds), 
selectable using the Units softkey.

8 Press the Create Mask softkey.

The mask is created and testing begins.

Whenever the Create Mask softkey is pressed the old mask is erased and a new 
mask is created.
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9 To clear the mask and switch off mask testing, press the Back/Up key to 
return to the Mask Test Menu, then press the Clear Mask softkey.

If infinite persistence display mode (see "To set or clear persistence" on page 167) 
is "on" when mask test is enabled, it stays on. If infinite persistence is "off" when 
mask test is enabled, it is switched on when mask test is switched on, then infinite 
persistence is switched off when mask test is switched off.

Troubleshooting
Mask Setup

If you press Create Mask and the mask appears to cover the entire screen, check the 
± Y and ± X settings in the Automask Menu. If these are set to zero the resulting 
mask will be extremely tight around the waveform.

If you press Create Mask and it appears that no mask was created, check the ± Y 
and ± X settings. They may be set so large that the mask is not visible.

Mask Test Setup Options

From the Mask Test Menu, press the Setup softkey to enter the Mask Setup Menu.

Back
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Run Until The Run Until softkey lets you specify a condition on which to terminate testing.

• Forever — The oscilloscope runs continuously. However, if an error occurs the 
action specified using the On Error softkey will occur.

• Minimum # of Tests — Choose this option and then use the # of Tests softkey 
to select the number of times the oscilloscope will trigger, display the 
waveform(s), and compare them to the mask. The oscilloscope will stop after 
the specified number of tests have been completed. The specified minimum 
number of tests may be exceeded. If an error occurs the action specified 
using the On Error softkey will occur. The actual number of tests completed 
is displayed above the softkeys.

• Minimum Time — Choose this option and then use the Test Time softkey to 
select how long the oscilloscope will run. When the selected time has passed 
the oscilloscope will stop. The specified time may be exceeded. If an error 
occurs the action specified using the On Error softkey will occur. The actual 
test time is displayed above the softkeys.

• Minimum Sigma — Choose this option and then use the Sigma softkey to 
select a minimum sigma. The mask test runs until enough waveforms are 
tested to achieve a minimum test sigma. (If an error occurs the oscilloscope 
will perform the action specified by the On Error softkey.) Note that this is a 
test sigma (the max achievable process sigma, assuming no defects, for a 
certain number of tested waveforms) as opposed to a process sigma (which is 
tied to the amount of failures per test). The sigma value may exceed the 
selected value when a small sigma value is chosen. The actual sigma is 
displayed.
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On Error The On Error setting specifies the action(s) to take when the input waveform 
does not conform to the mask. This setting supersedes the Run Until setting.

• Stop — The oscilloscope will stop when the first error is detected (on the first 
waveform that does not conform to the mask). This setting supersedes the 
Minimum # of Tests and Minimum Time settings.

• Save — The oscilloscope saves the screen image when an error is detected. In 
the Save Menu (press [Save/Recall] > Save), select an image format (*.bmp 
or *.png), destination (on a USB storage device), and file name (which can be 
auto-incrementing). If errors occur too frequently and the oscilloscope 
spends all its time saving images, press the [Stop] key to stop acquisitions.

• Print — The oscilloscope prints the screen image when an error is detected. 
This option is only available when a printer is connected as described in "To 
print the oscilloscope's display" on page 379.

• Measure — Measurements (and measurement statistics if your oscilloscope 
supports them) run only on waveforms that contain a mask violation. 
Measurements are not affected by passing waveforms. This mode is not 
available when the acquisition mode is set to Averaging.

Note that you can choose to Print or Save, but you cannot select both at the 
same time. All other actions may be selected at the same time. For example, you 
can select both Stop and Measure to cause the oscilloscope to measure and 
stop on the first error..

You can also output a signal on the rear panel TRIG OUT BNC connector when 
there is a mask test failure. See "Setting the Rear Panel TRIG OUT 
Source" on page 396.

Source Lock When you turn on Source Lock using the Source Lock softkey, the mask is 
redrawn to match the source whenever you move the waveform. For example, if 
you change the horizontal timebase or the vertical gain the mask is redrawn with 
the new settings.

When you turn off Source Lock, the mask is not redrawn when horizontal or 
vertical settings are changed.

Source If you change the Source channel, the mask is not erased. It is re-scaled to the 
vertical gain and offset settings of the channel to which it is assigned. To create 
a new mask for the selected source channel, go back up in the menu hierarchy; 
then, press Automask, and press Create Mask.

The Source softkey in the Mask Setup Menu is the same as the Source softkey in 
the Automask Menu.

Test All When enabled, all displayed analog channels are included in the mask test. 
When disabled, just the selected source channel is included in the test.
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Mask Statistics

From the Mask Test Menu, press the Statistics softkey to enter the Mask Statistics 
Menu.
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To manually modify a mask file

You can manually modify a mask file that you created using the Automask 
function.

1 Follow the steps 1-7 in "To create a mask from a "golden" waveform 
(Automask)" on page 317. Do not clear the mask after creating it.

2 Attach a USB mass storage device to the oscilloscope.

3 Press the [Save/Recall] key.

4 Press the Save softkey.

5 Press the Format softkey and select Mask.

6 Press the second softkey and select a destination folder on your USB mass 
storage device.

Show Stats When you enable Show Statistics the following information is displayed:

• Current mask, name of mask, Channel number, date and time.

• # of Tests (total number of mask tests executed).

• Status (Passing, Failing, or Untested).

• Accumulated test time (in hours, minutes, seconds, and tenths of seconds).

And for each analog channel:

• Number of failures (acquisitions in which the signal excursion went beyond 
the mask).

• Failure rate (percentage of failures).

• Sigma (the ratio of process sigma to maximum achievable sigma, based on 
number of waveforms tested).

Reset Statistics Note that statistics are also reset when:

• Mask Test is switched on after being switched off.

• Clear Mask softkey is pressed.

• An Automask is created.

Additionally, the accumulated time counter is reset whenever the oscilloscope 
is run after the acquisition was stopped.

Clear Display Clears acquisition data from the oscilloscope display.
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7 Press the Press to Save softkey. This creates an ASCII text file that describes the 
mask.

8 Remove the USB mass storage device and connect it to a PC.

9 Open the .msk file your created using a text editor (such as Wordpad).

10 Edit, save, and close the file.

The mask file contains the following sections:

• Mask File Identifier.

• Mask Title.

• Mask Violation Regions.

• Oscilloscope Setup Information.

Mask File Identifier The Mask File Identifier is MASK_FILE_548XX.

Mask Title The Mask Title is a string of ASCII characters. Example: autoMask CH1 OCT 03 
09:40:26 2008

When a mask file contains the keyword "autoMask" in the title, the edge of the 
mask is passing by definition. Otherwise, the edge of the mask is defined as a 
failure.
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Mask Violation
Regions

Up to 8 regions can be defined for a mask. They can be numbered 1-8. They can 
appear in any order in the .msk file. The numbering of the regions must go from 
top to bottom, left to right.

An Automask file contains two special regions: the region "glued" to the top of the 
display, and the region that is "glued" to the bottom. The top region is indicated by 
y-values of "MAX" for the first and last points. The bottom region is indicated by 
y-values of "MIN" for the first and last points.

The top region must be the lowest numbered region in the file. The bottom region 
must be the highest numbered region in the file.

Region number 1 is the top mask region. The vertices in Region 1 describe points 
along a line; that line is the bottom edge of the top portion of the mask.

Similarly, the vertices in Region 2 describe the line that forms the top of the 
bottom part of the mask.

The vertices in a mask file are normalized. There are four parameters that define 
how values are normalized:

Region 1

Region 2
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• X1

• ΔX

• Y1

• Y2

These four parameters are defined in the Oscilloscope Setup portion of the mask 
file.

The Y-values (normally voltage) are normalized in the file using the following 
equation:

Ynorm = (Y - Y1)/ΔY

where ΔY = Y2 - Y1

To convert the normalized Y-values in the mask file to voltage:

Y = (Ynorm * ΔY) + Y1

where ΔY = Y2 - Y1

The X-values (normally time) are normalized in the file using the following 
equation:

Xnorm = (X - X1)/ΔX

To convert the normalized X-values to time:

X = (Xnorm * ΔX) + X1

Oscilloscope
Setup Information

The keywords "setup" and "end_setup" (appearing alone on a line) define the 
beginning and end of the oscilloscope setup region of the mask file. The 
oscilloscope setup information contains remote programming language 
commands that the oscilloscope executes when the mask file is loaded.

Any legal remote programming command can be entered in this section.

The mask scaling controls how the normalized vectors are interpreted. This in turn 
controls how the mask is drawn on the display. The remote programming 
commands that control mask scaling are:
:MTES:SCAL:BIND 0
:MTES:SCAL:X1 -400.000E-06
:MTES:SCAL:XDEL +800.000E-06
:MTES:SCAL:Y1 +359.000E-03
:MTES:SCAL:Y2 +2.35900E+00
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Building a Mask File

The following display shows a mask that uses all eight regions.

This mask is created by recalling the following mask file:
MASK_FILE_548XX

"All Regions"

/* Region Number */ 1
/* Number of vertices */ 4
-12.50, MAX
-10.00, 1.750
10.00, 1.750
12.50, MAX

/* Region Number */ 2
/* Number of vertices */ 5
-10.00, 1.000
-12.50, 0.500
-15.00, 0.500
-15.00, 1.500
-12.50, 1.500
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/* Region Number */ 3
/* Number of vertices */ 6
-05.00, 1.000
-02.50, 0.500
02.50, 0.500
05.00, 1.000
02.50, 1.500
-02.50, 1.500

/* Region Number */ 4
/* Number of vertices */ 5
10.00, 1.000
12.50, 0.500
15.00, 0.500
15.00, 1.500
12.50, 1.500

/* Region Number */ 5
/* Number of vertices */ 5
-10.00, -1.000
-12.50, -0.500
-15.00, -0.500
-15.00, -1.500
-12.50, -1.500

/* Region Number */ 6
/* Number of vertices */ 6
-05.00, -1.000
-02.50, -0.500
02.50, -0.500
05.00, -1.000
02.50, -1.500
-02.50, -1.500

/* Region Number */ 7
/* Number of vertices */ 5
10.00, -1.000
12.50, -0.500
15.00, -0.500
15.00, -1.500
12.50, -1.500

/* Region Number */ 8
/* Number of vertices */ 4
-12.50, MIN
-10.00, -1.750
10.00, -1.750
12.50, MIN

setup
:CHANnel1:RANGe +8.00E+00
:CHANnel1:OFFSet +2.0E+00
:CHANnel1:DISPlay 1
:TIMebase:MODE MAIN
:TIMebase:REFerence CENTer
:TIMebase:RANGe +50.00E-09
:TIMebase:POSition +10.0E-09
:MTESt:SOURce CHANnel1
:MTESt:ENABle 1
:MTESt:LOCK 1
:MTESt:SCALe:X1 +10.0E-09
:MTESt:SCALe:XDELta +1.0000E-09
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:MTESt:SCALe:Y1 +2.0E+00
:MTESt:SCALe:Y2 +4.00000E+00
end_setup

In a mask file, all region definitions need to be separated by a blank line.

Mask regions are defined by a number of (x,y) coordinate vertices (as on an 
ordinary x,y graph). A "y" value of "MAX" specifies the top of the graticule, and a 
"y" value of "MIN" specifies the bottom of the graticule.

The mask x,y graph is related to the oscilloscope graticule using the 
:MTESt:SCALe setup commands.

The oscilloscope's graticule has a time reference location (at the left, center, or 
right of the screen) and a trigger (t=0) position/delay value relative to the 
reference. The graticule also has a vertical ground 0 V reference (offset relative to 
the center of the screen) location.

The X1 and Y1 setup commands relate the mask region's x,y graph origin to the 
oscilloscope graticule's t=0 and V=0 reference locations, and the XDELta and Y2 
setup commands specify the size of the graph's x and y units.

• The X1 setup command specifies the time location of the x,y graph's x origin.

• The Y1 setup command specifies the vertical location of the x,y graph's y origin.

• The XDELta setup command specifies the amount of time associated with each 
x unit.

• The Y2 setup command is the vertical location of the x,y graph's y=1 value (so 
in effect, Y2 – Y1 is the YDELta value).

For example:

• With a graticule whose trigger position is 10 ns (before a center screen 
reference) and whose ground reference (offset) is 2 V below the center of the 
screen, to place the mask region's x,y graph's origin at center screen, you would 
set X1 = 10 ns and Y1 = 2 V.

• If the XDELta parameter is set to 5 ns and Y2 is set to 4 V, a mask region whose 
vertices are (-1, 1), (1, 1), (1, -1), and (-1, -1) goes from 5 ns to 15 ns and from 
0 V to 4 V.

NOTE If there are more than 1000 vertices in a mask region, only the first 1000 vertices will be 
processed.
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• If you move the mask region's x,y graph origin to the t=0 and V=0 location by 
setting X1 = 0 and Y1 = 0, the same vertices define a region that goes from 
-5 ns to 5 ns and from -2 V to 2 V.

How is mask testing done?

InfiniiVision oscilloscopes start mask testing by creating a database that is 200 x 
640 for the waveform viewing area. Each location in the array is designated as 
either a violation or a pass area. Each time a data point from a waveform occurs in 
a violation area a failure is logged. If Test All was selected, every active analog 
channel is tested against the mask database for each acquisition. Over 2 billion 
failures can be logged per-channel. The number of acquisitions tested is also 
logged and displayed as "# of Tests".

The mask file allows greater resolution than the 200 X 640 database. Some 
quantization of data occurs to reduce the mask file data for display on-screen.

NOTE Although a mask can have up to 8 regions, in any given vertical column, it is only possible to 
define 4 regions. When there are 4 regions in a vertical column, one region must be tied to the 
top (using the MAX y value) and one must be tied to the bottom (using the MIN y value).
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19 Digital Voltmeter and 
Counter
Digital Voltmeter / 332
Counter / 334

The Digital Voltmeter (DVM) and Counter analysis features are standard on the 
6000 X-Series oscilloscopes.
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Digital Voltmeter

The digital voltmeter (DVM) analysis feature provides 3-digit voltage 
measurements on any analog channel. DVM measurements are asynchronous 
from the oscilloscope's acquisition system and are always acquiring.

The DVM display is a seven-segment readout like you would see on a digital 
voltmeter. It shows the selected mode as well as the units. Units are selected 
using the Units softkey in the channel's Probe Menu.

The DVM display also has a scale that is determined by the channel's vertical scale 
and reference level. The scale's blue triangle pointer shows the most recent 
measurement. The white bar above that shows the measurement extrema over the 
last 3 seconds.
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The DVM makes accurate RMS measurements when the signal frequency is 
between 20 Hz and 2 kHz. When the signal frequency is outside this range, "<BW 
Limit?" or ">BW Limit?" appears in the DVM display to caution you about 
inaccurate RMS measurement results.

To use the digital voltmeter:

1 Press the [Analyze] key.

2 Press Features; then, select Digital Voltmeter.

3 Press Features again to enable the DVM measurements.

4 Press the Source softkey and turn the Entry knob to select the analog channel 
on which digital voltmeter (DVM) measurements are made.

The selected channel does not have to be on (displaying a waveform) in order 
for DVM measurements to be made.

5 Press the Mode softkey and turn the Entry knob to select the digital voltmeter 
(DVM) mode:

• AC RMS — displays the root-mean-square value of the acquired data, with 
the DC component removed.

• DC — displays the DC value of the acquired data.

• DC RMS — displays the root-mean-square value of the acquired data.

6 If the selected source channel is not used in oscilloscope triggering, press Auto 
Range to disable or enable automatic adjustment of the DVM channel's vertical 
scale, vertical (ground level) position, and trigger (threshold voltage) level (used 
for the counter frequency measurement).

When enabled, Auto Range overrides attempted adjustments of the channel's 
vertical scale and position knobs.

When disabled, you can use the channel's vertical scale and position knobs 
normally.

7 Press the Limits softkey to open the DVM Beep Limit Menu where you can 
specify voltage reading limits that will cause the oscilloscope to beep.
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• Press the Beep softkey to enable/disable beeps when the specified digital 
voltmeter reading limits occur.

• Press the Beep When softkey to select whether the oscilloscope should beep 
when Within Limits or Outside Limits.

• Press the Lower Limit and Upper Limit softkeys and use the Entry knob to 
adjust the lower limit of the DVM reading range. You can press these 
softkeys again for a keypad entry dialog that lets you enter an exact value.

Counter

The counter analysis feature provides frequency, period, or edge event (totalize) 
counter measurements on any analog channel.

The counter counts trigger level crossings within a certain amount of time (gate 
time) and displays the results on a seven-segment readout (like you would see on 
a standalone counter instrument).

For frequency and period counter measurements:

• The gate time is specified indirectly by the selected number of digits of 
resolution, from 3 to 10. For higher resolutions, the gate time is greater.

• Up to 3.2 GHz (4 GHz typical) frequencies can be measured, unless high-speed 
USB decoding is active, in which case, up to 1 GHz (1.2 GHz typical) 
frequencies can be measured.

For totalize measurements:

• A running count of edges is kept. You can choose whether to count positive or 
negative edges, and when edge triggering on any analog channel, you can gate 
the count with a positive or negative pulse on a second analog channel.

• Edge events with up to 1 GHz (1.2 GHz typical) frequencies can be counted.

• When gating the count, the gating signal setup time is 500 ps typical and the 
hold time is 500 ps typical when using similar probes for the totalize source and 
the gate source.

The counter is asynchronous from the oscilloscope's acquisition system and is 
always acquiring.
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To use the counter:

1 Press the [Analyze] key.

2 Press Features; then, select Counter.

3 Press Features again to enable the counter.

4 Press the Source softkey and turn the Entry knob to select the analog channel or 
Trigger Qualified Event signal to make counter measurements on.

With the Trigger Qualified Event source, you can see how often trigger events are 
detected. This can be more often than when triggers actually occur, due to the 
oscilloscope's acquisition time or update rate capabilities. The TRIG OUT signal 
shows when triggers actually occur. Remember that the oscilloscope's trigger 
circuitry does not re-arm until the holdoff time occurs and that the minimum 
holdoff time is 40 ns; therefore, the maximum trigger qualified event frequency 
that can be counted is 25 MHz.

The selected channel does not have to be on (displaying a waveform) in order 
for counter measurements to be made.

5 Press Auto Setup Threshold softkey to have the oscilloscope automatically 
determine and set the threshold voltage (trigger) level for the selected analog 
channel source.

6 Press the Measure softkey and turn the Entry knob to select what the counter 
measures:

• Frequency — the cycles per second (Hz, kHz, or MHz) of the signal.

• Period — the time periods of the signal's cycles.

• Totalize — the count of edge events on the signal.

Frequency and
Period Counter

For frequency and period measurements, press the # of Digits softkey to specify the 
resolution of the counter. You can choose from 3 to 10 digit resolutions.

Higher resolutions require longer gate times, which cause the measurement times 
to be longer as well.

Totalize Counter For (edge event) totalize measurements, press the Clear Count softkey to zero the 
edge event counter.

Press the Totalize softkey to open the Counter Totalize Menu where you can:
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• Press the Source softkey and turn the Entry knob to change the analog channel 
on which counter measurements are made.

• Press the Event Slope softkey to choose whether positive or negative edge 
events are counted.

• Press the Gate softkey to enable or disable gating of the edge event count using 
a positive or negative level on a second analog channel.

When gating is enabled:

a Press the Gate Source softkey and turn the Entry knob to select the analog 
channel that will supply the gating signal.

The selected channel does not have to be on (displaying a waveform).

b Press the polarity softkey to choose whether positive or negative levels are 
used to gate the edge event count.

The trigger level for the selected analog channel is used to determine the 
polarity of the signal.
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20 Frequency Response 
Analysis
To make connections / 337
To set up and run the analysis / 338
To view and save the analysis results / 340

Frequency Response Analysis (FRA) is a licensed feature.

The Frequency Response Analysis (FRA) feature controls the built-in waveform 
generator to sweep a sine wave across a range of frequencies while measuring the 
input to and output from a device under test (DUT). At each frequency, gain (A) 
and phase are measured and plotted on a frequency response Bode chart.

When the frequency response analysis completes, you can move a marker across 
the chart to see the measured gain and phase values at each frequency point. You 
can also adjust the chart's scale and offset settings for the gain and phase plots.

To make connections

The waveform generator output is connected to a device under test (DUT). The 
input to the device and the output from the device are probed by the 
oscilloscope's input channels.
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 To set up and run the analysis

1 Choose Main Menu > Analyze > Analyze Menu.

2 Click Features; then, select Frequency Response Analysis.

3 Click Features again to enable the feature.

4 Click the Open Dialog... softkey to open the Frequency Response Analysis dialog 
box.

5 Select the setup tab on the left side of the dialog box (gear icon).

DUT
(Transfer Function)

Input Output

Wave
Gen

1 2 3 4

Oscilloscope
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There are settings for:

• The start and stop frequencies in the sweep, as well as the number of points 
per decade.

• The channels probing the input and output. (Click the help icon to view a 
connection diagram.)

• The waveform generator amplitude and expected output load impedance.

To specify different amplitudes for different decades, select Amplitude Profile.

The output impedance of the Gen Out signal is fixed at 50 ohms. However, 
the output load selection lets the waveform generator display the correct 
amplitude and offset levels for the expected output load. If the actual load 
impedance is different than the selected value, the displayed amplitude and 
offset levels will be incorrect.

6 Click the Run Analysis softkey.
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To view and save the analysis results

If the Frequency Response Analysis dialog box is not open, click the Open Dialog... 
softkey.

Select the plot tab on the left side of the dialog box (plot icon) to view the analysis 
results in a Bode plot.

The plot shows both gain and phase measurements versus frequency. There are 
two markers that can be dragged to view actual values along the plot. There is a 
control in the upper right corner for enabling or disabling the gain or phase plots, 
adjusting the scale/offset of the plots, or autoscaling.

There are also Chart Controls softkeys for making chart adjustments using the Entry 
knob or keypad dialog boxes. You can use these softkeys to adjust the gain scale 
and offset, phase scale and offset, frequency scale (starting and ending 
frequencies), or marker 1 and marker 2 positions.
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Select the table tab on the left side of the dialog box (table icon) to view the 
analysis results in table form.

The table shows: the data point number, the frequency, the waveform generator 
output amplitude, the measured gain, and the measured phase. You can scroll the 
data. There is a menu control in the upper right corner for enabling or disabling 
the gain or phase table data.

You can save (or e-mail) the analysis results by choosing Main Menu > File > 
Save Menu, clicking Format, and selecting the Frequency Response Analysis data (*.csv) 
option.
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21 Waveform Generator
To select generated waveform types and settings / 343
To edit arbitrary waveforms / 347
Output Settings / 354
To use waveform generator logic presets / 356
To add noise to the waveform generator output / 357
To add modulation to the waveform generator output / 358
To restore waveform generator defaults / 363
To set up dual channel tracking / 363

A waveform generator is built into the oscilloscope. It is enabled by Option WGN 
or the DSOX6WAVEGEN2 upgrade. The waveform generator gives you an easy 
way to provide input signals when testing circuitry with the oscilloscope.

Waveform generator settings can be saved and recalled with oscilloscope setups. 
See Chapter 22, “Save/Email/Recall (Setups, Screens, Data),” starting on page 
365.

To select generated waveform types and settings

1 To access the Waveform Generator Menu and enable or disable the waveform 
generator output on the front panel Gen Out BNC, press the [Wave Gen] key.

When waveform generator output is enabled, the [Wave Gen] key is illuminated. 
When waveform generator output is disabled, the [Wave Gen] key is off.

The waveform generator output is always disabled when the instrument is first 
turned on.
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The waveform generator output is automatically disabled if excessive voltage is 
applied to the Gen Out BNC.

2 In the Waveform Generator Menu, press the Waveform softkey and turn the 
Entry knob to select the waveform type.

3 Depending on the selected waveform type, use the remaining softkeys and the 
Entry knob to set the waveform's characteristics.
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Waveform 
Type

Characteristics Frequency 
Range

Max. 
Amplitude2 
(High-Z) 1

Offset2 
(High-Z)1

Arbitrary Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, and Offset/Low-Level 
softkeys to set the arbitrary waveform signal 
parameters.

Use the Edit Waveform softkey to define the 
arbitrary waveform shape. See "To edit arbitrary 
waveforms" on page 347.

100 mHz to 
12 MHz

20 mVpp to 
10 Vpp

±5.00 V

Sine Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, and Offset/Low-Level 
softkeys to set the sine signal parameters.

100 mHz to 
20 MHz

20 mVpp to 
10 Vpp

±4.00 V

Square Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, Offset/Low-Level, and 
Duty Cycle softkeys to set the square wave signal 
parameters.

The duty cycle can be adjusted from 20% to 80%.

100 mHz to 
10 MHz

20 mVpp to 
10 Vpp

±5.00 V

Ramp Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, Offset/Low-Level, and 
Symmetry softkeys to set the ramp signal 
parameters.

Symmetry represents the amount of time per cycle 
that the ramp waveform is rising and can be 
adjusted from 0% to 100%.

100 mHz to 
200 kHz

20 mVpp to 
10 Vpp

±5.00 V

Pulse Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, Offset/Low-Level, and 
Width/Width Fine softkeys to set the pulse signal 
parameters.

The pulse width can be adjusted from 20 ns to the 
period minus 20 ns.

100 mHz to 
10 MHz.

20 mVpp to 
10 Vpp

±5.00 V

DC Use the Offset softkey to set the DC level. n/a n/a ±10.00 V

Noise Use the Amplitude/High-Level and 
Offset/Low-Level to set the noise signal parameters.

n/a 20 mVpp to 
10 Vpp

±5.00 V

Sine Cardinal Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude, and Offset softkeys to set the sinc 
signal parameters.

100 mHz to 
1 MHz

20 mVpp to 
9 Vpp

±2.50 V
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Pressing a signal parameter softkey can open a menu for selecting the type of 
adjustment. For example, you can choose to enter amplitude and offset values, 
or you can choose to enter high-level and low-level values. Or, you can choose 
to enter frequency values or period values. Keep pressing the softkey to select 
the type of adjustment. Turn the Entry knob to adjust the value.

Also note that you can set up the other waveform generator output to track 
frequency, amplitude, offset, and duty cycle adjustments. See "To set up dual 
channel tracking" on page 363.

The Settings softkey opens the Waveform Generator Settings Menu which lets you 
make other settings related to the waveform generator.

Exponential 
Rise

Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, and Offset/Low-Level 
softkeys to set the exponential rise signal 
parameters.

100 mHz to 
5 MHz

20 mVpp to 
10 Vpp

±5.00 V

Exponential 
Fall

Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude/High-Level, and Offset/Low-Level 
softkeys to set the exponential fall signal 
parameters.

100 mHz to 
5 MHz

20 mVpp to 
10 Vpp

±5.00 V

Cardiac Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude, and Offset softkeys to set the 
cardiac signal parameters.

100 mHz to 
200 kHz

20 mVpp to 
9 Vpp

±2.50 V

Gaussian Pulse Use the Frequency/Frequency Fine/Period/Period 
Fine, Amplitude, and Offset softkeys to set the 
Gaussian pulse signal parameters.

100 mHz to 
5 MHz

20 mVpp to 
7.5 Vpp

±2.50 V

1When the output load is 50 Ω, these values are halved.

2The minimum amplitude is limited to 40 mVpp if the offset is greater than 500 mV or less than -500 mV. Likewise, the offset is 
limited to +/-500 mV if the amplitude is less than 40 mVpp.

Waveform 
Type

Characteristics Frequency 
Range

Max. 
Amplitude2 
(High-Z) 1

Offset2 
(High-Z)1
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See:

• "To output the waveform generator sync pulse" on page 356

• "To specify the expected output load" on page 355

• "To use waveform generator logic presets" on page 356

• "To set up dual channel tracking" on page 363

• "To add modulation to the waveform generator output" on page 358

• "To add noise to the waveform generator output" on page 357

• "To restore waveform generator defaults" on page 363

To edit arbitrary waveforms

1 When Arbitrary is selected as the generated waveform type (see "To select 
generated waveform types and settings" on page 343), press the Edit Waveform 
softkey to open the Edit Waveform Menu.
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When you open the Edit Waveform Menu, you see the existing arbitrary 
waveform definition. The voltage and time period you see in the diagram are 
the bounding parameters — they come from the frequency and amplitude 
settings in the main Waveform Generator Menu.

2 Use the softkeys in the Edit Waveform Menu to define the shape of the arbitrary 
waveform:

Creating New Arbitrary Waveforms

The New Waveform Menu is opened by pressing Create New in the Edit Waveform 
Menu.

Softkey Description

Create New Opens the New Waveform Menu. See "Creating New Arbitrary Waveforms" on page 348.

Edit Existing Opens the Edit Waveform Points Menu. See "Editing Existing Arbitrary Waveforms" on 
page 349.

Interpolate Specifies how lines are drawn between arbitrary waveform points.

When enabled, lines are drawn between points in the waveform editor. Voltage levels change 
linearly between one point and the next.

When disabled, all line segments in the waveform editor are horizontal. The voltage level of 
one point remains until the next point.

Source Selects the analog channel or reference waveform to be captured and stored to the arbitrary 
waveform. See "Capturing Other Waveforms to the Arbitrary Waveform" on 
page 354.

Store Source to Arb Captures the selected waveform source and copy it to the arbitrary waveform. See 
"Capturing Other Waveforms to the Arbitrary Waveform" on page 354.

NOTE You can use the [Save/Recall] key and menu to save arbitrary waveforms to one of four 
internal storage locations or to a USB storage device, and you can recall them later. See "To 
save arbitrary waveforms" on page 373 and "To recall arbitrary waveforms" on 
page 377.
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To create a new arbitrary waveform:

1 In the New Waveform Menu, press Initial Pts; then, use the Entry knob to select 
the initial number of points in the new waveform.

The new waveform will be a square wave with the number of points you specify. 
The points are evenly spaced over the time period.

2 Use the Frequency/Frequency Fine/Period/Period Fine softkey to set the time period 
bounding parameter (repetition frequency) of the arbitrary waveform.

3 Use the Amplitude/High-Level and Offset/Low-Level softkeys to set the voltage 
bounding parameter of the arbitrary waveform.

4 When you are ready to create the new arbitrary waveform, press Apply & Edit.

The new waveform is created and the Edit Waveform Points menu is opened. 
See "Editing Existing Arbitrary Waveforms" on page 349.

Note that you can also create a new arbitrary waveform by capturing another 
waveform. See "Capturing Other Waveforms to the Arbitrary Waveform" on 
page 354.

Editing Existing Arbitrary Waveforms

Using the
Touchscreen to

Edit Existing
Waveforms

To select a point, touch or drag in the upper, full waveform display:

CAUTION When you create a new arbitrary waveform, the existing arbitrary waveform definition is 
overwritten. Note that you can use the [Save/Recall] key and menu to save arbitrary 
waveforms to one of four internal storage locations or to a USB storage device, and you 
can recall them later. See "To save arbitrary waveforms" on page 373 and "To 
recall arbitrary waveforms" on page 377.
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For fine points selection, touch the previous point or next point arrows:

To adjust the value of a point, drag the voltage level handle up or down:
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To select a points region, drag across the upper or lower waveform display:

For fine adjustment of the region selection (or to clear the selection), use the 
Selected Region controls:

To perform points operations, touch the Operation controls drop-down, select the 
operation, and use the controls for the selected operation:

• Cut/Copy selected points regions to the clipboard and Paste points from the 
clipboard.

When pasting points from the clipboard, you can paste at the beginning, end, 
cursor location (currently selected point), or you can replace the currently 
selected points region.

• Insert New points.
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You can specify the number of new points and their voltage.

• Replace a selected points region with new points.

• Delete a selected points region.

To navigate the arbitrary waveform (and select points), drag the point selection 
handle left or right across the display area:

Using Softkeys to
Edit Existing
Waveforms

The Edit Waveform Points Menu is opened by pressing Edit Existing in the Edit 
Waveform Menu or by pressing Apply & Edit when creating a new arbitrary 
waveform.
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To specify the voltage values of points:

1 Press Point #; then, use the Entry knob to select the point whose voltage value 
you wish to set.

2 Press Voltage; then, use the Entry knob to set the point's voltage value.

To insert a point:

1 Press Point #; then, use the Entry knob to select the point after which the new 
point will be inserted.

2 Press Insert Point.

All points are adjusted to maintain uniform time spacing between points.

To remove a point:

1 Press Point #; then, use the Entry knob to select the point you want to remove.

2 Press Remove Point.

All points are adjusted to maintain uniform time spacing between points.
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Capturing Other Waveforms to the Arbitrary Waveform

The Edit Waveform Menu is opened by pressing Edit Waveform in the main 
Waveform Generator Menu.

To capture another waveform to the arbitrary waveform:

1 Press Source; then, use the Entry knob to select the analog channel, math, or 
reference location whose waveform you wish to capture.

2 Press Store Source to Arb.

The source waveform is decimated into 8192 (maximum) or fewer arbitrary 
waveform points.

Output Settings

• "To specify the expected output load" on page 355

• "To invert the waveform generator output" on page 355

• "To output a single-shot waveform" on page 355

• "To output the waveform generator sync pulse" on page 356

CAUTION When you create a new arbitrary waveform, the existing arbitrary waveform definition is 
overwritten. Note that you can use the [Save/Recall] key and menu to save arbitrary 
waveforms to one of four internal storage locations or to a USB storage device, and you 
can recall them later. See "To save arbitrary waveforms" on page 373 and "To 
recall arbitrary waveforms" on page 377.

NOTE If the source waveform frequency and/or voltage exceed the capabilities of the waveform 
generator, the arbitrary waveform will be limited to the capabilities of the waveform 
generator. For example, a 20 MHz waveform captured as the arbitrary waveform, becomes a 
12 MHz waveform.
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To specify the expected output load

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Out Load softkey and turn 
the Entry knob to select:

• 50 Ω

• High-Z

The output impedance of the Gen Out BNC is fixed at 50 ohms. However, the 
output load selection lets the waveform generator display the correct amplitude 
and offset levels for the expected output load.

If the actual load impedance is different than the selected value, the displayed 
amplitude and offset levels will be incorrect.

To invert the waveform generator output

You can invert the shape of the generated waveform output:

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, click the Settings softkey.

3 In the Waveform Generator Settings Menu, click the Output Settings softkey.

4 In the Waveform Generator Output Settings Menu, click the Invert Output 
softkey to enable or disable an inverted output.

The waveform's offset is not inverted.

To output a single-shot waveform

You can set up the waveform generator to output one cycle of the defined 
waveform:

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, click the Settings softkey.

3 In the Waveform Generator Settings Menu, click the Output Settings softkey.
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4 In the Waveform Generator Output Settings Menu, click the Output Mode softkey 
and select Single-Shot.

5 Click the Transmit Single-Shot softkey.

This will output one cycle of the defined waveform.

Clicking this softkey multiple times will interrupt a slow signal output before its 
cycle is completed.

Note that the transmit single-shot action can also be mapped to the [Utility] > 
Quick Action menu item (see "Configuring the [Quick Action] Key" on page 407) 
or as a control in the sidebar Controls dialog box (see "Select Sidebar 
Information or Controls" on page 54).

To return to normal waveform generator output, click the Output Mode softkey and 
select Normal.

To output the waveform generator sync pulse

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Trig Out softkey and turn 
the Entry knob to select Waveform Generator Sync Pulse.

To use waveform generator logic presets

With logic level presets, you can easily set the output voltage to TTL, CMOS 
(5.0V), CMOS (3.3V), CMOS (2.5V), or ECL compatible Low and High levels.

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

Waveform Type Sync Signal Characteristics

All waveforms except 
DC, Noise, and 
Cardiac

The Sync signal is a TTL positive pulse that occurs when the waveform 
rises above zero volts (or the DC offset value).

DC, Noise, and 
Cardiac

N/A
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2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Logic Presets softkey.

4 In the Waveform Generator Logic Level Presets Menu, press one of the softkeys 
to set the generated signal's Low and High voltages to logic compatible levels:

To add noise to the waveform generator output

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Add Noise softkey and turn 
the Entry knob to select the amount of white noise to add to the waveform 
generator output.

Note that adding noise affects edge triggering on the waveform generator source 
(see "Edge Trigger" on page 184) as well as the waveform generator sync pulse 
output signal (which can be sent to TRIG OUT, see "Setting the Rear Panel TRIG 
OUT Source" on page 396). This is because the trigger comparator is located after 
the noise source.

Softkey (logic levels) Low level High level

TTL 0 V +5 V (or a TTL-compatible 
high level if +5 V cannot 
be reached)

CMOS (5.0V) 0 V +5 V

CMOS (3.3V) 0 V +3.3 V

CMOS (2.5V) 0 V +2.5 V

ECL -1.7 V -0.9 V
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To add modulation to the waveform generator output

Modulation is where an original carrier signal is modified according to the 
amplitude of a second modulating signal. The modulation type (AM, FM, or FSK) 
specifies how the carrier signal is modified.

Modulated waveforms are available on the WaveGen1 output.

To enable and set up modulation for the waveform generator output:

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Modulation softkey.

4 In the Waveform Generator Modulation Menu:

• Press the Modulation softkey to enable or disable modulated waveform 
generator output.

You can enable modulation for all waveform generator function types except 
arbitrary, square, pulse, DC, noise, and Gaussian pulse.

Modulation is not available when waveform generator dual channel tracking 
is being used.

• Press the Type softkey and turn the Entry knob to select the modulation type:

• Amplitude Modulation (AM) — the amplitude of the original carrier signal is 
modified according to the amplitude of the modulating signal. See "To 
set up Amplitude Modulation (AM)" on page 359.

• Frequency Modulation (FM) — the frequency of the original carrier signal is 
modified according to the amplitude of the modulating signal. See "To 
set up Frequency Modulation (FM)" on page 360.

• Frequency-Shift Keying Modulation (FSK) — the output frequency "shifts" 
between the original carrier frequency and a "hop frequency" at the 
specified FSK rate. The FSK rate specifies a digital square wave 
modulating signal. See "To set up Frequency-Shift Keying Modulation 
(FSK)" on page 362.
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To set up Amplitude Modulation (AM)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Amplitude Modulation 
(AM).

2 Press the Waveform softkey and turn the Entry knob to select the shape of the 
modulating signal:

• Sine

• Square

• Ramp

When the Ramp shape is selected, a Symmetry softkey appears so that you can 
specify the amount of time per cycle that the ramp waveform is rising.

3 Press the AM Freq softkey and turn the Entry knob to specify the frequency of 
the modulating signal.

4 Press the AM Depth softkey and turn the Entry knob to specify the amount of 
amplitude modulation.

AM Depth refers to the portion of the amplitude range that will be used by the 
modulation. For example, a depth setting of 80% causes the output amplitude 
to vary from 10% to 90% (90% – 10% = 80%) of the original amplitude as the 
modulating signal goes from its minimum to maximum amplitude.

The following screen shows an AM modulation of a 100 kHz sine wave carrier 
signal.
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To set up Frequency Modulation (FM)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency Modulation 
(FM).

2 Press the Waveform softkey and turn the Entry knob to select the shape of the 
modulating signal:

• Sine

• Square

• Ramp

When the Ramp shape is selected, a Symmetry softkey appears so that you can 
specify the amount of time per cycle that the ramp waveform is rising.

3 Press the FM Freq softkey and turn the Entry knob to specify the frequency of the 
modulating signal.
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4 Press the FM Dev softkey and turn the Entry knob to specify the frequency 
deviation from the original carrier signal frequency.

When the modulating signal is at its maximum amplitude, the output frequency 
is the carrier signal frequency plus the deviation amount, and when the 
modulating signal is at its minimum amplitude, the output frequency is the 
carrier signal frequency minus the deviation amount.

The frequency deviation cannot be greater than the original carrier signal 
frequency.

Also, the sum of the original carrier signal frequency and the frequency 
deviation must be less than or equal to the maximum frequency for the selected 
waveform generator function plus 100 kHz.

The following screen shows an FM modulation of a 100 kHz sine wave carrier 
signal.
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To set up Frequency-Shift Keying Modulation (FSK)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency-Shift Keying 
Modulation (FSK).

2 Press the Hop Freq softkey and turn the Entry knob to specify the "hop 
frequency".

The output frequency "shifts" between the original carrier frequency and this 
"hop frequency".

3 Press the FSK Rate softkey and turn the Entry knob to specify the rate at which 
the output frequency "shifts".

The FSK rate specifies a digital square wave modulating signal.

The following screen shows an FSK modulation of a 100 kHz sine wave carrier 
signal.
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To restore waveform generator defaults

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Default Wave Gen softkey.

The waveform generator factory default settings (1 kHz sine wave, 500 mVpp, 
0 V offset, High-Z output load) are restored.

To set up dual channel tracking

You can set up one waveform generator output to track adjustments in the other 
waveform generator output.

To set up dual channel tracking:

1 Press the [Wave Gen1] or [Wave Gen2] key for the waveform generator output 
that you want to be tracked.

2 In the Waveform Generator Menu, press Settings.

3 In the Waveform Generator Settings Menu, press Dual Chan.

4 In the Waveform Generator: Dual-Channel Menu, you have these options:

• Tracking — frequency, amplitude, offset, and duty cycle adjustments to this 
waveform generator output signal are tracked by the other waveform 
generator output.

• Freq Tracking — frequency adjustments to this waveform generator output 
signal are tracked by the other waveform generator output.

• Amp Tracking — amplitude and offset adjustments to this waveform generator 
output signal are tracked by the other waveform generator output.

• Phase (°) — lets you adjust the phase of a frequency-tracked waveform 
generator output.

Not all waveform shapes that can be frequency tracked can have their phase 
adjusted.

• Copy Waveform to WaveGen2/1 — sets the other waveform generator output to 
be identical to this waveform generator output (except that the shape of 
either output may be inverted).
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Not all waveform shapes can be frequency tracked. When Tracking or Freq Tracking 
is enabled, the other generator's waveform selections will be limited dependent 
upon this generator's waveform.

Also, when tracking is enabled, adjustments for tracked settings in the other 
waveform generator become unavailable (ghosted).
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22 Save/Email/Recall 
(Setups, Screens, Data)
Saving Setups, Screen Images, or Data / 365
Emailing Setups, Screen Images, or Data / 374
Recalling Setups, Masks, or Data / 375
Recalling Default Setups / 377
Performing a Secure Erase / 378

Oscilloscope setups, reference waveforms, and mask files can be saved to internal 
oscilloscope memory or to a USB storage device and recalled later. You can also 
recall default or factory default setups.

Oscilloscope screen images can be saved to a USB storage device in BMP or PNG 
formats.

Acquired waveform data can be saved to a USB storage device in 
comma-separated value (CSV), ASCII XY, and binary (BIN) formats.

Any file that can be saved to a USB storage device can also be e-mailed over the 
network.

There is also a command to securely erase all the oscilloscope's non-volatile 
internal memory.

Saving Setups, Screen Images, or Data

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Save.
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3 In the Save Trace and Setup Menu, press Format; then, turn the Entry knob to 
select the type of file you want to save:

• Setup (*.scp) — The oscilloscope's horizontal timebase, vertical sensitivity, 
trigger mode, trigger level, measurements, cursors, and math function 
settings that tell the oscilloscope how to make a particular measurement. 
See "To save setup files" on page 367.

• 8-bit Bitmap image (*.bmp) — The complete screen image in a reduced color 
(8-bit) bitmap format. See "To save BMP or PNG image files" on page 368.

• 24-bit Bitmap image (*.bmp) — The complete screen image in a 24-bit color 
bitmap format. See "To save BMP or PNG image files" on page 368.

• 24-bit image (*.png) — The complete screen image in a 24-bit color PNG 
format that uses lossless compression. Files are much smaller than the BMP 
format. See "To save BMP or PNG image files" on page 368.

• CSV data (*.csv) — This creates a file of comma-separated values of all 
displayed channels and math waveforms. This format is suitable for 
spreadsheet analysis. See "To save CSV, ASCII XY, or BIN data files" on 
page 368.

• ASCII XY data (*.csv) — This creates separate files of comma-separated values 
for each displayed channel. This format is also suitable for spreadsheets. See 
"To save CSV, ASCII XY, or BIN data files" on page 368.

• Binary data (*.bin) — This creates a binary file, with a header, and data in the 
form of time and voltage pairs. This file is much smaller than the ASCII XY 
data file. See "To save CSV, ASCII XY, or BIN data files" on page 368.

• Lister data (*.csv) — This is a CSV format file containing serial decode row 
information with commas separating the columns. See "To save Lister data 
files" on page 371.

• Reference Waveform data (*.h5) — Saves waveform data in a format that can be 
recalled to one of the oscilloscope's reference waveform locations. See "To 
save reference waveform files to a USB storage device" on page 372.

• Multi Channel Waveform data (*.h5) — Saves multiple channels of waveform 
data in a format that can be opened by the N8900A Infiniium Offline 
oscilloscope analysis software. You can recall the first Analog or Math 
channel from a multi channel waveform data file.
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• Mask (*.msk) — This creates a mask file in a Keysight proprietary format that 
can be read by Keysight InfiniiVision oscilloscopes. A mask data file includes 
some oscilloscope setup information, but not all setup information. To save 
all setup information including the mask data file, choose "Setup (*.scp)" 
format instead. See "To save masks" on page 372.

• Arbitrary Waveform data (*.csv) — This creates a file of comma-separated 
values for the arbitrary waveform points' time and voltage values. See "To 
save arbitrary waveforms" on page 373.

• USB Signal Quality (*.html & *.bmp) — When the USB 2.0 signal quality analysis 
application is licensed, this saves test results information which includes 
waveform plot and eye diagram pictures. See the USB 2.0 Signal Quality 
Analysis Application Electrical Testing Notes manual for more information.

• Analysis Results (*.csv) — A file of comma-separated values is saved for the 
analysis types selected using the Analysis Select softkey.

• Current Harmonics data (*.csv), Power Supply Rejection Ration (PSRR) data (*.csv) , 
Control Loop Response (Bode) data (*.csv) — When the power analysis 
application is licensed, these options create a file of comma-separated 
values for the different types of analysis results. See the Power 
Measurement Application User's Guide for more information.

• Frequency Response Analysis data (*.csv) — This creates a file of 
comma-separated values for the Frequency Response Analysis results table 
values. In the saved file, there are three data columns: frequency (Hz), gain 
(dB), and phase (degrees). See "To view and save the analysis results" on 
page 340.

You can also configure the [Quick Action] key to save setups, screen images, or 
data. See "Configuring the [Quick Action] Key" on page 407.

To save setup files

Setup files can be saved to one of 10 internal (\User Files) locations or to an 
external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Setup 
(*.scp).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.
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Setup files have the extension SCP. These extensions appear when using the File 
Explorer (see "File Explorer" on page 388), but they do not appear when using the 
Recall Menu.

To save BMP or PNG image files

Image files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 8-bit 
Bitmap image (*.bmp), 24-bit Bitmap image (*.bmp), or 24-bit image (*.png).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — setup information (vertical, horizontal, trigger, acquisition, math, 
and display settings) is also saved in a separate file with a TXT extension.

• Invert Grat — the graticule in the image file has a white background instead of 
the black background that appears on-screen.

• Palette — lets you choose between Color or Grayscale images.

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

See Also • "To add an annotation" on page 170

To save CSV, ASCII XY, or BIN data files

Data files can be saved to an external USB storage device.

NOTE When saving screen images, the oscilloscope uses the last menu visited before pressing the 
[Save/Recall] key. This lets you save any relevant information within the softkey menu area.

To save a screen image showing the Save/Recall Menu at the bottom, press the [Save/Recall] 
key twice before saving the image.

NOTE You can also save the oscilloscope's display image using a web browser. See "Get 
Image" on page 417 for details.
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1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select CSV data 
(*.csv), ASCII XY data (*.csv), or  Binary data (*.bin).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, trigger, 
acquisition, math, and display settings) is also saved in a separate file with a 
TXT extension.

• Length — sets the number of data points that will be output to the file. For 
more information, see "Length Control" on page 370.

• Save Seg — when data is acquired to segmented memory, you can specify 
whether the currently displayed segment is saved or all acquired segments 
are saved. (See also "Saving Data from Segmented Memory" on page 244.)

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

CSV Data When the CSV data (*.csv) file format is selected, comma-separated values for 
each displayed waveform and digital channel pod are saved as multiple columns 
in a single file. Math FFT waveforms, whose values are in the frequency domain, 
are appended at the bottom of the .csv file. Pod names (for example, D0-D7) or 
waveform labels are used as column headers. This format is suitable for 
spreadsheet analysis.

For CSV data, length "N" value-at-time measurements are performed across the 
entire screen (using the measurement record data) for each active source. 
Interpolation between measurement record data points is performed as needed.

ASCII XY Data When the ASCII XY data (*.csv) file format is selected, comma-separated value 
files for each displayed waveform, digital channel pod, digital bus, and serial bus 
are saved. For digital pods, an underscore (_) and the pod name (for example, 
D0-D7) are appended to the specified file name; otherwise, an underscore and the 
waveform's label are appended.

If the oscilloscope acquisition is stopped, data from the raw acquisition record 
(which has more points than the measurement record) can be written. Press the 
[Single] key to obtain maximum memory depth with current settings. If enabled, 
serial decode data is saved.
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When you want to save less than the maximum number of data points, a 1-of-N 
decimation is performed to produce an output whose length is less than or equal 
to the requested length. For example, if there are 100k points of data, and you 
specify a length of 2k, 1 of every 50 data points is saved.

See Also • "Binary Data (.bin) Format" on page 431

• "CSV and ASCII XY files" on page 438

• "Minimum and Maximum Values in CSV Files" on page 439

Length Control

The Length control is available when saving data to CSV, ASCII XY, or BIN format 
files. It sets the number of data points that will be output to the file. Only displayed 
data points are saved.

When Max Length is enabled, the maximum number of waveform data points is 
saved.

The maximum number of data points depends on these things:

• Whether acquisitions are running. When stopped, data comes from the raw 
acquisition record. When running, data comes from the smaller measurement 
record or the precision analysis record if enabled (see "Precision Measurements 
and Math" on page 289).

• Whether the oscilloscope was stopped using [Stop] or [Single]. Running 
acquisitions split memory to provide fast waveform update rates. Single 
acquisitions use full memory.

• Whether only one channel of a pair is turned on. (Channels 1 and 2 are one pair, 
channels 3 and 4 are the other.) Acquisition memory is divided among the 
channels in a pair.

• Whether reference waveforms are on. Displayed reference waveforms consume 
acquisition memory.

• Whether digital channels are on. Displayed digital channels consume 
acquisition memory.

• Whether segmented memory is on. Acquisition memory is divided by the 
number of segments.

• The horizontal time/div (sweep speed) setting. At faster settings, fewer data 
points appear on the display.
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Also, when the sample rate is above 2 GSa/s (or 1 GSa/s when two channels of 
a pair are on), the maximum record length is 1M points. Acquisition memory is 
still divided among the channels in a pair, but there is no difference between 
using [Stop] or [Single].

• When saving to a CSV format file, the maximum number of data points is 64K.

When necessary, the Length control performs a "1 of n" decimation of the data . 
For example: if the Length is set to 1000, and you are displaying a record that is 
5000 data points in length, four of each five data points will be decimated, 
creating an output file 1000 data points in length.

When saving waveform data, the save times depend on the chosen format:

See Also • "Binary Data (.bin) Format" on page 431

• "CSV and ASCII XY files" on page 438

• "Minimum and Maximum Values in CSV Files" on page 439

To save Lister data files

Lister data files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Lister data 
file.

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, trigger, 
acquisition, math, and display settings) is also saved in a separate file with a 
TXT extension.

4 Finally, press the Press to Save softkey.

Data File Format Save Times

BIN fastest

ASCII XY medium

CSV slowest
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A message indicating whether the save was successful is displayed.

To save reference waveform files to a USB storage device

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press the Save softkey.

3 In the Save Menu, press the Format softkey and turn the Entry knob to select 
Reference Waveform data (*.h5) .

4 Press the Source softkey and turn the Entry knob to select the source waveform.

5 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

6 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

To save masks

Mask files can be saved to one of four internal (\User Files) locations or to an 
external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Mask 
(*.msk).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

Mask files have the extension MSK.

See Also • Chapter 18, “Mask Testing,” starting on page 317

NOTE Masks are also saved as part of setup files. See "To save setup files" on page 367.
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To save arbitrary waveforms

Arbitrary waveform files can be saved to one of four internal (\User Files) locations 
or to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select Arbitrary 
Waveform data (*.csv).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the save location. See "To navigate storage locations" on page 373.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

See Also • "To edit arbitrary waveforms" on page 347

To navigate storage locations

When saving or recalling files, the softkey in the second position of the Save Menu 
or Recall Menu, along with the Entry knob, are used to navigate to storage 
locations. The storage locations can be internal oscilloscope storage locations (for 
setup files or mask files) or they can be external storage locations on a connected 
USB storage device.

The softkey in the second position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new folder or 
storage location.

• Location — when you have navigated to the current folder location (and are not 
saving files).

• Save to — when you can save to the selected location.

• Load from — when you can recall from the selected file.

When saving files:

• The proposed file name is shown in the Save to file = line above the softkeys.

• To overwrite an existing file, browse to that file and select it. To create a new file 
name, see "To enter file names" on page 373.

To enter file names

To create new file names when saving files to a USB storage device:

1 In the Save Menu, press the File Name softkey.
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You must have a USB storage device connected to the oscilloscope for this 
softkey to be active.

2 In the File Name Menu, press the File Name softkey.

3 In the File Name keypad dialog, you can enter file names using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; then, push 

the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that can be 
touched.

4 When you are done entering the file name, select the dialog's Enter or OK key 
or press the File Name softkey again.

The file name appears in the softkey.

5 When available, the Increment softkey can be used to enable or disable 
automatically incremented file names. Auto increment adds a numeric suffix to 
your file name and increments the number with each successive save. It will 
truncate characters as necessary when the file name length is at maximum and 
more digits are required for the numeric portion of the file name.

Emailing Setups, Screen Images, or Data

You can send oscilloscope files over the network via e-mail. You can e-mail any file 
that can be saved.

To e-mail a setup, screen image, or data file:

1 Make sure the oscilloscope is connected to the local area network (see "To 
establish a LAN connection" on page 387).

2 Press the [Save/Recall] key.

3 In the Save/Recall Menu, press Email.

4 In the Email Menu, press Format; then, select the type of file you want to send.

You can select from the same formats that are available when saving files. 
Settings for the selected format are also the same. See "Saving Setups, Screen 
Images, or Data" on page 365.
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5 Press the Attachment Name softkey and use the keypad dialog to enter the name 
of the attachment file that will be sent.

6 In the e-mail configuration dialog box, touch the To, From, Server, and Subject 
fields and use the keypad dialog to enter the appropriate strings.

You can also enter these strings by pressing the Config Email softkey and the To, 
From, Server, and Subject softkeys in the Configure Email Menu.

You can specify multiple e-mail addresses by separating each address by a 
semi-colon.

The Server name is the name of your mail server running the Simple Mail 
Transfer Protocol (SMTP). If you do not know this name, ask your Network 
Administrator.

7 Finally, press the Press to Send Email softkey.

You can also configure the [Quick Action] key to e-mail setups, screen images, or 
data. See "Configuring the [Quick Action] Key" on page 407.

Recalling Setups, Masks, or Data

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Recall.

3 In the Recall Menu, press Recall:, then, turn the Entry knob to select the type of 
file you want to recall:

• Setup (*.scp) — See "To recall setup files" on page 376.

• Mask (*.msk) — See "To recall mask files" on page 376.

• Reference Waveform data (*.h5) — See "To recall reference waveform files from 
a USB storage device" on page 376.

• Arbitrary Waveform data (*.csv) — See "To recall arbitrary waveforms" on 
page 377.

• CAN Symbolic data (*.dbc) — For CAN serial decode.

• LIN Symbolic data (*.ldf) — For LIN serial decode.

You can also recall setups and mask files by loading them using the File Explorer. 
See "File Explorer" on page 388.
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You can also configure the [Quick Action] key to recall setups, masks, or reference 
waveforms. See "Configuring the [Quick Action] Key" on page 407.

To recall setup files

Setup files can be recalled from one of 10 internal (\User Files) locations or from 
an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select Setup 
(*.scp).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 373.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display, press Clear Display.

To recall mask files

Mask files can be recalled from one of four internal (\User Files) locations or from 
an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select Mask 
(*.msk).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 373.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display or clear the recalled mask, press Clear 
Display or Clear Mask.

To recall reference waveform files from a USB storage device

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press the Recall softkey.

3 In the Recall Menu, press the Recall softkey and turn the Entry knob to select 
Reference Waveform data (*.h5) .

4 Press the To Ref: softkey and turn the Entry knob to select the desired reference 
waveform location.
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5 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 373.

6 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

7 If you would like to clear the display of everything except the reference 
waveform, press Clear Display.

To recall arbitrary waveforms

Arbitrary waveform files can be recalled from one of four internal (\User Files) 
locations or from an external USB storage device.

When recalling arbitrary waveforms (from an external USB storage device) that 
were not saved from the oscilloscope, be aware that:

• If the file contains two columns, the second column is automatically chosen.

• If the file contains more than two columns, you are prompted to select which 
column to load. Up to five columns are parsed by the oscilloscope; columns 
above the fifth are ignored.

• The oscilloscope uses a maximum of 8192 points for an arbitrary waveform. For 
more efficient recalls, make sure your arbitrary waveforms are 8192 points or 
less.

To recall an arbitrary waveform:

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select Arbitrary 
Waveform data (*.csv).

2 Press the softkey in the second position and use the Entry knob to navigate to 
the file to recall. See "To navigate storage locations" on page 373.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display, press Clear Display.

See Also • "To edit arbitrary waveforms" on page 347

Recalling Default Setups

1 Press the [Save/Recall] key.
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2 In the Save/Recall Menu, press Default/Erase.

3 In the Default Menu, press one of these softkeys:

• Default Setup — recalls the oscilloscope's default setup. This is the same as 
pressing the front panel [Default Setup] key. See "Recall the Default 
Oscilloscope Setup" on page 37.

Some user settings are not changed when recalling the default setup.

• Factory Default — recalls the oscilloscope's factory default settings.

You must confirm the recall because there are no user settings that are left 
unchanged.

Performing a Secure Erase

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Default/Erase.

3 In the Default menu, press Secure Erase.

This performs a secure erase of all non-volatile memory in compliance with 
National Industrial Security Program Operation Manual (NISPOM) Chapter 8 
requirements.

You must confirm the secure erase, and the oscilloscope will reboot when 
finished.
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23 Print (Screens)
To print the oscilloscope's display / 379
To set up network printer connections / 381
To specify the print options / 382
To specify the palette option / 383

You can print the complete display, including the status line and softkeys, to a 
USB printer or a network printer when the LAN connection is used.

The Print Configuration Menu is displayed when you press the [Print] key. The print 
option softkeys and the Press to Print softkey are ghosted (not available) until a 
printer is connected.

To print the oscilloscope's display

1 Connect a printer. You can:

• Connect a USB printer to one of the the USB ports on the front panel or the 
rectangular USB host port on the rear panel.

For the most up-to-date listing of printers that are compatible with the 
InfiniiVision oscilloscopes, please visit 
www.keysight.com/find/InfiniiVision-printers.

• Set up a network printer connection. See "To set up network printer 
connections" on page 381.

2 Press the [Print] key on the front panel.

3 In the Print Configuration Menu, press the Print to softkey; then, turn the Entry 
knob to select the desired printer.

4 Press the Options softkey to select the print options.

http://www.keysight.com/find/InfiniiVision-printers
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See "To specify the print options" on page 382.

5 Press the Palette softkey to select the print palette. See "To specify the palette 
option" on page 383.

6 Press the Press to Print softkey.

You can stop printing by pressing the Cancel Print softkey.

You can also configure the [Quick Action] key to print the display. See "Configuring 
the [Quick Action] Key" on page 407.

See Also • "To add an annotation" on page 170

NOTE The oscilloscope will print the last menu visited before you pressed the [Print] key. Therefore, 
if you have measurements (Amplitude, Frequency, etc.) showing on the display before you 
press [Print], the measurements will be shown on the printout.

To print the display showing the Print Configuration Menu at the bottom, press the [Print] key 
twice; then, press the Press to Print softkey.
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To set up network printer connections

When the oscilloscope is connected to a LAN, you can set up network printer 
connections.

A network printer is a printer attached to a computer or print server on the 
network.

1 Press the [Print] key on the front panel.

2 In the Print Configuration Menu, press the Print to softkey; then, turn the Entry 
knob to select the network printer you want to configure (either #0 or #1).

3 Press the Network Setup softkey.

4 In the Network Printer Setup Menu:

a Press the Address softkey.

b In the Address keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; then, 

push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that can 
be touched.

The Address is the printer or print server's address in one of the following 
formats:

• IP address of a network-enabled printer (for example: 192.168.1.100 or 
192.168.1.100:650). Optionally, a non-standard port number can be 
specified following a colon.

• IP address of a print server followed by the path to the printer (for 
example: 192.168.1.100/printers/printer-name or 
192.168.1.100:650/printers/printer-name).

• Path to a Windows network printer share (for example: \\server\share).

c When you are done entering text, select the dialog's Enter or OK key or press 
the Address softkey again.
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The address appears in the softkey.

d When the Address is a Windows network printer share, these softkeys appear 
and let you enter additional settings:

• Domain — this is the Windows network domain name.

• Username — this is your login name for the Windows network domain.

• Password — this is your login password for the Windows network domain.

To clear an entered password, press the Clear key in the Password keypad 
dialog.

e Press the Apply softkey to make the printer connection.

A message appears to tell you whether the connection was successful.

To specify the print options

In the Print Configuration Menu, press the Options softkey to change the following 
options:

• Setup Information — Select this to print oscilloscope setup information on your 
printout, including vertical, horizontal, trigger, acquisition, math, and display 
settings.

• Invert Graticule Colors — Select this to reduce the amount of black ink it takes to 
print oscilloscope images by changing the black background to white. Invert 
Graticule Colors is the default mode.

• Form Feed — Select this to send a form feed command to the printer after the 
waveform is printed and before the setup information is printed. Switch Form 
Feed off if you want setup information printed on the same sheet of paper with 
the waveform. This option only has an effect when the Setup Information option is 
selected. Also, if the amount of setup information will not fit on the same page 
with the waveform, it will be printed on a new page regardless of the Form Feed 
setting.

• Landscape — Select this to print horizontally on the page instead of vertically 
(portrait mode).
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To specify the palette option

In the Print Configuration Menu, press the Palette softkey to change the following 
options.

• Color — Select this to print the screen in color.

• Grayscale — Select this to print the screen in shades of gray rather than in color.
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24 Utility Settings
I/O Interface Settings / 385
Setting up the Oscilloscope's LAN Connection / 386
File Explorer / 388
Setting Oscilloscope Preferences / 391
Setting the Oscilloscope's Clock / 395
Setting the Rear Panel TRIG OUT Source / 396
Setting the Reference Signal Mode / 397
Enabling Remote Command Logging / 399
Setting Enhanced Security Options / 400
Performing Service Tasks / 403
Configuring the [Quick Action] Key / 407

This chapter explains oscilloscope utility functions.

I/O Interface Settings

The oscilloscope can be accessed and/or controlled remotely via these I/O 
interfaces:

• USB device port on the rear panel (square shaped USB port).

• LAN interface on the rear panel.

To configure the I/O interfaces:

1 On the oscilloscope's front panel, press [Utility].

2 In the Utility Menu, press I/O.

3 In the I/O Menu, press Configure.
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• LAN — When connected to a LAN, you can use the LAN Settings and LAN Reset 
softkeys to configure the LAN interface. See "Setting up the Oscilloscope's 
LAN Connection" on page 386.

When an I/O interface is installed, remote control over that interface is always 
enabled. Also, the oscilloscope can be controlled via multiple I/O interfaces (for 
example, USB and LAN) at the same time.

See Also • Chapter 25, “Web Interface,” starting on page 409 (when the oscilloscope is 
connected to a LAN).

• "Remote Programming via the Web Interface" on page 412

• The oscilloscope's Programmer's Guide.

• "Remote Programming with Keysight IO Libraries" on page 414

Setting up the Oscilloscope's LAN Connection

Using the rear panel LAN port, you can place the oscilloscope on the network and 
set up its LAN connection. Once that is done, you can set up and use network 
printers or use the oscilloscope's web interface or remotely control the 
oscilloscope via the LAN interface.

The oscilloscope supports methods for automated LAN configuration or manual 
LAN configuration (see "To establish a LAN connection" on page 387). It is also 
possible to set up a point-to-point LAN connection between a PC and the 
oscilloscope (see "Stand-alone (Point-to-Point) Connection to a PC" on 
page 388).

Once the oscilloscope is set up on the network, you can use the oscilloscope's 
web page to view or change its network configuration and access additional 
settings (like the network password). See Chapter 25, “Web Interface,” starting on 
page 409.

NOTE When you connect the oscilloscope to a LAN it is a good practice to limit access to the 
oscilloscope by setting a password. By default, the oscilloscope is not password protected. 
See "Setting a Password" on page 420 to set a password.
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To establish a LAN connection

Automatic
Configuration

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 If your network provides Dynamic DNS, you can enable the Dynamic DNS option 
to let the oscilloscope register its hostname and use the DNS server for name 
resolution.

5 You can enable the Multicast DNS option to let the oscilloscope use Multicast 
DNS for name resolution on small networks without a conventional DNS server.

6 Connect the oscilloscope to the local area network (LAN) by inserting the LAN 
cable into the "LAN" port on the rear panel of the oscilloscope.

In a few moments the oscilloscope will connect to the network automatically.

If the oscilloscope does not automatically connect to the network, press [Utility] 
> I/O > LAN Reset. In a few moments the oscilloscope will connect to the 
network.

Manual
Configuration

1 Get the oscilloscope's network parameters (host name, IP address, subnet 
mask, gateway IP, DNS IP, etc.) from your network administrator.

2 Press [Utility] > I/O.

3 Press the LAN Settings softkey.

4 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to disable it.

If Automatic is not enabled, the oscilloscope's LAN configuration must be set 
up manually using the Modify and Host name softkeys

NOTE Any time you modify the oscilloscope's hostname, it breaks the connection between the 
oscilloscope and the LAN. You need to re-establish communication to the oscilloscope using 
the new hostname.
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5 Configure the oscilloscope's LAN interface:

a Use the Modify softkey (and the other softkeys and keypad entry dialogs) to 
enter the IP Address, Subnet Mask, Gateway IP, and DNS IP values.

b Press the Host name softkey and use the keypad entry dialog to enter the 
Host Name.

c Press the Apply softkey.

6 Connect the oscilloscope to the local area network (LAN) by inserting the LAN 
cable into the "LAN" port on the rear panel of the oscilloscope.

Stand-alone (Point-to-Point) Connection to a PC

The following procedure describes how to establish a point-to-point (stand alone) 
connection to the oscilloscope. This is useful if you want to control the 
oscilloscope using a laptop computer or a stand-alone computer.

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, and press 
the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 Connect your PC to the oscilloscope using a cross-over LAN cable such as 
Keysight part number 5061-0701, available on the web at 
www.keysight.com/find/parts.

5 Cycle power on the oscilloscope. Wait until the LAN connection is configured:

• Press [Utility] > I/O and wait until the LAN status shows "configured".

This may take a few minutes.

Now, the instrument is connected, and the instrument's web interface or remote 
control via LAN may be used.

File Explorer

The File Explorer lets you navigate the oscilloscope's internal file system and the 
file systems of connected USB storage devices.

From the internal file system, you can load oscilloscope setup files or mask files.

http://www.keysight.com/find/parts
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From a connected USB storage device, you can load setup files, mask files, license 
files, firmware update (*.ksx) files, label files, etc. Also, you can delete files on a 
connected USB storage device.

The oscilloscope's internal file system, under "\User Files", consists of 10 locations 
for oscilloscope setup files, four locations for mask files, and four locations for 
waveform generator arbitrary waveform files.

To use the File Explorer:

1 Press [Utility] > File Explorer.

2 In the File Explorer Menu, press the softkey in the first position and use the 
Entry knob to navigate.

NOTE The USB port on the front panel, and the USB port on the rear panel labeled "HOST" are USB 
Series A receptacles. These are the receptacles to which you can connect USB mass storage 
devices and printers.

The square receptacle on the rear panel labeled "DEVICE" is provided for controlling the 
oscilloscope over USB. See the Programmer's Guide for more information.
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The softkey in the first position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new folder 
or storage location.

• Location — when pointing to a directory that is currently selected.

• Selected — when pointing to a file that can be loaded or deleted.

When this label appears, you can press the Load File or Delete File softkeys to 
take the action.

Pushing the Entry knob is the same as pressing the Load File softkey.

A file that has been deleted from a USB storage device cannot be recovered 
by the oscilloscope.

Use your PC to create directories on a USB storage device.

USB Storage
Devices

Most USB mass storage devices are compatible with the oscilloscope. However, 
certain devices may be incompatible, and may not be able to be read or written to. 
USB storage devices must be formatted with the FAT, FAT32, or exFAT file system 
format. Any given storage device may not support all of these formats.
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When the USB mass storage device is connected to the oscilloscope's front or rear 
USB host port, a small four-color circle icon may be displayed briefly as the USB 
device is read.

You do not need to "eject" the USB mass storage device before removing it. Simply 
ensure that any file operation you've initiated is done, and remove the USB drive 
from the oscilloscope's host port.

Do not connect USB devices that identify themselves as hardware type "CD" 
because these devices are not compatible with the InfiniiVision X-Series 
oscilloscopes.

If two USB mass storage devices are connected to the oscilloscope, the first one is 
designated "\usb" and the second one is designated "\usb2".

See Also • Chapter 22, “Save/Email/Recall (Setups, Screens, Data),” starting on page 365

Setting Oscilloscope Preferences

The User Preferences Menu (under [Utility] > Options > Preferences) lets you specify 
oscilloscope preferences.

• "To choose "expand about" center or ground" on page 391

• "To disable/enable transparent backgrounds" on page 392

• "To set voice recognition and speaker options" on page 392

• "To set up the screen saver" on page 393

• "To set Autoscale preferences" on page 394

• "Jitter-Free Trigger" on page 395

To choose "expand about" center or ground

When you change a channel's volts/division setting, the waveform display can be 
set to expand (or compress) about the signal ground level or the center of the 
display.

To set the waveform expansion reference point:

1 Press [Utility] > Options > Preferences > Expand and select:

• Ground — The displayed waveform will expand about the position of the 
channel's ground. This is the default setting.
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The ground level of the signal is identified by the position of the ground level 

( ) icon at the far-left side of the display.

The ground level will not move when you adjust the vertical sensitivity 
(volts/division) control.

If the ground level is off screen, the waveform will expand about the top or 
bottom edge of the screen based on where the ground is off screen.

• Center — The displayed waveform will expand about the center of the display.

To disable/enable transparent backgrounds

There is a preference setting for whether measurements, statistics, reference 
waveform information, and other text displays have transparent or solid 
backgrounds.

1 Press [Utility] > Options > Preferences.

2 Press Transparent to toggle between transparent and solid text display 
backgrounds.

To set voice recognition and speaker options

The oscilloscope's voice recognition and speaker volume options can be set in the 
user preferences.

1 Press [Utility] > Options > Preferences > Audio to display the Audio Menu.

You can also display the Audio Menu by touching the microphone icon on the 
display — see "Learn the Voice Controls" on page 63.

2 Press the Voice Recognition softkey to enable or disable the feature.

3 Press the Language (Voice) softkey; then, turn the Entry knob to select your 
speaking language.

4 Press the Speaker Volume softkey; then, turn the Entry knob to change the 
setting.

The speaker beeps during user calibration when you need to reconnect the 
calibration cable.
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5 Press the Beep softkey to open the beep event selection menu, use the Entry 
knob (or touch) to select the event, and then press the softkey again to 
enable/disable beeps on the selected event.

The oscilloscope can beep on these events:

• On Single — when you perform a single run and the single trigger occurs.

• On Trig — in the Normal trigger mode, when the trigger status transitions 
from "Trig'd?" (trigger not found) to "Trig'd" (trigger found).

• On Mask Failure — when relatively rare mask test failures occur.

• On DVM Limit — when the specified digital voltmeter reading limit occurs. 
Press the Limits softkey to open a menu where you can specify the limits. See 
"Digital Voltmeter" on page 332.

• On Long Save — when saving a file takes longer than 20 seconds and the save 
completes.

• On Calibration — when performing a user calibration and it is time to move the 
calibration cable from one channel to the next.

To set up the screen saver

The oscilloscope can be configured to turn on a display screen saver when the 
oscilloscope has been idle for a specified length of time.

1 Press [Utility] > Options > Preferences > Screen Saver to display the Screen Saver 
Menu.

2 Press the Screen Saver softkey to select the screen saver type.

The screen saver can be set to Off, to display any of the images shown in the 
list, or can display a user-defined text string.

If User is selected:
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a Press the Text softkey.

b In the Text keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; then, 

push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that can 
be touched.

c When you are done entering text, select the dialog's Enter or OK key or press 
the Text softkey again.

The user-defined screen saver text appears in the softkey.

3 Press the Wait softkey; then, turn the Entry knob to select the number of 
minutes to wait before the selected screen saver activates.

When you turn the Entry knob, the number of minutes is displayed on the Wait 
softkey. The default time is 180 minutes (3 hours).

4 Press the Preview softkey to preview the screen saver you have selected with the 
Saver softkey.

5 To view the normal display after the screen saver has started, press any key or 
turn any knob.

To set Autoscale preferences

1 Press [Utility] > Options > Preferences > Autoscale.

2 In the Autoscale Preferences Menu, you can:

• Press the Fast Debug softkey enable/disable this type of autoscale.

When fast debug is enabled, autoscale lets you make quick visual 
comparisons to determine whether the signal being probed is a DC voltage, 
ground, or an active AC signal.

Channel coupling is maintained to allow easy viewing of oscillating signals.
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• Press the Channels softkey and turn the Entry knob to specify the channels to 
be autoscaled:

• All Channels — The next time you press [Auto Scale], all channels that meet 
the requirements of Autoscale will be displayed.

• Only Displayed Channels — The next time you press [Auto Scale], only the 
channels that are turned on will be examined for signal activity. This is 
useful if you only want to view specific active channels after pressing [Auto 
Scale].

• Press the Acq Mode softkey and turn the Entry knob to select whether the 
acquisition mode should be preserved during autoscale:

• Normal — to make the oscilloscope switch to Normal acquisition mode 
whenever the [Auto Scale] key is pressed. This is the default mode.

• Preserve — to make the oscilloscope remain in the acquisition mode you 
have chosen when the [Auto Scale] key is pressed.

Jitter-Free Trigger

Oscilloscope trigger circuitry introduces a certain amount of noise and jitter that 
result in horizontal error. To correct for this error, in certain trigger modes and at 
certain timebase ranges, hardware Jitter-Free Trigger correction is used to 
minimize trigger jitter at the trigger point.

The effect seen on the oscilloscope display is that all plotted acquisitions cross 
through the same pixel location at the intersection of the trigger level and time=0.

Jitter-Free Trigger correction works well for fast digital edges, but you may want 
to turn it off for some slow slew rate analog signals.

Setting the Oscilloscope's Clock

The Clock Menu lets you set the current date and time of day (24-hour format). 
This time/date stamp will appear on hardcopy prints and directory information on 
the USB mass storage device.

To set the date and time, or to view the current date and time:

1 Press [Utility] > Options > Clock.
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2 Press the Year, Month, Day, Hour or Minute softkey; then, rotate the Entry knob to 
set to the desired number.

The hours are shown in the 24-hour format. So 1:00 PM is hour 13.

The real-time clock only allows selection of valid dates. If a day is selected and the 
month or year is changed so the day is invalid, the day is automatically adjusted.

Setting the Rear Panel TRIG OUT Source

You can choose the source of the TRIG OUT connector on the rear panel of the 
oscilloscope:

1 Press [Utility] > Options > Rear Panel.

2 In the Rear Panel Menu, press Trig Out; then, turn the Entry knob to select from:

• Triggers — Each time the oscilloscope triggers, a rising edge occurs on 
TRIG OUT. The rising edge is delayed 30 ns from the oscilloscope's trigger 
point. The output level is 0-5 V into an open circuit, and 0-2.5 V into 50 Ω. 
See Chapter 10, “Triggers,” starting on page 181.

• Mask — The pass/fail status is evaluated periodically. When the evaluation of 
the testing period results in a failure, the trigger output pulses high (+5 V). 
Otherwise, the trigger output remains at low (0 V). See Chapter 18, “Mask 
Testing,” starting on page 317.

• Waveform Generator 1/2 Sync Pulse — All of the waveform generator output 
functions (except DC, Noise, and Cardiac) have an associated Sync signal:

The Sync signal is a TTL positive pulse that occurs when the waveform rises 
above zero volts (or the DC offset value).

See Chapter 21, “Waveform Generator,” starting on page 343.

The TRIG OUT connector also provides the User Calibration signal. See "To 
perform user calibration" on page 404.
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Setting the Reference Signal Mode

The 10 MHz REF BNC connector on the rear panel is provided so you can:

• Supply a more accurate sample clock signal to the oscilloscope, or

• Synchronize the timebase of two or more instruments.

Sample clock and
frequency counter

accuracy

The oscilloscope's timebase uses a built-in reference that has an accuracy of 
15 ppm. This is sufficient for most uses. However, if you are looking at a window 
that is very narrow compared to the selected delay (for example, looking at a 15 ns 
pulse with the delay set to 1 ms), significant error can be introduced.

Using the built-in sample clock, the oscilloscope's hardware frequency counter is 
a 5-digit counter.

See "To supply a sample clock to the oscilloscope" on page 397.

Supplying an
external timebase

reference

When you supply an external timebase reference, the hardware frequency counter 
is automatically changed to an 8-digit counter. In this case, the frequency counter 
([Meas] > Select > Counter) is as accurate as the external clock.

See "To synchronize the timebase of two or more instruments" on page 398.

For more information on the hardware frequency counter, see "Counter" on 
page 272.

To supply a sample clock to the oscilloscope

1 Connect a 10 MHz square or sine wave to the BNC connector labeled 10 MHz 
REF. The amplitude must be from -5 dBm to 17 dBm (356 mVpp to 4.48 Vpp).

2 Press [Utility] > Options > Rear Panel > 10MHz Ref Signal.

3 Use the Entry knob and the 10MHz Ref Signal softkey to select Input On.

A locked padlock icon appears at the top of the display.

CAUTION  Maximum input voltage at 10 MHz REF connector

Do not apply more than 20 dBm Max (6.32 Vpp Max) at the 10 MHz REF BNC connector 
on the rear panel or damage to the instrument may occur.
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If the externally supplied sample clock signal is lost, a hard unlock will occur. The 
lock symbol in the upper right part of the display will become an unlocked padlock 
icon and the oscilloscope will stop acquiring data. The oscilloscope will resume 
sampling when the externally supplied sample clock becomes stable again.

To synchronize the timebase of two or more instruments

The oscilloscope can output its 10 MHz system clock for the purpose of 
synchronization with other instruments.

1 Connect a BNC cable to the BNC connector labeled 10 MHz REF on the rear 
panel of the oscilloscope.

2 Connect the other end of the BNC cable to the instrument(s) that will accept 
the 10 MHz reference signal.

The amplitude of this 10 MHz reference output signal is 5 Vpp into a high 
impedance or 2.5 Vpp into 50 Ohms. It is capable of driving into lower 
impedances, but the output will be reduced because of the 50 Ohm source 
impedance.
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3 Press [Utility] > Options > Rear Panel > 10MHz Ref Signal.

4 Use the Entry knob and the 10MHz Ref Signal softkey to select Output On.

Enabling Remote Command Logging

When remote command logging is enabled, remote commands sent to the 
instrument (and results returned by the instrument) can be logged to the screen, 
to a text file on a USB storage device, or to both the screen and a text file.

To enable remote command logging:

1 Press [Utility] > Options > Remote Log to open the Remote Log Menu:

2 Press Enable to enable or disable the remote command logging feature.

When remote logging is enabled, additional debug information can be included 
in the returned error string. If the error is detected by the SCPI command 
parser, such as a header error or other syntax error, the extra debug 
information is generated and included. But if the error is detected by the 
oscilloscope system, such as when an out-of-range value is sent, then no extra 
debug information is included.

3 Press Destination to select whether remote commands are logged to a text file 
(on a connected USB storage device), logged to the screen, or both.

4 Press Write Mode to specify whether logged commands will be created in a new 
list or appended to existing logged commands.

Your selection takes effect when remote command logging is enabled.

This option applies to both screen and file logging.

5 Press File Name to open the Remote Log Filename Menu where you can specify 
the name of the file (on the USB storage device) to which remote commands 
are logged.

6 Press Display On to enable or disable the screen display of logged remote 
commands and their return values (if applicable).

7 Press Transparent to disable or enable a transparent background for the remote 
command logging screen display.
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Enable to make the background transparent. This lets you view underlying 
waveforms.

Disable for a solid background which makes the logged remote commands 
easier to read.

Setting Enhanced Security Options

With the Enhanced Security license, you can disable features to further secure the 
oscilloscope.

A password is required to make enhanced security changes.

To make enhanced security changes:

1 Press [Utility] > Options > Enhanced Security.

2 In the Enhanced Security menu, press Unlock Panel.

3 If you are setting the pasword for the first time:

a In the Password menu, press New Password.

b In the New Password menu, press New Password.

In the keypad dialog box, enter the new password.

When you are done entering the password, select OK or Enter in the dialog 
box, or press New Password again.

c Press Repeat Password. In the keypad dialog box, re-enter the new password.

d Press Set Password.

e In the confirmation dialog, read the warning information. Then, press OK.
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If there is an existing password:

a In the Password menu, press Enter Password.

In the keypad dialog box, enter the existing password.

When you are done entering the password, select OK or Enter in the dialog 
box, or press Enter Password again.

Once a password is set or entered, you are automatically taken back to the 
unlocked Enhanced Security menu where you can change these options:

Non-Volatile 
Memory

Use this softkey to disable or enable the oscilloscope's non-volatile memory. 
The contents of non-volatile memory are kept when the oscilloscope is powered 
off.

Normally, the oscilloscope's internal storage for setup files, mask files, and 
arbitrary waveforms (under "\User files") and for symbolic decoding files, etc., is 
non-volatile; however, when the non-volatile memory is disabled, this internal 
storage becomes volatile and is not kept when the oscilloscope is powered off.

Also, when non-volatile memory is disabled:

• The oscilloscope is restored to a factory default setup when powered on.

• Licenses and calibration factors, which are not user-accessible, are retained.

• Web-based firmware upgrades are disabled, even if the oscilloscope's LAN 
Port and Firmware Upgrade options are enabled.

LAN Port Use this softkey to disable or enable the oscilloscope's LAN port. The LAN port 
lets you print to network printers, access the oscilloscope's built-in web 
interface, and issue remote commands.

When the LAN port is disabled, the oscilloscope cannot be pinged and is 
essentially invisible over Ethernet to any device, even if an Ethernet cable in 
plugged into the oscilloscope's LAN port.
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When changing the non-volatile memory, LAN Port, USB Device Port, or USB Host 
Ports settings, you must reboot the oscilloscope for the change to take place.

Press Lock Panel to lock the enhanced security options panel.

To change the enhanced security password:

1 Press [Utility] > Options > Enhanced Security.

2 In the Enhanced Security menu, press Unlock Panel.

3 In the Password menu, press New Password.

4 In the New Password menu, press Current Password.

In the keypad dialog box, enter the existing password.

When you are done entering the password, select OK or Enter in the dialog box, 
or press Current Password again.

USB Device Port Use this softkey to disable or enable the oscilloscope's USB Device port. The 
USB Device port is the square shaped USB port for connecting the oscilloscope 
to a host PC for remote communication.

USB Host Ports Use this softkey to disable or enable the oscilloscope's USB Host ports. The USB 
Host ports are the rectangular shaped USB ports used for connecting a USB 
mass storage device, printer, mouse, or keyboard to the oscilloscope.

Firmware 
Upgrade

Use this softkey to disable or enable the ability to upgrade firmware.

When firmware upgrades are disabled:

• Firmware installers (.ksx files) are prevented from being loaded into, or run in, 
the oscilloscope. This applies to firmware upgrades from external USB mass 
storage devices as well as web-based firmware upgrades.

• Licenses can still be installed

• Recallable files (setup files, mask files, etc.) can still be accessed from 
external media if the appropriate communication ports are enabled.

Note that web-based firmware upgrades are disabled when non-volatile 
memory is disabled, even when this and the LAN Port options are enabled.
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5 Press New Password. In the keypad dialog box, enter the new password.

6 Press Repeat Password. In the keypad dialog box, re-enter the new password.

7 Press Set Password.

8 In the confirmation dialog, read the warning information. Then, press OK.

To reset (clear) the enhanced security password:

1 Press [Utility] > Options > Enhanced Security.

2 In the Enhanced Security menu, press Unlock Panel.

3 In the Password menu, press Reset Password.

4 In the Reset Password menu, press Current Password.

In the keypad dialog box, enter the existing password.

When you are done entering the password, select OK or Enter in the dialog box, 
or press Current Password again.

5 Press Reset Password.

6 In the confirmation dialog, read the warning information. Then, press OK.

Performing Service Tasks

The Service Menu (under [Utility] > Service) lets you perform service-related tasks:

• "To perform user calibration" on page 404

• "To perform hardware self test" on page 404

• "To perform front panel self test" on page 405

• "To display oscilloscope information" on page 405

• "To display the user calibration status" on page 405
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For other information related to oscilloscope maintenance and service, see:

• "To clean the oscilloscope" on page 405

• "To check warranty and extended services status" on page 406

• "To contact Keysight" on page 406

• "To return the instrument" on page 406

To perform user calibration

Perform user-calibration:

• Every two years or after 4000 hours of operation.

• If the ambient temperature is >10° C from the calibration temperature.

• If you want to maximize the measurement accuracy.

The amount of use, environmental conditions, and experience with other 
instruments help determine if you need shorter User Calibration intervals.

User Calibration performs an internal self-alignment routine to optimize the signal 
path in the oscilloscope. The routine uses internally generated signals to optimize 
circuits that affect channel sensitivity, offset, and trigger parameters.

Performing User Calibration will invalidate your Certificate of Calibration. If NIST 
(National Institute of Standards and Technology) traceability is required, perform 
the "Performance Verification" procedure in the Keysight InfiniiVision 
6000 X-Series Oscilloscopes Service Guide using traceable sources.

To perform user calibration:

1 Disconnect all inputs from the front and rear panels, including the digital 
channels cable on an MSO, and allow the oscilloscope to warm up before 
performing this procedure.

2 Press the rear-panel CAL button to disable calibration protection.

3 Connect the included calibration BNC cable (54609-61609) from the TRIG OUT 
connector on the rear panel to the channel 1 input.

4 Press the [Utility] key; then, press the Service softkey.

5 Begin the Self Calibration by pressing the Start User Calibration softkey.

To perform hardware self test

Pressing [Utility] > Service > Hardware Self Test performs a series of internal 
procedures to verify that the oscilloscope is operating properly.
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It is recommended you run Hardware Self Test:

• After experiencing abnormal operation.

• For additional information to better describe an oscilloscope failure.

• To verify proper operation after the oscilloscope has been repaired.

Successfully passing Hardware Self Test does not guarantee 100% of the 
oscilloscope's functionality. Hardware Self Test is designed to provide an 80% 
confidence level that the oscilloscope is operating properly.

To perform front panel self test

Pressing [Utility] > Service > Front Panel Self Test lets you test the front panel keys 
and knobs as well as the oscilloscope display.

Follow the on-screen instructions.

To display oscilloscope information

Press [Help] > About Oscilloscope to display information about your oscilloscope:

• Model number.

• Serial number.

• Bandwidth.

• Module installed.

• Software version.

• Installed licenses. See also "Loading Licenses and Displaying License 
Information" on page 427.

To display the user calibration status

Pressing [Utility] > Service > User Calibration Status displays the summary results of 
the previous User Calibration, and the status of probe calibrations for probes that 
can be calibrated. Note that passive probes do not need to be calibrated, but 
InfiniiMax probes can be calibrated. For more information about calibrating probes 
see "To calibrate a probe" on page 93.

To clean the oscilloscope

1 Remove power from the instrument.
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2 Clean the external surfaces of the oscilloscope with a soft cloth dampened with 
a mixture of mild detergent and water.

3 Make sure that the instrument is completely dry before reconnecting it to a 
power source.

To check warranty and extended services status

To learn the warranty status of your oscilloscope:

1 Point your web browser to: www.keysight.com/find/warrantystatus

2 Enter your product's model number and serial number. The system will search 
for the warranty status of your product and display the results. If the system 
cannot find your product's warranty status, select Contact Us and speak with a 
Keysight Technologies representative.

To contact Keysight

Information on contacting Keysight Technologies can be found at: 
www.keysight.com/find/contactus

To return the instrument

Before shipping the oscilloscope to Keysight Technologies, contact your nearest 
Keysight Technologies sales or service office for additional details. Information on 
contacting Keysight Technologies can be found at: 
www.keysight.com/find/contactus

1 Write the following information on a tag and attach it to the oscilloscope.

• Name and address of owner.

• Model number.

• Serial number.

• Description of service required or failure indication.

2 Remove accessories from the oscilloscope.

Only return accessories to Keysight Technologies if they are associated with the 
failure symptoms.

3 Package the oscilloscope.

You can use the original shipping container, or provide your own materials 
sufficient to protect the instrument during shipping.

http://www.keysight.com/find/warrantystatus
http://www.keysight.com/find/contactus
http://www.keysight.com/find/contactus
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4 Seal the shipping container securely, and mark it FRAGILE.

Configuring the [Quick Action] Key

The [Quick Action] key lets you perform common, repetitive actions by pressing a 
single key.

To configure the [Quick Action] key:

1 Press [Utility] > Quick Action > Action; then, select the action that should be 
performed:

• Off — disables the [Quick Action] key.

• Quick Measure All — displays a popup containing a snapshot of all the single 
waveform measurements. The Source softkey lets you select the waveform 
source (which also becomes the source selection in the Measurement 
Menu). See Chapter 14, “Measurements,” starting on page 255.

• Quick Measure Statistics Reset — resets all measurement statistics and the 
measurement count. See "Measurement Statistics" on page 285.

• Quick Mask Statistics Reset — resets mask statistics and counters. See "Mask 
Statistics" on page 322.

• Quick Print — prints the current screen image. Press Settings to set up the 
printing options. See Chapter 23, “Print (Screens),” starting on page 379.

• Quick Save — saves the current image, waveform data, or setup. Press Settings 
to set up the save options. See Chapter 22, “Save/Email/Recall (Setups, 
Screens, Data),” starting on page 365.

• Quick Email — e-mails the current setup, screen image, or data file. Press 
Settings to set up the e-mail options. See "Emailing Setups, Screen Images, 
or Data" on page 374.

• Quick Recall — recalls a setup, mask, or reference waveform. Press Settings to 
set up the recall options. See Chapter 22, “Save/Email/Recall (Setups, 
Screens, Data),” starting on page 365.

• Quick Freeze Display — freezes the display without stopping running 
acquisitions or un-freezes the display if currently frozen. For more 
information, see "To freeze the display" on page 174.

• Quick Trigger Mode — toggles the trigger mode between Auto and Normal, see 
"To select the Auto or Normal trigger mode" on page 220.
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• Quick Clear Display — clears the display, see "To clear the display" on 
page 169.

• Quick WaveGen Single-Shot — outputs one cycle of the waveform generator's 
defined waveform. See "To output a single-shot waveform" on page 355.

Once the [Quick Action] key is configured, you simply press it to perform the 
selected action.
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When Keysight InfiniiVision 6000 X-Series oscilloscopes are set up on the LAN, 
you can access the oscilloscope's built-in web server using a web browser. The 
oscilloscope's web interface lets you:

• View information about the oscilloscope like its model number, serial number, 
host name, IP address, and VISA (address) connect string.

• Control the oscilloscope using the Remote Front Panel.

• Send SCPI (Standard Commands for Programmable Instrumentation) remote 
programming commands via the SCPI Commands applet window.

• Save setups, screen images, waveform data, and mask files.

• Recall setup files, reference waveform data files, or mask files.

• Get screen images and save or print them from the browser.

• Activate the Identification function to identify a particular instrument by 
causing a message to be displayed or a front panel light to blink.

• View installed options, view firmware versions and install firmware upgrade 
files, and view calibration status (via the Instrument Utilities page).

• View and modify the oscilloscope's network configuration.
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The web interface for InfiniiVision X-Series oscilloscopes also provides help for 
each of its pages.

Before you can use the web interface, you must place the oscilloscope on the 
network and set up its LAN connection.

Accessing the Web Interface

To access the oscilloscope's web interface:

1 Connect the oscilloscope to your LAN (see "To establish a LAN connection" on 
page 387) or establish a point-to-point connection (see "Stand-alone 
(Point-to-Point) Connection to a PC" on page 388).

It is possible to use a point-to-point connection, but using a normal LAN 
connection is the preferred method.

2 Type the oscilloscope's hostname or IP address in the web browser.

The oscilloscope's web interface Welcome Page is displayed.
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Browser Web Control

The web interface's Browser Web Control page gives you access to:

• The Browser-Based Remote Front Panel (see "Browser-Based Remote Front 
Panel" on page 412).
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• The SCPI Command window applet for Remote Programming (see "Remote 
Programming via the Web Interface" on page 412).

Browser-Based Remote Front Panel

To operate the oscilloscope using the web interface's Tablet Remote Front Panel:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).

2 When the oscilloscope's web interface is displayed, select the Control Instrument 
tab, then select Use Remote Front Panel. After a few seconds the Remote Front 
Panel appears.

3 Click keys or knobs that you would normally press on the oscilloscope's front 
panel. Buttons have been added for turning knobs.

Remote Programming via the Web Interface

NOTE If Java is not installed on your PC, you will be prompted to install the Java Plug-in. This 
plug-in must be installed on the controlling PC for the web interface's Remote Programming 
operations.
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The SCPI Command window is useful for testing commands or entering a few 
commands interactively. When creating automated programs for controlling the 
oscilloscope, you will typically use the Keysight IO Libraries from within a 
programming environment like Microsoft Visual Studio (see "Remote 
Programming with Keysight IO Libraries" on page 414).

To send remote programming commands to the oscilloscope via the SCPI 
Commands applet window:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).

2 When the oscilloscope's web interface is displayed, select the Control Instrument 
tab, then select Use Instrument IO.

The SCPI Commands applet appears within the browser web page.
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Remote Programming with Keysight IO Libraries

While the SCPI Commands applet window lets you enter and remote 
programming commands, remote programming for automated test and data 
acquisition is typically done using the Keysight IO Libraries, which are separate 
from the instrument's web interface.

The Keysight IO Libraries let a controller PC communicate with Keysight 
InfiniiVision X-Series oscilloscopes via their USB, LAN, or GPIB interfaces (if 
available).

The Keysight IO Libraries Suite connectivity software to enables communication 
over these interfaces. You can download the Keysight IO Libraries Suite from 
www.keysight.com/find/iolib.

http://www.keysight.com/find/iolib
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Information about controlling the oscilloscope through remote commands is 
contained in the Programmer's Guide.

For more information about connecting to the oscilloscope, refer to the Keysight 
Technologies USB/LAN/GPIB Interfaces Connectivity Guide. For a printable 
electronic copy of the Connectivity Guide, direct your Web browser to 
www.keysight.com and search for "Connectivity Guide".

Save/Recall

You can save setup files, screen images, waveform data files, or mask files to your 
PC via the oscilloscope's web interface (see "Saving Files via the Web 
Interface" on page 415).

You can recall setup files, reference waveform data files, or mask files from your PC 
via the oscilloscope's web interface (see "Recalling Files via the Web 
Interface" on page 416).

Saving Files via the Web Interface

To save setup files, screen images, waveform data, Lister data, or mask files to 
your PC via the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).

2 When the oscilloscope's web interface is displayed, select the Save tab.

3 On the Save page:

a Enter the name of the file you are saving to.

b Select the format.

http://www.keysight.com
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You can click Preview to view the oscilloscope's current screen image.

With some formats, you can click Save Setup Info to save setup information to 
an ASCII .txt format file.

c Click Save.

The current acquisition is saved.

d In the File Download dialog, click Save.

e In the Save As dialog, navigate to the folder where you want to save the file; 
then, click Save.

Recalling Files via the Web Interface

To recall setup files, reference waveform data files, mask files, or arbitrary 
waveform files from your PC via the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).
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2 When the oscilloscope's web interface is displayed, select the Recall tab.

3 On the Recall page:

a Click Browse....

b In the "Choose file" dialog, select the file you want to recall; then, click Open.

c When recalling arbitrary waveform data files, select the Recall to Arb Data 
Column option.

d When recalling reference waveform data files, select the Recall to Reference 
Waveform option.

e Click Recall.

Get Image

To save (or print) the oscilloscope's display from the web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).



418 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

25 Web Interface
 

2 When the oscilloscope's web interface is displayed, select the Get Image tab. 
After a delay of several seconds, the oscilloscope's screen image will be 
displayed.

You can select the Change background to printer friendly colors check box to invert 
graticule colors.

Click Refresh Image to get an updated screen image.

3 Right-click on the image and select Save Picture As... (or Print Picture...).

4 Select a storage location for the image file and click Save.

Identification Function

The Identification web interface feature is useful when trying to locate a specific 
instrument in a rack of equipment.

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).

2 When the oscilloscope's web interface Welcome Page is displayed, select the 
Enable front panel identification indicator check box.

An "Identify" status dialog box is displayed on the oscilloscope.

You can either clear the Enable front panel identification indicator check box or 
close the dialog box on the oscilloscope to continue.
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Instrument Utilities

The Instrument Utilities page of the web interface lets you:

• View installed options.

• View firmware versions.

• Install firmware upgrade files.

• View calibration status.

You can select these capabilities via a drop-down menu.

Identification option
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Setting a Password

Whenever you connect the oscilloscope to a LAN, it is good practice to set a 
password. The password prevents someone from remotely accessing the 
oscilloscope via a Web browser and modifying its settings. Remote users can still 
view the Welcome screen, view network status, etc., but they cannot modify 
instrument settings without the password.

To set a password:

1 Access the oscilloscope's web interface (see "Accessing the Web Interface" on 
page 410).

2 When the oscilloscope's web interface is displayed, select the gear icon in the 
upper-right corner of the web page.

3 Click the Enable password button.

4 Enter your desired password in the New Password field. Enter the password 
again in the Confirm Password field. Click Enable Password.
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When a password is enabled for the web interface, Log out or Log in appears in 
the upper-right corner next to the gear icon.

To change or
disable the

password

Do one of these things:

• Select the gear icon in the upper-right corner of the web page. In the Password 
Options page, click Change Password or Disable Password.

• Another way to disable the password is to reset the oscilloscope's LAN settings. 
To do this, select the Configure LAN tab, select Advanced options, and select 
LAN Reset.

• You can also reset the oscilloscope's LAN settings using the keys on the front 
panel of the oscilloscope: press [Utility] > I/O > LAN Reset.
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Specifications and Characteristics

Please see the InfiniiVision oscilloscope data sheets for complete, up-to-date 
specifications and characteristics. To download a data sheet, please visit: 
www.keysight.com/find/6000X-Series

Measurement Category

• "Oscilloscope Measurement Category" on page 423

• "Measurement Category Definitions" on page 424

• "Maximum Input Voltages" on page 425

Oscilloscope Measurement Category

The InfiniiVision oscilloscopes are not intended to be used for measurements in 
Measurement Category II, III, or IV.

http://www.keysight.com/find/6000X-Series
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Measurement Category Definitions

The "Not rated for CAT II, III, IV" measurement category is for measurements 
performed on circuits not directly connected to MAINS. Examples are 
measurements on circuits not derived from MAINS, and specially protected 
(internal) MAINS derived circuits. In the latter case, transient stresses are variable; 
for that reason, the transient withstand capability of the equipment is made known 
to the user.

Measurement category II is for measurements performed on circuits directly 
connected to the low voltage installation. Examples are measurements on 
household appliances, portable tools and similar equipment.

Measurement category III is for measurements performed in the building 
installation. Examples are measurements on distribution boards, circuit-breakers, 
wiring, including cables, bus-bars, junction boxes, switches, socket-outlets in the 
fixed installation, and equipment for industrial use and some other equipment, for 
example, stationary motors with permanent connection to the fixed installation.

Measurement category IV is for measurements performed at the source of the 
low-voltage installation. Examples are electricity meters and measurements on 
primary overcurrent protection devices and ripple control units.

WARNING Use this instrument only for measurements within its specified measurement category 
(not rated for CAT II, III, IV). No transient overvoltages allowed.
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Maximum Input Voltages

Environmental Conditions

CAUTION  Maximum input voltage at analog inputs

Do not exceed the maximum input voltage rating.

The maximum input voltage for the 50 Ω input impedance setting is ±5 V.

Input protection is enabled in 50 Ω mode and the 50 Ω load will disconnect if greater 
than 5 Vrms is detected. However the inputs could still be damaged, depending on the 
time constant of the signal. The 50 Ω input protection functions only when the 
oscilloscope is powered on.

The maximum input voltage for the 1 MΩ input impedance setting is 30 Vrms or 
±40 Vmax (DC+Vpeak)

Probing technology allows for testing of higher voltages; the included N2894A 10:1 
probe supports 300 Vrms or ±400 Vmax (DC+Vpeak). No transient overvoltage allowed.

CAUTION When measuring voltages over 30 V, use a 10:1 probe.

CAUTION  Maximum input voltage at digital channels

±40 V peak

Environment Indoor use only.

Ambient 
temperature

0 to 50 °C

Humidity Maximum Relative Humidity (non-condensing): 80% RH up to 40 °C.

From 40 °C to 50 °C, the maximum % Relative Humidity follows a line of 
constant dew point.

Altitude 3,962 m max
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Probes and Accessories

For a list of the probes and accessories that are compatible with the 
3000T X-Series oscilloscopes, see the data sheet at: 
www.keysight.com/find/6000X-Series

AutoProbe
Interface

Most Keysight single-ended active, differential, and current probes are compatible 
with the AutoProbe interface. Active probes that do not have their own external 
power supply require substantial power from the AutoProbe interface.

If too much current is drawn from the AutoProbe interface, an error message will 
be displayed, indicating that you must momentarily disconnect all probes to reset 
the AutoProbe interface, then connect only the supported quantity of active 
probes.

See Also For more information on probes and accessories, see www.keysight.com for:

• Probes and Accessories Selection Guide (5989-6162EN)

• InfiniiVision Oscilloscope Probes and Accessories Selection Guide Data Sheet 
(5968-8153EN)

• For compatibility information, manuals, application notes, data sheets, 
selection guides, SPICE models, and more for oscilloscope probes, see the 
Probe Resource Center at: www.keysight.com/find/PRC

Overvoltage 
Category

This product is intended to be powered by MAINS that comply to Overvoltage 
Category II, which is typical of cord-and-plug connected equipment.

Pollution Degree The InfiniiVision 6000 X-Series oscilloscopes may be operated in environments 
of Pollution Degree 2 (or Pollution Degree 1).

Pollution Degree 
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs. 
The pollution has no influence. Example: A clean room or climate controlled 
office environment.

Pollution Degree 2. Normally only dry non-conductive pollution occurs. 
Occasionally a temporary conductivity caused by condensation may occur. 
Example: General indoor environment.

Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive 
pollution occurs which becomes conductive due to condensation which is 
expected. Example: Sheltered outdoor environment.

http://www.keysight.com/find/6000X-Series
http://www.keysight.com
http://literature.cdn.keysight.com/litweb/pdf/5989-6162EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5968-8153EN.pdf
http://www.keysight.com/find/PRC
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Loading Licenses and Displaying License Information

License files are loaded from a USB storage device using the File Explorer (see 
"File Explorer" on page 388).

License information is displayed with other oscilloscope information (see "To 
display oscilloscope information" on page 405).

For more information about the licenses and other oscilloscope options available, 
see:

• "Licensed Options Available" on page 427

• "Other Options Available" on page 430

• "Upgrading to an MSO" on page 430

Licensed Options Available

The following licensed options can be easily installed without returning the 
oscilloscope to a Service Center. See data sheets for details.

Table 4 Licensed Options Available

License Description After purchase model number, notes

D6000AERA/B Aerospace Software for 6000 X-Series 

Replaces licenses AERO, VID, MASK, and FRA.

Order D6000AERA/B (replaces DSOX6AERO, 
DSOX6VID, DSOX6MASK, and DSOX6FRA).

D6000AUTA/B Automotive Software for 6000 X-Series 

Replaces licenses AUTO, FLEX, MASK, SENSOR, NRZ, 
CXPI, and FRA.

Order D6000AUTA/B (replaces DSOX6AUTO, 
DSOX6FLEX, DSOX6MASK, DSOX6SENSOR, 
DSOX6NRZ, DSOX6CXP, DSOX6FRA).

D6000BDLA/B Ultimate Bundle Software for 6000 X-Series Order D6000BDLA/B.

D6000GENA/B Embedded Software for 6000 X-Series 

Replaces licenses EMBD, COMP, AUDIO, VID, MASK, 
USBPD, and FRA.

Order D6000GENA/B (replaces DSOX6EMBD, 
DSOX6COMP, DSOX6AUDIO, DSOX6VID, 
DSOX6MASK, DSOX6UPD, and DSOX6FRA).

D6000PWRA/B Power Supply Test Software for 6000 X-Series 

Replaces licenses PWR, USBPD, MASK, and FRA.

Order D6000PWRA/B (replaces DSOX6PWR, 
DSOX6UPD, DSOX6MASK, and DSOX6FRA).

D6000USBA/B USB Test Software for 6000 X-Series 

Replaces licenses USBPD, USF, U2H, USBSQ, JITTER, 
MASK, and FRA.

Order D6000USBA/B (replaces DSOX6UPD, 
DSOX6USBFL, DSOX6USBH, DSOX6USBSQ, 
DSOX6JITTER, DSOX6MASK, DSOX6FRA).
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AERO MIL-STD-1553 and ARINC 429 Serial Triggering and 
Analysis.

Order D6000AERA/B (replaces DSOX6AERO 
and others).

AUDIO Audio Serial Triggering and Analysis (I2S). Order D6000GENA/B (replaces DSOX6AUDIO 
and others).

AUTO Automotive Serial Triggering and Analysis (CAN,LIN). Order D6000AUTA/B (replaces DSOX6AUTO 
and others).

CANFD Automotive Serial Triggering and Analysis (CAN,LIN). Order D6000AUTA/B (replaces DSOX6AUTO 
and others).

COMP Computer Serial Triggering and Analysis 
(RS232/422/485/UART).

Provides trigger and decode capability for many UART 
(Universal Asynchronous Receiver/Transmitter) protocols 
including RS232 (Recommended Standard 232).

Order D6000GENA/B (replaces DSOX6COMP 
and others).

CXPI CXPI (Clock Extension Peripheral Interface) Serial 
Triggering and Analysis.

Order D6000AUTA/B (replaces DSOX6CXPI 
and others).

EMBD Embedded Serial Triggering and Analysis (I2C, SPI). Order D6000GENA/B (replaces DSOX6EMBD 
and others).

FLEX FlexRay Triggering and Analysis. Order D6000AUTA/B (replaces DSOX6FLEX 
and others).

JITTER Jitter Analysis. Order D6000USBA/B (replaces 
DSOX6JITTER and others).

FRA Frequency Response Analysis. Order D6000GENA/B, D6000AUTA/B, 
D6000AERA/B, D6000PWRA/B, or 
D6000USBA/B (which include and replace 
DSOX6FRA).

MASK Mask Limit Test

Lets you create a mask and test waveforms to determine 
whether they comply to the mask.

Order D6000GENA/B, D6000AUTA/B, 
D6000AERA/B, D6000PWRA/B, or 
D6000USBA/B (which include and replace 
DSOX6MASK).

mem4M Memory Upgrade.

It shows the total memory depth (4 Mpts interleaved).

Order DSOX6MEMUP.

Table 4 Licensed Options Available (continued)

License Description After purchase model number, notes
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MSO Mixed Signal Oscilloscope (MSO). Upgrade a DSO to an 
MSO.

Adds 16 digital channels. You do not have to install any 
hardware.

Order DSOX6MSO.

The digital probe cable kit is supplied with 
the MSO license.

NRZ Manchester/NRZ (Non Return to Zero) Triggering and 
Analysis.

Order D6000AUTA/B (replaces DSOX6NRZ 
and others).

PWR Power Measurement and Analysis. Order D6000PWRA/B (replaces DSOX6PWR 
and others).

You can find the Power Measurement 
Application User's Guide at 
www.keysight.com/find/6000X-Series
-manual.

SENSOR SENT (Single Edge Nibble Transmission) Triggering and 
Analysis.

Order D6000AUTA/B (replaces 
DSOX6SENSOR and others).

U2H USB 2.0 High Speed Triggering and Decode. Order D6000USBA/B (replaces DSOX6USBH 
and others).

USF USB 2.0 Full/Low Speed Triggering and Decode. Order D6000USBA/B (replaces DSOX6USBFL 
and others).

USBPD USB PD (Power Delivery) Serial Triggering and Decode. Order D6000GENA/B, D6000PWRA/B, or 
D6000USBA/B (which include and replace 
DSOX6UPD).

USBSQ USB 2.0 Signal Quality Analysis. Order D6000USBA/B (replaces 
DSOX6USBSQ and others).

You can find the USB 2.0 Signal Quality 
Analysis Application Electrical Testing Notes 
manual at 
www.keysight.com/find/6000X-Series
-manual.

VID Extended Video Triggering and Analysis. Order D6000GENA/B (replaces DSOX6VID 
and others).

WAVEGEN Waveform Generator. Order DSOX6WAVEGEN2.

Table 4 Licensed Options Available (continued)

License Description After purchase model number, notes

http://www.keysight.com/find/6000X-Series-manual
http://www.keysight.com/find/6000X-Series-manual
http://www.keysight.com/find/6000X-Series-manual
http://www.keysight.com/find/6000X-Series-manual
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Upgrade model numbers with the "A" suffix are subscription-based licenses; the 
ones with the "B" suffix are perpetual licenses.

Other Options Available

Upgrading to an MSO

A license can be installed to activate the digital channels of an oscilloscope that 
was not originally ordered as a mixed-signal oscilloscope (MSO). A mixed signal 
oscilloscope has analog channels plus 16 time-correlated digital timing channels.

For information about upgrading your oscilloscope through licensing, contact your 
local Keysight Technologies representative or see 
www.keysight.com/find/6000X-Series.

Software and Firmware Updates

From time to time Keysight Technologies releases software and firmware updates 
for its products. To search for firmware updates for your oscilloscope, direct your 
web browser to www.keysight.com/find/6000X-Series-sw.

To view the currently installed software and firmware press [Help] > About 
Oscilloscope.

Once you have downloaded a firmware update file, you can place it on a USB 
storage device and load the file using File Explorer (see "File Explorer" on 
page 388), or you can use the Instrument Utilities page of the oscilloscope's web 
interface (see "Instrument Utilities" on page 419).

Table 5 Calibration Option

Option Order

A6J ANSI Z540 Compliant Calibration

http://www.keysight.com/find/6000X-Series
http://www.keysight.com/find/6000X-Series-sw
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Binary Data (.bin) Format

The binary data format stores waveform data in binary format and provides data 
headers that describe that data.

Because the data is in binary format, the size of the file is approximately 5 times 
smaller than the ASCII XY format.

If more than one source is on, all displayed sources will be saved, except math 
functions.

When using segmented memory, each segment is treated as a separate 
waveform. All segments for a channel are saved, then all segments of the next 
(higher numbered) channel are saved. This continues until all displayed channels 
are saved.

When the oscilloscope is in the Peak Detect acquisition mode, the minimum and 
maximum value waveform data points are saved to the file in separate waveform 
buffers. The minimum value data points are saved first; then, the maximum value 
data points are saved.

BIN data - using
segmented

memory

When saving all segments, each segment has its own waveform header (see 
"Binary Header Format" on page 432).

In BIN file format, data are presented as follows:

• Channel 1 data (all segments)

• Channel 2 data (all segments)

• Channel 3 data (all segments)

• Channel 4 data (all segments)

• Digital channel data (all segments)

• Math waveform data (all segments)

When not saving all segments, the number of waveforms is equivalent to the 
number of active channels (including math and digital channels, with up to seven 
waveforms for each digital pod). When saving all segments, the number of 
waveforms is equal to the number of active channels multiplied by the number of 
segments acquired.
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Binary Data in MATLAB

Binary data from an InfiniiVision oscilloscope can be imported to The MathWorks 
MATLAB®. You can download the appropriate MATLAB functions from the 
Keysight Technologies web site at 
www.keysight.com/find/6000X-Series-examples.

Keysight provides the .m files, which need to be copied into the work directory for 
MATLAB. The default work directory is C:\MATLAB7\work.

Binary Header Format

File Header There is only one file header in a binary file. The file header consists of the 
following information.

Waveform Header It is possible to store more than one waveform in the file, and each waveform 
stored will have a waveform header. When using segmented memory, each 
segment is treated as a separate waveform. The waveform header contains 
information about the type of waveform data that is stored following the waveform 
data header.

Cookie Two byte characters, AG, that indicate the file is in the Keysight Binary Data file 
format.

Version Two bytes that represent the file version.

File Size A 32-bit integer that is the number of bytes that are in the file.

Number of 
Waveforms

A 32-bit integer that is the number of waveforms that are stored in the file.

Header Size A 32-bit integer that is the number of bytes in the header.

http://www.keysight.com/find/6000X-Series-examples
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Waveform Type A 32-bit integer that is the type of waveform stored in the file:

• 0 = Unknown.

• 1 = Normal.

• 2 = Peak Detect.

• 3 = Average.

• 4 = Not used in InfiniiVision oscilloscopes.

• 5 = Not used in InfiniiVision oscilloscopes.

• 6 = Logic.

Number of 
Waveform 
Buffers

A 32-bit integer that is the number of waveform buffers required to read the 
data.

Points A 32-bit integer that is the number of waveform points in the data.

Count A 32-bit integer that is the number of hits at each time bucket in the waveform 
record when the waveform was created using an acquisition mode like 
averaging. For example, when averaging, a count of four would mean every 
waveform data point in the waveform record has been averaged at least four 
times. The default value is 0.

X Display Range A 32-bit float that is the X-axis duration of the waveform that is displayed. For 
time domain waveforms, it is the duration of time across the display. If the value 
is zero then no data has been acquired.

X Display Origin A 64-bit double that is the X-axis value at the left edge of the display. For time 
domain waveforms, it is the time at the start of the display. This value is treated 
as a double precision 64-bit floating point number. If the value is zero then no 
data has been acquired.

X Increment A 64-bit double that is the duration between data points on the X axis. For time 
domain waveforms, this is the time between points. If the value is zero then no 
data has been acquired.

X Origin A 64-bit double that is the X-axis value of the first data point in the data record. 
For time domain waveforms, it is the time of the first point. This value is treated 
as a double precision 64-bit floating point number. If the value is zero then no 
data has been acquired.
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Waveform Data
Header

A waveform may have more than one data set. Each waveform data set will have a 
waveform data header. The waveform data header consists of information about 
the waveform data set. This header is stored immediately before the data set.

X Units A 32-bit integer that identifies the unit of measure for X values in the acquired 
data:

• 0 = Unknown.

• 1 = Volts.

• 2 = Seconds.

• 3 = Constant.

• 4 = Amps.

• 5 = dB.

• 6 = Hz.

Y Units A 32-bit integer that identifies the unit of measure for Y values in the acquired 
data. The possible values are listed above under X Units.

Date A 16-byte character array, left blank in InfiniiVision oscilloscopes.

Time A 16-byte character array, left blank in the InfiniiVision oscilloscopes.

Frame A 24 byte character array that is the model number and serial number of the 
oscilloscope in the format of: MODEL#:SERIAL#.

Waveform Label A 16 byte character array that contains the label assigned to the waveform.

Time Tags A 64-bit double, only used when saving multiple segments (requires segmented 
memory option). This is the time (in seconds) since the first trigger.

Segment Index A 32-bit unsigned integer. This is the segment number. Only used when saving 
multiple segments.

Waveform Data 
Header Size

A 32-bit integer that is the size of the waveform data header.
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Example Program for Reading Binary Data

To find an example program for reading binary data, direct your web browser to 
www.keysight.com/find/6000X-Series-examples, and select "Example Program 
for Reading Binary Data".

Examples of Binary Files

Single Acquisition
Multiple Analog

Channels

The following picture shows a binary file of a single acquisition with multiple 
analog channels.

Buffer Type A 16-bit short that is the type of waveform data stored in the file:

• 0 = Unknown data.

• 1 = Normal 32-bit float data.

• 2 = Maximum float data.

• 3 = Minimum float data.

• 4 = Not used in InfiniiVision oscilloscopes.

• 5 = Not used in InfiniiVision oscilloscopes.

• 6 = Digital unsigned 8-bit char data (for digital channels).

Bytes Per Point A 16-bit short that is the number of bytes per data point.

Buffer Size A 32-bit integer that is the size of the buffer required to hold the data points.

http://www.keysight.com/find/6000X-Series-examples
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Single Acquisition
All Pods Logic

Channels

The following picture shows a binary file of a single acquisition with all pods for the 
logic channels saved.

File Header
12 bytes

Number of Waveforms = N

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4
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Segmented
Memory

Acquisition on One
Analog Channel

The following picture shows a binary file of a segmented memory acquisition on 
one analog channel.

File Header
12 bytes

Waveform Header 2
140 bytes

Waveform Data
Header 1
12 bytes

Pod 1 Timing Data
buffer size

Waveform Data
Header 2
12 bytes

Pod 2 Timing Data
buffer size

Number of Waveforms = 2

Number of Waveform Buffers = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Waveform Header 1
140 bytes

Number of Waveform Buffers = 1
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CSV and ASCII XY files

• "CSV and ASCII XY file structure" on page 439

• "Minimum and Maximum Values in CSV Files" on page 439

• "Frequency Data in CSV Files" on page 440

File Header
12 bytes

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveforms = N = Number of Segments

Number of Waveform Buffers = 1
Index = 1
Time Tag = 0.0

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = 2
Time Tag = time between segment 1 and 2

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = N
Time Tag = time between segment 1 and N

Buffer Type = 1 (floating point)
Bytes per Point = 4
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CSV and ASCII XY file structure

In CSV or ASCII XY format the Length control selects the number of points per 
segment. All segments are contained in the CSV file or in each ASCII XY data file.

For example: If the Length control is set to 1000 points, there will be 1000 points 
(rows in the spreadsheet) per segment. When saving all segments there are three 
header rows, so the data for the first segment starts at row 4. The second 
segment's data starts at row 1004. The time column shows the time since the 
trigger on the first segment. The top row shows the selected number of points per 
segment.

BIN files are a more efficient data transfer format than CSV or ASCII XY. Use this 
file format for fastest data transfer.

Minimum and Maximum Values in CSV Files

If you are running a Minimum or Maximum measurement, the minimum and 
maximum values shown in the measurement display may not appear in the CSV 
file.

Explanation: When the oscilloscope's sample rate is 4 GSa/s, a sample will be taken every 
250 ps. If the horizontal scale is set to 10 us/div, there will be 100 us of data 
displayed (because there are ten divisions across the screen). To find the total 
number of samples the oscilloscope will take:

100 us x 4 GSa/s = 400K samples

The oscilloscope is required to display those 400K samples using 640 pixel 
columns. The oscilloscope will decimate the 400K samples to 640 pixel columns, 
and this decimation keeps track of the min and max values of all the points that 
are represented by any given column. Those min and max values will be displayed 
in that screen column.

A similar process is used to reduce the acquired data to produce a record usable 
for various analysis needs such as measurements and CSV data. This analysis 
record (or measurement record) is much larger than 640 and may in fact contain 
up to 65536 points. Still, once the # of acquired points > 65536, some form of 
decimation is required. The decimator used to produce a CSV record is configured 
to provide a best-estimate of all the samples that each point in the record 
represents. Therefore, the min and max values may not appear in the CSV file.
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Frequency Data in CSV Files

When data for multiple frequency sources is saved to a CSV file, this data is saved 
as one set (with multiple columns) using a horizontal (X) range that covers all 
sources.

Acknowledgements

Third-party software acknowledgements and licenses for these InfiniiVision 
X-Series oscilloscopes are located at 
www.keysight.com/find/InfiniiVision-third-party-software.

Product Markings and Regulatory Information

These symbols are used on the 6000 X-Series oscilloscopes.

Symbol Description

Caution, risk of electric shock

Caution, refer to accompanying documentation

The crossed out wheeled bin symbol indicates that separate collection for 
waste electric and electronic equipment (WEEE) is required, as obligated 
by the EU DIRECTIVE and other National legislation.

Please refer to keysight.com/go/takeback to understand your Trade 
in options with Keysight in addition to product takeback instructions.

Indicates the time period during which no hazardous or toxic substance 
elements are expected to leak or deteriorate during normal use. Forty 
years is the expected useful life of the product.

The RCM mark is a registered trademark of the Australian 
Communications and Media Authority.

http://www.keysight.com/go/takeback
http://www.keysight.com/find/InfiniiVision-third-party-software
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Compliance with
German Noise
Requirements

This is to declare that this instrument is in conformance with the German 
Regulation on Noise Declaration for Machines (Laermangabe nach der 
Maschinenlaermrerordnung -3.GSGV Deutschland).

The CE mark is a registered trademark of the European Community.

ICES / NMB-001 Cet appareil ISM est conforme a la norme NMB du 
Canada. This is a marking to indicate product compliance with the 
Industry Canadian Interference-Causing Equipment Standard (ICES-001).

This is also a symbol of an Industrial Scientific and Medical Group 1 Class 
A product (CISPR 11, Clause 4).

The CSA mark is a registered trademark of the CSA International.

South Korean Certification (KC) mark; includes the marking's identifier 
code which follows this format:

MSIP-REM-YYY-ZZZZZZZZZZZZZZ.

This mark denotes compliance with the essential requirements of the 
following applicable UK regulations:

• Electromagnetic Compatibility Regulations 2016 No. 1091 (as 
amended)

• Electrical Equipment (Safety) Regulations 2016 No. 1101 (as 
amended)

• The Restriction of the Use of Certain Hazardous Substances in 
Electrical and Electronic Equipment Regulations 2012 No. 3032 (as 
amended)

Symbol Description

Acoustic Noise Emission/Geraeuschemission

LpA <70 dB

Operator position

Normal position

per ISO 7779

LpA <70 dB

am Arbeitsplatz

normaler Betrieb

nach DIN 45635 t.19
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27 CAN/LIN Triggering and 
Serial Decode
Setup for CAN/CAN FD Signals / 443
Loading and Displaying CAN Symbolic Data / 446
CAN/CAN FD Triggering / 447
CAN/CAN FD Serial Decode / 450
Setup for LIN Signals / 456
Loading and Displaying LIN Symbolic Data / 457
LIN Triggering / 458
LIN Serial Decode / 460

The CAN/LIN triggering and serial decode option is license-enabled.

Setup for CAN/CAN FD Signals

Setup consists of connecting the oscilloscope to a CAN signal, using the Signals 
Menu to specify the signal source, threshold voltage level, baud rate, and sample 
point.

Connect the oscilloscope to a CAN signal that has a dominant-low polarity. If you 
are connecting to the CAN signal using a differential probe, connect the probe's 
positive lead to the dominant-low CAN signal and connect the negative lead to 
the dominant-high CAN signal.

To set up the oscilloscope to capture CAN signals:

1 Press [Serial].
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2 Press the Serial softkey, turn the Entry knob to select Serial 1 or Serial 2, and 
press the softkey again to enable decode.

3 Press the Mode softkey; then, select CAN trigger type.

4 Press the Signals softkey to open the CAN Signals Menu.

5 Press Source; then, select the channel for the CAN signal.

The label for the CAN source channel is automatically set.

6 Press the Threshold softkey; then, turn the Entry knob to select the CAN signal 
threshold voltage level.

The threshold voltage level is used in decoding, and it will become the trigger 
level when the trigger type is set to the selected serial decode slot.

7 Press the Std. Rate Settings softkey to open the CAN Standard Rate Settings 
Menu.

a Press the Baud softkey; then, turn the Entry knob to select the baud rate that 
matches match your CAN bus signal.

The CAN baud rate can be set to predefined baud rates from 10 kb/s up to 
5 Mb/s or a user-defined baud rate from 10.0 kb/s to 4 Mb/s in increments 
of 100 b/s. Fractional user-defined baud rates between 4 Mb/s and 5 Mb/s 
are not allowed.

The default baud rate is 125 kb/s

If none of the pre-defined selections match your CAN bus signal, select User 
Defined; then, press the User Baud softkey and turn the Entry knob to enter 
the baud rate.

b Press the Sample Point softkey; then, turn the Entry knob to select the point 
between phase segments 1 and 2 where the state of the bus is measured. 
This controls the point within the bit's time where the bit value is captured.
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c Press the Back/Up key to return to the CAN Signals Menu.

8 When decoding CAN FD, press the FD Rate Settings softkey to open the CAN FD 
Rate Settings Menu.

a Press the Baud softkey; then, turn the Entry knob to match the CAN FD baud 
rate of the signal from your device under test.

If the desired baud rate is not shown in the list, select User Defined and use 
the User Baud softkey to set the baud rate.

The CAN FD baud rate can be set to predefined baud rates from 1-10 Mb/s 
or a user-defined baud rate from 10.0 kb/s to 10 Mb/s in increments of 
100 b/s.

If the baud rate you select does not match the CAN FD baud rate, false 
triggers and decoding may occur.

b Press the Sample Point softkey; then, turn the Entry knob to select the sample 
point.

The sample point is the point during the bit time where the bit level is 
sampled to determine whether it is dominant or recessive. The sample point 
represents the percentage of time between the beginning of the bit time to 
the end of the bit time.

60%
70%

80%
Sample Point

One Bit

Back

NOTE For standard CAN, only the Standard Rate Settings must be set correctly. For CAN FD, both 
the Standard Rate Settings and the FD Rate Settings must be set correctly.
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You may need to adjust the sample point to get a reliable trigger and 
decode, depending on your CAN FD network topology and where the 
oscilloscope probe is located in the network.

c Press the Standard softkey to select the standard that will be used when 
decoding or triggering on FD frames, ISO, or non-ISO.

This setting has no effect on the processing of non-FD (classical) frames.

d Press the Back/Up key to return to the CAN Signals Menu.

9 Press the Signal softkey and select the type and polarity of the CAN signal. This 
also automatically sets the channel label for the source channel.

• CAN_H — The actual CAN_H differential bus.

• Differential (H-L) — The CAN differential bus signals connected to an analog 
source channel using a differential probe. Connect the probe's positive lead 
to the dominant-high CAN signal (CAN_H) and connect the negative lead to 
the dominant-low CAN signal (CAN_L).

Dominant low signals:

• Rx — The Receive signal from the CAN bus transceiver.

• Tx — The Transmit signal from the CAN bus transceiver.

• CAN_L — The actual CAN_L differential bus signal.

• Differential (L-H) — The CAN differential bus signals connected to an analog 
source channel using a differential probe. Connect the probe's positive lead 
to the dominant-low CAN signal (CAN_L) and connect the negative lead to 
the dominant-high CAN signal (CAN_H).

Loading and Displaying CAN Symbolic Data

When you load (recall) a CAN DBC communication database (*.dbc) file into the 
oscilloscope, its symbolic information can be:

• Displayed in the decode waveform and Lister window.

• Used when setting up CAN triggering.

• Used when searching for CAN data in the decode.

To recall a DBC file into the oscilloscope:

1 Press [Save/Recall] > Recall > Recall > CAN Symbolic data (*.dbc).

Back
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2 Press Press to go and navigate to the DBC file on a USB storage device.

3 Press Load to: and select which serial decode (S1 or S2) the symbolic information 
will be used with.

4 Press Press to Recall.

The DBC file remains in the oscilloscope until it is overwritten or a secure erase is 
performed.

To display CAN symbolic data:

1 Press [Serial].

2 Press the Display softkey and select Symbolic (instead of Hexadecimal).

Your choice affects both the decode waveform and the Lister window.

CAN/CAN FD Triggering

To set up the oscilloscope to capture a CAN signal, see "Setup for CAN/CAN FD 
Signals" on page 443.

The Controller Area Network (CAN) trigger allows triggering on CAN version 2.0A, 
2.0B, and CAN FD (Flexible Data-rate) signals.

A CAN message frame in CAN_L signal type is shown below:

After setting up the oscilloscope to capture a CAN signal:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select Serial 1 or Serial 2 on which the CAN signal is being decoded.

NOTE For CAN FD frames, symbolic decoding is limited to the first eight bytes.

Arbitration
Field

Bus
Idle

Data
Field

SOF edge

Control
Field

ACK
Field

IntermissionCRC
Field

EOF
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3 Press the Trigger on: softkey; then, turn the Entry knob to select the trigger 
condition:

• SOF - Start of Frame — triggers at the start bit for both data and overload 
frames.

• EOF - End of Frame — triggers at the end of any frame. *

• Frame ID — triggers on any standard CAN (data or remote) or CAN FD frame 
at the end of the 11- or 29-bit ID field.

• Data Frame ID (non-FD) — triggers on standard CAN data frames at the end of 
the 11- or 29-bit ID field.

• Data Frame ID and Data (non-FD) — triggers on any standard CAN data frame at 
the end of the last data byte defined in the trigger. The DLC of the packet 
must must match the number of bytes specified.

• Data Frame ID and Data (FD) — triggers on CAN FD frames at the end of the last 
data byte defined in the trigger. You can trigger on up to 8 bytes of data 
anywhere within the CAN FD data, which can be up to 64 bytes long.

• Remote Frame ID — triggers on standard CAN remote frames at the end of the 
11- or 29-bit ID field.

• Error Frame — triggers after 6 consecutive 0s while in a data frame, at the 
EOF. *

• Acknowledge Error — triggers on the acknowledge bit if the polarity is 
incorrect. *

• Form Error — triggers on reserved bit errors. *

• Stuff Error — triggers on 6 consecutive 1s or 6 consecutive 0s, while in a 
non-error or non overload frame. *

• CRC Field Error — triggers when the calculated CRC does not match the 
transmitted CRC. In addition, for FD frames, will also trigger if the Stuff 
Count is in error. *

• Spec Error (Ack or Form or Stuff or CRC) — triggers on Ack, Form, Stuff, or CRC 
errors. *

• All Errors — triggers on all Spec errors and error frames. *

• BRS Bit (FD) — triggers on the BRS bit of CAN FD frames. *

• CRC Delimiter Bit (FD) — triggers on the CRC delimiter bit in CAN FD frames. *



CAN/LIN Triggering and Serial Decode 27

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 449

 

• ESI Bit Active (FD) — triggers on the ESI bit if set active. *

• ESI Bit Passive (FD) — triggers on the ESI bit if set passive. *

• Overload Frame — triggers on an overload frame.

* You can optionally qualify the trigger for frames whose ID you specify.

When CAN symbolic data is loaded into the oscilloscope (see "Loading and 
Displaying CAN Symbolic Data" on page 446), you can trigger on:

• Message — a symbolic message.

• Message and Signal (non-FD) — a symbolic message and a signal value.

• Message and Signal (FD, first 8 bytes only) — a symbolic message and a signal 
value, limited to the first 8 bytes of FD data.

Symbolic messages, signals, and values are defined in the DBC communication 
database file.

A message is the symbolic name for a CAN frame ID, a signal is the symbolic 
name for a bit or set of bits within the CAN data, and a value can be a symbolic 
representation of the signal bit values or it can be a decimal number with units.

4 If you select a condition that lets you qualify by ID or trigger on ID or data 
values, use the Filter by ID softkey, or the Bits softkey and the CAN Bits Menu, 
and the remaining softkeys to specify those values.

For details about using the remaining softkeys to enter values, press and hold 
the softkey in question to display the built-in help.

You can use the Zoom mode for easier navigation of the decoded data.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.

NOTE To display CAN serial decode, see "CAN/CAN FD Serial Decode" on page 450.
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CAN/CAN FD Serial Decode

To set up the oscilloscope to capture CAN signals, see "Setup for CAN/CAN FD 
Signals" on page 443.

To set up CAN serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting CAN/CAN FD Decode" on page 451

• "CAN Totalizer" on page 452

• "Interpreting CAN Lister Data" on page 454

• "Searching for CAN Data in the Lister" on page 455

NOTE For CAN triggering set up see "CAN/CAN FD Triggering" on page 447.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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Interpreting CAN/CAN FD Decode

The CAN decode display is color coded as follows:

• Blue angled waveforms show an active bus (inside a packet/frame).

• Blue mid-level lines show an idle bus.

• Frame ID — yellow.

• Data bytes — white hex digits.

• CAN frame type and Data Length Code (DLC) — blue for data frames, green for 
remote frames. The DLC is always a decimal value. CAN frame types can be:

• FD — a CAN FD frame whose bit rate does not switch during the data phase.

• BRS — a CAN FD frame whose bit rate switches during the data phase.

• RMT — a standard CAN remote frame.

• Data — a standard CAN data frame.
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The status of the Error State Indicator (ESI) flag is shown in the "Type" column 
of the Lister. If the ESI bit is recessive, indicating error passive, the background 
of the "Type" column will be yellow. If the ESI bit indicates error active, the 
"Type" column's background will be unshaded.

The DLC field will always be displayed in decimal, and will indicate the number 
of bytes in the frame. So for example, for an FD frame that has the DLC code 
0xF, which represents a packet with 64 bytes, "DLC=64" will be displayed on 
the decode line, and "64" will be displayed in the DLC column of the Lister.

• Overload frame — blue with the text "OVRLD". An overload condition may occur 
before an end of frame condition. If so, the frame is closed and opened with 
blue brackets at the start of the overload condition.

• Stuff Count — green hex digit when valid, red when error detected. The hex digit 
shows the gray-coded with parity bit stuff count.

• CRC — blue hex digits when valid, red when error detected.

• Red angled waveforms — Unknown or error condition.

• Flagged error frames — red with "ERR FRAME", "STUFF ERR", "FORM ERR", 
"ACK ERR", "GLITCH ERR", or "?" (unknown).

• Pink vertical bars — Expand horizontal scale (and run again) to see decode.

• Red Dot — More information is available. Decoded text is truncated to fit. 
Expand the horizontal scale to view the information.

CAN Totalizer

The CAN totalizer provides a direct measure of bus quality and efficiency. The CAN 
totalizer measures total CAN frames, Specification error counter, flagged error 
frames, and bus utilization.

The totalizer is always running (counting frames and calculating percentages) and 
is displayed whenever CAN decode is displayed. The totalizer counts even when 
the oscilloscope is stopped (not acquiring data). Pressing the [Run/Stop] key does 
not affect the totalizer. When an overflow condition occurs, the counter displays 
OVERFLOW. The counters can be reset to zero by pressing the Reset CAN Counters 
softkey.
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Types of Frames • Active error frames are CAN frames in which a CAN node recognizes an error 
condition during a data or remote frame and issues an active error flag.

• A partial frame occurs when the oscilloscope detects any error condition during 
a frame that is not followed by an active error flag. Partial frames are not 
counted.

Counters • The FRAMES counter gives the total number of completed remote, data, 
overload, and active error frames.

• The SPEC counter gives the total number of Specification errors. This counter 
tracks the number of Acknowledge, Form, Stuff, and CRC errors. If a packet has 
more than one type of error, that packet will increment the counter by the total 
number of errors in the packet.

• The ERR FR counter gives the total number of completed active error frames 
and their percentage of the total number of frames.

• The LOAD (bus load) indicator measures the percentage of time the bus is 
active. The calculation is done on 330 ms periods, approximately every 400 ms.

Example: If a data frame contains an active error flag, both the FRAMES counter 
and the ERR FR counter will be incremented. If a data frame contains an error that 
is not an active error it is considered a partial frame and no counters are 
incremented.
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Interpreting CAN Lister Data

In addition to the standard Time column, the CAN Lister contains these columns:

• ID — frame ID. Can be displayed as hex digits or symbolic information (see 
"Loading and Displaying CAN Symbolic Data" on page 446).

• Type — frame type (RMT remote frame or Data).

• DLC — data length code.

• Data — data bytes. Can be displayed as hex digits or symbolic information.

• CRC — cyclic redundancy check.

• Errors — highlighted in red. Errors can be Acknowledge (Ack, A), Form (Fo), or 
Frame (Fr). Different kinds of errors can be combined like "Fo,Fr" in the above 
example.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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Searching for CAN Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
CAN data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With CAN selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
Serial 1 or Serial 2 on which the CAN signal is being decoded.

3 Press Search for; then, select from these options:

• Frame ID — Finds remote or data frames matching the specified ID.

• Data Frame ID — Finds data frames matching the specified ID.

• Data Frame ID and Data — Finds data frames matching the specified ID and 
data.

• Remote Frame ID — Finds remote frames with the specified ID.

• Error Frame — Finds CAN active error frames.

• Acknowledge Error — Finds the acknowledge bit if the polarity is incorrect.

• Form Error — Finds reserved bit errors.

• Stuff Error — Finds 6 consecutive 1s or 6 consecutive 0s, while in a non-error 
or non overload frame.

• CRC Field Error — Finds when the calculated CRC does not match the 
transmitted CRC.

• All Errors — Finds any form error or active error.

• Overload Frame — Finds CAN overload frames.

When CAN symbolic data is loaded into the oscilloscope (see "Loading and 
Displaying CAN Symbolic Data" on page 446), you can search for:

• Message — a symbolic message.

• Message and Signal — a symbolic message and a signal value.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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Setup for LIN Signals

LIN (Local Interconnect Network) signal setup consists of connecting the 
oscilloscope to a serial LIN signal, specifying the signal source, threshold voltage 
level, baud rate, sample point, and other LIN signal parameters.

To set up the oscilloscope to capture LIN signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select LIN trigger type.

4 Press the Signals softkey to open the LIN Signals Menu.

5 Press the Source softkey to select the channel connected to the LIN signal line.

The label for the LIN source channel is automatically set.

6 Press the Threshold softkey; then, turn the Entry knob to set the LIN signal 
threshold voltage level to the middle of the LIN signal.

The threshold voltage level is used in decoding, and it will become the trigger 
level when the trigger type is set to the selected serial decode slot.

7 Press the Baud Rate softkey to open the LIN Baud Rate Menu.

8 Press the Baud softkey; then, turn the Entry knob to select the baud rate that 
matches match your LIN bus signal.

The default baud rate is 19.2 kb/s.

If none of the pre-defined selections match your LIN bus signal, select User 
Defined; then, press the User Baud softkey and turn the Entry knob to enter the 
baud rate.

You can set the LIN baud rate from 2.4 kb/s to 625 kb/s in increments of 
100 b/s.

9 Press the Back/Up key to return to the LIN Signals Menu.Back
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10 Press the Sample Point softkey; then, turn the Entry knob to select the sample 
point at which the oscilloscope will sample the bit value.

11 Press the Standard softkey; then, turn the Entry knob to select the LIN standard 
you are measuring:

• LIN 1.3

• LIN 1.3 (no length control) — Select this for systems where length control is not 
used and all nodes have knowledge of the data packet size. In LIN 1.3, the ID 
may or may not be used to indicate the number of bytes. (In LIN 2.X, there is 
no length control.)

• LIN 2.X

For LIN 1.2 signals, use the LIN 1.3 setting. The LIN 1.3 setting assumes the 
signal follows the "Table of Valid ID Values" as shown in section A.2 of the LIN 
Specification dated December 12, 2002. If your signal does not comply with the 
table, use the LIN 2.X setting.

12 Press the Sync Break softkey and select the minimum number of clocks that 
define a sync break in your LIN signal.

Loading and Displaying LIN Symbolic Data

When you load (recall) a LIN description file (*.ldf) into the oscilloscope, its 
symbolic information can be:

• Displayed in the decode waveform and Lister window.

• Used when setting up LIN triggering.

• Used when searching for LIN data in the decode.

To recall a LIN description file into the oscilloscope:

1 Press [Save/Recall] > Recall > Recall > LIN Symbolic data (*.ldf).

2 Press Press to go and navigate to the LIN description file on a USB storage 
device.

60%
70%

80%
Sample Point

One Bit
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3 Press Load to: and select which serial decode (S1 or S2) the symbolic information 
will be used with.

4 Press Press to Recall.

The LIN description file remains in the oscilloscope until it is overwritten or a 
secure erase is performed.

To display LIN symbolic data:

1 Press [Serial].

2 Press the Display softkey and select Symbolic (instead of Hexadecimal).

Your choice affects both the decode waveform and the Lister window.

LIN Triggering

To set up the oscilloscope to capture a LIN signal, see "Setup for LIN Signals" on 
page 456.

LIN triggering can trigger on the rising edge at the Sync Break exit of the LIN 
single-wire bus signal (that marks the beginning of the message frame), the 
Frame ID, or the Frame ID and Data.

A LIN signal message frame is shown below:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the CAN signal is being 
decoded.

Sync
Break

Identifier
Break

Sync Break Exit

Sync
Field

Checksum
Field

Data
Fields
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3 Press the Trigger on: softkey; then, turn the Entry knob to select the trigger 
condition:

• Sync (Sync Break) — The oscilloscope triggers on the rising edge at the Sync 
Break exit of the LIN single-wire bus signal that marks the beginning the 
message frame.

• ID (Frame ID) — The oscilloscope triggers when a frame with an ID equal to 
the selected value is detected. Use the Entry knob to select the value for the 
Frame ID.

• ID & Data (Frame ID and Data) — The oscilloscope triggers when a frame with 
an ID and data equal to the selected values is detected. When triggering on 
a frame ID and data:

• To select the frame ID value, press the Frame ID softkey, and use the Entry 
knob.

Note that you can enter a "don't care" value for the frame ID and trigger 
on data values only.

• To set up the number of data bytes and enter their values (in hexadecimal 
or binary), use the remaining softkeys.

• Parity Error — The oscilloscope triggers on parity errors.

• Checksum Error — The oscilloscope triggers on checksum errors.

When a LIN description file (*.ldf) is loaded (recalled) into the oscilloscope (see 
"Loading and Displaying LIN Symbolic Data" on page 457), you can trigger on:

• Frame (Symbolic) — a symbolic frame value.

• Frame and Signal — a symbolic frame value and a signal value.

Symbolic frames, signals, and values are defined in the LIN description file.

A frame is the symbolic name for a LIN frame ID, a signal is the symbolic name 
for a bit or set of bits within the LIN data, and a value can be a symbolic 
representation of the signal bit values or it can be a decimal number with units.
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LIN Serial Decode

To set up the oscilloscope to capture LIN signals, see "Setup for LIN Signals" on 
page 456.

NOTE For details about using the LIN Bits Menu softkeys, press and hold the softkey in question to 
display the built-in help.

NOTE For LIN decode information see "LIN Serial Decode" on page 460.
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To set up LIN serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Choose whether to include the parity bits in the identifier field.

a If you want to mask the upper two parity bits, ensure that the box under the 
Show Parity softkey is not selected.

b If you want to include the parity bits in the identifier field, ensure that the box 
under the Show Parity softkey is selected.

3 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting LIN Decode" on page 462

• "Interpreting LIN Lister Data" on page 463

• "Searching for LIN Data in the Lister" on page 464

NOTE For LIN triggering setup see "LIN Triggering" on page 458.

NOTE If the setup does not produce a stable trigger, the LIN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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Interpreting LIN Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• The hexadecimal ID and parity bits (if enabled) appear in yellow. If a parity error 
is detected the hexadecimal ID and parity bits (if enabled) appear in red.

• Decoded hexadecimal data values appear in white.

• The checksum appears in blue if correct, or red if incorrect.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Unknown bus values (undefined or error conditions) are drawn in red.
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• If there is an error in the synch field, SYNC will appear in red.

• If the header exceeds the length specified in the standard, THM will appear red.

• If the total frame count exceeds the length specified in the standard, TFM will 
appear red (LIN 1.3 only).

• For LIN 1.3 a wakeup signal is indicated by WAKE in blue. If the wakeup signal 
is not followed by a valid wakeup delimiter a wakeup error is detected and 
displayed as WUP in red.

Interpreting LIN Lister Data

In addition to the standard Time column, the LIN Lister contains these columns:

• ID — frame ID. Can be displayed as hex digits or symbolic information (see 
"Loading and Displaying LIN Symbolic Data" on page 457).

• Data — data bytes. Can be displayed as hex digits or symbolic information.

• Checksum.

• Errors — highlighted in red.
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Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Searching for LIN Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
LIN data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With LIN selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the LIN signal is being decoded.

3 Press Search; then, select from these options:

• ID — Finds frames with the specified ID. Press the Frame ID softkey to select 
the ID.

• ID & Data — Finds frames with the specified ID and data. Press the Frame ID 
softkey to select the ID. Press the Bits softkey to enter the data value.

• Errors — Finds all errors.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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28 CXPI Triggering and Serial 
Decode
Setup for CXPI Signals / 465
CXPI Triggering / 466
CXPI Serial Decode / 469

The CXPI (Clock Extension Peripheral Interface) triggering and serial decode 
option is license-enabled.

Setup for CXPI Signals

To set up the oscilloscope to capture CXPI signals:

1 Connect an oscilloscope channel to the signal in the device under test.

Analog channels can be used.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select CXPI.

5 Press the Bus Config softkey to open the CXPI Bus Configuration Menu.
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a Press the Source softkey; then, turn the Entry knob to select the channel for 
the signal.

b Press the Threshold softkey; then, turn the Entry knob to select the signal 
threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode 
(Serial 1 or Serial 2).

c Press the Tolerance softkey; then, turn the Entry knob (or press the softkey 
again and use a keypad dialog) to specify the tolerance as a percentage of 
the Tbit width.

d Press the Baud Rate softkey; then, turn the Entry knob (or press the softkey 
again and use a keypad dialog) to match the baud rate of the CXPI signal 
from your device under test.

The CXPI baud rate can be set from 9600 b/s to 40000 b/s in 100 b/s 
increments.

You must set the baud rate to match your device under test.

The default baud rate is 20 kb/s.

e Select Show Parity to include the parity bit in the identifier field.

When Show Parity is not selected, the upper bit is masked. The parity is still 
checked, but it is not displayed unless a parity error occurs.

Parity errors are shown in red.

f Press the Back/Up key to return to the CXPI Serial Decode Menu.

CXPI Triggering

To set up the oscilloscope to capture CXPI signals, see "Setup for CXPI 
Signals" on page 465.

When CXPI (Clock Extension Peripheral Interface) is selected as one of the serial 
bus decodes, you can trigger on CXPI signals.

Back
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CXPI frames have the following format:

• DLC = Data Length Code

• NM = Network Management

• CT = Counter

To set up a CXPI trigger condition:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select the serial decode (Serial 1 or Serial 2) of the CXPI signal.

3 Press the Trigger on: softkey and use the  Entry knob to select the CXPI 
trigger type:

• SOF - Start of Frame — triggers at the start bit of any frame.

• EOF - End of Frame — triggers at the end of any frame.

• PTYPE — triggers on any frame that starts with the special PTYPE byte.

PTYPE frames begins with an extra PID byte with a Frame ID of 0000000b 
(reserved for only PTYPE frames). The PTYPE PID byte is then followed by a 
regular PID byte and the rest of the normal frame. The extra PTYPE byte is 
never included in the CRC calculation.

Parity 
(1 bit)

Frame ID 
(7 bits)

DLC 
(4 bits)

NM 
(2 bits)

wakeup sleep

CT 
(2 bits)

Data 
(0-12 bytes)

CRC 
(1 byte)

Frame Info 
(1 byte)

PID 
(1 byte)

Normal frame

Long frame

Parity 
(1 bit)

Frame ID 
(7 bits)

DLC 
(4 bits, 
= 0xF)

NM 
(2 bits)

wakeup sleep

CT 
(2 bits)

Data 
(0-255 bytes)

CRC 
(2 bytes)

Frame Info 
(2 bytes)

PID 
(1 byte)

Extension 
DLC 

(1 byte)
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• Frame ID — triggers on a user-defined Frame ID at the end of the PID byte. 
The Frame ID value is user-defined, 7 bits, and has bitwise don't-cares. You 
can specify whether to trigger on PTYPE present or no PTYPE present.

• Frame ID, Info and Data — triggers on CXPI frames at the end of the last data 
byte defined in the trigger. In addition to the PID value, you can specify the 
contents of the Frame Info byte with bitwise don't-cares. You can specify up 
to 12 data bytes on which to trigger with bitwise don't-cares.

• Frame ID, Info and Data (Long Frame) — triggers on CXPI frames at the end of the 
last data byte defined in the trigger. The standard DLC field will be locked to 
1111b. You can specify up to 12 bytes of data on which to trigger and specify 
the start byte number as an offset. The offset can be up to 123 bytes when 
PTYPE is present or 124 bytes when PTYPE is not present.

• CRC Field Error — triggers when the calculated CRC does not match the 
transmitted CRC. You can optionally filter by Frame ID and PTYPE as in the 
Frame ID trigger.

• Parity Error — triggers when the parity bit in the PID or PTYPE field is not 
correct.

• Inter-Byte Space Error — triggers when there are more than 9 bits between 
consecutive bytes in a frame. You can optionally filter by Frame ID and 
PTYPE as in the Frame ID trigger.

• Inter-Frame Space Error — triggers when there are fewer than 10 idle bits 
before a new frame begins.

• Framing Error — triggers when the stop bit of a byte is not logical 1. You can 
optionally filter by Frame ID and PTYPE as in the Frame ID trigger.

• Data Length Error — triggers when there are more data bytes in a frame than is 
indicated by the DLC or Extended DLC field. You can optionally filter by 
Frame ID and PTYPE as in the Frame ID trigger.

• Sample Error — triggers when 10 consecutive logical 0s are detected.

• All Errors — triggers on all CRC, Parity, IBS, Stop Bit, Data Length, and 
Sample errors.

• Sleep Frame — triggers when a normal frame is transmitted matching the 
definition of a sleep frame in the CXPI specification.

• Wakeup Pulse — triggers when a wakeup pulse is detected.

4 For the trigger types that let you trigger on data, press the Bits softkey. In the 
CXPI Bits Menu, you can specify ID, Frame Info, and Data values to trigger on:
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• Define — this softkey selects what you want to specify (ID, Frame Info, or 
Data) and in what format (Hex, or Binary). The remaining softkeys in the 
menu let you enter values.

• PTYPE — when specifying ID values, this softkey specifies whether you want 
to trigger when the special PTYPE byte is present or not present.

• DLC — when specifying Frame Info or Data values, this softkey specifies the 
data length code to trigger on. This will also affect the number of data bytes 
you can specify in the trigger.

• # of Bytes — this softkey specifies the number of bytes of data to trigger on. It 
is limited by the specified DLC value but can be smaller.

• Start Byte # — when triggering on long frames, the maximum number of bytes 
of data you can trigger on is 12, but those 12 bytes can be located at an 
offset within the data. This softkey specifies the offset starting byte. The 
starting byte can be up to 123 when PTYPE is present or up to 124 when 
PTYPE is not present.

5 When triggering on CRC Field Errors, Inter-Byte Space Errors, Framing Errors, 
or Data Length Errors, there is a Filter by ID softkey that you can enable to 
modify the trigger so that it occurs only for a specified ID.

CXPI Serial Decode

To set up the oscilloscope to capture CXPI signals, see "Setup for CXPI 
Signals" on page 465.

NOTE If the setup does not produce a stable trigger, the CXPI signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.

NOTE To display CXPI serial decode, see "CXPI Serial Decode" on page 469.

NOTE For CXPI triggering setup see "CXPI Triggering" on page 466.
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To set up CXPI serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting CXPI Decode" on page 471

• "Interpreting CXPI Lister Data" on page 473

NOTE If the setup does not produce a stable trigger, the CXPI signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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Interpreting CXPI Decode

The CXPI decode display is color coded as follows:

• Blue angled waveforms show an active bus (inside a packet/frame).

• Blue mid-level lines show an idle bus.

• For PTYPE frames, the text "PTYPE" is shown in the decode before the Frame 
ID. If the parity bit in the PTYPE field is in error, the "PTYPE" text is displayed in 
red.

• Packet/Frame ID — yellow hex digits. The packet/frame ID can optionally show 
or omit the leading parity bit.

• Data Length Code (DLC) — cyan. The DLC is always a decimal value.

• Network Management (NM) — green. Binary value, two bits.

• Counter (CT) — yellow. Binary value, two bits.

• Data bytes — white text formatted as a pair of hexadecimal nibbles for each 
byte. These hexadecimal bytes are shown with MSB at the left..
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• CRC — cyan hex digits when valid, red when error detected.

• Red angled waveforms — Unknown or error condition.

• Flagged error frames — red, with:

• "IBS ERR" — Inter-Byte Space error. When the space between bytes in a 
frame is greater than 9 bits.

• "IFS ERR" — Inter-Frame Space error. When there are fewer than 10 bits 
present in the idle state before a new frame starts.

• "FRAME ERR" — Framing error. When the stop bit is not a logical 1.

• "LEN ERR" — Data Length error. If the frame has more data bytes than are 
indicated in the DLC field.

• "SAMP ERR" — Sample error. If 10 logical 0s are detected consecutively.

• "?" — (unknown)

• Pink vertical bars — Expand horizontal scale (and run again) to see decode.

• Red Dot — More information is available. Decoded text is truncated to fit. 
Expand the horizontal scale to view the information.

When the bus goes into sleep conditions, special frames are drawn:

• SLEEP frame — orange. Displayed 2.5 ms after the bus goes idle-high. In the 
Lister, the fixed hex data values in the Data column are replaced by the text 
"SLEEP FRAME".

• WAKE frame — blue. When a low pulse of 250-2500 µs is detected, it is a 
wakeup pulse, and a blue WAKE frame will be drawn. After that pulse will be an 
orange line. The decode line will turn blue/idle after the first 10 clock ticks are 
detected (but not before).
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Interpreting CXPI Lister Data

In addition to the standard Time column, the CXPI Lister contains these columns:

• ID — value in Hex.

• DLC — (Data Length Code) values in Decimal.

• NM/CT — (Network Management/Counter) values in Binary.

• Data — values in Hex.

For sleep frames, data values are replaced by the text "SLEEP FRAME". 

• CRC — value in Hex.

• Errors — string value that displays the type of error detected:

• CRC — CRC Error.

• Parity Error.

• IBS — IBS Error.

• Fr — Frame Error.
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• LEN — LENGTH Error.

• SAMP — SAMPLE Error.
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29 FlexRay Triggering and 
Serial Decode
Setup for FlexRay Signals / 475
FlexRay Triggering / 476
FlexRay Serial Decode / 479

The FlexRay triggering and serial decode option is license-enabled.

Setup for FlexRay Signals

FlexRay signal setup consists of first connecting the oscilloscope to a differential 
FlexRay signal using a differential active probe (the Keysight N2792A is 
recommended), specifying the signal source, threshold voltage trigger level, baud 
rate, and bus type.

To set up the oscilloscope to capture FlexRay signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired serial bus 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select FlexRay mode.

5 Press the Signals softkey to open the FlexRay Signals Menu.
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6 Press Source and select the analog channel that is probing the FlexRay signal.

7 Press Threshold; then, turn the Entry knob to set the threshold voltage level.

The threshold level should be set below the idle level.

The threshold voltage level is used in decoding and will become the trigger 
level when the trigger type is set to the selected serial decode bus.

8 Press Baud and select the baud rate of the FlexRay signal being probed.

9 Press Bus and select the bus type of the FlexRay signal being probed.

It is important to specify the correct bus because this setting affects CRC error 
detection.

10 Press Auto Setup to perform the following actions:

• Sets the selected source channel's impedance to 50 Ohms, assuming a 
differential active probe that requires a 50 ohm termination is being used .

• Sets the selected source channel's probe attenuation to 10:1.

• Sets the trigger level (on the selected source channel) to -300 mV.

• Turns on trigger Noise Reject.

• Turns on Serial Decode.

• Sets the trigger type to FlexRay.

FlexRay Triggering

To set up the oscilloscope to capture a FlexRay signal, see "Setup for FlexRay 
Signals" on page 475.

After you have set up the oscilloscope to capture a FlexRay signal, you can then 
set up triggers on frames (see page 477), errors (see page 478), or events (see 
page 478).

NOTE To display FlexRay serial decode, see "FlexRay Serial Decode" on page 479.
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Triggering on FlexRay Frames

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial bus (Serial 1 or Serial 2) on which the FlexRay signals are being 
decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Frame.

4 Press the Frames softkey to open the FlexRay Frame Trigger Menu.

5 Press the Frame ID softkey, and use the Entry knob to select the frame ID value 
from All or 1 to 2047.

6 Press the Frame Type softkey to select the frame type:

• All Frames

• Startup Frames

• NULL Frames

• Sync Frames

• Normal Frames

• NOT Startup Frames

• NOT NULL Frames

• NOT Sync Frames

7 Press the Cyc Ct Rep softkey, and use the Entry knob to select the cycle count 
repetition factor (2, 4, 8, 16, 32, or 64, or All).

8 Press the Cyc Ct Bas softkey, and use the Entry knob to select the cycle count 
base factor from 0 through the Cyc Ct Rep factor minus 1.

For example, with a base factor of 1 and a repetition factor of 16, the 
oscilloscope triggers on cycles 1, 17, 33, 49, and 65.
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To trigger on a particular cycle, set the Cycle Repetition factor to 64 and use 
the cycle base factor to choose a cycle.

To trigger all (any) cycles, set the Cycle Repetition factor to All. The scope will 
trigger on any and all cycles.

Triggering on FlexRay Errors

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial bus (Serial 1 or Serial 2) on which the FlexRay signals are being 
decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Error.

4 Press the Errors softkey; then, select the error type:

• All Errors

• Header CRC Error — cyclic redundancy check error in the header.

• Frame CRC Error — cyclic redundancy check error in the frame.

Triggering on FlexRay Events

1 Press [Trigger].

NOTE Because specific FlexRay frames may occur infrequently, it may be helpful to press the 
[Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto to 
Normal. This prevents the oscilloscope from Auto triggering while waiting for a particular 
frame and cycle combination.

NOTE Because FlexRay errors occur infrequently it may be helpful to set the oscilloscope to press 
the [Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto to 
Normal. This prevents the oscilloscope from Auto triggering while waiting for an error to 
occur. You may need to adjust trigger holdoff to see a particular error when multiple errors 
exist.



FlexRay Triggering and Serial Decode 29

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 479

 

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial bus (Serial 1 or Serial 2) on which the FlexRay signals are being 
decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Event.

4 Press the Event softkey; then, select the event type:

• Wake-up

• TSS — Transmission Start Sequence.

• BSS — ByteStart Sequence.

• FES/DTS — Frame End or Dynamic Trailing Sequence.

5 Press Auto Setup for Event.

This automatically configures oscilloscope settings (as shown on the display) 
for the selected event trigger.

FlexRay Serial Decode

To set up the oscilloscope to capture FlexRay signals, see "Setup for FlexRay 
Signals" on page 475.

To set up FlexRay serial decode:

1 Press [Serial] to display the Serial Decode Menu.

NOTE For FlexRay triggering setup see "FlexRay Triggering" on page 476.
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2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting FlexRay Decode" on page 480

• "FlexRay Totalizer" on page 481

• "Interpreting FlexRay Lister Data" on page 482

• "Searching for FlexRay Data in the Lister" on page 483

Interpreting FlexRay Decode

• Frame type (NORM, SYNC, SUP, NULL in blue).

• Frame ID (decimal digits in yellow).

• Payload-length (decimal number of words in green).
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• Header CRC (hex digits in blue plus red HCRC error message if invalid).

• Cycle number (decimal digits in yellow).

• Data bytes (HEX digits in white).

• Frame CRC (hex digits in blue plus red FCRC error message if invalid).

• Frame/coding errors (specific error symbol in red).

FlexRay Totalizer

The FlexRay totalizer consists of counters that provide a direct measure of bus 
quality and efficiency. The totalizer appears on screen whenever FlexRay Decode 
is ON in the Serial Decode Menu.

• The FRAMES counter gives a real-time count of all captured frames.

• The NULL counter gives the number and percentage of null frames.

• The SYNC counter gives the number and percentage of sync frames.

The totalizer runs, counting frames and calculating percentages, even when the 
oscilloscope is stopped (not acquiring data).

When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset FlexRay Counters softkey.
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Interpreting FlexRay Lister Data

In addition to the standard Time column, the FlexRay Lister contains these 
columns:

• FID — frame ID.

• Len — payload length.

• HCRC — header CRC.

• CYC — cycle number.

• Data.

• FCRC — frame CRC.

• Frames with errors are highlighted in red.
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Searching for FlexRay Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
FlexRay data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With FlexRay selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial bus (Serial 1 or Serial 2) on which the FlexRay signals are being 
decoded.

3 In the Search Menu, press Search for; then, select from these options:

• Frame ID — Finds frames with the specified ID. Press the Frame ID softkey to 
select the ID.

• Cycle number (+ Frame ID) — Finds frames with the specified cycle number and 
ID. Press the Frame ID softkey to select the ID. Press the Cycle # softkey to 
select the number.

• Data (+ Frame ID + Cycle number) — Finds frames with the specified data, cycle 
number, and frame ID. Press the Frame ID softkey to select the ID. Press the 
Cycle # softkey to select the number. Press the Data softkey to open a menu 
where you can enter the data value.

• Header CRC Error — Finds cyclic redundancy check errors in headers.

• Frame CRC Error — Finds cyclic redundancy check errors in frames.

• Errors — finds all errors.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.



484 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

29 FlexRay Triggering and Serial Decode
 



485

Keysight InfiniiVision 6000 X-Series Oscilloscopes 
User's Guide

 

30 I2C/SPI Triggering and 
Serial Decode
Setup for I2C Signals / 485
I2C Triggering / 486
I2C Serial Decode / 490
Setup for SPI Signals / 494
SPI Triggering / 498
SPI Serial Decode / 500

The I2C/SPI triggering and serial decode option is license-enabled.

Setup for I2C Signals

I2C (Inter-IC bus) signals setup consists of connecting the oscilloscope to the 
serial data (SDA) line and the serial clock (SCL) line and then specifying the input 
signal threshold voltage levels.

To set up the oscilloscope to capture I2C signals, use the Signals softkey which 
appears in the Serial Decode Menu:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

NOTE Only one SPI serial bus can be decoded at a time.
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3 Press the Mode softkey; then, select I2C trigger type.

4 Press the Signals softkey to open the I2C Signals Menu.

5 For both the SCL (serial clock) and SDA (serial data) signals:

a Connect an oscilloscope channel to the signal in the device under test.

b Press the SCL or SDA softkey; then, turn the Entry knob to select the channel 
for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob to select 
the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

Data must be stable during the whole high clock cycle or it will be 
interpreted as a start or stop condition (data transitioning while the clock is 
high).

The SCL and SDA labels for the source channels are automatically set.

I2C Triggering

To set up the oscilloscope to capture I2C signals, see "Setup for I2C Signals" on 
page 485.

After the oscilloscope has been set up to capture I2C signals, you can trigger on a 
stop/start condition, a restart, a missing acknowledge, an EEPROM data read, or 
on a read/write frame with a specific device address and data value.

1 Press [Trigger]; then, select the I2C trigger type.

2 Press [Trigger].

3 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the I2C signals are being 
decoded.
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4 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• Start Condition — triggers when SDA data transitions from high to low while 
the SCL clock is high. For triggering purposes (including frame triggers), a 
restart is treated as a start condition.

• Stop Condition — triggers when data (SDA) transitions from low to high while 
the clock (SCL) is high.

• Restart — triggers when another start condition occurs before a stop 
condition.

• Address — triggers on the selected address. The R/W bit is ignored.

• Address with no Ack — The oscilloscope triggers when the acknowledge of the 
selected address field is false. The R/W bit is ignored.

• Write Data with no Ack — triggers if a write data byte is not acknowledged. 
Note that this trigger mode will not trigger if the ack following the R/W bit is 
missing, but will only trigger on missing acks following data bytes.

• Missing Acknowledge — triggers when SDA data is high during any Ack SCL 
clock bit.

• EEPROM Data Read — The trigger looks for EEPROM control byte value 
1010xxx on the SDA line, followed by a Read bit and an Ack bit. It then looks 
for the data value and qualifier set by the Data softkey and the Data is softkey. 
When this event occurs, the oscilloscope will trigger on the clock edge for 
the Ack bit after the data byte. This data byte does not need to occur directly 
after the control byte.

SDA

SCL

Stop
Condition

R/Start
Condition

AckAck DataAddress
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• Frame (Start: Addr7: Read: Ack: Data) or Frame (Start: Addr7: Write: Ack: Data) — The 
oscilloscope triggers on a read or write frame in 7-bit addressing mode on 
the 17th clock edge if all bits in the pattern match. For triggering purposes, 
a restart is treated as a start condition.

• Frame (Start: Addr7: Read: Ack: Data: Ack: Data2) or Frame (Start: Addr7: Write: Ack: 
Data: Ack: Data2) — The oscilloscope triggers on a read or write frame in 7-bit 
addressing mode on the 26th clock edge if all bits in the pattern match. For 
triggering purposes, a restart is treated as a start condition.

• 10-bit Write — The oscilloscope triggers on a 10-bit write frame on the 26th 
clock edge if all bits in the pattern match. The frame is in the format:

Frame (Start: Address byte 1: Write: Address byte 2: Ack: Data)

For triggering purposes, a restart is treated as a start condition.

SDA

SCL

Control
byte

Read

R/ Ack Data Ack
Trigger point

Start or
Restart

Condition

SDA

SCL

Stop 
Condition

Start or
Restart

Condition
Trigger point

17th clock edge

Address

Read Write

R/ Ack Data Ack

Read Write

Start
Condition

Address R/W Ack Data Ack Data 2

Trigger point
26th clock edge

Ack Stop
Condition
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5 If you have set the oscilloscope to trigger on an EEPROM Data Read condition:

Press the Data is softkey to set the oscilloscope to trigger when data is = (equal 
to), ≠ (not equal to), < (less than), or > (greater than) the data value set in the 
Data softkey.

The oscilloscope will trigger on the clock edge for the Ack bit after the trigger 
event is found. This data byte does not need to occur directly after the control 
byte. The oscilloscope will trigger on any data byte that meets the criteria 
defined by the Data is and Data softkeys during a current address read or a 
random read or a sequential read cycle.

6 If you have set the oscilloscope to trigger on a 7-bit address read or write frame 
condition or a 10-bit write frame condition:

a Press the Address softkey and turn the Entry knob to select the 7-bit or 
10-bit device address.

You can select from an address range of 0x00 to 0x7F (7-bit) or 0x3FF 
(10-bit) hexadecimal. When triggering on a read/write frame, the 
oscilloscope will trigger after the start, address, read/write, acknowledge, 
and data events occur.

If don't care is selected (0xXX or 0xXXX) for the address, the address will be 
ignored. The trigger will always occur on the 17th clock for 7-bit addressing 
or 26th clock for 10-bit addressing.

b Press the Data value softkey and turn the Entry knob to select the 8-bit data 
pattern on which to trigger.

You can select a data value in the range of 0x00 to 0xFF (hexadecimal). The 
oscilloscope will trigger after the start, address, read/write, acknowledge, 
and data events occur.

SCL

SDA

Stop
Condition

Start or
Restart

Condition
Trigger point

26th clock edge

Address
1st byte

R/ Ack1 AckAddress
2nd byte

Write

Ack2 Data
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If don't care (0xXX) is selected for data, the data will be ignored. The trigger 
will always occur on the 17th clock for 7-bit addressing or 26th clock for 
10-bit addressing.

c If you have selected a three-byte trigger, press the Data2 value softkey and 
turn the Entry knob to select the 8-bit data pattern on which to trigger.

I2C Serial Decode

To set up the oscilloscope to capture I2C signals, see "Setup for I2C Signals" on 
page 485.

To set up I2C serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Choose 7-bit or 8-bit address size. Use 8-bit address size to include the R/W 
bit as part of the address value, or choose 7-bit address size to exclude the 
R/W bit from the address value.

3 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

NOTE To display I2C serial decode, see "I2C Serial Decode" on page 490.

NOTE For I2C triggering setup see "I2C Triggering" on page 486.



I2C/SPI Triggering and Serial Decode 30

Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide 491

 

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting I2C Decode" on page 491

• "Interpreting I2C Lister Data" on page 493

• "Searching for I2C Data in the Lister" on page 493

Interpreting I2C Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• In the decoded hexadecimal data:

• Address values appear at the start of a frame.

NOTE If the setup does not produce a stable trigger, the I2C signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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• Write addresses appear in light-blue along with the "W" character.

• Read addresses appear in yellow along with the "R" character.

• Restart addresses appear in green along with the "S" character.

• Data values appear in white.

• "a" indicates Ack (low), "~a" indicates No Ack (high).

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that more data can be displayed. Scroll or 
expand the horizontal scale to view the data.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.
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Interpreting I2C Lister Data

In addition to the standard Time column, the I2C Lister contains these columns:

• Restart — indicated with an "X".

• Address — colored blue for writes, yellow for reads.

• Data — data bytes.

• Missing Ack — indicated by an "X", highlighted in red if an error.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Searching for I2C Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
I2C data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With I2C selected as the serial decode mode, press [Search].
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2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the I2C signal is being decoded.

3 Press Search; then, select from these options:

• Restart — finds when another start condition occurs before a stop condition.

• Address — finds a packet with the specified address, ignoring the R/W bit.

• Address with no Ack — finds when the acknowledge of the selected address 
field is false. The R/W bit is ignored.

• Missing Acknowledge — finds SDA data is high during any Ack SCL clock bit.

• EEPROM Data Read — finds EEPROM control byte value 1010xxx on the SDA 
line, followed by a Read bit and an Ack bit. It then looks for the data value 
and qualifier set by the Data is softkey and the Data softkeys.

• Frame(Start:Address7:Read:Ack:Data) — finds a read frame on the 17th clock 
edge if all bits in the pattern match.

• Frame(Start:Address7:Write:Ack:Data) — finds a write frame on the 17th clock 
edge if all bits in the pattern match.

• Frame(Start:Address7:Read:Ack:Data:Ack:Data2) — finds a read frame on the 26th 
clock edge if all bits in the pattern match.

• Frame(Start:Address7:Write:Ack:Data:Ack:Data2) — finds a write frame on the 
26th clock edge if all bits in the pattern match.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.

Setup for SPI Signals

Serial Peripheral Interface (SPI) signals setup consists of connecting the 
oscilloscope to a clock, MOSI data, MISO data, and framing signal, then setting 
the threshold voltage level for each input channel, and finally specifying any other 
signal parameters.

To set up the oscilloscope to capture SPI signals, use the Signals softkey which 
appears in the Serial Decode Menu:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.
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3 Press the Mode softkey; then, select SPI trigger type.

4 Press the Signals softkey to open the SPI Signals Menu.

5 Press the Clock softkey to open the SPI Clock Menu.

In the SPI Clock Menu:

a Press the Clock softkey; then, turn the Entry knob to select the channel 
connected to the SPI serial clock line.

The CLK label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the clock 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

c Press the slope softkey ( ) to select rising edge or falling edge for the 
selected Clock source.

This determines which clock edge the oscilloscope will use to latch the serial 
data. When Display Info is enabled, the graphic changes to show the current 
state of the clock signal.

6 Press the MOSI softkey to open the SPI Master-Out Slave-In Menu.
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In the SPI Master-Out Slave-In Menu:

a Press the MOSI Data softkey; then, turn the Entry knob to select the channel 
that is connected to a SPI serial data line. (If the channel you selected is off, 
switch it on.)

The MOSI label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the MOSI 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

7 (Optional) Press the MISO softkey to open the SPI Master-In Slave-Out Menu.

In the SPI Master-In Slave-Out Menu:

a Press the MISO Data softkey; then, turn the Entry knob to select the channel 
that is connected to a second SPI serial data line. (If the channel you 
selected is off, switch it on.)

The MISO label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the MISO 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

c Press the Delay softkey; then, turn the Entry knob to select the number of 
bits to ignore (delay) before decoding the MISO stream.

8 Press the CS softkey to open the SPI Chip Select Menu.
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In the SPI Chip Select Menu:

a Press the Frame by softkey to select a framing signal that the oscilloscope will 
use for determining which clock edge is the first clock edge in the serial 
stream.

You can set the oscilloscope to trigger during a high chip select (CS), a low 
chip select (~CS), or after a Timeout period during which the clock signal has 
been idle.

• If the framing signal is set to CS (or ~CS), the first clock edge as defined, 
rising or falling, seen after the CS (or ~CS) signal transitions from low to 
high (or high to low) is the first clock in the serial stream.

Chip Select — Press the CS or ~CS softkey; then, turn the Entry knob to 
select the channel that is connected to the SPI frame line. The label (~CS 
or CS) for the source channel is automatically set. The data pattern and 
the clock transition must occur during the time when the framing signal is 
valid. The framing signal must be valid for the entire data pattern.
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• If the framing signal is set to Timeout, the oscilloscope generates it's own 
internal framing signal after it sees inactivity on the serial clock line.

Clock Timeout — Select Clock Timeout in the Frame by softkey, then select 
the Timeout softkey and turn the Entry knob to set the minimum time that 
the Clock signal must be idle (not transitioning) before the oscilloscope 
will search for the Data pattern on which to trigger.

The Timeout value can be set anywhere from 100 ns to 10 s.

When you press the Frame by softkey, the Display Info graphic changes to 
show timeout selection or the current state of the chip select signal.

b Press the Threshold softkey; then, turn the Entry knob to select the chip select 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

When Display Info is enabled, information about the selected signal sources and 
their threshold voltage levels, as well as a waveform diagram, appears on the 
screen.

SPI Triggering

To set up the oscilloscope to capture SPI signals, see "Setup for SPI Signals" on 
page 494.

After the oscilloscope has been set up to capture SPI signals, you can then trigger 
on a data pattern that occurs at the start of a frame. The serial data string can be 
specified to be from 4 to 32 bits long.

When you select the SPI trigger type and Display Info is enabled, a graphic is 
displayed showing the current state of the frame signal, clock slope, number of 
data bits, and data bit values.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the SPI signals are being 
decoded.
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3 Press the second Trigger Type softkey; then, turn the Entry knob to select the 
trigger condition:

• Master-Out, Slave-In (MOSI) Data — for triggering on the MOSI data signal.

• Master-In, Slave-Out (MISO) Data — for triggering on the MISO data signal.

4 Press the #Bits softkey, and turn the Entry knob to set the number of bits (#Bits) 
in the serial data string.

The number of bits in the string can be set anywhere from 4 bits to 64 bits. The 
data values for the serial string are displayed in the MOSI/MISO Data string in 
the waveform area.

5 Press the MOSI Data or MISO Data softkey and use the binary keypad dialog to 
enter bit values of 0 (low), 1 (high), or X (don't care).
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The data value is left-justified in the frame when setting up the trigger. If the 
base is Hex, the first digit represents the first 4 bits after the start of frame, 
continuing with the remaining digits in the data value.

SPI Serial Decode

To set up the oscilloscope to capture SPI signals, see "Setup for SPI Signals" on 
page 494.

To set up SPI serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press the Word Size softkey; then, turn the Entry knob to select the number of 
bits in a word.

3 Press the Bit Order softkey; then turn the Entry knob to select the bit order, most 
significant bit first (MSB) or least significant bit first (LSB), used when 
displaying data in the serial decode waveform and in the Lister.

4 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

NOTE For SPI decode information see "SPI Serial Decode" on page 500.

NOTE For SPI triggering setup see "SPI Triggering" on page 498.
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You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting SPI Decode" on page 501

• "Interpreting SPI Lister Data" on page 502

• "Searching for SPI Data in the Lister" on page 503

Interpreting SPI Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• The number of clocks in a frame appears in light-blue above the frame, to the 
right.

NOTE If the setup does not produce a stable trigger, the SPI signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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• Decoded hexadecimal data values appear in white.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.

Interpreting SPI Lister Data

In addition to the standard Time column, the SPI Lister contains these columns:

• Data — data bytes (MOSI and MISO).
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Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Searching for SPI Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
SPI data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With SPI selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the SPI signals are being decoded.

3 Press Search for:; then, select from these options:

• Master-Out, Slave-In (MOSI) Data — for searching MOSI data.

• Master-In, Slave-Out (MISO) Data — for searching MISO data.

4 In the SPI Bits Search Menu, use the Words softkey to specify the number of 
words in the data value; then, use the remaining softkeys to enter the hex digit 
values.

5 Press the Data softkey and use the keypad dialog to enter the hexadecimal data 
value.

The search pattern is always left-justified in the packet. If you want to search 
for a value in the second or higher word, increase the Words count and enter 
don't cares ('X's) for the earlier words.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating 
the Time Base" on page 81.
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31 I2S Triggering and Serial 
Decode
Setup for I2S Signals / 505
I2S Triggering / 508
I2S Serial Decode / 511

The I2S triggering and serial decode option is license-enabled.

Setup for I2S Signals

I2S (Inter-IC Sound or Integrated Interchip Sound) signals setup consists of 
connecting the oscilloscope to the serial clock, word select, and serial data lines 
and then specifying the input signal threshold voltage levels.

To set up the oscilloscope to capture I2S signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select I2S trigger type.

4 Press the Signals softkey to open the I2S Signals Menu.

NOTE Only one I2S serial bus can be decoded at a time.
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5 For the SCLK (serial clock), WS (word select), and SDATA (serial data) signals:

a Connect an oscilloscope channel to the signal in the device under test.

b Press the SCLK, WS, or SDATA softkey; then, turn the Entry knob to select the 
channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob to select 
the signal threshold voltage level.

Set the threshold levels for the SCLK, WS, and SDATA signals to the middle 
of the signals.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

The SCLK, WS, and SDATA labels for the source channels are automatically set.

6 Press the Back/Up key to return to the Serial Decode Menu.

7 Press the Bus Config softkey to open the I2S Bus Configuration Menu and display 
a diagram showing WS, SCLK, and SDATA signals for the currently specified 
bus configuration.

8 Press the Word Size softkey. Turn the Entry knob to match the transmitter word 
size of the device under test (from 4 to 32 bits).

9 Press the Receiver softkey. Turn the Entry knob to match the receiver word size 
of the device under test (from 4 to 32 bits).

10 Press the Alignment softkey; then, turn the Entry knob to select the desired 
alignment of the data signal (SDATA). The on-screen diagram changes with 
your selection.

Standard Alignment — MSB of data for each sample is sent first, LSB is sent last. 
The MSB appears on the SDATA line one bit clock after the edge of the WS 
transition.

Back
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Left-Justified — Data transmission (MSB first) begins at the edge of the WS 
transition (without the one-bit delay that Standard format employs).

Right-Justified — Data transmission (MSB first) is right-justified to the transition 
of WS.

11 Press the WS Low softkey; then, turn the Entry knob to select whether WS Low 
indicates Left or Right channel data. The on-screen diagram changes with your 
selection.

WS Low = Left Channel — Left-channel data corresponds to WS=low; 
right-channel data corresponds to WS=high. WS Low=Left is the oscilloscope's 
default WS setting.
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SCLK

SDATA

LEFT CHANNEL RIGHT CHANNEL

ONE SCLK CYCLE

MSB LSB
1 2 n-2 n-10

MSB LSB
1 2 n-2 n-10
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MSB LSB
1 2 n-2 n-10

WS

SCLK

SDATA

LEFT CHANNEL RIGHT CHANNEL

MSB LSB
1 2 n-2 n-10

MSB LSB
1 2 n-2 n-10
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WS Low = Right Channel — Right-channel data corresponds to WS=low; 
left-channel data corresponds to WS=high.

12 Press the SCLK Slope softkey; then, turn the Entry knob to select the SCLK edge 
on which data is clocked in your device under test: either rising or falling. The 
on-screen diagram changes with your selection.

I2S Triggering

To set up the oscilloscope to capture I2S signals, see "Setup for I2S Signals" on 
page 505.

After you have set up the oscilloscope to capture I2S signals, you can then trigger 
on a data value.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the I2S signals are being 
decoded.
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3 Press the Trigger Setup softkey to open the I2S Trigger Setup Menu.

4 Press the Audio softkey; then, turn the Entry knob to choose to trigger on Left 
channel events, Right channel events, or events that occur on Either channel.

5 Press the Trigger softkey and choose a qualifier:

• Equal — triggers on the specified audio channel's data word when it equals 
the specified word.

• Not equal — triggers on any word other than the specified word.

• Less than — triggers when the channel's data word is less than the specified 
value.

• Greater than — triggers when the channel's data word is greater than the 
specified value.

• In Range — enter upper and lower values to specify the range in which to 
trigger.

• Out of Range — enter upper and lower values to specify range in which trigger 
will not occur.

• Increasing value — triggers when the data value is increasing over time and 
the specified value is met or exceeded. Set Trigger >= to the data value that 
must be reached. Set Armed <= to the value to which the data must fall 
before the trigger circuit is re-armed (ready to trigger again). These settings 
are made in the current menu when Base is Decimal or in the Bits submenu 
when the Base is Binary. The Armed control reduces triggers due to noise.

This trigger condition is best understood when the digital data transferred 
over the I2S bus is considered in terms of representing an analog waveform. 
The figure below shows a plot of sample data transmitted over an I2S bus for 
one channel. In this example, the oscilloscope will trigger at the 2 points 
shown since there are two instances in which the data increases from a value 
below (or at) the "Armed" value to a value greater than (or equal to) the 
specified "Trigger" value.
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If you select an "Armed" value that is equal to or greater than the "Trigger" 
value, the "Trigger" value will be increased so that it is always greater than 
the "Armed" value.

• Decreasing value — similar to the description above except the trigger occurs 
on a decreasing data word value, and the "Armed" value is the value to 
which the data must rise in order to re-arm the trigger.

6 Press the Base softkey and select a number base for entering data values:

• Binary (2's complement).

When Binary is selected, the Bits softkey appears. This softkey opens the I2S 
Bits Menu for entering data values.

When the trigger qualifier requires a pair of values (as with In Range, Out of 
Range, Increasing value, or Decreasing value), the first softkey in the I2S Bits 
Menu lets you select which value of the pair.

In the I2S Bits Menu, press the Bit softkey and rotate the Entry knob to select 
each bit; then, use the 0 1 X softkey to set each bit value to zero, one, or 
don't care. You can use the Set all Bits softkey to set all bits to the value 
chosen on the 0 1 X softkey. Don't care values are only allowed with Equal or 
Not Equal trigger qualifiers.

• Signed decimal.

When Decimal is selected, the softkey(s) to the right let you enter decimal 
values with the Entry knob. These softkeys can be Data, <, >, or Threshold 
depending on the selected trigger qualifier.

"Trigger" value

Trigger Trigger No trigger

"Armed" value

NOTE If the setup does not produce a stable trigger, the I2S signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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I2S Serial Decode

To set up the oscilloscope to capture I2S signals, see "Setup for I2S Signals" on 
page 505.

To set up I2S serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press the Base softkey to select the number base in which to display decoded 
data.

3 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting I2S Decode" on page 512

• "Interpreting I2S Lister Data" on page 513

NOTE To display I2S serial decode, see "I2S Serial Decode" on page 511.

NOTE For I2S triggering setup see "I2S Triggering" on page 508.

NOTE If the setup does not produce a stable trigger, the I2S signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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• "Searching for I2S Data in the Lister" on page 514

Interpreting I2S Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• In the decoded data:

• Right channel data values appear in green along with the "R:" characters.

• Left channel data values appear in white along with the "L:" characters.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• Red dots in the decode line indicate that more data can be displayed. Scroll or 
expand the horizontal scale to view the data.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.
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• Unknown bus values (undefined or error conditions) are drawn in red.

Interpreting I2S Lister Data

In addition to the standard Time column, the I2S Lister contains these columns:

• Left Channel — displays the left channel data.

• Right Channel — displays the right channel data.

• Errors — highlighted in red and marked with an "X".

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

NOTE When the receiver word size is greater than the transmit word size, the decoder fills the least 
significant bits with zeros and the decoded value does not match the trigger value.
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Searching for I2S Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
I2S data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With I2S selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the I2S signals are being decoded.

3 In the Search Menu, press Search; then, select from these options:

• = (Equal) — finds the specified audio channel's data word when it equals the 
specified word.

• != (Not Equal) — finds any word other than the specified word.

• < (Less than) — finds when the channel's data word is less than the specified 
value.

• > (Greater than) — finds when the channel's data word is greater than the 
specified value.

• >< (In Range) — enter upper and lower values to specify the range to find.

• <> (Out of Range) — enter upper and lower values to specify range not to find.

• Errors — finds all errors.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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32 Manchester/NRZ 
Triggering and Serial 
Decode
Setup for Manchester Signals / 515
Manchester Triggering / 518
Manchester Serial Decode / 520
Setup for NRZ Signals / 523
NRZ Triggering / 526
NRZ Serial Decode / 527

The Manchester/NRZ triggering and serial decode option is license-enabled.

The Manchester/NRZ triggering and decode solutions support generic 
Manchester- or NRZ-encoded serial buses.

Setup for Manchester Signals

Manchester signal setup consists of first connecting the oscilloscope to a 
Manchester-encoded serial bus signal, then specifying the signal, bus 
configuration, and other settings.

To set up the oscilloscope to capture Manchester signals:

1 Press [Serial].

2 Press the Serial softkey and choose the serial decode (Serial 1 or Serial 2) to 
use; then, press the softkey again to enable decode.
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3 Press the Mode softkey; then, select the Manchester decode mode.

4 Press the Signals softkey to open the Manchester Signals Menu.

In the Manchester Signals Menu:

a Press the Source softkey to select the channel connected to the Manchester 
signal line.

The label for the Manchester source channel is automatically set.

b Press the Threshold softkey; then, enter the trigger threshold voltage level.

The threshold voltage level is used in decoding and will become the trigger 
level when the trigger type is set to the Manchester serial decode.

c Press the Baud softkey; then, enter the baud rate of the Manchester signal 
from your device under test.

The baud rate can be set from 2 kb/s to 5 Mb/s in 100 b/s increments.

You must set the baud rate to match your device under test.

The default baud rate is 125 kb/s.

d Press the Tolerance softkey to specify the tolerance for the Manchester 
signal. Valid values range from 5% to 30% in terms of percentage of the bit 
period.

e Press the Back/Up key to return to the Serial Decode Menu.

5 Press the Bus Config softkey to open the Manchester Bus Configuration Menu.

In the Manchester Bus Configuration Menu:

a Press the Display Format softkey and select the display format:

• Word — lets you break the frame into sync, header, data, and trailer fields.

Back
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In Word format, you can select between hexadecimal, unsigned decimal, 
and ASCII decode bases. The base setting is used for both the Lister and 
the decode line and applies to the data field only. The header and trailer 
fields are always displayed in hex.

• Bit — displays the entire content of the frame as a string of bits.

In Bit format, the entire frame is always displayed in binary.

6 If the Word display format is selected:

a Press the Sync Size softkey and enter the sync field size, from 0 to 255 bits.

b Press the Header Size softkey and enter the header size, from 0 to 32 bits.

c Press the # of Words softkey and enter the number of words in the data field, 
from 1 to 255.

When the Trailer Size is set to 0, the <auto> option becomes available. In 
<auto> mode, any number of words can be supported.

d Press the Data Word Size softkey and enter the data word size, from 2 to 32 
bits.

e Press the Trailer Size softkey and enter the trailer size, from 0 to 32 bits.

7 If the Bits display format is selected:

a Press the Sync Size softkey and enter the sync field size, from 0 to 255 bits.

8 Press the Back/Up key to return to the Serial Decode Menu.

9 Press the Settings softkey to open the Manchester Settings Menu.

In the Manchester Settings Menu:

a Press the Start Edge # softkey and enter the starting edge of the Manchester 
signal, from 1 to 256.

b Press the Polarity softkey and select the Manchester signal's logic type:

• Rising — specifies that a rising edge is used to encode a bit value of logic 
1 (and a falling edge encodes a bit value of logic 0).

Back
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• Falling — specifies that a falling edge is used to encode a bit value of logic 
1 (and a rising edge encodes a bit value of logic 0).

c Press the Bit Order softkey and select the bit order, either most significant bit 
first (MSB) or least significant bit first (LSB).

The selected order is used when displaying data in the serial decode 
waveform and in the Lister.

This softkey is available when the Word display format is selected in the 
Manchester Bus Configuration Menu.

d Press the Idle Bits softkey and enter the minimum idle time/inter-frame gap 
time of the Manchester bus in terms of the bit width.

Framing is determined by idle time.

e Use the Decode Base softkey to select between hexadecimal, unsigned 
decimal, or ASCII display of the decoded data.

The decode base setting is used for the display of the data field in both the 
decode line and in the Lister.

When the Bit display format is selected in the Manchester Bus Configuration 
Menu, this softkey is unavailable and the decode base is forced to Binary.

f Press the Back/Up key to return to the Serial Decode Menu.

Manchester Triggering

To set up the oscilloscope to capture a Manchester signal, see "Setup for 
Manchester Signals" on page 515.

To set up a Manchester trigger:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, select the Manchester 
decode (Serial 1 or Serial 2).

3 Press the Trigger softkey; then, select the trigger condition:

Back
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• SOF - Start of Frame — triggers after the starting edge, between the starting 
edge and the sync field.

• Value — triggers on a value you specify, up to 128 bits, after the sync field 
(starting with header bits).

Note that the trigger value is always for bits as they arrive (that is, MSB first).

When the decode bit order (specified in the serial decode settings menu) is 
MSB first, the decoded value bit order matches the trigger value bit order.

When the serial decode bit order is LSB first, the decoded value bit order is 
opposite of the trigger value bit order.

When Value is selected:

i Press the #Bits softkey and set the number of bits in the serial data value, 
from 4 bits to 128 bits.

The serial data value is displayed in the Value string in the waveform area.

ii Press the Value softkey and use the keypad dialog box to enter the data 
value.

Note that the trigger value is always for bits as they arrive (that is, MSB 
first).

When the decode bit order (specified in the serial decode settings menu) 
is MSB first, the decoded value bit order matches the trigger value bit 
order.

When the serial decode bit order is LSB first, the decoded value bit order 
is opposite of the trigger value bit order.

• Manchester Error — triggers if a Manchester encoding error is detected.

You can use the Zoom mode for easier navigation of the decoded data.

NOTE For Manchester decode information see "Manchester Serial Decode" on page 520.
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Manchester Serial Decode

To set up the oscilloscope to capture Manchester signals, see "Setup for 
Manchester Signals" on page 515.

To set up Manchester serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting Manchester Decode" on page 520

• "Interpreting Manchester Lister Data" on page 522

Interpreting Manchester Decode

To display serial decode information, you must press [Run] or [Single] after 
switching on serial decode.

NOTE For Manchester triggering setup see "Manchester Triggering" on page 518.

NOTE If the setup does not produce a stable trigger, the Manchester signal may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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The Manchester decode display is color coded as follows:

• In Word format:

• Header (yellow)

• Data (white)

• Trailer (blue)

• In Bit format:

• Value (white)

The decode display shows a blue idle line until the specified starting edge # is 
reached, at which point the start of frame angle bracket is drawn in blue.

In Word format, no value is associated with the sync field. The first value displayed 
on the decoded bus is associated with the header field if you select a header size > 
0. Otherwise, the first value displayed is associated with the data field. The end of 
frame angle bracket is drawn in blue at the end of the trailer field, or data field if 
the trailer size is 0, followed by a blue idle line.
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In Bit format, the frame is not divided into fields. All bits in the frame are displayed 
as soon as the starting edge occurs. Each bit is displayed on the decoded bus, 
time-aligned with the corresponding Manchester signal.

The only type of error that will be reported in the Manchester decode is 
Manchester Error. When this occurs, a red error frame is drawn with the text 
"MANCH" in red inside the error frame. Any previously valid frame before the error 
is terminated with a blue closing > angle bracket. Because all data is assumed 
invalid following a Manchester Error, the red error frame is drawn until a valid idle 
signal is detected. In the sync field, any bit value errors are ignored. Manchester 
errors are reported anywhere in the frame.

Interpreting Manchester Lister Data

In addition to the standard Time column, the Manchester Lister contains these 
columns:

• In Word format:

• Header (hex)
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• Data (hex, unsigned decimal, or ASCII)

• Trailer (hex)

• Errors

• In Bit format:

• Value (binary)

• Errors

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Setup for NRZ Signals

NRZ signal setup consists of first connecting the oscilloscope to a NRZ-encoded 
serial bus signal, then specifying the signal, bus configuration, and other settings.

To set up the oscilloscope to capture NRZ signals:

1 Press [Serial].

2 Press the Serial softkey and choose the serial decode (Serial 1 or Serial 2) to 
use; then, press the softkey again to enable decode.

3 Press the Mode softkey; then, select the NRZ decode mode.

4 Press the Signals softkey to open the NRZ Signals Menu.

In the NRZ Signals Menu:

a Press the Source softkey to select the channel connected to the NRZ signal 
line.

The label for the NRZ source channel is automatically set.

b Press the Threshold softkey; then, enter the trigger threshold voltage level.

The threshold voltage level is used in decoding and will become the trigger 
level when the trigger type is set to the NRZ serial decode.

c Press the Baud softkey; then, enter the baud rate of the NRZ signal from your 
device under test.
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The baud rate can be set from 5 kb/s to 5 Mb/s in 100 b/s increments.

You must set the baud rate to match your device under test.

The default baud rate is 125 kb/s.

d Press the Back/Up key to return to the Serial Decode Menu.

5 Press the Bus Config softkey to open the NRZ Bus Configuration Menu.

In the NRZ Bus Configuration Menu:

a Press the Display Format softkey and select the display format:

• Word — lets you break the frame into header, data, and trailer fields.

In Word format, you can select between hexadecimal, unsigned decimal, 
and ASCII decode bases. The base setting is used for both the Lister and 
the decode line and applies to the data field only. The header and trailer 
fields are always displayed in hex.

• Bit — displays the entire content of the frame as a string of bits.

In Bit format, the entire frame is always displayed in binary.

6 If the Word display format is selected:

a Press the # Start Bits softkey and enter the number of starting bits, from 0 to 
255 bits.

b Press the Header Size softkey and enter the header size, from 0 to 32 bits.

c Press the # of Words softkey and enter the number of words in the data field, 
from 1 to 255.

d Press the Data Word Size softkey and enter the data word size, from 2 to 32 
bits.

e Press the Trailer Size softkey and enter the trailer size, from 0 to 32 bits.

7 If the Bits display format is selected:

a Press the # Start Bits softkey and enter the number of starting bits, from 0 to 
255 bits.

b Press the Frame Size softkey and enter the total frame size of the NRZ signal, 
from 2 to 255 bits.

Back
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This would be equivalent to the sum of the number of bits in the header, 
data, and trailer fields in Word display format.

8 Press the Back/Up key to return to the Serial Decode Menu.

9 Press the Settings softkey to open the NRZ Settings Menu.

In the NRZ Settings Menu:

a Press the Polarity softkey and select the NRZ signal's logic type:

• High — specifies that a positive voltage is used to encode a bit value of 
logic 1 (and a negative voltage encodes a bit value of logic 0).

• Low — specifies that a negative voltage is used to encode a bit value of 
logic 1 (and a positive voltage encodes a bit value of logic 0).

b Press the Bit Order softkey and select the bit order, either most significant bit 
first (MSB) or least significant bit first (LSB).

The selected order is used when displaying data in the serial decode 
waveform and in the Lister.

c Press the Idle State softkey and choose the idle state of the NRZ bus, either 
Low or High.

d Press the Idle Bits softkey and enter the minimum idle time/inter-frame gap 
time of the NRZ bus in terms of the bit width.

Framing is determined by idle time.

e Use the Decode Base softkey to select between hexadecimal, unsigned 
decimal, or ASCII display of the decoded data.

The decode base setting is used for the display of the data field in both the 
decode line and in the Lister.

f Press the Back/Up key to return to the Serial Decode Menu.

Back

Back
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NRZ Triggering

To set up the oscilloscope to capture a NRZ signal, see "Setup for NRZ 
Signals" on page 523.

To set up a NRZ signal:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, select the NRZ decode 
(Serial 1 or Serial 2).

3 Press the Trigger softkey; then, select the trigger condition:

• SOF - Start of Frame — triggers after the starting edge, at the start of a NRZ 
frame.

• Value — triggers on a value you specify, up to 128 bits, after the specified 
number of starting bits.

Note that the trigger value is always for bits as they arrive (that is, MSB first).

When the decode bit order (specified in the serial decode settings menu) is 
MSB first, the decoded value bit order matches the trigger value bit order.

When the serial decode bit order is LSB first, the decoded value bit order is 
opposite of the trigger value bit order.

When Value is selected:

i Press the #Bits softkey and set the number of bits in the serial data value, 
from 4 bits to 128 bits.

The serial data value is displayed in the Value string in the waveform area.

ii Press the Value softkey and use the keypad dialog box to enter the data 
value.

Note that the trigger value is always for bits as they arrive (that is, MSB 
first).

When the decode bit order (specified in the serial decode settings menu) 
is MSB first, the decoded value bit order matches the trigger value bit 
order.
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When the serial decode bit order is LSB first, the decoded value bit order 
is opposite of the trigger value bit order.

You can use the Zoom mode for easier navigation of the decoded data.

NRZ Serial Decode

To set up the oscilloscope to capture NRZ signals, see "Setup for NRZ Signals" on 
page 523.

To set up NRZ serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting NRZ Decode" on page 528

NOTE To display NRZ serial decode, see "NRZ Serial Decode" on page 527.

NOTE For NRZ triggering set up see "NRZ Triggering" on page 526.

NOTE If the setup does not produce a stable trigger, the NRZ signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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• "Interpreting NRZ Lister Data" on page 529

Interpreting NRZ Decode

The NRZ decode display is color coded as follows:

• Word format

• Header (yellow)

• Data (white)

• Trailer (blue)

• Bit format

• Value (white)

The decode display shows a blue idle line until the start of frame, at which point, 
the start of frame angle bracket is drawn in blue.
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In Word format, the first value displayed on the decoded bus is associated with the 
header field if you select a header size > 0. Otherwise, the first value displayed is 
associated with the data field. The end of frame angle bracket is drawn in blue at 
the end of the trailer field, or data field if the trailer size is 0, followed by a blue idle 
line.

In Bit format, the frame is not divided into fields. All bits in the frame are displayed 
as soon as the start of frame occurs. Each bit is displayed on the decoded bus, 
time-aligned with the corresponding NRZ signal.

Interpreting NRZ Lister Data

In addition to the standard Time column, the NRZ Lister contains these columns:

• In Word format:

• Header (hex)

• Data (hex, unsigned decimal, or ASCII)

• Trailer (hex)
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• In Bit format:

• Value (binary)

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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ARINC 429 Serial Decode / 541

The MIL-STD-1553/ARINC 429 triggering and serial decode option is 
license-enabled.

The MIL-STD-1553 triggering and decode solution supports bi-phase 
MIL-STD-1553 signaling by using dual threshold triggering. The solution supports 
the standard 1553 Manchester II encoding, data rate of 1 Mb/s, and word length 
of 20 bits.

Setup for MIL-STD-1553 Signals

MIL-STD-1553 signal setup consists of first connecting the oscilloscope to a serial 
MIL-STD-1553 signal using a differential active probe (the Keysight N2791A is 
recommended), specifying the signal source, and specifying the high and low 
trigger threshold voltage levels.

To set up the oscilloscope to capture MIL-STD-1553 signals:
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1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select MIL-STD-1553 decode mode.

5 Press the Signals softkey to open the MIL-STD-1553 Signals Menu.

6 Press the Source softkey to select the channel connected to the MIL-STD-1553 
signal line.

The label for the MIL-STD-1553 source channel is automatically set.

7 Press the Back/Up key to return to the Serial Decode Menu.

8 Press the Auto Setup softkey which performs these actions:

• Sets the probe attenuation factor of the input Source channel to 10:1.

• Sets upper and lower thresholds to a voltage value equal to ±1/3 division 
based on the current V/div setting.

• Turns off trigger noise reject.

• Turns on Serial Decode.

• Sets the trigger type to MIL-1553.

9 If the upper and lower thresholds are not set correctly by Auto Setup, press the 
Signals softkey to return to the MIL-STD-1553 Signals Menu. Then:

• Press the High Threshold softkey; then, turn the Entry knob to set the high 
trigger threshold voltage level.

• Press the Low Threshold softkey; then, turn the Entry knob to set the low 
trigger threshold voltage level.

The threshold voltage levels are used in decoding and will become the trigger 
levels when the trigger type is set to the selected serial decode slot.

Back
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MIL-STD-1553 Triggering

To set up the oscilloscope to capture a MIL-STD-1553 signal, see "Setup for 
MIL-STD-1553 Signals" on page 531.

To set up a MIL-STD-1553 trigger:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the MIL-STD-1553 signal is 
being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select the trigger 
condition:

• Data Word Start — triggers on the start of a Data word (at the end of a valid 
Data Sync pulse).

• Data Word Stop — triggers on the end of a Data word.

• Command/Status Word Start — triggers on the start of Command/Status word 
(at the end of a valid C/S Sync pulse).

• Command/Status Word Stop — triggers on the end of a Command/Status word.

• Remote Terminal Address — triggers if the RTA of the Command/Status word 
matches the specified value.

When this option is selected, the RTA softkey becomes available and lets you 
select the hex Remote Terminal Address value to trigger on. If you select 
0xXX (don't cares), the oscilloscope will trigger on any RTA.

• Remote Terminal Address + 11 Bits — triggers if the RTA and the remaining 11 
bits match the specified criteria.

When this option is selected, these softkeys become available:

• The RTA softkey lets you select the hex Remote Terminal Address value.

• The Bit Times softkey lets you specify the bit time position values using a 
binary keypad dialog to enter bit values of 0 (low), 1 (high), or X (don't 
care).
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• Parity Error — triggers if the (odd) parity bit is incorrect for the data in the 
word.

• Sync Error — triggers if an invalid Sync pulse is found.

• Manchester Error — triggers if a Manchester encoding error is detected.

MIL-STD-1553 Serial Decode

To set up the oscilloscope to capture MIL-STD-1553 signals, see "Setup for 
MIL-STD-1553 Signals" on page 531.

To set up MIL-STD-1553 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Use the Base softkey to select between hexadecimal and binary display of the 
decoded data.

The base setting is used for the display of the remote terminal address and the 
data, in both the decode line and in the Lister.

3 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting MIL-STD-1553 Decode" on page 535

NOTE For MIL-STD-1553 decode information see "MIL-STD-1553 Serial Decode" on page 534.

NOTE For MIL-STD-1553 triggering setup see "MIL-STD-1553 Triggering" on page 533.
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• "Interpreting MIL-STD-1553 Lister Data" on page 536

• "Searching for MIL-STD-1553 Data in the Lister" on page 537

Interpreting MIL-STD-1553 Decode

To display serial decode information, you must press [Run] or [Single] after 
switching on serial decode.

The MIL-STD-1553 decode display is color coded as follows:

• Command and Status decoded data is colored green, with the Remote Terminal 
Address (5 bits of data) being displayed first, then the text "C/S:", followed by 
the value of the remaining 11 bits of a Command/Status word.

• Data word decoded data is colored white, preceded by the text "D:".

• Command/Status or Data words with a Parity error have the decode text 
displayed in red instead of green or white.

• SYNC errors are displayed with the word "SYNC" within red angle brackets.
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• Manchester encoding errors are displayed with the word "MANCH" within blue 
angle brackets (blue instead of red because a valid Sync pulse started the 
word).

Interpreting MIL-STD-1553 Lister Data

In addition to the standard Time column, the MIL-STD-1553 Lister contains these 
columns:

• RTA — displays the Remote Terminal Address for Command/Status words, 
nothing for Data words.

• Word Type — "Cmd/Status" for Command/Status words, "Data" for Data words. 
For Command/Status words the background color is green to match the 
decode text color.

• Data — the 11 bits after the RTA for Command/Status words, or the 16 bits of a 
Data word.

• Errors — "Sync", "Parity", or "Manchester" errors as appropriate. The 
background color is red to indicate an error.
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Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Searching for MIL-STD-1553 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
MIL-STD-1553 data in the Lister. You can use the [Navigate] key and controls to 
navigate through the marked rows.

1 With MIL-STD-1553 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the MIL-STD-1553 signal is being 
decoded.

3 Press Search; then, select from these options:

• Data Word Start — finds the start of a Data word (at the end of a valid Data 
Sync pulse).

• Command/Status Word Start — finds the start of Command/Status word (at the 
end of a valid C/S Sync pulse).

• Remote Terminal Address — finds the Command/Status word whose RTA 
matches the specified value. The value is specified in hex.

When this option is selected, the RTA softkey becomes available and lets you 
select the hex Remote Terminal Address value to find.

• Remote Terminal Address + 11 Bits — finds the RTA and the remaining 11 bits 
that match the specified criteria.

When this option is selected, these softkeys become available:

• The RTA softkey lets you select the hex Remote Terminal Address value.

• The Bit Time softkey lets you select the bit time position.

• The 0 1 X softkey lets you set the bit time position value as a 1, 0, or X 
(don't care).

• Parity Error — finds (odd) parity bits that are incorrect for the data in the word.

• Sync Error — finds invalid Sync pulses.

• Manchester Error — finds Manchester encoding errors.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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Setup for ARINC 429 Signals

Setup consists of first connecting the oscilloscope to a ARINC 429 signal using a 
differential active probe (the Keysight N2791A is recommended), then using the 
Signals Menu to specify the signal source, the high and low trigger threshold 
voltage levels, the signal speed, and the signal type.

To set up the oscilloscope to capture ARINC 429 signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select ARINC 429 decode mode.

4 Press the Signals softkey to open the ARINC 429 Signals Menu.

5 Press Source; then, select the channel for the ARINC 429 signal.

The label for the ARINC 429 source channel is automatically set.

6 Press the Speed softkey to open the ARINC 429 Speed Menu.

7 In the ARINC429 Speed Menu, press the Speed softkey and specify the speed of 
the ARINC 429 signal:

• High — 100 kb/s.

• Low — 12.5 kb/s.

• User Defined — press the User Baud softkey and enter the user-defined speed 
value.

8 Press the Back/Up key to return to the ARINC 429 Signals Menu.

9 Press the Signal Type softkey and specify the signal type of the ARINC 429 
signal:

• Line A (non-inverted).

Back
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• Line B (inverted).

• Differential (A-B).

10 Press the Auto Setup softkey to automatically set these options for decoding and 
triggering on ARINC 429 signals:

• High Trigger Threshold: 3.0 V.

• Low Trigger Threshold: -3.0 V.

• Noise Reject: Off.

• Probe Attenuation: 10.0.

• Vertical Scale: 4 V/div.

• Serial Decode: On.

• Base: Hex.

• Word Format: Label/SDI/Data/SSM.

• Trigger: currently active serial bus.

• Trigger Mode: Word Start.

11 If the high and low thresholds are not set correctly by Auto Setup:

• Press the High Threshold softkey; then, turn the Entry knob to set the high 
trigger threshold voltage level.

• Press the Low Threshold softkey; then, turn the Entry knob to set the low 
trigger threshold voltage level.

The threshold voltage levels are used in decoding and will become the trigger 
levels when the trigger type is set to the selected serial decode slot.

ARINC 429 Triggering

To set up the oscilloscope to capture a ARINC 429 signal, see "Setup for 
ARINC 429 Signals" on page 538.

After setting up the oscilloscope to capture a ARINC 429 signal:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the ARINC 429 signal is 
being decoded.
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3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• Word Start — triggers on the start of a word.

• Word Stop — triggers at the end of a word.

• Label — triggers on the specified label value.

• Label + Bits — triggers on the label and the other word fields as specified.

• Label Range — triggers on a label following in a min/max range.

• Parity Error — triggers on words with a parity error.

• Word Error — triggers on an intra-word coding error.

• Gap Error — triggers on an inter-word gap error.

• Word or Gap Error — triggers on either a Word or Gap Error.

• All Errors — triggers on any of the above errors.

• All Bits (Eye) — triggers on any bit, which will therefore form an eye diagram.

• All 0 Bits — triggers on any bit with a value of zero.

• All 1 Bits — triggers on any bit with a value of one.

4 If you select the Label or Label + Bits condition, use the Label softkey to specify 
the label value.

Label values are always displayed in octal.

5 If you select the Label + Bits condition, use the Bits softkey and submenu to 
specify the bit values:

Press the Data, SSM, and/or SSM softkeys and use the binary keypad dialog to 
enter the 0, 1, or X (don't care) values.

The SDI or SSM selections may not be available, depending on word format 
selection in the Serial Decode Menu.
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6 If you select the Label Range condition, use the Label Min and Label Max softkeys 
to specify the ends of the range.

Again, label values are always displayed in octal.

You can use the Zoom mode for easier navigation of the decoded data.

ARINC 429 Serial Decode

To set up the oscilloscope to capture ARINC 429 signals, see "Setup for 
ARINC 429 Signals" on page 538.

To set up ARINC 429 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 In the submenu accessed by the Settings softkey, you can use the Base softkey 
to select between hexadecimal and binary display of the decoded data.

The base setting is used for data display in both the decode line and in the 
Lister.

Label values are always displayed in octal, and SSM and SDI values are always 
displayed in binary.

3 Press the Word Format softkey and specify the word decode format:

• Label/SDI/Data/SSM:

• Label - 8 bits.

NOTE To display ARINC 429 serial decode, see "ARINC 429 Serial Decode" on page 541.

NOTE For ARINC 429 triggering set up see "ARINC 429 Triggering" on page 539.
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• SDI - 2 bits.

• Data - 19 bits.

• SSM - 2 bits.

• Label/Data/SSM:

• Label - 8 bits.

• Data - 21 bits.

• SSM - 2 bits.

• Label/Data:

• Label - 8 bits.

• Data - 23 bits.

4 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the decoded data.

See Also • "Interpreting ARINC 429 Decode" on page 543

• "ARINC 429 Totalizer" on page 544

• "Interpreting ARINC 429 Lister Data" on page 545

• "Searching for ARINC 429 Data in the Lister" on page 546

NOTE If the setup does not produce a stable trigger, the ARINC 429 signal may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting ARINC 429 Decode

Depending on the selected word decode format, the ARINC 429 decode display is 
color coded as follows:

• When the decode format is Label/SDI/Data/SSM:

• Label (yellow) (8 bits) – displayed in octal.

• SDI (blue) (2 bits) – displayed in binary.

• Data (white, red if parity error) (19 bits) – displayed in the selected Base.

• SSM (green) (2 bits) – displayed in binary.

• When the decode format is Label/Data/SSM:

• Label (yellow) (8 bits) – displayed in octal.

• Data (white, red if parity error) (21 bits) – displayed in the selected Base.

• SSM (green) (2 bits) – displayed in binary.

• When the decode format is Label/Data:

• Label (yellow) (8 bits) – displayed in octal.
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• Data (white, red if parity error) (23 bits) – displayed in the selected Base.

The Label bits are displayed in the same order as they are received on the wire. For 
the Data, SSM, and SDI bits, the fields are displayed in the order received; 
however, the bits within those fields are displayed in reverse order. In other words, 
the non-Label fields are displayed in the ARINC 429 Word Format, while the bits 
for those fields have the opposite transfer order on the wire.

ARINC 429 Totalizer

The ARINC 429 totalizer measures the total ARINC 429 words and errors.

The totalizer is always running, counting words and errors, and is displayed 
whenever ARINC 429 decode is displayed. The totalizer counts even when the 
oscilloscope is stopped (not acquiring data).

Pressing the [Run/Stop] key does not affect the totalizer.

When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset ARINC 429 Counters softkey 
(in the decode Settings menu).
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Interpreting ARINC 429 Lister Data

In addition to the standard Time column, the ARINC 429 Lister contains these 
columns:

• Label — the 5-bit label value in octal format.

• SDI — the bit values (if included in the word decode format).

• Data — the data value in binary or hex, depending on the base setting.

• SSM — the bit values (if included in the word decode format).

• Errors — highlighted in red. Errors can be Parity, Word, or Gap.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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Searching for ARINC 429 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
ARINC 429 data in the Lister. You can use the [Navigate] key and controls to 
navigate through the marked rows.

1 With ARINC 429 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the ARINC 429 signal is being 
decoded.

3 Press Search; then, select from these options:

• Label — finds the specified label value.

Label values are always displayed in octal.

• Label + Bits — finds the label and the other word fields as specified.

• Parity Error — finds words with a parity error.

• Word Error — finds an intra-word coding error.

• Gap Error — finds an inter-word gap error.

• Word or Gap Error — finds either a Word or Gap Error.

• All Errors — finds any of the above errors.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.



547

Keysight InfiniiVision 6000 X-Series Oscilloscopes 
User's Guide

 

34 SENT Triggering and Serial 
Decode
Setup for SENT Signals / 547
SENT Triggering / 552
SENT Serial Decode / 554

The SENT (Single Edge Nibble Transmission) triggering and serial decode option 
is license-enabled.

Setup for SENT Signals

To set up the oscilloscope to capture SENT signals:

1 Connect an oscilloscope channel to the signal in the device under test.

Analog channels or digital channels can be used.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select SENT.

5 Press the Source softkey to open the SENT Source Menu.
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a Press the Source softkey; then, turn the Entry knob to select the channel for 
the signal.

b Press the Threshold softkey; then, turn the Entry knob to select the signal 
threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode 
(Serial 1 or Serial 2).

c Press the Back/Up key to return to the SENT Serial Decode Menu.

6 Press the Bus Config softkey to open the SENT Bus Configuration Menu.

a Press the Clock Period softkey; then, turn the Entry knob (or press the softkey 
again and use a keypad dialog) to specify the nominal clock period (tick) 
time.

b Press the Tolerance softkey; then, turn the Entry knob (or press the softkey 
again and use a keypad dialog) to specify the percent tolerance for 
determining whether the sync pulse is valid for decoding the data.

If the measured time of the sync pulse is within the percent tolerance of the 
nominal clock period setting, the decode proceeds; otherwise, the sync 
pulse is in error, and the data is not decoded.

c Press the # of Nibbles softkey; then, turn the Entry knob (or press the softkey 
again and use a keypad dialog) to specify the number of nibbles in a Fast 
Channel Message.

d Press the Idle State softkey to specify the idle state of the SENT signal.

e Press the CRC Format softkey to specify the CRC format that will be used in 
calculating the correctness of the CRCs.

Back
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Enhanced Serial Message CRCs are always calculated using the 2010 
format, but for the Fast Channel Messages, and for Short Serial Message 
CRCs, the chosen setting is used.

f Press the Pause Mode softkey to specify whether there is a pause pulse 
between Fast Channel Messages:

• Off — There is no pause pulse between Fast Channel Messages.

Note that a SENT serial bus with no pause pulse is never idle. This means, 
during normal operation, the fast channel decode line will show a 
continuous stream of packets, with a new packet opening as soon as the 
previous one has closed.

• On — Pause pulses are added between Fast Channel Messages so that 
frames come at a regular interval.

If there is a pause pulse (and Pause Pulse is on), idle time is shown 
between messages.

• SPC (Short PWM Code) — In SENT SPC, there are no pause pulses. 
Instead, the message event is triggered by the master when it wants to 
receive data. SENT SPC ends the transmission after the CRC so it almost 
appears as if there is a pause pulse from the end until the next master 
trigger.

g Press the Back/Up key to return to the SENT Serial Decode Menu.

7 Press the Settings softkey to open the SENT Settings Menu.

a Press the Message Format softkey to select the message decode/triggering 
format:

• Fast Nibbles (All) — displays the raw transmitted nibble values.

• Fast Signals — displays Fast Channel Message Signals.

• Fast + Short Serial — displays both Fast and Slow Messages (Short format) 
simultaneously.

• Fast + Enhanced Serial — displays both Fast and Slow Messages (Enhanced 
format) simultaneously.

• Short Serial — displays Slow Channel Messages in Short format.

Back
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• Enhanced Serial — displays Slow Channel Messages in Enhanced format.

This selection affects both decoding and triggering. The decode is affected 
both in how the system interprets the data, and what will be displayed. The 
trigger is affected in that the trigger hardware needs to be configured to 
trigger on serial messages correctly.

You can specify the nibble display order for Fast Channel Message Signals 
(under the Fast Signals softkey). Raw transmitted nibble values are displayed 
in the order received.

Slow Channel Serial Messages are always displayed as defined by the SENT 
specification.

b Press the Display softkey to select between hexadecimal, unsigned decimal, 
or "transfer function" display of Fast Channel nibbles, signals, and CRC 
values, as well as Slow Channel IDs, data, and CRC values. (The S&C value is 
always displayed in binary.)

Your selection is used for both the Lister and the decode line displays.

When Transfer Function is selected (for message formats that include fast 
signals), Fast Channel Signals display a calculated physical value based on 
the specified Multiplier and Offset (under the Fast Signals softkey):

• PhysicalValue = (Multiplier * SignalValueAsUnsignedInteger) + Offset

When Transfer Function is selected, the CRC and Slow Channel information is 
displayed in hex.

8 When a fast signals message decode/triggering is selected, press the Fast 
Signals softkey to open the SENT Signals Menu where you can define and 
specify the display of up to six Fast Signals.

NOTE For the Slow Channel, the proper format, Short or Enhanced, must be chosen for proper 
decoding and triggering to occur.
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a Press the Fast Signals softkey and use the Entry knob to select the Fast Signal 
to be defined.

Once a Fast Signal is selected, press the softkey again to enable or disable 
decode for that signal.

b Press the Start Bit # (MSB) softkey to specify the starting bit for the selected 
signal.

c Press the # of Bits softkey to specify the number of bits in the selected signal.

d Press the Nibble Order softkey to specify the nibble display order as either 
most significant nibble (MSN) or least significant nibble (LSN) first.

e When the display mode setting is Transfer Function (see the SENT Settings 
Menu), press the Multiplier or Offset softkeys; then, turn the Entry knob (or 
press the softkey again and use a keypad dialog) to specify the value.

The multiplier and offset values are used in calculating a physical value 
displayed for the Fast Signal:

• PhysicalValue = (Multiplier * SignalValueAsUnsignedInteger) + Offset

Here are some Fast Signal definition examples:

Example 1: Start Bit # = 13, # of bits = 8, Nibble Order = LSN First

15

Result bits:

Message data:

Example 2: Start Bit # = 10, # of bits = 5, Nibble Order = MSN First

14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

13 1211 10 9 87 6

15

Result bits:

Message data: 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

10 9 8 7 6
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SENT Triggering

To set up the oscilloscope to capture SENT signals, see "Setup for SENT 
Signals" on page 547.

To set up a SENT trigger condition:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select the serial decode (Serial 1 or Serial 2) of the SENT signal.

3 Press the Trigger on: softkey and use the  Entry knob to select the SENT 
trigger condition:

• Start of Fast Channel Message — triggers on the start of any Fast Channel 
Message (after 56 Synchronization/Calibration ticks).

• Start of Slow Channel Message — trigger on the start of any Slow Channel 
Message.

• Fast Channel SC & Data — triggers on a Fast Channel Message when the Status 
& Communication nibble and the data nibbles match the values entered 
using additional softkeys.

• Slow Channel Message ID — triggers when a Slow Channel Message ID 
matches the value entered using additional softkeys.

• Slow Channel Message ID & Data — triggers when a Slow Channel Message ID 
and Data field both match the values entered using additional softkeys.

• Tolerance Violation — triggers when the sync pulse width varies from the 
nominal value by greater than the entered percentage.

• Fast Channel CRC Error — triggers on any Fast Channel Message CRC error.

• Slow Chanel CRC Error — triggers on any Slow Channel Message CRC error.

• All CRC Errors — triggers on any CRC error, Fast or Slow.

• Pulse Period Error — triggers if a nibble is either too wide or too narrow (for 
example, data nibble < 12 (11.5) or > 27 (27.5) ticks wide). Sync, S&C, data, 
or checksum pulse periods are checked.
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• Successive Sync Pulses Error — triggers on a sync pulse whose width varies 
from the previous sync pulse's width by greater than 1/64 (1.5625%, as 
defined in the SENT specification).

4 If you choose the Fast Channel SC & Data trigger condition:

a Press the Base softkey to choose between Hex or Binary data value entry.

Use the Binary method if you need to enter "don't care" bits (X) within a 
nibble. If all bits in a nibble are "don't care", the hex nibble is displayed as 
"don't care" (X). When all bits in a nibble are 1s or 0s, the hex value is shown. 
Hex nibbles that contain a mix of 0/1 bits and "don't care" bits are displayed 
as "$".

b Press the SC & Data softkey and use the keypad dialog to enter the data 
value.

The S&C nibble is the left most nibble entered in the string of numbers, 
followed by the data nibbles.

5 If you choose the Slow Channel Message ID or Slow Channel Message ID & Data 
trigger condition:

a Press the Configuration softkey to select the desired packet ID for the selected 
packet type.

When an Enhanced Serial message format is specified (see "Setup for SENT 
Signals" on page 547), press this softkey to select which enhanced format 
configuration is being used:

• 16-Bit Data, 4-Bit ID

• 12-Bit Data, 8-Bit ID

b Press the Slow Message ID softkey and use the Entry knob (or press the 
softkey again and use a keypad dialog) to specify the Slow Message ID.

c If you choose the Slow Channel Message ID & Data trigger condition, press the 
Slow Data softkey and use the Entry knob (or press the softkey again and use 
a keypad dialog) to specify the Slow Message data.

6 If you choose the Tolerance Violation trigger condition, press the Tolerance 
softkey and use the Entry knob (or press the softkey again and use a keypad 
dialog) to specify the tolerance variation that is considered a violation.

The percentage entered must be less than the percent tolerance specified in 
the decode bus configuration settings.
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SENT Serial Decode

To set up the oscilloscope to capture SENT signals, see "Setup for SENT 
Signals" on page 547.

To set up SENT serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

NOTE If the setup does not produce a stable trigger, the SENT signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.

NOTE To display SENT serial decode, see "SENT Serial Decode" on page 554.

NOTE For SENT triggering setup see "SENT Triggering" on page 552.

NOTE If the setup does not produce a stable trigger, the SENT signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode softkey 
to set the trigger mode from Auto to Normal.
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See Also • "Interpreting SENT Decode" on page 555

• "Interpreting SENT Lister Data" on page 557

• "Searching for SENT Data in the Lister" on page 559

Interpreting SENT Decode

The fields of the Fast and Slow Channels are displayed as follows. Note that the 
Slow Channel has three different variants. The colors noted below indicate the 
color of the text:

• Fast Channel:

• Status & Communication (S&C) Nibble (green) (4 bits):

• 2 Application bits and 2 Serial Message bits will be displayed, in all 
formats.

• Data Nibbles (white) (4 bits, but may be combined into Signals, based on 
format):
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• "Fast Nibbles (All)" format — each nibble displayed as hex or decimal 
number.

• "Fast Signals", "Fast + Short Serial", or "Fast + Enhanced Serial" formats — If 
any fast signals are enabled, signals are displayed like:

• S1:<value>;S2:<value>.

• Unused nibbles are not displayed (example, when 6th nibble is an 
inverted copy of the 1st nibble).

• CRC Nibble (blue when valid, red when error detected) (4 bits).

• Slow Channel – Short Serial Message:

• Message ID (yellow) (4 bits).

• Data Byte (white) (8 bits).

• CRC (blue when valid, red when error detected) (4 bits).

• Slow Channel – Enhanced Serial Message:

• CRC (blue when valid, orange if end of message is off screen, red when error 
detected) (6 bits).
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• Message ID (yellow) (4 or 8 bits).

• Data Field (white) (16 or 12 bits).

Enhanced Serial Message CRCs will be displayed in orange if the data to calculate 
the CRC is off-screen to the right. Serial messages will also be shown with a 
leading idle line in orange and an opening brace in orange if the starting location 
cannot be precisely determined due to that data being off screen to the left.

The decode will also indicate errors where a nibble's pulse is too wide or too 
narrow. This will be indicated by a ">" or "<" in red, as well as the rest of the 
packet's outline and closing brace being in red, as well as an orange idle line until 
the next valid sync. At the time of the valid sync, there will be an orange opening 
brace.

Interpreting SENT Lister Data
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Each Fast or Slow Channel message is represented on its own row. The start time 
of Slow Channel messages determines their order relative to the Fast Channel 
messages. Therefore, a Slow Channel message appears before most of the Fast 
Channel messages that it was built from. This is due to the "Time" column holding 
the start time of a packet.

In addition to the standard Time column, the following columns are used to 
support both the Fast Channel and the Slow Channel simultaneously, and these 
columns are displayed for all Message Format modes except Fast Nibbles (All):

• S&C — (Fast Channel Only) (binary).

• ID — (Slow Channel Only) (Hex or Decimal).

• Data — (Hex or Decimal):

• Fast Channel:

• <value> (value in Hex or Decimal) (Raw Decode Format).

• S1:<value>;S2:<value> (values are in Hex or Decimal) (other formats).

• Slow Channel: Hex or Decimal display of a single value.

• CRC — (value in Hex or Decimal).

• Pause Ticks (ticks will be displayed in orange if the uncertainty of the 
measurement is > 25%).

• Errors.

When the Message Format is set to Fast Nibbles (All), the following columns are 
displayed:

• Sync Width.

• S&C — (Fast Channel Only) (binary).

• Data — (Hex or Decimal).

• CRC — (value in Hex or Decimal).

• Errors.

When the selected Message Format contains both Fast and Slow Channel 
Messages, the S&C Lister field (populated for Fast Messages) has a green 
background, and the ID Lister field (populated for Slow Messages) has a yellow 
background.

Slow Channel CRC values that cannot be confirmed as valid or invalid due to data 
used in the calculation being off screen to the right, will have an orange 
background in the Lister.
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Searching for SENT Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
SENT data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With SENT selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
Serial 1 or Serial 2, where the SENT signals is being decoded.

3 In the Search Menu, press Search for; then, select from these options:

• Fast Channel Data — finds Fast Channel data nibbles that match the values 
entered using additional softkeys.

• Slow Channel Message ID — finds Slow Channel Message IDs that match the 
value entered using additional softkeys.

• Slow Channel Message ID & Data — finds Slow Channel Message IDs and Data 
that match the values entered using additional softkeys.

• All CRC Errors — finds any CRC error, Fast or Slow.

• Pulse Period Error — finds where a nibble is either too wide or too narrow (for 
example, data nibble < 12 (11.5) or > 27 (27.5) ticks wide). Sync, S&C, data, 
or checksum pulse periods are checked.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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35 UART/RS232/422/485 
Triggering and Serial 
Decode
Setup for UART/RS232/422/485 Signals / 561
UART/RS232/422/485 Triggering / 563
UART/RS232/422/485 Serial Decode / 565

The UART/RS232/422/485 triggering and serial decode option is license-enabled.

Setup for UART/RS232/422/485 Signals

To set up the oscilloscope to capture UART/RS232/422/485 signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select UART/RS232 trigger type.

4 Press the Signals softkey to open the UART/RS232 Signals Menu.



562 Keysight InfiniiVision 6000 X-Series Oscilloscopes User's Guide

35 UART/RS232/422/485 Triggering and Serial Decode
 

5 For both the Rx and Tx signals:

a Connect an oscilloscope channel to the signal in the device under test.

b Press the Rx or Tx softkey; then, turn the Entry knob to select the channel for 
the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob to select 
the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

The RX and TX labels for the source channels are automatically set.

6 Press the Back/Up key to return to the Serial Decode Menu.

7 Press the Bus Config softkey to open the UART/RS232 Bus Configuration Menu.

Set the following parameters.

a #Bits — Set the number of bits in the UART/RS232 words to match your 
device under test (selectable from 5-9 bits).

b Parity — Choose odd, even, or none, based on your device under test.

c Baud — Press the Baud Rate softkey, then press the Baud softkey and select a 
baud rate to match the signal in your device under test. You can select baud 
rates from 1.2 kb/s to 12 Mb/s.

If the desired baud rate is not listed, select User Defined on the Baud softkey; 
then, select the desired baud rate using the User Baud softkey. You can set 
the user-defined UART baud rate from 100 b/s to 8.0000 Mb/s.

d Polarity — Select idle low or idle high to match your device under test's state 
when at idle. For RS232 select idle low.

e Bit Order — Select whether the most significant bit (MSB) or the least 
significant bit (LSB) is presented after the start bit in the signal from your 
device under test. For RS232 select LSB.

Back

NOTE In the serial decode display, the most significant bit is always displayed on the left regardless 
of how Bit Order is set.
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UART/RS232/422/485 Triggering

To set up the oscilloscope to capture UART/RS232/422/485 signals, see "Setup 
for UART/RS232/422/485 Signals" on page 561.

To trigger on a UART (Universal Asynchronous Receiver/Transmitter) signal 
connect the oscilloscope to the Rx and Tx lines and set up a trigger condition. 
RS232 (Recommended Standard 232) is one example of a UART protocol.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the UART/RS232 signals are 
being decoded.

3 Press the Trigger Setup softkey to open the UART/RS232 Trigger Setup Menu.

4 Press the Base softkey to select Hex or ASCII as the base displayed on the Data 
softkey in the UART/RS232 Trigger Setup Menu.

Note that the setting of this softkey does not affect the selected base of the 
decode display.

5 Press the Trigger softkey and set up the desired trigger condition:

• Rx Start Bit — The oscilloscope triggers when a start bit occurs on Rx.

• Rx Stop Bit — Triggers when a stop bit occurs on Rx. The trigger will occur on 
the first stop bit. This is done automatically whether the device under test 
uses 1, 1.5, or 2 stop bits. You do not need to specify the number of stop bits 
used by the device Under test.

• Rx Data — Triggers on a data byte that you specify. For use when the device 
under test data words are from 5 to 8 bits in length (no 9th (alert) bit).
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• Rx 1:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers only when the 9th (alert) 
bit is 1. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit).

• Rx 0:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers only when the 9th (alert) 
bit is 0. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit).

• Rx X:Data — For use when the device under test data words are 9 bits in 
length including the alert bit (the 9th bit). Triggers on a data byte that you 
specify regardless of the value of the 9th (alert) bit. The specified data byte 
applies to the least significant 8 bits (excludes the 9th (alert) bit).

• Similar choices are available for Tx.

• Rx or Tx Parity Error — Triggers on a parity error based on the parity you have 
set in the Bus Configuration Menu.

6 If you choose a trigger condition that includes "Data" in its description (for 
example: Rx Data), then press the Data is softkey, and choose an equality 
qualifier. You can choose equal to, not equal to, less than, or greater than a 
specific data value.

7 Use the Data softkey to choose the data value for your trigger comparison. This 
works in conjunction with the Data is softkey.

8 Optional: The Burst softkey lets you trigger on the Nth frame (1-4096) after an 
idle time you select. All trigger conditions must be met for the trigger to occur.

9 If Burst is selected, an idle time (1 µs to 10 s) can be specified so that the 
oscilloscope will look for a trigger condition only after the idle time has past. 
Press the Idle softkey and rotate the Entry knob to set an idle time.

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow enough 
that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.

NOTE To display UART/RS232 serial decode, see "UART/RS232/422/485 Serial Decode" on 
page 565.
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UART/RS232/422/485 Serial Decode

To set up the oscilloscope to capture UART/RS232/422/485 signals, see "Setup 
for UART/RS232/422/485 Signals" on page 561.

To set up UART/RS232/422/485 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press Settings.

3 In the UART/RS232 Settings Menu, press the Base softkey to select the base 
(hex, binary, or ASCII) in which decoded words are displayed.

• When displaying words in ASCII, the 7-bit ASCII format is used. Valid ASCII 
characters are between 0x00 and 0x7F. To display in ASCII you must select 
at least 7 bits in the Bus Configuration. If ASCII is selected and the data 
exceeds 0x7F, the data is displayed in hex.

• When #Bits is set to 9 in the UART/RS232 Bus Configuration Menu, the 9th 
(alert) bit is displayed directly to the left of the ASCII value (which is derived 
from the lower 8 bits).

4 Optional: Press the Framing softkey and select a value. In the decode display, 
the chosen value will be displayed in light blue. However, if a parity error occurs 
the data will be displayed in red.

5 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

NOTE For UART/RS232/422/485 triggering setup see "UART/RS232/422/485 Triggering" on 
page 563.
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6 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting UART/RS232/422/485 Decode" on page 566

• "UART/RS232/422/485 Totalizer" on page 567

• "Interpreting UART/RS232/422/485 Lister Data" on page 568

• "Searching for UART/RS232/422/485 Data in the Lister" on page 568

Interpreting UART/RS232/422/485 Decode

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow enough 
that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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• Angled waveforms show an active bus (inside a packet/frame).

• Mid-level blue lines show an idle bus.

• When using 5-8 bit formats, the decoded data is displayed in white (in binary, 
hex, or ASCII).

• When using the 9 bit format, all data words are displayed in green, including 
the 9th bit. The 9th bit is displayed on the left.

• When a data word value is selected for framing, it is displayed in light blue. 
When using 9-bit data words, the 9th bit will also be displayed in light blue.

• Decoded text is truncated at the end of the associated frame when there is 
insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and run 
again) to see decode.

• When the horizontal scale setting does not permit the display of all available 
decoded data, red dots will appear in the decoded bus to mark the location of 
hidden data. Expand the horizontal scale to allow the data to display.

• An unknown (undefined) bus is shown in red.

• A parity error will cause the associated data word to be shown in red, which 
includes the 5-8 data bits and the optional 9th bit.

UART/RS232/422/485 Totalizer

The UART/RS232/422/485 totalizer consists of counters that provide a direct 
measure of bus quality and efficiency. The totalizer appears on screen whenever 
UART/RS232 Decode is ON in the Serial Decode Menu.

The totalizer is running, counting frames and calculating the percentage of error 
frames, even when the oscilloscope is stopped (not acquiring data).

The ERR (error) counter is a count of Rx and Tx frames with parity errors. The TX 
FRAMES and RX FRAMES counts include both normal frames and frames with 
parity errors. When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset UART Counters softkey in 
the UART/RS232 Settings Menu.
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Interpreting UART/RS232/422/485 Lister Data

In addition to the standard Time column, the UART/RS232 Lister contains these 
columns:

• Rx — receive data.

• Tx — transmit data.

• Errors — highlighted in red, Parity Error or Unknown Error.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.

Searching for UART/RS232/422/485 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
UART/RS232/422/485 data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With UART/RS232 selected as the serial decode mode, press [Search].
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2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the UART/RS232 signals are being 
decoded.

3 In the Search Menu, press Search; then, select from these options:

• Rx Data — Finds a data byte that you specify. For use when the DUT data 
words are from 5 to 8 bits in length (no 9th (alert) bit).

• Rx 1:Data — For use when the DUT data words are 9 bits in length including 
the alert bit (the 9th bit). Finds only when the 9th (alert) bit is 1. The 
specified data byte applies to the least significant 8 bits (excludes the 9th 
(alert) bit)

• Rx 0:Data — For use when the DUT data words are 9 bits in length including 
the alert bit (the 9th bit). Finds only when the 9th (alert) bit is 0. The 
specified data byte applies to the least significant 8 bits (excludes the 9th 
(alert) bit).

• Rx X:Data — For use when the DUT data words are 9 bits in length including 
the alert bit (the 9th bit). Finds a data byte that you specify regardless of the 
value of the 9th (alert) bit. The specified data byte applies to the least 
significant 8 bits (excludes the 9th (alert) bit).

• Similar choices are available for Tx.

• Rx or Tx Parity Error — Finds a parity error based on the parity you have set in 
the Bus Configuration Menu.

• Rx or Tx Any Error — Finds any error.

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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36 USB 2.0 Triggering and 
Serial Decode
Setup for USB 2.0 Signals / 571
USB 2.0 Triggering / 573
USB 2.0 Serial Decode / 575

The USB 2.0 triggering and serial decode option is license-enabled.

Setup for USB 2.0 Signals

To set up the oscilloscope to capture USB 2.0 signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select USB trigger type.

4 Press the Speed softkey and specify the speed of the USB signal:

• Low (1.5 Mb/s) — requires two single-ended probes.

• Full (12 Mb/s) — requires two single-ended probes.

• High (480 Mb/s) — requires a differential probe.

Analog channels can be used for any of these speeds. Digital channels can be 
used for Low and Full speed only.

5 Press the Signals softkey to open the USB Signals Menu.
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6 For both the D+ and D- signals (for low or full speed, similar steps for the single 
Source for high speed):

a Connect an oscilloscope channel to the signal in the device under test.

b Press the D+ Source or D- Source softkey; then, turn the Entry knob to select 
the channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob to select 
the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode slot.

7 Press Auto Setup to automatically set these options for decoding and triggering 
on USB signals:

• Low-speed:

• D+/- Source thresholds: 1.4 V

• D+/- Source vertical scale: 1.0 V/div

• D+/- Source vertical offset: 0.0 V

• Horizontal scale: 5 µs/div

• Full-speed:

• D+/- Source thresholds: 1.4 V

• D+/- Source vertical scale: 1.0 V/div

• D+/- Source vertical offset: 0.0 V

• Horizontal scale: 500 ns/div

• High-speed:

• D+/- Source thresholds: 0.0 V

• D+/- Source vertical scale: 200 mV/div

• D+/- Source vertical offset: 0.0 V

• Horizontal scale: 20 ns/div

• Serial Decode: On

• Trigger Mode: currently active serial bus

• USB Trigger Mode: Start of Packet
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USB 2.0 Triggering

To set up the oscilloscope to capture USB 2.0 signals, see "Setup for USB 2.0 
Signals" on page 571.

To trigger on a USB 2.0 signal, connect the oscilloscope to the D+ and D- lines 
and set up a trigger condition.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob to 
select the serial slot (Serial 1 or Serial 2) on which the USB 2.0 signals are 
being decoded.

3 Press the Trigger softkey and use the  Entry knob to select the USB packet, 
error, or event to trigger on:

• SOP - Start of Packet — triggers on the sync bit at the beginning of the packet 
(low and full speed only).

• EOP - End of Packet — triggers at the end of the SE0 portion of the EOP (low 
and full speed only).

• Suspend — triggers when the bus is idle for > 3 ms (low and full speed only).

• Resume — triggers when exiting an idle state > 10 ms (low and full speed 
only).

• Reset — triggers when SE0 is > 10 ms (low and full speed only).

• Token Packet — triggers when a token packet with the specified content is 
detected.

• Data Packet — triggers when a data packet with the specified content is 
detected.

• Handshake Packet — triggers when a handshake packet with the specified 
content is detected.

• Special Packet — triggers when a special packet with the specified content is 
detected.

• All Errors — triggers when any of the following errors are detected.
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• PID Error — triggers when the packet type field does not match the check 
field.

• CRC5 Error — triggers when a 5 bit CRC error is detected.

• CRC16 Error — triggers when a 16 bit CRC error is detected.

• Glitch Error — triggers when two transitions occur in half a bit time.

• Bit Stuff Error — triggers when > 6 consecutive ones are detected (low and full 
speed only).

• SE1 Error — triggers if SE1 > 1 bit time (low and full speed only).

4 If you choose the Token Packet, Data Packet, Handshake Packet, or Special Packet 
trigger condition:

a Press the PID softkey to select the desired packet ID for the selected packet 
type.

b Press the Base softkey to select the Hex or Binary number base when 
displaying or entering USB packet trigger values.

Note that the setting of this softkey does not affect the selected base of the 
decode display.

c Press the Bits softkey.

d In the USB Bits Menu, press the Define softkey to select the trigger value to 
specify.

e Use the remaining softkeys to specify the value.

For details about using the USB Bits Menu softkeys, press and hold the 
softkey in question to display the built-in help.

NOTE If the setup does not produce a stable trigger, the USB 2.0 signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.

NOTE To display USB 2.0 serial decode, see "USB 2.0 Serial Decode" on page 575.
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USB 2.0 Serial Decode

To set up the oscilloscope to capture USB 2.0 signals, see "Setup for USB 2.0 
Signals" on page 571.

To set up USB 2.0 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press the Base for Data softkey to select the base (hex, binary, ASCII, or decimal) 
in which decoded data is displayed.

3 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting USB 2.0 Decode" on page 576

• "Interpreting USB 2.0 Lister Data" on page 578

• "Searching for USB 2.0 Data in the Lister" on page 579

NOTE For USB 2.0 triggering setup see "USB 2.0 Triggering" on page 573.

NOTE If the setup does not produce a stable trigger, the USB 2.0 signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting USB 2.0 Decode

The USB decode display is color coded as follows:

• For Token Packets (all but SOF):

• PID (yellow, "OUT", "IN", "SETUP", "PING")

• PID Check (yellow when valid, red when error detected)

• Address (blue)

• Endpoint (green)

• CRC (blue when valid, red when error detected)

• For Token Packets (SOF):

• PID (yellow, "SOF")

• PID Check (yellow when valid, red when error detected)

• Frame (green) – the frame number

• CRC (blue when valid, red when error detected)
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• For Data Packets:

• PID (yellow, "DATA0", "DATA1", "DATA2", "MDATA")

• PID Check (yellow when valid, red when error detected)

• Data (white)

• CRC (blue when valid, red when error detected)

• For Handshake Packets:

• PID (yellow, "ACK", "NAK", "STALL", "NYET", "PRE", "ERR")

• PID Check (yellow when valid, red when error detected)

• For Split Transaction Token Packets:

• PID (yellow, "SPLIT")

• PID Check (yellow when valid, red when error detected)

• Hub Addr (green)

• SC (blue)

• Port (green)

• S & E|U (blue)

• ET (green)

• CRC (blue when valid, red when error detected)

If the packet type is unknown because the PID is off screen, all bytes will be 
displayed in orange.
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Interpreting USB 2.0 Lister Data

In addition to the standard Time column, the USB 2.0 Lister contains these 
columns:

• PID — PID is displayed as red text if the PID check value does not match.

• Addr — Address.

• Endp — Endpoint.

• Data — either the Data of a Data Packet, or the various fields of a SPLIT packet.

• Fr — Frame – frame number of a SOF packet.

• CRC.

• Errors — "PID", "CRC5", "CRC16", "Glitch", "Stuff" , or "SE1" errors as 
appropriate. The background color is red to indicate an error.

Aliased data is highlighted in pink. When this happens, decrease the horizontal 
time/div setting and run again.
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If the packet type is unknown because the PID is off screen, the Lister text will 
have an orange background.

Searching for USB 2.0 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain types of 
USB 2.0 data in the Lister. You can use the [Navigate] key and controls to navigate 
through the marked rows.

1 With USB 2.0 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob to select 
the serial slot (Serial 1 or Serial 2) on which the USB 2.0 signals are being 
decoded.

3 In the Search Menu, press Search for; then, select from these options:

• Token Packet — finds token packets with the specified content.

• Data Packet — finds data packets with the specified content.

• Handshake Packet — finds handshake packets with the specified content.

• Special Packet — finds special packets with the specified content.

• All Errors — finds any of the following errors.

• PID Error — finds packet type fields that do not match the check field.

• CRC5 Error — finds 5 bit CRC errors.

• CRC16 Error — finds 16 bit CRC errors.

• Glitch Error — finds two transitions that occur in half a bit time.

• Bit Stuff Error — finds > 6 consecutive ones (low and full speed only).

• SE1 Error — finds when SE1 > 1 bit time (low and full speed only).

For more information on searching data, see "Searching Lister Data" on page 163.

For more information on using the [Navigate] key and controls, see "Navigating the 
Time Base" on page 81.
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37 USB PD Triggering and 
Serial Decode
Setup for USB PD Signals / 581
USB PD Triggering / 582
USB PD Serial Decode / 584

The USB PD (Power Delivery) triggering and serial decode option is 
license-enabled.

Setup for USB PD Signals

To set up the oscilloscope to capture USB PD signals:

1 Connect an oscilloscope channel to the signal in the device under test.

Analog channels can be used.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot (Serial 1 or 
Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select USB PD.

5 Press the Source softkey; then, turn the Entry knob to select the channel for the 
signal.
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6 Press the Threshold softkey; then, turn the Entry knob to select the signal 
threshold voltage level.

The threshold voltage level is used in decoding, and it will become the trigger 
level when the trigger type is set to the selected serial decode (Serial 1 or 
Serial 2).

USB PD Triggering

To set up the oscilloscope to capture USB PD signals, see "Setup for USB PD 
Signals" on page 581.

When USB PD (Power Delivery) is selected as one of the serial bus decodes, you 
can trigger on USB PD signals.

To set up a USB PD trigger condition:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry knob to 
select the serial decode (Serial 1 or Serial 2) of the USB PD signal.

3 Press the Trigger softkey and use the  Entry knob to select the USB PD 
trigger mode:

• Preamble Start — triggers at the start of a preamble, which starts with 0.

• EOP — triggers at the end of packet.

• SOP — triggers on ordered set Sync-1, Sync-1, Sync-1, Sync-2.

• SOP' — triggers on ordered set Sync-1, Sync-1, Sync-3, Sync-3.

• SOP'' — triggers on ordered set Sync-1, Sync-3, Sync-1, Sync-3.

• SOP' Debug — triggers on ordered set Sync-1, RST-2, RST-2, Sync-3.

• SOP'' Debug — triggers on ordered set Sync-1, RST-2, Sync-3, Sync-2.

• Hard Reset — triggers on ordered set RST-1, RST-1, RST-1, RST-2.

• Cable Reset — triggers on ordered set RST-1, Sync-1, RST-1, Sync-3.

• CRC Error — triggers when an error is detected on a 32-bit CRC.
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• Preamble Error — triggers when an error is detected on a 64-bit sequence of 
alternating 0 and 1.

• Header Content — triggers on a user-defined 16-bit value.

In this mode, additional softkeys let you further set up the trigger mode.

4 When the Header Content trigger mode is selected, press the Header Type softkey 
to select the header type:

• Control Message — triggers on control message types (0 data object). Press 
the Message Type softkey to select the control message.

• Data Message — triggers on data message types (1 or more data objects). 
Press the Message Type softkey to select the data message.

• Extended Message — triggers on extended message types (bit 15 is set). Press 
the Message Type softkey to select the extended data message.

• Value — triggers on a user-defined header value. Press the Base softkey to 
specify the number base, and press the Header softkey to enter the value.

5 Also when the Header Content trigger mode is selected, there is a Qualifier 
softkey that can further qualify the trigger:

• None — There is no additional qualifier for the trigger.

• SOP — The trigger occurs on Sync-1, Sync-1, Sync-1, Sync-2 ordered sets 
only.

• SOP' — The trigger occurs on Sync-1, Sync-1, Sync-3, Sync-3 ordered sets 
only.

• SOP'' — The trigger occurs on Sync-1, Sync-3, Sync-1, Sync-3 ordered sets 
only.

NOTE If the setup does not produce a stable trigger, the USB PD signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.

NOTE To display USB PD serial decode, see "USB PD Serial Decode" on page 584.
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USB PD Serial Decode

To set up the oscilloscope to capture USB PD signals, see "Setup for USB PD 
Signals" on page 581.

To set up USB PD serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key to turn it 
on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and decode 
data.

You can use the horizontal Zoom window for easier navigation of the acquired data.

See Also • "Interpreting USB PD Decode" on page 585

• "Interpreting USB PD Lister Data" on page 586

NOTE For USB PD triggering setup see "USB PD Triggering" on page 582.

NOTE If the setup does not produce a stable trigger, the USB PD signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting USB PD Decode

The USB PD decode is displayed as a single bus, with one decode line positioned 
at the bottom of the waveform area, time-aligned with the associated physical 
signal. Above the decode line is abbreviated symbolic decode information, shown 
in white, that describes the header's port power role (bit 8), port data role (bit 5), 
and message type (bits 4-0).

The decode line shows a blue idle line until the preamble is reached, at which 
point the start of frame angle bracket (<) is drawn in blue. The end of frame angle 
bracket (>) is drawn in blue at the end of the EOP, followed by a blue idle line. The 
fields and hex data within a packet are distinguished by color:

• SOP* (blue)

• Message Header (yellow)

• Extended Message Header (yellow)

• Data (white)

• CRC (green)
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• EOP (blue)

When errors occur, a red error frame is drawn until a valid idle signal is detected. 
For CRC errors, the decoded text is shown in red. For preamble errors, "PError" is 
shown in red.

Interpreting USB PD Lister Data

In addition to the standard Time column, the USB PD Lister contains these 
columns:

• ORD Set — the ordered set type.

• Header — the header type and value.

• Data — the data or extended message.

• CRC — value in Hex.

• Errors — string value that displays the type of error detected.
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Symbols
(-) Width measurement, 273
(+) Width measurement, 273
+Width to +Width jitter 

measurement, 312

Numerics
1 M ohm input impedance, 89
10 MHz REF connector, 65, 397
50 ohm input impedance, 89

A
About Oscilloscope, 405
absolute value math function, 117
AC channel coupling, 88
AC RMS - Full Screen 

measurement, 268
AC RMS - N Cycles measurement, 268
accessories, 32, 426
acquire, 227, 237
Acquire key, 43
acquisition memory, 182
acquisition memory, saving, 370
acquisition mode, 233
acquisition mode, averaging, 237
acquisition mode, high resolution, 239
acquisition mode, normal, 234
acquisition mode, peak detect, 234
acquisition mode, preserve during 

Autoscale, 395
acquisition modes, 227
active probes, 91
active serial bus, 462, 491, 501, 512, 

567
activity indicator, 147
actual sample rate, 233
adding digital channels license, 430
addition math function, 98

address with no ack condition, I2C 
trigger, 487

address, I2C trigger, 487
adjacent channel power ratio (ACPR) 

FFT analysis measurement, 281
AERO license, 428
aliasing, 229
aliasing, FFT, 113
all edges, measure, 307
alternating edge trigger, 185
AM (amplitude modulation), waveform 

generator output, 359
Amplitude measurement, 264
amplitude modulation (AM), waveform 

generator output, 359
analog channel inputs, 47
analog channel, probe attenuation, 92
analog channel, setup, 85
analog filters, adjusting, 106
analysis results, saving, 367
Analyze key, 43
Analyze Segments, 242, 244, 287
annotation, adding, 170
antialiasing, disabling/enabling, 173
arbitrary generated waveforms, 

editing, 347
arbitrary waveform generator 

output, 345
arbitrary waveforms, copying from other 

sources, 354
arbitrary waveforms, creating new, 348
arbitrary waveforms, editing 

existing, 349
Area - Full Screen measurement, 280
Area - N Cycles measurement, 280
ARINC 429 serial decode, 541
ARINC 429 totalizer, 544
ARINC 429 trigger, 539
ARINC 429 words/errors counter, 544
ARINC 429 decode, signal speed, 538
ARINC 429 decode, signal type, 538
ARINC 429 decode, word format, 541

ASCII file format, 366
ASCII XY data, 369
attenuation, probe, 92
attenuation, probe, external 

trigger, 226
attenuators, 94
AUDIO license, 428
Auto Increment, 374
AUTO Option, 428
Auto Scale key, 45
Auto Setup, FFT, 109
Auto trigger mode, 220
Auto? trigger indicator, 221
AutoIP, 387, 388
automatic measurements, 255, 258
automatic setup, 145
AutoProbe interface, 47, 89
Autoscale preferences, 394
Autoscale, digital channels, 145
Autoscale, undo, 38
Average - Full Screen 

measurement, 267
Average - N Cycles measurement, 267
average measurement trend, 126
averaged value math function, 122
averaging acquire mode, 233, 237
Ax + B math function, 115

B
Back Up key, 41
band pass filter math function, 121
bandwidth, 405
bandwidth limit, 89
bandwidth required, oscilloscope, 232
bandwidth, oscilloscope, 229
bandwidth, realtime sampling, 241
Bartlett FFT window, 107
base 10 exponential math 

function, 119
Base measurement, 265
beep on events, 393
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BIN file format, 366
binary data (.bin), 431
binary data file examples, 435
binary data in MATLAB, 432
binary data, example program for 

reading, 435
binary mode cursors, 247
bit rate measurement, 274
bits, SPI trigger, 499
Blackman Harris FFT window, 107
blanking, 76
BMP file format, 366
Bode plot, frequency response 

analysis, 340
brick-wall frequency response, 230
brightness of waveforms, 41
Browser Web Control, 411, 412, 413
Browser-Based Remote Front 

Panel, 412
built-in help, 67
burst width measurements, 273
burst, capture signal bursts, 242
bus display mode, 150
buttons (keys), front panel, 40
BW Limit? in DVM display, 333

C
calibrate probe, 93
calibration, 404
calibration protect switch, 64, 65
calibration status, 419
calibration, beep on, 393
CAN decode, source channels, 444
CAN FD standard, 446
CAN frame counter, 452
CAN serial decode, 450
CAN symbolic data, 446
CAN totalizer, 452
CAN trigger, 447
CANFD license, 428
capture signal bursts, 242
cardiac waveform generator 

output, 346
Center, FFT, 106
change network password, 421
channel labels, 175
channel power FFT analysis 

measurement, 281

channel, analog, 85
channel, bandwidth limit, 89
channel, coupling, 88
channel, fine adjustment, 90
channel, invert, 91
channel, on/off keys, 47
channel, position, 87
channel, probe external scaling, 93
channel, probe units, 92
channel, skew, 93
channel, vertical sensitivity, 87
characteristics, 423
chart logic bus state math 

function, 128
chart logic bus timing math 

function, 127
chart serial signal math function, 129
choosing values, 42
cleaning, 405
clear display, 169, 236
Clear Display key, 43
clear display, Quick Clear Display, 408
clear persistence, 168
clock, 395
Clock Extension Peripheral Interface 

(CXPI) serial analysis, license, 428
clock recovery, 132
Clock TIE jitter measurement, 310
CMOS threshold, 149
color grade themes, 304
color grade waveform, 301
color grade waveform, enabling, 302
common logarithm math function, 117
COMP license, 428
compensate passive probes, 39, 47
Config softkey, 387, 388
connect probes, digital, 141
connection, to a PC, 388
connections for frequency response 

analysis (FRA), 337
connectors, rear panel, 64
constant frequency clock 

recovery, 133
control, remote, 385
controls, front panel, 40
copyright, 2
counter, 334
Counter measurement, 272
counter, ARINC 429 words/errors, 544

counter, CAN frame, 452
counter, FlexRay frame, 481
counter, UART/RS232/422/485 

frame, 567
coupling, channel, 88
coupling, trigger, 221
crosstalk problems, 106
CSV data, 369
CSV file format, 366
CSV files, minimum and maximum 

values, 439
cursor measurements, 245
cursor units, 248
Cursors key, 46
Cursors knob, 46
cursors, binary, 247
cursors, gated measurement 

window, 285
cursors, hex, 247
cursors, manual, 246
cursors, measure mode, 246
cursors, track waveform, 246
custom location, time reference, 79
CXPI decode, interpreting, 471
CXPI decode, signal setup, 465
CXPI license, 428
CXPI Lister data, 473
CXPI serial decode, 469
CXPI trigger, 466

D
D*, 45, 150
d/dt math function, 101
D6000AERA/B license, 427
D6000AUTA/B license, 427
D6000BDLA/B license, 427
D6000GENA/B license, 427
D6000PWRA/B license, 427
D6000USBA/B license, 427
damage, shipping, 31
damping factor (second-order PLL), 

clock recovery, 134
data acquisition mode, 240
data sheet, 423
Data TIE jitter measurement, 309
DC channel coupling, 88
DC offset correction for integrate 

waveform, 103
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DC RMS - Full Screen 
measurement, 268

DC RMS - N Cycles measurement, 268
DC signals, checking, 221
DC waveform generator output, 345
DDR burst, random trigger holdoff, 224
dead time (re-arm), 244
decaying average approximation, 122
decibels, FFT vertical units, 107
decimating samples, 233
decimation, for measurement 

record, 439
decimation, for screen, 439
default configuration, 37
default setup, 37, 378
Default Setup key, 44
defaults, waveform generator, 363
delay knob, 71
Delay measurement, 259, 275
delay time indicator, 79
delayed sweep, 77
delete file, 388
Demo 1 terminal, 47
Demo 2 terminal, 47
depth, AM modulation, 359
detection type, FFT (Magnitude), 108
deviation, FM modulation, 361
DHCP, 387, 388
differentiate math function, 101
digital bus mode, 150
digital channel controls, 45
digital channel inputs, 65
digital channel menu, 148
digital channels, 148
digital channels, Autoscale, 145
digital channels, enabling, 430
digital channels, logic threshold, 149
digital channels, probing, 153
digital channels, size, 147
digital display, interpreting, 146
Digital key, 45
digital probes, 141, 153
digital probes, impedance, 153
digital voltmeter (DVM), 332
digits, counter resolution, 335
disable network password, 421
Display key, 43
display multiple acquisitions, 228
display, area, 66

display, clear, 169
display, interpreting, 65
display, persistence, 167
display, signal detail, 165
display, softkey labels, 67
display, status line, 66
displayed channels Autoscale, 395
distortion problems, 106
Divide math function, 99
DNS IP, 387
dots or vectors, waveform display, 172
drag touch gesture, 52
dual channel tracking, waveform 

generator, 363
dual-channel (N2820A probe) 

measurements, 261
Duty cycle measurement, 273
duty cycle measurement trend, 126
DVM (digital voltmeter), 332
DVM limit, beep on, 333, 393
Dynamic DNS, 387

E
ECL threshold, 149
edge speeds, 232
edge then edge triggering, 186
edge triggering, 184
edges, measure all, 307
editing measurements, 258
EEPROM data read, I2C trigger, 487
either edge trigger, 185
e-mail setups, images, or data, 374
e-mail, Quick Email, 407
EMBD license, 428
energy of a pulse, 102
enhanced security options, 400
Entry knob, 42
Entry knob, push to select, 42
envelope math function, 123
envelope, max/min, 125
equivalent time sampling, 241
erase, secure, 378
event table, 161
exFAT file system format, 390
expand about, 87, 391
expand about center, 392
expand about ground, 391
explicit clock recovery, 134

exponential fall waveform generator 
output, 346

exponential math function, 118
exponential rise waveform generator 

output, 346
exporting waveform, 365
EXT TRIG IN as Z-axis input, 76
EXT TRIG IN connector, 48
external memory device, 48
external scaling, probe, 93
external trigger, 225
external trigger, input impedance, 225
external trigger, input signal 

range, 226
external trigger, probe 

attenuation, 226
external trigger, probe units, 225

F
factory default settings, 378
Fall time measurement, 274
fall time measurement trend, 127
falling edges count 

measurements, 279
fast debug Autoscale, 394
FAT file system format, 390
FAT32 file system format, 390
FFT (Magnitude) detection type, 108
FFT aliasing, 113
FFT analysis measurements, 281
FFT DC value, 112
FFT gating, 107
FFT magnitude math function, 105
FFT measurement hints, 111
FFT peaks, searching, 110
FFT phase math function, 105
FFT resolution, 111
FFT spectral leakage, 114
FFT units, 112
FFT vertical units, 107
FFT window, 107
file explorer, 388
file format, ASCII, 366
file format, BIN, 366
file format, BMP, 366
file format, CSV, 366
file format, PNG, 366
File keys, 46
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file name, new, 373
file, save, recall, load, 388
filter math function, averaged 

value, 122
filter math function, band pass, 121
filter math function, envelope, 123
filter math function, high pass and low 

pass, 120
filter math function, smoothing, 122
filters, math, 119
fine adjustment, channel, 90
fine adjustment, horizontal scale, 78
firmware updates, 430
firmware upgrade files, 419
firmware version information, 409
firmware versions, 419
first-order PLL clock recovery, 133
flash drive, 48
Flat top FFT window, 107
FLEX license, 428
FlexRay frame counter, 481
FlexRay serial decode, 479
FlexRay totalizer, 481
FlexRay trigger, 476
flick touch gesture, 52
FM (frequency modulation), waveform 

generator output, 360
folding frequency, 229
forcing a trigger, 183
FRA (frequency response analysis), 337
FRA license, 428
frame trigger, I2C, 488
frame, LIN symbolic, 459
freeze display, 407
freeze display, Quick Freeze 

Display, 407
French front panel overlays, 50
frequency counter, 335
frequency data in CSV files, 440
frequency deviation, FM 

modulation, 361
Frequency measurement, 271
frequency measurement trend, 126
frequency modulation (FM), waveform 

generator output, 360
frequency peaks, searching, 110
frequency requirements, power 

source, 34
frequency response analysis (FRA), 337

frequency response analysis data, 
save, 341

frequency, Nyquist, 229
frequency-shift keying modulation 

(FSK), waveform generator 
output, 362

front panel controls and connectors, 40
front panel self test, 405
front panel, browser-based 

remote, 412
front panel, language overlay, 48
FSK (frequency-shift keying 

modulation), waveform generator 
output, 362

G
gated by cursors measurement 

window, 285
gateway IP, 387
gating, FFT, 107
Gaussian frequency response, 230
Gaussian pulse waveform generator 

output, 346
Generic video trigger, 207
German front panel overlays, 50
German noise requirements, 441
glitch capture, 235
glitch trigger, 188
golden waveform test, 317
grabber, 143, 144
graph, histogram, 297
graphical user interface language, 68
graticule intensity, 169
graticule type, 169
grid intensity, 169
grid type, 169
ground level, 86
Ground terminal, 47

H
Hanning FFT window, 107
hardware self test, 404
Help key, 46
help, built-in, 67
hex bus trigger, 193
hex mode cursors, 247
HF Reject, 223

high pass filter math function, 120
high-frequency noise rejection, 223
high-resolution mode, 233, 239
histogram, 291
histogram graph, 297
histogram statistics, 298
histogram, measurement, 292, 296
holdoff, 224
hop frequency, FSK modulation, 362
Horiz key, 44, 69, 74, 77, 237
Horizontal controls, 44, 73
horizontal Navigate key, 44
horizontal position control, 44
horizontal position knob, 71
horizontal scale fine adjustment, 78
horizontal Search key, 44
horizontal sweep speed control, 44
horizontal time/div control, 44
horizontal Zoom key, 44
host name, 387, 409
Host name softkey, 388

I
I/O interface settings, 385
I2C serial decode, 490
I2C trigger, 486
I2S serial decode, 511
I2S trigger, 508
identification function, web 

interface, 418
idle serial bus, 462, 491, 501, 512, 

567
Imped softkey, 89
impedance, digital probes, 153
increment statistics, 287
indeterminate state, 247
InfiniiMax probes, 91
infinite persistence, 168, 228, 235
information area, 67
input impedance, analog channel 

input, 89
installed licenses, 405
installed options, 419
instantaneous slope of a 

waveform, 101
Instrument Utilities web page, 419
Integrate math function, 102
intensity color grade scheme, 304
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intensity control, 165
Intensity key, 41
interpolate, arbitrary waveform 

option, 348
invert graticule colors, 368
invert waveform, 91
invert waveform generator output, 355
IP address, 387, 409
Italian front panel overlays, 50

J
Japanese front panel overlays, 50
jitter analysis, 305
Jitter analysis measurements, 261
jitter analysis, setting up, 306
Jitter key, 43
JITTER license, 428
jitter measurements, 309
Jitter-Free Trigger, 395

K
keys, front panel, 40
Keysight IO Libraries Suite, 414
knobs, front panel, 40
Korean front panel overlays, 50
ksx files, 389

L
Label key, 47
label list, 179
label list, loading from text file, 178
labels, 175
labels, auto-increment, 178
labels, reset library, 179
LAN connection, 387
LAN interface, remote control, 385
LAN port, 65
LAN Settings softkey, 387, 388
landscape mode, 382
language, user interface and Quick 

Help, 68
length control, 370
length softkey, 369
level, trigger, 182
LF Reject, 222
library, labels, 177

licenses, 427, 430
limit testing, measurement, 287
LIN serial decode, 460
LIN symbolic data, 457
LIN trigger, 458
line voltage, 34
Lister, 161
load file, 388
Load from, 373
localized front panel overlay, 48
Location, 373
Location, File Explorer softkey 

label, 390
logging remote commands, 399
logic presets, waveform generator, 356
logic threshold, 149
long save, beep on, 393
loop bandwidth (PLL), clock 

recovery, 133
low pass filter math function, 120
low-frequency noise rejection, 222

M
magnify math function, 123
Manchester serial decode, 520
Manchester trigger, 518
Manchester/NRZ serial analysis, 

license, 429
markings, product, 440
mask failure, beep on, 393
mask files, recall, 376
MASK license, 428
mask statistics, quick reset, 407
mask test, trigger output, 321, 396
mask testing, 317
mask, TRIG OUT signal, 396
math filters, 119
math functions, cascaded, 96
Math key, 45
math operators, 98
math transforms, 100
math visualizations, 123
math, 1*2, 99
math, 1/2, 99
math, addition, 98
math, differentiate, 101
math, divide, 99
math, FFT magnitude/phase, 105

math, functions, 95
math, integrate, 102
math, multiply, 99
math, offset, 97
math, scale, 97
math, subtract, 98
math, units, 97
math, using waveform math, 95
MATLAB binary data, 432
max envelope, 125
max hold math function, 125
maximum input voltages, 425
maximum math function, 124
Maximum measurement, 264
maximum sample rate, 233
Meas key, 46, 255
measure all edges, 307
Measure controls, 46
measure mode cursors, 246
measure statistics, quick reset, 407
measure, Quick Measure All, 407
measurement category, 

definitions, 424
measurement definitions, 258
measurement histogram, 292, 296
measurement limit testing, 287
measurement record, 370
measurement statistics, 285
measurement thresholds, 283
measurement trend math function, 125
measurement window, 285
measurements, 258
measurements, automatic, 255
measurements, delay, 259
measurements, edit, 258
measurements, jitter, 309
measurements, overshoot, 259
measurements, phase, 260
measurements, preshoot, 260
measurements, time, 270
measurements, voltage, 263
MegaZoom IV, 5
mem4M, 428
memory depth and sample rate, 233
memory, segmented, 242
menu line, 67
message, CAN symbolic, 449
MIL-STD-1553 serial decode, 534
MIL-STD-1553 trigger, 533
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min envelope, 125
min hold math function, 125
minimum math function, 124
Minimum measurement, 264
missing acknowledge condition, I2C 

trigger, 487
Mode/Coupling key, trigger, 219
model number, 405, 409
Modify softkey, 388
modulation, waveform generator 

output, 358
module installed, 405
MSO, 5
MSO feature upgrade, 430
MSO license, 429
Multicast DNS, 387
multiplexed position knob, 45
multiplexed scale knob, 45
Multiply math function, 99

N
N2820A high-sensitivity current 

probe, 261
N8900A Infiniium Offline oscilloscope 

analysis software, 366
natural logarithm math function, 118
navigate files, 388
Navigate key, 44
navigating the time base, 81
negative pulse width measurement 

trend, 126
network configuration parameters, 409
network printer connection, 381
network, connecting to, 387
new label, 177
noise rejection, 223
noise waveform generator output, 345
noise, adding to waveform generator 

output, 357
noise, high-frequency, 223
noise, low-frequency, 222
noisy signals, 219
nominal data rate, clock recovery, 133
non-volatile memory, secure 

erase, 378
normal acquire mode, 234
normal mode, 233, 234
Normal trigger mode, 220

notices, 2
N-Period jitter measurement, 310
NRZ license, 429
NRZ serial decode, 527
NRZ trigger, 526
Nth edge burst trigger, 197
Nth edge burst triggering, 197
number of negative pulses 

measurements, 279
number of positive pulses 

measurements, 278
Nyquist frequency, 113
Nyquist sampling theory, 229

O
occupied bandwidth FFT analysis 

measurement, 281
offset (DC) correction for integrate 

waveform, 103
operators, math, 98
options, print, 382
OR trigger, 194
oscilloscope bandwidth, 229
oscilloscope bandwidth required, 232
oscilloscope rise time, 231
oscilloscope sample rate, 231
output load expected, waveform 

generator, 355
output settings, waveform 

generator, 354
output, trigger, 396
overlay, localized, 48
Overshoot measurement, 259, 265
overvoltage category, 426

P
palette, 368
pan and zoom, 70
passive probes, 91
passive probes, compensating, 39
password (network), change or 

disable, 421
password (network), setting, 420
pattern trigger, 191
pattern, SPI trigger, 499
PC connection, 388
peak detect mode, 233, 234, 235

peak-peak math function, 125
Peak-peak measurement, 263
period counter, 335
Period measurement, 271
period measurement trend, 126
Period-Period jitter measurement, 311
persistence, 167
persistence, clearing, 168
persistence, infinite, 228
Phase measurement, 260, 276
phase of frequency-tracked waveform 

generator output, 363
phase X cursor units, 248
pinch touch gesture, 52
PNG file format, 366
points per span, FFT (Magnitude), 108
point-to-point connection, 388
pollution degree, 426
pollution degree, definitions, 426
Portuguese front panel overlays, 50
position digital channels, 149
position knob, 149
position, analog, 87
positive pulse width measurement 

trend, 126
post-processing, 256
post-trigger information, 72
Power App measurements, 260
power consumption, 34
power cord connector, 64
power requirements, 34
power supply, 64
power switch, 35, 41
power-on, 34
precision analysis record, 370
precision measurements and 

math, 289
precision measurements, jitter analysis 

and, 306
predefined labels, 176
Preshoot measurement, 260, 267
Press to go, 373
Press to go, File Explorer softkey 

label, 390
pre-trigger information, 72
print, 407
Print key, 46
print options, 382
print screen, 379
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print, landscape, 382
print, Quick Print, 407
printer, USB, 48, 379
printing the display, 379
probe attenuation, 92
probe attenuation, external 

trigger, 226
probe compensation, 47
probe external scaling, 93
probe head, 94
probe units, 92
probe, AutoProbe interface, 47
probe, calibrate, 93
probes, 426
probes, connecting to oscilloscope, 35
probes, digital, 141
probes, passive, compensating, 39
programmer's guide, 415
PTYPE frames, CXPI, 467
pulse polarity, 189
pulse waveform generator output, 345
pulse width trigger, 188
PWR license, 429

Q
qualifier, pulse width, 190
Quick Action key, 46, 407
Quick Clear Display, 408
Quick Email, 407
Quick Freeze Display, 407
Quick Help, 67
Quick Help language, 68
Quick Mask Statistics Reset, 407
Quick Measure All, 407
Quick Measure Statistics Reset, 407
Quick Print, 407
Quick Recall, 407
Quick Save, 407
Quick Trigger Mode, 407
Quick WaveGen Single-Shot, 408

R
ramp waveform generator output, 345
random noise, 219
random trigger holdoff, 224
range, external trigger input, 226
ratio measurement, 270

ratio measurement trend, 126
ratio X cursor units, 248
ratio Y cursor units, 248
raw acquisition record, 370
real-time eye analysis, 313
Real-Time Eye analysis 

measurements, 261
realtime sampling and oscilloscope 

bandwidth, 241
realtime sampling option, 240
rear panel connectors, 64
re-arm time, 244
recall, 407
recall files via web interface, 416
recall mask files, 376
recall setups, 376
recall, Quick Recall, 407
recovery, clock, 132
rectangle draw mode, 51
Rectangular FFT window, 107
Ref key, 45, 137
reference point, waveform, 391
reference signal mode, 397
reference waveforms, 137
regulatory information, 440
remote commands, logging, 399
remote control, 385
Remote Front Panel, 413
remote programming, Keysight IO 

Libraries, 414
remote programming, web 

interface, 412
required oscilloscope bandwidth, 232
reset label library, 179
restart condition, I2C trigger, 487
results, frequency response analysis 

(FRA), 340
return instrument for service, 406
Rise time measurement, 274
rise time measurement trend, 126
rise time, oscilloscope, 231
rise time, signal, 232
rise/fall time triggering, 195
rising edge count measurements, 279
RMS - AC measurement trend, 126
roll mode, 73
RS232 trigger, 563
Run Control keys, 44
runt pulses, 271

runt triggering, 198
Russian front panel overlays, 50

S
sample rate, 4
sample rate and memory depth, 233
sample rate, current rate displayed, 70
sample rate, oscilloscope, 230, 231
sampling theory, 229
sampling, overview, 228
saturated color grade, 302
save, 407
save file, 388
save files via web interface, 415
save segment, 369
save setup files, 367
save times, data, 371
Save to, 373
save, Quick Save, 407
save/recall from web interface, 415
Save/Recall key, 46
saver, screen, 393
saving data, 365
SCL, I2C trigger, 486
SCLK, I2S trigger, 506
SCPI Commands window, 413
screen image via web interface, 417
screen saver, 393
SDA, 485
SDA, I2C trigger, 486
Search key, 44
second-order PLL clock recovery, 133
secure erase, 378
security options, enhanced, 400
segmented memory, 242
segmented memory, re-arm time, 244
segmented memory, saving 

segments, 369
segmented memory, statistical 

data, 244
select digital channels, 149
select knob, 149
Selected, File Explorer softkey 

label, 390
selecting, values, 42
self test, front panel, 405
self test, hardware, 404
SENSOR license, 429
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SENT data, searching, 559
SENT decode, interpreting, 555
SENT decode, signal setup, 547
SENT fast signals definition, 550
SENT Lister data, 557
SENT serial decode, 554
SENT trigger, 552
serial clock, I2C trigger, 486
serial clock, I2S trigger, 506
serial data, 485
serial data, I2C trigger, 486
serial decode controls, 45
Serial key, 45
serial number, 405, 409
serial signal chart, 129
service functions, 403
setup and hold triggering, 201
setup files, saving, 367
setup, automatic, 145
setup, default, 37
setup, frequency response analysis 

(FRA), 338
setups, recall, 376
shipping damage, 31
shipping precautions, 406
sidebar, 54
Sigma, minimum, 320
signal, CAN symbolic, 449
signal, LIN symbolic, 459
Simplified Chinese front panel 

overlays, 50
sinc waveform generator output, 345
sine waveform generator output, 345
single acquisition, 44
Single key, 227
single, beep on, 393
single-shot acquisitions, 221
single-shot events, 228
single-shot, waveform generator, 355
size, 147
skew, analog channel, 93
Slew Rate measurement, 280
slope trigger, 184
smoothing math function, 122
Snapshot All measurements, 262
snapshot all, quick action, 407
softkey labels, 67
softkeys, 9, 41
software updates, 430

software version, 405
Span, FFT, 106
Spanish front panel overlays, 50
speaker options, 392
specifications, 423
spectral leakage, FFT, 114
SPI serial decode, 500
SPI trigger, 498
square math function, 116
square root, 115
square waveform generator 

output, 345
square waves, 230
stand-alone connection, 388
start acquisition, 44
start condition, I2C, 487
Start Freq, FFT, 106
state logic bus chart, 128
statistics, histogram, 298
statistics, increment, 287
statistics, mask test, 322
statistics, measurement, 285
statistics, using segmented 

memory, 244
status line, 66
status, User Cal, 405
Std Deviation measurement, 268
stop acquisition, 44
stop condition, I2C, 487
Stop Freq, FFT, 106
storage locations, navigate, 373
subnet mask, 387
subtract math function, 98
sweep frequencies, frequency response 

analysis, 339
symbolic data, CAN, 446
symbolic data, LIN, 457
sync pulse, waveform generator, 356

T
temperature color grade scheme, 304
template, front panel, 48
test, mask, 317
themes, color grade, 304
theory, sampling, 229
threshold, analog channel 

measurements, 283
threshold, digital channels, 149

thumb drive, 48
tilt for viewing, 34
Time at Edge measurement, 274
time measurements, 270
time reference indicator, 79
time, re-arm, 244
timebase, 73
times for saving data, 371
timing logic bus chart, 127
Tools keys, 46
Top measurement, 264
total harmonic distortion (THD) FFT 

analysis measurement, 282
totalize counter, 335
totalizer, ARINC 429, 544
totalizer, CAN, 452
totalizer, FlexRay, 481
totalizer, UART/RS232/422/485, 567
Touch key, 47, 50
touchscreen controls, 50
tracking cursors, 246
Traditional Chinese front panel 

overlays, 50
training signals, 47
transforms, math, 100
transmit single-shot, waveform 

generator, 355
Transparent backgrounds, 392
TRIG OUT connector, 64, 396
TRIG OUT signal and zone qualified 

trigger, 218
Trig'd trigger indicator, 221
Trig'd? trigger indicator, 221
Trigger controls, 43
trigger coupling, 221
trigger indicator, Auto?, 221
trigger indicator, Trig'd, 221
trigger indicator, Trig'd?, 221
trigger level, 182
trigger mode, auto or normal, 220
trigger mode, Quick Trigger Mode, 407
trigger output, 396
trigger output, mask test, 321, 396
trigger qualified event signal, 

counting, 335
trigger type, ARINC 429, 539
trigger type, CAN, 447
trigger type, CXPI, 466
trigger type, edge, 184
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trigger type, edge then edge, 186
trigger type, FlexRay, 476
trigger type, glitch, 188
trigger type, hex bus, 193
trigger type, I2C, 486
trigger type, I2S, 508
trigger type, LIN, 458
trigger type, Manchester, 518
trigger type, MIL-STD-1553, 533
trigger type, NRZ, 526
trigger type, Nth edge burst, 197
trigger type, OR, 194
trigger type, pattern, 191
trigger type, pulse width, 188
trigger type, rise/fall time, 195
trigger type, RS232, 563
trigger type, runt, 198
trigger type, SENT, 552
trigger type, setup and hold, 201
trigger type, slope, 184
trigger type, SPI, 498
trigger type, UART, 563
trigger type, USB 2.0, 573
trigger type, USB PD, 582
trigger type, video, 202
trigger types, 181
trigger, beep on, 393
trigger, definition, 182
trigger, external, 225
trigger, forcing a, 183
trigger, general information, 182
trigger, holdoff, 224
trigger, mode/coupling, 219
trigger, source, 184
trigger, zone qualified, 216
triggers, TRIG OUT signal, 396
TTL threshold, 149
turn channel on, 47

U
U2H license, 429
UART totalizer, 567
UART trigger, 563
UART/RS232 license, 428
UART/RS232/422/485 frame 

counter, 567
UART/RS232/422/485 serial 

decode, 565

under-sampled signals, 229
units, cursor, 248
units, external trigger probe, 225
units, math, 97
units, probe, 92
updating software and firmware, 430
upgrade files, 419
upgrade options, 427
upgrading the oscilloscope, 430
upload new firmware, 409
usb, 391
USB 2.0 serial decode, 575
USB 2.0 trigger, 573
USB decode, signal speed, 571
USB device port, 65
USB device port, remote control, 385
USB host port, 65, 379
USB host ports, 48
USB PD decode, interpreting, 585
USB PD decode, signal setup, 581
USB PD Lister data, 586
USB PD serial analysis, license, 429
USB PD serial decode, 584
USB PD trigger, 582
USB printer, 379
USB printers, supported, 379
USB storage device, 48
USB, CD device, 391
USB, eject device, 48
USB, storage device numbering, 391
usb2, 391
USBPD license, 429
USBSQ license, 429
user cal, 404
user calibration, 404
user interface language, 68
User-defined threshold, 149
USF license, 429
utilities, 385
Utility key, 46

V
V RMS, FFT vertical units, 107
values, choosing, 42
variable persistence, 168
vectors or dots, waveform display, 172
ventilation requirements, 34
Vertical controls, 47

vertical expansion, 87
vertical offset, 87
vertical position, 87
vertical position knobs, 47
vertical scale knobs, 47
vertical sensitivity, 47, 87
Vertical Units, FFT, 107
VGA video output, 65
VID license, 429
video trigger, 202
video trigger, custom Generic, 207
viewing, tilt the instrument, 34
VISA connect string, 409
visualizations, math, 123
voice control, 392
voice recognition, 63
voltage measurements, 263

W
warranted specifications, 423
warranty, 2, 406
Wave Gen1/2 keys, 46, 48
waveform generator, 343
waveform generator amplitude, 

frequency response analysis, 339
waveform generator defaults, 

restoring, 363
waveform generator dual channel 

tracking, 363
waveform generator expected output 

load, 355
waveform generator logic presets, 356
waveform generator output 

settings, 354
waveform generator sync pulse, 356
waveform generator sync pulse, TRIG 

OUT signal, 396
waveform generator, arbitrary 

waveforms, 347
waveform generator, invert output, 355
waveform generator, output 

single-shot, 355
waveform generator, output single-shot 

quick action, 408
waveform generator, waveform 

type, 343
Waveform keys, 43
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waveform type, waveform 
generator, 343

waveform, cursor tracking, 246
waveform, intensity, 165
waveform, printing, 379
waveform, reference point, 391
waveform, saving/exporting, 365
WAVEGEN license, 429
web interface, 409
web interface, accessing, 410
white noise, adding to waveform 

generator output, 357
Width - measurement, 273
Width + measurement, 273
-Width to -Width jitter 

measurement, 312
Window, FFT, 107
write data with no ack condition, I2C 

trigger, 487

X
X at Max Y measurement, 278
X at Max Y on FFT, 260
X at Min Y measurement, 278
X at Min Y on FFT, 260
XY mode, 73, 74

Y
Y at X measurement, 264

Z
Z-axis blanking, 76
zero phase reference, FFT (Phase), 109
zone qualified trigger, 216
zoom and pan, 70
zoom display measurement 

window, 285
Zoom key, 44
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